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About this publication
IBM Workload Scheduler  simplifies systems management across distributed environments by integrating systems 

management functions. IBM Workload Scheduler  plans, automates, and controls the processing of your enterprise's entire 

production workload. The IBM Dynamic Workload Console User's Guide  provides detailed information about how to 

configure and use the Dynamic Workload Console  to manage your IBM Workload Scheduler  environment.

What is new in this release
For information about the new or changed functions in this release, see IBM Workload Automation: Overview, section 

Summary of enhancements.

For information about the APARs that this release addresses, the Dynamic Workload Console  Release Notes  at Dynamic 

Workload Console Release Notes.

Accessibility
Accessibility features help users with a physical disability, such as restricted mobility or limited vision, to use software 

products successfully.

With this product, you can use assistive technologies to hear and navigate the interface. You can also use the keyboard 

instead of the mouse to operate all features of the graphical user interface.

For full information, see the Accessibility Appendix in the IBM Workload Scheduler User's Guide and Reference.

Technical training
Cloud & Smarter Infrastructure provides technical training.

For Cloud & Smarter Infrastructure technical training information, see:  http://www.ibm.com/software/tivoli/education

Support information
IBM provides several ways for you to obtain support when you encounter a problem.

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides the following ways for you to 

obtain the support you need:

• Searching knowledge bases: You can search across a large collection of known problems and workarounds, 

Technotes, and other information.

• Obtaining fixes: You can locate the latest fixes that are already available for your product.

• Contacting IBM Software Support: If you still cannot solve your problem, and you need to work with someone from 

IBM, you can use a variety of ways to contact IBM Software Support.

For more information about these three ways of resolving problems, see the appendix about support information in IBM 

Workload Scheduler: Troubleshooting Guide.

http://www.ibm.com/support/docview.wss?uid=ibm10733054
http://www.ibm.com/support/docview.wss?uid=ibm10733054
http://www.ibm.com/software/tivoli/education


Chapter 1. Getting Started
Information about the Dynamic Workload Console  installation and configuration.

For more information about this installation, see the IBM Workload Scheduler: Planning and Installation.

installingDynamic Workload Console installationDynamic Workload Console

To configure the Dynamic Workload Console, see the section about configuring the Dynamic Workload Console  in the IBM 

Workload Scheduler: Administration Guide  to find information about:

• Launching in context with the Dynamic Workload Console

• Configuring access to the Dynamic Workload Console

• Configuring Dynamic Workload Console  to use Single Sign-On

• Configuring the use of Lightweight Third-Party Authentication

• Configuring Dynamic Workload Console  to use SSL

• Customizing your global settings

• Configuring Dynamic Workload Console  to view reports

You can access the Dynamic Workload Console  from any computer in your environment using a web browser through either 

the secure HTTPS or HTTP protocol.

The first and main actions that you perform when you connect to the Dynamic Workload Console  are:

Creating a connection to a IBM Workload Scheduler  engine

You specify the details (such as IP address, user name, and password) to access a IBM Workload Scheduler 

engine, and, optionally, a database to operate with objects defined in plans or stored in the database.

From the Dynamic Workload Console, you can access the current plan, a trial plan, a forecast plan, or an 

archived plan for the distributed environment or the current plan for the z/OS®  environment.

You might want to access the database to perform actions against objects stored in it or to generate reports 

showing historical or statistical data.

In addition, working both on the database and on plans, you can create and run event rules  to define and trigger 

actions that you want to run in response to events occurring on IBM Workload Scheduler  nodes.

Defining a scheduling environment

You define your IBM Workload Scheduler  network. You create workstation definitions in the database to 

represent the physical machines or computer systems on which your workload is scheduled to run. A 

IBM Workload Scheduler  network is made up of the workstations where job and job stream processing 

occurs. When you design your network, you assign roles to these workstations to suit your specific business 

requirements. You can design your network with multiple domains, to divide control of a large network into 

smaller manageable groups. A typical IBM Workload Scheduler  network consists of a workstation acting as the 

master domain manager and at least one domain.

9
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Defining scheduling objects in the database

You define your workload, which consists of jobs that are concatenated in job streams. Then, you specify 

the calendars and run cycles according to which job streams must run. You can also define dependencies to 

condition the workload processing. All these definitions can be done within the Workload Designer.

Creating tasks to manage IBM Workload Scheduler  objects in the plan

You specify some filtering criteria to query a list of scheduling objects whose attributes satisfy the criteria you 

specified. Starting from this list, you can navigate and modify the content of the plan, switch between objects, 

open more lists, and access other plans or other IBM Workload Scheduler  environments.

Related information

Creating and managing engine connections  on page 13

Designing your Workload  on page 101

Monitoring your Workload  on page 197

Navigating the Dynamic Workload Console
An overview to the Dynamic Workload Console.

For an interactive overview of the product and its features, you can view several demo scenarios, available (in English only) 

on the Workload Automation YouTube channel.

After you have installed and configured the Dynamic Workload Console, you can start defining and scheduling your workload. 

Log in by connecting to:

https://˂your_ip_address>:9443/console/login.jsp

You can access the Dynamic Workload Console  from any computer in your environment using a web browser through the 

secure HTTPS protocol.

To have a quick and rapid overview of the portal and of its use, after logging in, the Welcome page for the Dynamic Workload 

Console  is displayed in the console window. This window has a navigation menu across the top, organized in categories. 

Each category drops down to display a number of options that when clicked, display a page in the work area on the left. Each 

page displays with a title in its tabbed window in the work area.

Several products can be integrated in this portal and their related entries are listed together with those belonging to the 

Dynamic Workload Console  in the navigation bar displayed at the top of the page.

The navigation bar at the top of the page is your entry point to the Dynamic Workload Console.

Related information

Accessing online product documentation  on page 243

Scenarios  on page 234

https://www.youtube.com/user/workloadautomation2
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Convention for specific platform information
Icons to identify the information related only to specific platforms.

This publication uses the following icons to identify the information related only to specific platforms:

The information applies only to IBM®  Workload Scheduler  running in a distributed environment.

The information applies only to IBM®  Workload Scheduler  running in a z/OS environment.

All information that is not marked by an icon applies to all the supported environments.

Naming conventions for scheduling objects

The Dynamic Workload Console  allows you to manage and control IBM®  Workload Scheduler  production for z/OS and 

distributed environments.

There are some differences in the processing and behavior between the IBM®  Workload Scheduler  products for z/OS 

and distributed environments. When there are differences, the descriptions and related actions of scheduling objects are 

explained for both environments.

Table 1: Naming convention for scheduling objects  on page 11 lists the objects and object names typical of the IBM® 

Workload Scheduler  environment where they are defined.

Table  1. Naming convention for scheduling objects

Object description Object name in a distributed environment Object name in a z/OS environment

An ordered list of activities in 

plan for the current production 

period. The production 

plan contains information 

about the processes to run, 

on which workstation, and 

what dependencies must be 

satisfied before each process is 

launched. The production plan 

is automatically created and 

managed by the product and 

requires no user intervention. 

The production plan is generated 

daily at 05:00 CDT time.

Production Plan Current Plan

A unit of work that is part of 

an application or a job stream 

Job Operation. An operation can contain a 

list of steps to run.

11
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Table  1. Naming convention for scheduling objects  (continued)

Object description Object name in a distributed environment Object name in a z/OS environment

and that is processed at a 

workstation.

A list of jobs that run as a unit 

to accomplish a task (such as 

calculating payroll), together 

with times, priorities, and other 

dependencies that determine the 

order in which the jobs run.

Job stream Application

A run of a job stream or an 

application scheduled in the plan.

Instance Occurrence

A type of application description 

related to run cycle, calendar 

information, or job descriptions 

common to all applications 

defined as members of the 

group.

N/A Application Group

A physical or logical asset where 

job processing occurs.

Workstation. It is qualified according to its 

position in the topology of the scheduling 

network and on its ability to interact with the 

information contained in the current plan.

Workstation. It is qualified according 

to the type of job processing it does 

in computer workstation, general 

workstation, print workstation.

IBM®  Workload Scheduler 

database

A customized set of tables in a relational 

database containing definitions for all 

scheduling objects, network topology, 

variables, and job processing statistics.

A collection of six sets of data, acting 

as a flat database, that contain 

information about calendars, periods, 

workstation descriptions, JCL variable 

tables, application descriptions, and 

operator instructions.

Related information

Workstation  on page 44

Job  on page 52

Job stream  on page 53

Production process  on page 80
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Creating and managing engine connections
How you can create, modify, or delete engine connections.

About this task

To create, modify, or delete an engine connection, perform the following steps.

Note:  You can modify or delete only engine connections that you have created.

1. From the navigation toolbar, click Administration  > Manage Engines.

2. From the displayed panel you can create, edit, delete, or share an engine connection, and test the connection to the 

remote server where IBM Workload Scheduler  is installed. You can order the list of engine connections displayed in 

this panel by using sorting criteria that you select with the buttons at the top left corner of the table.

Related information

Scheduling objects  on page 51

Engine connections  on page 85

Event management configuration
Authorizations needed to use event management.

You can use the event management feature both from the IBM Workload Scheduler  command line interface and from the 

Dynamic Workload Console.

You need the following authorizations to perform event management operations from the Dynamic Workload Console:

On Dynamic Workload Console

The user ID you use to log in to Dynamic Workload Console  must be defined as user in the Manage Roles 

section and must be defined within one of the following groups:

Table  2. Event Management Authorizations

Groups Event management operations you can perform

Operator List and manage Event Rule Instances, Log Messages, and Triggered 

Actions.

Developer Create, list, and manage Event Rules.

13
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Note:  Dynamic Workload Console  users belonging to the Administrator  group can perform all 

operations available in the web-based user interface.

How to get help

A new contextual help has been created to better guide you through the Dynamic Workload 

Console interface and its fields.

Note:  If you are using Microsoft Edge, the help tool is available only on version 44.19041 

or later (Chromium-based versions).

To open and start using the help tool, you need to click on the question mark 

 on the top of the page.

The help opens on the left of the interface. If you want to expand it, you can drag the right margin, 

or select the detach icon  to detach the help pane and view it in a separate window.

You can also change the font size of the topics by selecting the font size icon .

The home page shows the main topics related to the page you are navigating and three useful 

links that redirect you to the What’s new page, to our YouTube channel, or our Community page.

If you cannot find the information you are looking for in the main topics, you can enter a keyword 

in the search bar and find the information you need.

Once you performed a search, you can go back to previous searches by selecting the back icon 

. Otherwise, by selecting the home icon , you can go back to the home page to 

view again the main topics.

Leaving the help opened and moving from a field to another to configure them, the help 

automatically updates itself and shows you the information about the selected field.

On IBM Workload Scheduler

The IBM Workload Scheduler  user credentials defined in the engine connection must belong to a IBM Workload 

Scheduler  user authorized to perform event management operations in the IBM Workload Scheduler  security 

file.
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You need the create  permission set for the rule  object. You also need the use  permission on the objects (job, 

job stream, and so on) that you want to use as events.

For more information about how to define and manage user authorizations in the security file, see IBM 

Workload Scheduler: Administration Guide.

Related information

Event management  on page 86

Installing and configuring the Dynamic Workload Console
For more information about this installation, see the section about the typical installation scenario in Planning and 

Installation Guide  or Planning and Installation

installingDynamic Workload Console installationDynamic Workload Console

To configure the Dynamic Workload Console, see the Administration Guide  to find information about:

• Launching in context with the Dynamic Workload Console

• Configuring access to the Dynamic Workload Console

• Configuring Dynamic Workload Console  to use Single Sign-On

• Configuring Dynamic Workload Console  to use SSL

• Customizing your global settings

• Configuring High Availability for Dynamic Workload Console

• Configuring Dynamic Workload Console  to view reports

For more information about z/OS connector instances configuration by using WebSphere Application Server tools, see 

IBM Z Workload Scheduler: Planning and Installation> IBM Z Workload Scheduler connector  > Installing, Upgrading and 

Uninstalling IBM Z Workload Scheduler connector  on distributed systems.

15
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Chapter 2. Running IBM Workload Scheduler  from a mobile 
device
Use your mobile device to easily and quickly interact with your IBM Workload Scheduler  environment.

The IT market is moving towards mobile devices, which help you perform a large number of tasks, such as manage your 

sales workforce, read your email, check your accounting system, or attend a web conference. Applications designed for 

mobile devices must be intuitive and user-friendly while remaining robust and reliable, and providing instant access to 

business and client data wherever they are.

You can interact with IBM Workload Scheduler  by using the Self-Service Catalog and Self-Service Dashboards applications.

To open this home page on your mobile device, access the following URL:

https://host_name:port_number/dwc/mobile.jsp

where host_name  and port_number  are the host name and port number of the Dynamic Workload Console  you are 

connecting to.

You can open the applications also from the Single Entry Point  page.

For details refer to the section about product user interfaces in IBM Workload Automation: Overview.

To use an engine connection from a mobile device, ensure the engine credentials are shared or the Dynamic Workload 

Console  is configured to use Single-Sign On. For more information, see the section about configuring the Dynamic Workload 

Console  to use Single Sign-On in the IBM®  Workload Scheduler Administration Guide.

Self-Service Catalog

Define services that correspond to IBM®  Workload Scheduler  job streams and submit them from your mobile, 

even if you do not have any experience with IBM®  Workload Scheduler. Services are organized into catalogs.

Launch the Self-Service Catalog  from your mobile device by connecting to the following URL:

https://host_name:port_number/dwc/sscatalog.jsp

where host_name  and port_number  are the host name and port number of the Dynamic Workload Console  you 

are connecting to.
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To launch and use this application, you must have one of the following roles:

Mobile User

This is the minimum role required to access Self-Service Catalog. Users with this role can view 

catalogs and services to which they are authorized and submit service requests. Associate at 

least one entity to this role to allow other roles access to the Self-Service Catalog.

Administrator

Users with this role can create, edit, and delete catalogs and services. They can also associate 

roles to services and catalogs to authorize other users to work with them.

Self-Service Dashboards

By defining filter criteria to be applied to your jobs and workstations, you can view dashboards and drill down 

to more detailed information about the jobs and workstations that match the criteria. You can also perform 

recovery actions on the jobs and workstations.

Note:  Filtering by workstation job  is only available on distributed environments.

Launch the Self-Service Dashboards  app from your mobile device by connecting to the following URL:

https://host_name:port_number/dwc/ssmanagement.jsp

where host_name  and port_number  are the host name and port number of the Dynamic Workload Console  you 

are connecting to.

To launch and use this application, you must have one of the following roles:

Mobile User

This is the minimum role required to access Self-Service Dashboards. Users with this role can 

view dashboards for which they are authorized but they cannot modify dashboards.

Administrator

Users with this role can create, edit, and delete dashboards. They can also associate roles to 

dashboards to authorize other users to work with them.

Related information

Workload Dashboard  on page 188

17
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Chapter 3. Managing users and repositories
How to configure, change, and share your settings repository and change the DB2 user. How to manage the user settings.

The user settings such as user preferences, saved tasks, and engine connections, which by default are stored in a settings 

repository that is a local XML file, must be exported and stored in a settings repository on a DB2 database. Using a database 

as your repository, all your existing user settings relating to current Dynamic Workload Console  are saved in the database, 

and all the operations involving user settings are run using the settings in this repository.

Managing user settings
How to export the user settings and import them into a new Dynamic Workload Console

Before you begin

To perform this task you need to have Administrator role.

About this task

User settings such as user preferences, saved tasks, and engine connections are stored in the settings repository, which 

by default is a local file. However, you can decide to have your settings repository on a database for all Dynamic Workload 

Console  operations that involve user settings.

You can export the content of your settings repository as an XML file, optionally modify it, and then import it into the same or 

another instance of Dynamic Workload Console.

This is particularly useful for migration purposes or if you want to modify the same settings in multiple Dynamic Workload 

Console  instances.

To export the settings and import them into a new Dynamic Workload Console, perform the following procedure.

Note:  Import and export operations are performed from and to the currently-selected repository.

Note:  The Import/Export operation does not apply to the Custom Board.

1. From the navigation toolbar, click Administration  >  Manage Settings.

2. In the Manage Settings  panel, click Export Settings  and save the XML file in a directory of your choice.

3. Optionally, edit the file using an XML editor and save it.

4. Log in to the Dynamic Workload Console  where you want to import the settings and open the Manage Settings  panel.

5. Click Import Settings  and browse to the XML file containing the settings you want to import.

6. Log out from the Dynamic Workload Console  and log in again.

Moving configurations and settings definitions from one database to a 
different database
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About this task

You can use the procedure described below to to move Dynamic Workload Console  configurations and settings definitions 

from one database to a different database.

1. From the navigation toolbar, click Administration  >  Manage Settings.

2. In the Manage Settings  panel, click Export Settings  and save the XML file in a directory of your choice.

3. Optionally, edit the file using an XML editor and save it.

4. Optionally export your custom boards, as described in Exporting and importing a dashboard  on page 193.

5. Stop the Dynamic Workload Console  as described in Application server - starting and stopping.

6. Browse to the datasource_<db_vendor>.xml  file located in one of the following paths:

On UNIX operating systems

DWC_home/usr/servers/dwcServer/configDropins/templates

On Windows operating systems

DWC_home\usr\servers\dwcServer\configDropins\templates

7. Copy the datasource_<db_vendor>.xml  to the path for your operating system:

On UNIX operating systems

DWC_DATA_dir/usr/servers/dwcServer/configDropins/overrides

On Windows operating systems

DWC_home\usr\servers\dwcServer\configDropins\overrides

8. Configure the datasource_<db_vendor>.xml  file based on the specifics of your environment.

9. Only if you are moving from an Oracle database to a different database, browse to the following files:

◦ DWC_DATA_dir>/usr/servers/dwcServer/apps/DWC.ear/DWCRest.war/META-INF/orm.xml

◦ DWC_DATA_dir/usr/servers/dwcServer/apps/DWC.ear/Reporting.war/META-INF/orm.xml

◦ DWC_DATA_dir/usr/servers/dwcServer/apps/DWC.ear/TWSWebUI.war/META-INF/orm.xml

and replace the contents of the <schema>  tag with <schema>TDWC</schema>.

10. Only if you are moving to an Oracle database, browse to the following files:

◦ DWC_DATA_dir>/usr/servers/dwcServer/apps/DWC.ear/DWCRest.war/META-INF/orm.xml

◦ DWC_DATA_dir/usr/servers/dwcServer/apps/DWC.ear/Reporting.war/META-INF/orm.xml

◦ DWC_DATA_dir/usr/servers/dwcServer/apps/DWC.ear/TWSWebUI.war/META-INF/orm.xml

and replace the contents of the <schema>  tag with the name of the database user.

11. Restart the Dynamic Workload Console  as described in Application server - starting and stopping.

12. Click Import Settings  and browse to the XML file containing the settings you want to import.

13. Import custom boards, as described in Exporting and importing a dashboard  on page 193.

Results

You have now exported your configurations and settings definitions from one database to a different database.
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Changing the Dynamic Workload Console  user of DB repository
How to change the Dynamic Workload Console  user that updates the settings repository on DB2.

Before you begin

To perform this task you need to have the Administrator role.

You must have switched the Dynamic Workload Console  settings repository from a local file to a database repository, as 

described in Moving configurations and settings definitions from one database to a different database  on page 18.

About this task

Only users with database administrator rights are authorized to initialize the Dynamic Workload Console  related tables on the 

database.

If you want the Dynamic Workload Console  to access the database repository with a user without database administrator 

privileges you must follow these steps:

1. Create a new DB2 user and grant this user with SELECT, INSERT, UPDATE, DELETE rights on all the following tables, 

belonging to TDWC  schema:

TDWC_EngineConnection
TDWC_QueryTask
TDWC_ReportTask
TDWC_MEQueryTask
TDWC_Credential
TDWC_ConfigurationProperty
TDWC_Preferenceable

The above are the default permissions. However, if you need to restrict your policy, you can give the following 

permissions to the new DB2user:

revoke connect,bindadd, createtab, implicit_schema on database from public;
revoke use of tablespace USERSPACE1     from public;
 

grant use of tablespace userspace1 to  user twsdb2;
grant createtab on database to user  twsdb2;
grant implicit_schema on database to user twsdb2;

2. Change Dynamic Workload Console  user accessing DB2

a. From the navigation toolbar, click Administration  >  Manage Settings.

b. In the Database Settings  section, specify the credentials of the newly created user that must to connect to the 

database.

Note: As a result of this user switch, theDynamic Workload Console  without database administrator privileges will no 

longer be authorized to initialize the database in the Manage Settings  panel.
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How to configure, change, and share your settings repository.

Performance can be highly improved by configuring multiple Dynamic Workload Console  instances in a High Availability 

configuration, so as to have multiple console instances working at the same time and with the same repository settings.

The Dynamic Workload Console  is set to be always in High Availability and a front-end Network Dispatcher must be set up to 

handle and distribute all incoming session requests.

If you use a Dynamic Workload Console  in High Availability configuration, when you connect to a Dynamic Workload Console 

you are not actually connecting to a specific console but to a load balancer that dispatches and redirects the connections 

among the nodes in the configuration. Therefore, for example, if a node fails, new user sessions are directed to other active 

nodes in the configuration and this change is completely transparent to users.

To perform this task you need to have access to an installed DB2®, Oracle, Informix®  or MSSQL database. The High 

Availability cannot be configured using Apache Derby®

To implement this kind of configuration, the Administrator must ensure that the datasource.xml, located in the following path 

opt/wa/DWC/DWC_DATA/usr/servers/dwcServer/configDropins/overrides, has the same configuration on 

every Dynamic Workload Console  in the cluster.
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Chapter 5. Customizing your console
You can customize your console to have just the tasks that you want to access.

When you log in to the Dynamic Workload Console, a welcome page containing quick start information is displayed with links 

to additional information. A horizontal navigation bar across the top contains categories with different tasks.

Customizing roles
Following this scenario you can easily create your own customized roles in few steps.

About this task

Create a customized role for the Dynamic Workload Console

1. from the top panel click Administration  > Security  > Manage Roles

2. Click Add new, insert name, description and give the access to the pages desidered.

3. Click Ok

From the same tab you can edit, delete or duplicate the new role.

Add the new role to an existing entity

1. From the Manage Roles  panel, select the entity corresponding to the new role created by clicking on the number 

under the column Entity.

2. click Add  and type the name of the entity and specify whether it is a user or a group

Ensure you already have set the entity in the securty file as described in Configuring authenticationthe Configuring 

Authentication section of the Administration Guide.  the default security file is authorization_config.xml.

Customizing your portfolio
How to customize your portfolio.

About this task

Many different elements can be customized in the navigation toolbar across the top and on the left side of you Dynamic 

Workload Console.

You can create a list of your favorite pages, including only the tasks you use most often.

The Favorites  icon , lets you access your daily tasks.

To add a task to Favorites, simply click the icon  when opening the drop-down menu. To remove an item from your list 

of favorites, click the icon .

What to do next
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You can also define which pages must be automatically launched when logging into the Dynamic Workload Console  by 

pinning them. On the left bar, when the page is opened, click the icon .

Customizing your startup page
How to customize the startup page

About this task

In the Dynamic Workload Console, you can define the list of pages that are launched, on the left bar, every time you log in to 

the console. To pin a page on the left bar at every login, click the icon  when the page is displayed. Alternatively from the 

Manage Roles  section, users with role Administrator, can add or remove the pinned pages for each role.

Create and customize your boards

About this task

In the Dynamic Workload Console, users can create and customize a Board  not only with widgets to monitor the scheduling 

environment but also with web contents. For example, you can add a widget in the dashboard with your company's website 

and other external contents.

1. To add a web content to your dashboard, from the Dynamic Workload Console  click the tab Boards  > Create Board.

2. Enter the name of the custom Board.

3. Click  to add the widget.

4. Select Static widgets  and Web content.

5. Enter the name and the source of your content.

6. Click Save.

Result

The new frame is displayed in the board.

Customizing your global settings
How to customize global settings.

About this task

To customize the behavior of the Dynamic Workload Console, you can optionally configure some advanced settings. These 

settings are specified in a customizable file named TdwcGlobalSettings.xml.template.

By default, the customizable file is copied into the following path after you install the Dynamic Workload Console:

On Windows operating systems:

DWC_home\usr\servers\dwcServer\registry\TdwcGlobalSettings.xml.template
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On UNIX and Linux operating systems:

DWC_home/usr/servers/dwcServer/configDropins/templates/

TdwcGlobalSettings.xml.template

If you have Administrator privileges, you can modify the file to replace default values with customized ones and enable 

commented sections. To enable commented sections, remove the  tags that enclose the section. You then save the file 

locally with the name TdwcGlobalSettings.xml.

Note:  On UNIX and Linux operating systems, you need to save the TdwcGlobalSettings.xml  file in the following 

path: DWC_DATA_dir/usr/servers/dwcServer/registry/TdwcGlobalSettings.xml

You can add and modify some customizable information, such as:

• The URLs that link to videos in the Dynamic Workload Console. For example, you can link to a company intranet 

server to view help videos rather than to a public video site.

• The maximum number of objects to be shown in the graphical views.

• The setting to display the plan view in a new window.

• The auto refresh interval for the Show Plan View  graphical view.

• The creation of predefined tasks.

• The URLs where you can store customized documentation about your jobs or job streams to associate customized 

documentation to them.

• The current user registry in use.

• The timeout to read and write information on a IBM Z Workload Scheduler  engine.

• The maximum number of objects to be retrieved with a query, the maximum number of rows to display in a table, and 

the maximum number of direct queries to maintain in history.

• Allowing or preventing users from sharing tasks and engine connections.

• The display of all dependencies, both satisfied and unsatisfied.

• The use of audit files to track activities in the Self-Service Catalog  and Self-Service Dashboards  mobile applications.

• Displaying or hiding all predecessors from the What-if Analysis Gantt view.

This file is accessed at each login, and all configurations specified in the file are immediately applied, except for the 

precannedTaskCreation  property. This property is read only when a user logs in for the first time and is then used whenever 

this user logs in again.

You can use any text or XML editor to edit this file, but ensure that you save it is as a valid XML file.

The file is organized into sections that group similar properties. An explanation of each section is available in the file. For 

more information, see TdwcGlobalSettings.xml sample  on page 39.

Sections can also be repeated multiple times in the same file and applied differently to different user roles. To apply a 

section only to the users belonging to a role, the section must be included within the tags <settings role="user_role">  and 

</settings>, where:
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<user_role>

The user for which the enclosed configuration must be applied. The default value is all users, unless otherwise 

specified.

Only one settings  section can be specified for each role. If a user has more than one role, the settings associated to the 

higher role are used.

To edit the file, proceed as follows:

1. Stop WebSphere Application Server Liberty Base  using the following command:

UNIX™

Stop the application server

./stopAppServer.sh  [-direct]
           

Windows™

Stop the application server

stopAppServer.bat  [-direct
            [-wlpHome <installation_directory>]
            [-options <parameters>]]

as described in the section about starting and stopping WebSphere Application Server Liberty Base  in Administration 

Guide.

2. Log is as root or Administrator to the Dynamic Workload Console.

3. Browse to

On Windows operating systems:

DWC_home\usr\servers\dwcServer\registry\TdwcGlobalSettings.xml.template

On UNIX and Linux operating systems:

DWC_home/usr/servers/dwcServer/configDropins/templates/

TdwcGlobalSettings.xml.template

4. Edit the file as necessary, rename it to TdwcGlobalSettings.xml  and save it.

Note:  On UNIX and Linux operating systems, you need to save the TdwcGlobalSettings.xml  file in the 

following path: DWC_DATA_dir/usr/servers/dwcServer/registry/TdwcGlobalSettings.xml

5. Start WebSphere Application Server Liberty Base  using the following command:

UNIX™

Start the application server

./startAppServer.sh  [-direct]
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Windows™

Start the application server

startAppServer.bat  [-direct]
                 

as described in the section about starting and stopping WebSphere Application Server Liberty Base  in Administration 

Guide.

Example:

<?xml version"1.0"?>
<tdwc>
.
.
<settings>
<graphViews>
<property name="planViewNewWindow" value="true"/>
</graphViews>
</settings>
 

<settings  role="TWSWEBUIOperator">
<graphViews>
<property name="planViewNewWindow" value="false"/>
</graphViews>
</settings>
.
.
</tdwc>

To view the complete syntax for the file, see TdwcGlobalSettings.xml sample  on page 39.

Customize video URLs

This section shows how you should customize your URLs that link video content in the Dynamic Workload Console so that 

you can link to a company intranet server to view help videos rather than a public video site.

The _baseURL  prefix will be added to all your video URLs . If you do not specify a link for your video the default setting will 

automatically be used.

˂?xml version"1.0"?>
˂tdwc>
.
.
˂settings>
-˂videoGallery>
˂property  name="_baseURL" value="">˂/property>
˂property  name="depLoop" value="">˂/property>
˂property  name="highlightRelDep" value="">˂/property>
˂property  name="viewDepPrompt" value="">˂/property>
˂property  name="usingImpactView" value="">˂/property>
˂property  name="createUseTasks" value="">˂/property>
˂property  name="weAddRemoveFile" value="">˂/property>
˂property  name="weCreateDeps" value="">˂/property>
˂property  name="weAddJob" value="">˂/property>
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˂property  name="weHighlightDeps" value="">˂/property>
˂property  name="weCreateJCL" value="">˂/property>
˂/videoGallery>
 

Override graphical view limits

This section contains the configuration parameters that apply to the graphical views in the plan, such as the maximum 

number of objects shown in each view.

planViewMaxJobstreams

The maximum number of job streams displayed in the Plan View. Default value is 1000. Values greater than 

1000  are not supported.

preProdPlanViewMaxJobstreams

The maximum number of job streams displayed in the preproduction plan view. Default value is 1000. Values 

greater than 1000  are not supported.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
<graphViews>
<property name="planViewMaxJobstreams" value="1000"></property>
<property name="preProdPlanViewMaxJobstreams" value="1000"></property>
</graphViews>
 </settings>
.
.
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Plan View in new window

This section is used to prevent Internet Explorer 7 from freezing while using the Plan View. To solve the problem, set value to 

true.

planViewNewWindow

Set it to true  if you want the plan view to be displayed in a new window each time it is launched. Default value is 

false.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
<graphViews>
<property name="planViewNewWindow" value="true"/>
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</graphViews>
.
.
 </settings>
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Plan View auto refresh interval

Use this section to change the default setting of the auto refresh interval for the Show Plan View graphical view for all users. 

By default, the auto refresh interval is 300 seconds  (five minutes).

PlanViewAutorefresh

The graphical representation of the Plan View is automatically refresh every 300 seconds by default. To 

change this setting, edit the value assigned to the DefaultTime  property. The minimum value you can set is 30 

seconds. Any value specified below this value is reset to 30 seconds. You must restart the Dynamic Workload 

Console  application server after modifying this value.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
<PlanViewAutorefresh>
<property name="DefaultTime" value="300"/>
</PlanViewAutorefresh>
.
.
 </settings>
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Disable and customize NewsFeed function

This section contains the configuration details to be constantly up-to-date with product information.

FeedURL

Contains the URL from which you receive news and updates. Default value is:https://www.ibm.com/

developerworks/community/wikis/form/anonymous/api/wiki/585f5525-a7f5-48ef-9222-50ad582e85f4/page/

e599dd3c-8dc3-4ab6-89fd-33f81a994799/attachment/de677e63-5a9d-46db-a010-18ca38f05812/media/

tws.jsonp

FeedType

A string that identifies the format of update information. Default value is JSONP.

https://www.ibm.com/developerworks/community/wikis/form/anonymous/api/wiki/585f5525-a7f5-48ef-9222-50ad582e85f4/page/e599dd3c-8dc3-4ab6-89fd-33f81a994799/attachment/de677e63-5a9d-46db-a010-18ca38f05812/media/tws.jsonp
https://www.ibm.com/developerworks/community/wikis/form/anonymous/api/wiki/585f5525-a7f5-48ef-9222-50ad582e85f4/page/e599dd3c-8dc3-4ab6-89fd-33f81a994799/attachment/de677e63-5a9d-46db-a010-18ca38f05812/media/tws.jsonp
https://www.ibm.com/developerworks/community/wikis/form/anonymous/api/wiki/585f5525-a7f5-48ef-9222-50ad582e85f4/page/e599dd3c-8dc3-4ab6-89fd-33f81a994799/attachment/de677e63-5a9d-46db-a010-18ca38f05812/media/tws.jsonp
https://www.ibm.com/developerworks/community/wikis/form/anonymous/api/wiki/585f5525-a7f5-48ef-9222-50ad582e85f4/page/e599dd3c-8dc3-4ab6-89fd-33f81a994799/attachment/de677e63-5a9d-46db-a010-18ca38f05812/media/tws.jsonp
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PollInterval

The interval in seconds between two checks for updates. Default value is 600.

PollInitialDelay

An initial delay in seconds before the first attempt to read the news feeds. After the initial load, the poll interval 

is used. Default value is 120.

NewsFeed

Property used to add further customized news feeds. Specify the format and address of the file that 

contains the customized communication. Supported formats are RSS 2.0 and ATOM 1.0. You must write the 

communication in ATOM 1.0 or RSS 2.0 format and store this file in the an HTTP server complying with the 

same origin policy. For browser security reasons, this policy permits to access information only on server using 

the same protocol, hostname and port number as the one to which you are connected. Optionally, if you want 

to store your customized feed on an external server, you must configure an HTTP reverse proxy server mapping 

the external server address.

<property name="NewsFeed" type="RSS"
value="http://DWC_hostname:portnumber.com/news.rss" />

Note:  To specify multiple feeds, you must specify multiple NewsFeed  properties.

NewsFeedCategory

The name of the customized information. It can be used to identify informational, warning or alert messages, 

for example. The path to an image can also be added to better identify the information with an icon.

To add more category images, specify a list of properties named NewsFeedCategory, for example:

<property name="NewsFeedCategory" value="my company info"
icon="http://www.my.company.com/info.png" />
<property name="NewsFeedCategory" value="my company alert"
icon="http://www.my.company.com/alert.png" />

If no customized feed is specified, the default feed is used, which retrieves the latest product information from official 

support sites. To disable any notification, comment the entire section. To disable only external notifications about product 

information updates, assign an empty string as value to the FeedURL  property of JSONP  feed like:

  <property name="FeedURL" type="JSONP" value="" />

Example:

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
<NewsFeed>
<property name="NewsFeed" type="RSS"
value="http://www.DWC_hostname:portnumber.com/my_rss.xml" />
<property name="NewsFeed" type="ATOM"
value="http://www.DWC_hostname:portnumber.com/my_atom.xml" />
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<property name="PollInterval" value="600" />
<property name="PollInitialDelay" value="1" />
 

<property name="FeedURL" type="JSONP" value="" />
 

<property name="NewsFeedCategory"
value="my company info" icon="http://www.DWC_hostname:portnumber.com
/info.png" />
<property name="NewsFeedCategory"
value="my company alert" icon="http://www.DWC_hostname:portnumber.com
/alert.png" />
 

</NewsFeed>
 </settings>
.
.
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Disable and customize the creation of predefined tasks

This section defines the environment for which predefined tasks are created.

precannedTaskCreation

Some predefined tasks are created by default and are available when you log in to the console. There is a 

predefined Monitor task for every object, for both z/OS®  and distributed engines. Default value is all. To change 

this setting, use one of the following values:

all

All predefined tasks are created. This is the default.

distributed

Only predefined tasks for distributed engines are created

zos

Only predefined tasks for z/OS engines are created

none

No predefined task is created.

<?xml version"1.0"?>
<tdwc>
.
.
   <settings>
     <application>
      <property name="precannedTaskCreation" value="all"/>
     </application>
   </settings>
.
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.
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Add customized URL to job and job streams

This section contains URLs where you can store customized documentation about your jobs or job streams. By default, this 

setting is not specified. If you want to associate customized documentation to a job or job stream, use this setting to specify 

the external address where this information is located.

If you want to specify a URL where customized documentation for a job and job stream is stored, uncomment the section 

lines, specify the required URL, and optionally assign a name to the UI label by specifying a value for the customActionLabel 

property. By default this name is Open Documentation. This label is then displayed in the More Actions  menus in Monitor 

Jobs and Monitor Job Streams tasks, as well as in the graphical views of the plan (in the object's tooltips, context menus and 

properties). In this example, selecting Open Documentation  accesses the relevant documentation making it possible to open 

the documentation while monitoring your job or job stream in the plan.

To implement this setting, assign values to the following keywords:

customActionLabel

The name of the action displayed in menus, object properties, and tooltips to access customized 

documentation about your jobs or job streams. By default this name is "Open Documentation" unless you 

customize the name with this keyword.

jobUrlTemplate

The address of your job documentation. No default value available.

jobstreamUrlTemplate

The address of your job stream documentation. No default value available.

Consider the following example:

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
  <twsObjectDoc>
    <property name="jobstreamUrlTemplate"
      value="http://www.yourhost.com/tws/docs/${js_encoded_folder_path}${js_name_w}"/>
    <property name="jobUrlTemplate"
      value="http://www.yourhost.com/docs/jobs/${job_name_w}"/>
    <property name="customActionLabel" value="Your Custom Label Name"/>
  </twsObjectDoc>
 </settings>
.
.
</tdwc>
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See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

These properties must be valid URLs, containing one or more of the variables listed in the table below.

If you use any of the following special characters in the URL, you must write them as follows:

Table  3. Syntax for special characters

Special characters Write them as...

quote  (") \"

apostrophe  (') &apos;

ampersand  (&) &amp;

less than  (<) &lt

greater than  (>) &gt

backslash  (\) \\

Multiple variables can be included in a URL and must be specified using the following syntax: ${variable}:

Table  4. Variables used in the URL definition

Name Object Description

job_number_w Job z/OS® The number of the job

job_wkst_w Job The name of the workstation on which the job runs and the folder where it is stored, if 

any.

job_jsname_w Job The name of the job stream that contains the job and the folder where it is stored, if any.

job_jswkst_w Job The name of the job stream that contains the job and the folder where it is stored, if any.

job_actualarriva

l_w

Job z/OS® The actual start time of the job (date format: YYYY-MM-DDThh:mm:ss)

job_actualend_w Job z/OS® When the job actually completed (date format: YYYY-MM-DDThh:mm:ss)

job_starttime_w Job The start time of the job (date format: YYYY-MM-DDThh:mm:ss)

job_id_w Job The ID of the job

job_returncode_w Job The return code of the job

js_name_w Job 

stream

The name of the job stream that contains the job

js_wkst_w Job 

stream

The name of the job stream that contains the job and the folder where it is stored, if any.

js_id_w Job 

stream

The job stream ID
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Table  4. Variables used in the URL definition  (continued)

Name Object Description

js_latest_start_w Job 

stream

The latest time at which a job stream can start (date format: YYYY-MM-DDThh:mm:ss)

engine_name_w Engine The name of the engine connection

engine_host_w Engine The hostname of the engine connection

engine_port_w Engine The port number of the engine connection

engine_plan_w Engine The ID of selected plan

engine_serv_w Engine The remote server name of the engine connection

User registry

Use this section to configure some properties related to the User Registry in use.

groupIdMap

The property groupIdMap is related to the groups of User Registry, and can be modified to map and display the 

specified value of each group. By default the common name of the group is displayed.

importSettingsMaxFileSize

The property importSettingsMaxFileSize is related to the "Manage settings" > "Import Settings" functionality 

and defines the max file size of the uploaded TDWCSettings.xml. KB is the unit of measure, and by default, it 

is set to 102400 KB (100 MB). If you need to upload a property file bigger than 100MB, you can increase this 

value, but for security purposes, it is strongly suggested to revert the file size back to the default value once the 

import has been performed.

Examples:

<?xml version"1.0"?>
<tdwc>
.
.
<settings>
<security>
<property name="groupIdMap" value="cn"></property>
<property name="importSettingsMaxFileSize" value="102400"></property>
</security>
</settings>
.
.
</tdwc>

Therefore, if you need to change the default value "cn"  to "racfid", you can define this property as follows:

<property name="groupIdMap" value="racfid"></property>

See xref href="awsadtdwcglobsetxmp.dita"/> to view the complete syntax for the file.
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or see User Settings  on page 18 to manage Dynamic Workload Console  settings.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

z/OS http connections

Use this section to configure the timeout to read and write information on IBM®  Z®  Workload Scheduler  engine. When you 

connect to the IBM®  Z®  Workload Scheduler  engine to retrieve a list of defined objects, you receive an error message if the 

list is not returned within the timeout period. The value is expressed in milliseconds.

Example:

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
<http>
<property name="zosHttpTimeout" value="90000" />
</http>
.
.
 </settings>
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Limit the number of objects retrieved by queries

Use this section to configure: the number of results displayed for Monitor tasks, the maximum number of rows to display on 

each page, and the number of direct queries to maintain in history.

If you want to limit the number of results produced by your queries, you can specify the maximum number of items that must 

be retrieved using the monitorMaxObjectsPM property. The minimum number of retrieved results is 500.

Note:  monitorMaxObjectsPM property only limits the number of results for archived plans queries. The property does 

not affect current plan queries.

The default value is -1; any value lower than 0 means that there is no limit in the number of objects retrieved.

Because data is extracted in blocks of 250 rows, the value you enter is adjusted to complete an entire block. For example, if 

you specify a limit of 500, only 500 elements are retrieved, while if you specify a limit of 600, 750 elements are retrieved.

For Multiple engine tasks, this limit is applied to each engine included in the query. Therefore, if you specify a limit of 500 

results and, for example, you run a Monitor jobs on multiple engine task on three engines, the results produced by your query 

will be no more than 500 for each engine, for a maximum of 1500 rows.
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Note:  This setting does not apply to Monitor critical jobs tasks.

To set the maximum number of rows to display in a table view, configure the maxRowsToDisplay property.

To set the maximum number of direct queries to maintain in history, configure the maxHistoryCount property. These queries 

are available from the pull-down for the Query field on the Monitor Workload  page.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
  <monitor>
    <property name="monitorMaxObjectsPM" value="2000"></property>
  </monitor>
 

  <ph rev="v92"><monitor>
    <property name="maxRowsToDisplay" value="25"></property>
  </monitor>
 

  <monitor>
    <property name="maxHistoryCount" value="100"></property>
  </monitor>
</ph>
 </settings>
 

<settings>
        <search>
                  <property name="search_max_limit" value="1500"></property>
        </search>
    </settings>
.
.
</tdwc> 

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Related information

Job  on page 52

Creating job definitions  on page 107

Adding a job to a job stream  on page 121

Job stream  on page 53

Creating job stream definitions  on page 106

Workload service assurance  on page 92
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Using workload service assurance to monitor z/OS critical jobs  on page 236

Monitoring jobs running on multiple engines  on page 238

Limit task and engine sharing

Use this section to prevent users from sharing tasks and engines.

By default there is no limit to task and engine sharing and all users are authorized to share their tasks and engine 

connections. If you want to change this behavior, preventing users from sharing tasks and engines, set this property to true.

The property default value is false, set it to true  to enable the limit:

limitShareTask

Set to true to prevent users from sharing tasks.

limitShareEngine

Set to true to prevent users from sharing engine connections.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
  <security>
   <property name="limitShareTask"     value="false" />
   <property name="limitShareEngine"   value="false" />
  </security>
 </settings>
.
.
</tdwc> 

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Entries in Workload Designer search windows

This section contains the configuration parameters that apply to the search views of Workload Designer.

search_max_limit

This optional parameter sets the maximum number of entries displayed in Workload Designer search windows. 

The default value is 250. It is recommended not to use values greater than 999.

Example:

<?xml version"1.0"?>
<tdwc>
.
.
<settings>



Chapter 5. Customizing your console

 <search>
  <property name="search_max_limit" value="500"></property>
 </search>
</settings>
.
.
</tdwc>

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Show all dependencies

This section defines whether to show all dependencies displayed, regardless of their being satisfied or not.

ShowDependencies

When you open the dependencies panel from Monitor jobs and Monitor job streams task results, by default only 

Not Satisfied  dependencies are shown. Uncomment this section and leave the value set to "true" to have all 

dependencies displayed, regardless of their being satisfied or not. Possible values are:

true

All dependencies displayed, regardless of their being satisfied or not.

false

Only not satisfied dependencies are displayed.

<?xml version"1.0"?>
<tdwc>
 

.

.
 <settings>
  <ShowDependencies>
   <property name = "AlwaysShowAllDependencies"
             value="true"></property>
  </ShowDependencies>
 </settings>
.
.
 </tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Auditing mobile app activity

This section defines whether to track activities performed in the Self-Service Catalog  and Self-Service Dashboards 

applications in an auditing log file.

For information about the name and location of the log file, see the logs and traces section in the Troubleshooting Guide.
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SSAuditing

This value is set to "true" by default so that operations performed in the Self-Service Catalog  and Self-

Service Dashboards  applications are written to a log file. The log file contains information such as creation, 

modification and deletion dates, the operations performed in the mobile apps, and the user performing the 

operations. Possible values are:

true

Operations performed in the Self-Service Catalog  and Self-Service Dashboards  applications are 

tracked in an auditing log file.

false

Operations performed in the Self-Service Catalog  and Self-Service Dashboards  applications are 

not tracked in an auditing log file.

SSAuditingLogSize

The maximum size of a log file in KB. When a log file reaches the maximum size, the system rolls that log file 

over and creates a new file. By default, the maximum size of a log file is 100 KB.

SSAuditingLogFiles

The default number of log files to create. When this number is met and the latest log file reaches its maximum 

size, the system deletes the oldest log file and rolls the latest file over and creates a new file.

<?xml version"1.0"?>
<tdwc>
.
.
 <settings>
 <SSCMAuditing>
            <property name = "SSAuditing"         value="true"></property>
            <property name = "SSAuditingLogSize"  value="100"></property>
            <property name = "SSAuditingLogFiles" value="2"></property>
 </settings>
 .
 .
</tdwc>

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Modifying the number of archived plans displayed in the Dynamic Workload Console

You can modify the number of archived plans displayed in the Monitor Workload view of the Dynamic Workload Console. The 

default number is 30 plans.

To modify the default number, configure the following property in the TdwcGlobalSettings.xml  file:

<monitor>
    <property name="maxArchivedPlan"value="30"></property>
  </monitor>
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See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

Show or hide predecessors from What-if Analysis Gantt view

When you have hundreds of predecessors, you can optimize performance by excluding them from the What-if Analysis Gantt 

view. By default, all predecessors are loaded into the What-if Analysis Gantt view. To exclude them, uncomment this section 

and leave the default setting of the property whatIfAutoLoadPreds  to "false" . To revert back to the default behavior either 

set the property to "true" or comment the section again in the TdwcGlobalSettings.xml  file.

To modify the default setting, configure the following property in the TdwcGlobalSettings.xml  file:

      <WhatifAnalysis>
            <property name = "whatIfAutoLoadPreds" value="false"></property>
      </WhatifAnalysis>
            

See TdwcGlobalSettings.xml sample  on page 39 to view the complete syntax for the file.

For more information about how to customize global settings, see Customizing your global settings  on page 23.

TdwcGlobalSettings.xml sample

The following example is a sample of the file:

  ˂?xml version="1.0"?>
  ˂tdwc>
 

 

 #######################################################################################
 ##################  SETTINGS FOR ALL USERS                      #######################
 #######################################################################################
 

 ˂settings>
 

 

 #######################################################################################
 ##################  CUSTOMIZE LINKS TO VIDEOS                   #######################
 #######################################################################################
 

 

 This section shows how you should customize your URLs that link video content in
 the Dynamic Workload Console so that you can link to a company intranet server
 to view help videos rather than a public video site.
 

 ### This prefix "_baseURL" will be added to all video URLs ###
 

 ### Links to videos, missing entries or empty (blank) values are not considered ###
 

 #### Graphical view: detect loop                        ####
 #### Graphical view: highlight and release dependencies ####
 #### Graphical view: reply to prompt dependency         ####
 #### Graphical view: using the impact view              ####
 #### Table: creating and using tasks                    ####
 #### Workload editor: add and remove a file dependency  ####
 #### Workload editor: create a dependency               ####
 #### Workload editor: add a job                         ####
 #### Workload editor: highlight dependencies            ####
 #### Workload editor: creating a z/OS job               ####
 

 

 

  <videoGallery>
   <property name="_baseURL" value=""></property>
   <property name="depLoop" value=""></property>
   <property name="highlightRelDep" value=""></property>
   <property name="viewDepPrompt" value=""></property>
   <property name="usingImpactView" value=""></property>
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   <property name="createUseTasks" value=""></property>
   <property name="weAddRemoveFile" value=""></property>
   <property name="weCreateDeps" value=""></property>
   <property name="weAddJob" value=""></property>
   <property name="weHighlightDeps" value=""></property>
   <property name="weCreateJCL" value=""></property>
  </videoGallery>
 

 

 #######################################################################################
 ##################  SECTION 1 - GRAPHICAL VIEW SETTINGS         #######################
 #######################################################################################
 

 

 This section specifies the maximum number of objects shown in each graphical view.
  Default value is 1000 for all properties.
 

 

  <graphViews>
   <property name="planViewMaxJobstreams" value="1000"></property>
   <property name="preProdPlanViewMaxJobstreams" value="1000"></property>
  </graphViews>
 

 

 #######################################################################################
 #####################  SECTION 2 - PLAN VIEW IN NEW WINDOW       ######################
 #######################################################################################
 

 

 This section is used to prevent Internet Explorer 7 from freezing while using the Plan View. To solve the problem, set value         to true.
 Default value is false
 

 

  <graphViews>
   <property name="planViewNewWindow" value="true"/>
  </graphViews>
 

 

 #######################################################################################
 #################  SECTION 3 - DISABLE / CUSTOMIZE NEWS FEED FUNCTION  ################
 #######################################################################################
 

 

 This section allows overriding the properties concerning the "NewsFeed" function.
 Default values are as follows:
   <NewsFeed>
    <property name="FeedURL" 
 value="https://www.ibm.com/developerworks/wikis/pages/viewpageattachments.action?pageId=119079645&amp;sortBy=date&amp;highlight=tws.jsonp&amp;" />
    <property name="FeedType" value="JSONP" />
    <property name="PollInterval" value="3600" />
   </NewsFeed>
 

 

 To disable function
 

 

  <NewsFeed>
   <property name="FeedURL" value="" />
   <property name="FeedType" value="JSONP" />
   <property name="PollInterval" value="3600" />
  </NewsFeed>
 

  Starting from 8.6 FP2 you can allow multiple feeds, and create new categories:
  <NewsFeed>
   <property name="NewsFeed" type="RSS" value="https://httpserver.mycompany.com:29443/ibm/TWSWebUI/bulb/info_news_rss.xml" />
   <property name="NewsFeed" type="ATOM" value="https://httpserver.mycompany.com:29443/ibm/TWSWebUI/bulb/alert_news_atom.xml" />
 

   <property name="PollInterval" value="1" />
   <property name="PollInitialDelay" value="1" />
   <property name="FeedURL" type="RSS" value="" />
 

   <property name="NewsFeedCategory" value="InfoNews" icon="https://httpserver.mycompany.com:29443/ibm/TWSWebUI/bulb/info.png" />
   <property name="NewsFeedCategory" value="AlertNews" icon="https://httpserver.mycompany.com:29443/ibm/TWSWebUI/bulb/alert.png" />
  </NewsFeed>
 

 

 #######################################################################################
 #############  SECTION 4 - DISABLE /CUSTOMIZE CREATION OF PREDEFINED TASKS  ###########
 #######################################################################################
 

 

 To avoid or customize the creation of predefined tasks at first logon.
 Possible values are:
  all             both distributed and z/OS tasks are created. This is the default value
  none            no task is created
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  distributed     only distributed tasks are created
  zos             only z/OS tasks are created
 

 

  <application>
   <property name="precannedTaskCreation" value="all"/>
   <property name="updateWorkstationMaxNumber" value="20"/>
  </application>
 

 

 

  <PositionSorting>
   <property name="enabled" value="true"></property>
  </PositionSorting>
 

 

 

 #######################################################################################
 #############  SECTION 5 - ADD A CUSTOM DOCUMENTATION URL TO JOB/JOBSTREAM  ###########
 #######################################################################################
 

 

 This section contains URLs where you can store customized documentation about your jobs or job streams.
        By default this setting is not specified. If you want to associate customized documentation to a job or
        job stream, use this setting to specify the external address where this information is located.
        If you want to specify a URL to be opened as related documentation for jobs and job streams,
        uncomment the section lines so that a new action, Open Documentation, is inserted in the More Actions
        menu for Monitor Jobs and Monitor Job Streams tasks. The new action links to the specified URL
 

       You can customize the URL template by using variables. The variables have the following syntax
                     ${<variable_name>}
 

 For the complete list of variables, please refer to the documentation.
 

 

 

  <twsObjectDoc>
   <property name="jobstreamUrlTemplate" value="http://www.yourhost.com/tws/docs/jobstream/${js_name_w}" />
   <property name="jobUrlTemplate"    value="http://www.yourhost.com/docs/jobs/${job_name_w}" />
   <property name="customActionLabel"    value="Custom Action" />
  </twsObjectDoc>
 

 

 

    #######################################################################################
    #############  SECTION 6 - USER REGISTRY                                    ###########
    #######################################################################################
       In this section you can configure properties related to the User Registry in use.
 

       The property groupIdMap is related to the groups of User Registry, and can be modified
       to map and display the specified value of each group. By default the common name
       of the group is displayed.
 

       The property importSettingsMaxFileSize is related to the "Manage settings" > "Import Settings"
       functionality and defines the max file size of the uploaded TDWCSettings.xml.
       KB is the unit of measure, and by default, it is set to 102400 KB (100 MB).
       If you need to upload a property file bigger than 100MB, you can increase this value, but
       for security purposes, it is strongly suggested to revert the file size back to the default
       value once the import has been performed.
 

 

 

        <security>
            <property name="groupIdMap" value="cn"></property>
            <property name="importSettingsMaxFileSize" value="102400"></property>
        </security>
 

 

 

     #######################################################################################
  #############  SECTION 7 - Z/OS HTTP CONNECTIONS                            ###########
  #######################################################################################
 

 Use this section to increase or decrease timeout for http connection in Z/OS
 environment. Change this setting if you receive a connection timeout
 using plugin actions/picklists.
 

 The setting is in milliseconds.
 

 

   <http>
    <property name="zosHttpTimeout" value="90000" />
   </http>
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    #######################################################################################
 #########  SECTION 8 -  LIMIT THE NUMBER OF OBJECTS RETURNED BY THE QUERIES ###########
 #######################################################################################
 

     Use this section to configure: the number of results displayed for Monitor tasks, the maximum number of rows
     to display on each page, and the number of direct queries to maintain in history.
        This setting applies to all tasks except for Monitor critical jobs and Monitor jobs on multiple engines.
        If you want to limit the number of results produced by your queries, you can specify the maximum number of items that must be retrieved.
  The default value is -1; any value lower than 0 means that there is no limit in the number of objects  retrieved.
  The minimum number of retrieved results is 500. Because data is extracted in blocks of 250 rows,
        the value you enter is adjusted to complete an entire block. For example, if you specify a limit of 500,
        only 500 elements are retrieved, while if you specify a limit of 600, 750 elements are retrieved.
  To set the maximum number of rows to display in a table view, configure the maxRowsToDisplay property.
        To set the maximum number of direct queries to maintain in history, configure the maxHistoryCount property.
        These queries are available from the pull-down for the Query field on the Direct Query page.
 

 

 

 <monitor>
    <property name="monitorMaxObjectsPM" value="2000"></property>
 </monitor>
 <monitor>
  <property name="maxRowsToDisplay" value="25"></property>
 </monitor>
 

 

  You modify the number of archived plans displayed in the Monitor Workload view of the Dynamic
  Workload Console. The default number is 30 plans.
 

 

 <monitor>
  <property name="maxArchivedPlan"value="30"></property>
 </monitor>
 

 

 <monitor>
  <property name="maxHistoryCount" value="100"></property>
 </monitor>
 

 

 <settings>
  <search>
   <property name="search_max_limit" value="500"></property>
  </search>
 </settings>
 

 

        ##################################################################################
     #########  SECTION 9 - LIMIT TASK AND ENGINE SHARING                   ###########
     ##################################################################################
 

 Use this section to prevent users from sharing tasks and engines.
        By default there is no limit to task and engine sharing and all users are authorized to share
        their tasks and engine connections. If you want to change this behavior, preventing users from
        sharing tasks and engines, set this property to true. The property default value is false,
        set it to true to enable the limit:
 

 

 

  <security>
   <property name="limitShareTask"     value="false" />
   <property name="limitShareEngine"   value="false" />
  </security>
 

 

 

    #######################################################################################
    #########  SECTION 10 - CHANGE DEFAULT BEHAVIOR FOR DEPENDENCIES PANEL      ###########
    #######################################################################################
 

 Use this section to change the default behavior of the UI when displaying
 dependencies in the dependencies panel. By setting this value to true, by default,
 all dependencies are displayed, and not just the unsatisfied ones.
 

 

  <ShowDependencies>
   <property name = "AlwaysShowAllDependencies" value="true"></property>
  </ShowDependencies>
 

 

 

    ######################################################################################
    ##### SECTION 11 - CHANGE DEFAULT BEHAVIOR FOR SSC AND SSD AUDITING        ###########
    ######################################################################################
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    Use this section to change the default behavior of the auditing of activities performed
    using the Self-Service Catalog and the Self-Service Dashboards application. By default,
    auditing is enabled. You can also set the maximum size of the log file before it rolls
    over to a new log file, and the maximum number of log files maintained.
 

 

  <SSCMAuditing>
   <property name = "SSAuditing"         value="true"></property>
   <property name = "SSAuditingLogSize"  value="100"></property>
   <property name = "SSAuditingLogFiles" value="2"></property>
  </SSCMAuditing>
 

 

 

    ######################################################################################
    ##### SECTION 12 -     URL FOR AGENT LICENSE                               ###########
    ######################################################################################
    Use this section to change the default Agent License URL.
 

 

  <AgentLicense>
   <property name = "URL" value="Workoad Automation SaaS agent license document"></property>
  </AgentLicense>
 

 

 ˂/settings>
 

 

 #######################################################################################
 ##################  SETTINGS FOR ALL Administrators users #####################
 #######################################################################################
 

 ˂settings  role="Administrator">
  Put here setting to be applied only to users with Administrator role
 ˂/settings>
 

 #######################################################################################
 ##################  SETTINGS FOR ALL Operators users    #######################
 #######################################################################################
 

 ˂settings  role="Operator">
 ˂/settings>
 

 #######################################################################################
 ##################  SETTINGS FOR ALL Configurator users #######################
 #######################################################################################
 

 ˂settings  role="Configurator">
 ˂/settings>
 

 #######################################################################################
 ##################  SETTINGS FOR ALL Developer users    #######################
 #######################################################################################
 

 ˂settings  role="Developer">
 ˂/settings>
 

 #######################################################################################
 ##################  SETTINGS FOR ALL Analyst users      #######################
 #######################################################################################
 

 ˂settings  role="Analyst">
 ˂/settings>
 

˂/tdwc>

For more information about how to customize global settings, see Customizing your global settings  on page 23.
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Chapter 6. IBM Workload Scheduler  Concepts
Conceptual information about IBM Workload Scheduler

This section provides conceptual information about IBM Workload Scheduler  and the Dynamic Workload Console.

Scheduling environment
This section contains the main concepts that help you to understand what a scheduling environment is and what it 

comprises.

Workstation
Using workstations for scheduling jobs and job streams.

Note:  This section provides information relating to the use of workstations for scheduling jobs and job streams.

If, instead, you want to learn about workstations because you are planning your network, see IBM Workload 

Scheduler: Planning and Installation  or IBM Z Workload Scheduler: Planning and Installation.

The computer system where you run your jobs and job streams is called a workstation.

Workstations can be grouped logically into workstation classes  and organized hierarchically into domains, managed by 

domain managers.

When you create a workstation definition for a system in your network you define a set of characteristics that uniquely 

identify the system and that control how jobs run on it. For example, the IP address of the workstation, if it is behind a 

firewall, if communications with it must be secure, what time zone it is in, and the identity of its domain manager.

Workstations in the IBM Workload Scheduler  scheduling network perform job and job stream processing, but can also have 

other roles. When your network is designed, these roles are assigned to these workstations to suit the specific needs of your 

business. The following types of workstation are available:

Master domain manager

workstationmaster domain managermaster domain managerA workstation acting as the management hub for the network. It manages all your scheduling objects. The 

master domain manager workstation must be installed with this role.

Backup master domain manager

workstationbackup master domain managerbackup master domain managerA workstation that can act as a backup for the master domain manager  when problems occur. It is a master 

domain manager, waiting to be activated. Its use is optional. This workstation must be installed as a master 

domain manager workstation.

Learn more about switching to a backup master domain manager  in IBM Workload Scheduler: Administration 

Guide.
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Domain manager

workstationdomain managerdomain managerA workstation that controls a domain and that shares management responsibilities for part of the IBM 

Workload Scheduler  network. It is installed as an agent, and then configured as a domain manager workstation 

when you define the workstation in the database.

Dynamic domain manager

An installed component in a distributed IBM Workload Scheduler  network that is the management hub in 

a domain. All communication to and from the agents  in the domain is routed through the dynamic domain 

manager. When you install a dynamic domain manager  the workstation types listed below are created in the 

database:

fta

Fault-tolerant agent component manually configured as domain manager

broker

Broker server component

agent

Dynamic agent component

Backup dynamic domain manager

A workstation which can act as a backup for the dynamic domain manager, when problems occur. It is 

effectively a dynamic domain manager, waiting to be activated. Its use is optional.

Learn more about switching to a backup dynamic domain manager  in IBM Workload Scheduler: Administration 

Guide.

When you install a dynamic domain manager  the workstation types listed below are created in the database:

fta

Fault-tolerant agent component.

broker

Broker server component

agent

Dynamic agent component

Fault-tolerant agent

workstationfault-tolerant agentfault-tolerant agentA workstation that receives and runs jobs. If there are communication problems with its domain manager, 

it can run jobs locally. It is installed as an agent, and then configured as a fault-tolerant agent workstation 

when you define the workstation in the database. This workstation is recorded in the IBM Workload Scheduler 

database as fta.
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Standard agent

workstationstandard agentstandard agentA workstation that receives and runs jobs only under the control of its domain manager. It is installed as an 

agent, and then configured as a standard agent workstation when you define the workstation in the database.

Extended agent

workstationextended agentextended agent workstationA workstation that has a host and an access method. The host is any other workstation, except another 

extended agent. The access method is an IBM-supplied or user-supplied script or program that is run by the 

host whenever the extended agent is referenced in the production plan. Extended agents are used to extend 

the job scheduling functions of IBM Workload Scheduler  to other systems and applications. For example, to 

launch a job on an extended agent, the host runs the access method, passing it job details as command line 

options. The access method communicates with the external system or application to launch the job and return 

the status of the job.

Also it is a workstation where a IBM Workload Scheduler  access method has been installed as a bridge so that 

you can schedule jobs in the SAP, PeopleSoft, z/OS, or custom applications. It must be physically hosted by a 

fault-tolerant agent (up to 255 extended agents per fault-tolerant agent) and then defined as an extended agent 

in the database.

For more information, see IBM Workload Scheduler: User's Guide and Reference  and IBM Workload 

Automation: Scheduling Applications with IBM Workload Automation.

Workload broker agent

workstationworkload broker agentworkload brokeragent workstationA workstation that manages the lifecycle of Workload Broker jobs in  Workload Broker. It is installed and 

configured as a dynamic workload broker workstation in the database.

z/OS agent

workstation IBM Z Workload Scheduler AgentA distributed workstation that runs jobs scheduled from IBM Workload Scheduler  for z/OS. Like fault-tolerant 

workstations, it is installed in a IBM Workload Scheduler  distributed domain. Unlike fault-tolerant workstations, 

it does not:

• Have fault tolerance

• Require an end-to-end server

• Need topology definitions

Communication with the agents is handled directly by the controller. For more information about the end-to-end 

scheduling with fault tolerance capabilities, see IBM Z Workload Scheduler: Scheduling End-to-end with Fault 

Tolerance Capabilities.

Virtual workstation

workstationvirtualvirtual workstationA workstation that is created with the automatic reporting attribute and the virtual option, defining a list of 

destinations, for the workload submission, that are used to spread the workload across trackers. When the 

scheduler processes the jobs submitted to a virtual workstation, it distributes the workload according to a 

sequenced turn criteria, based on a round-robin algorithm. To submit the job, at least one of the destinations in 

the list must be available.
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You can associate open intervals, parallel servers, and fixed resources to each destination belonging to the 

defined pool. The association is disabled at virtual workstation level, because the jobs that you submit on a 

virtual workstation are actually run on a single destination. When you associate parallel servers with a virtual 

workstation destination, you can specify a value up to 65535. The alternative workstation definition is not 

applicable either at workstation level or at single destination level.

Remote engine

workstationremote engineremote engine workstationA workstation that represents locally a remote IBM®  Workload Scheduler  engine. It is a workstation used 

to run only shadow jobs. A shadow job is a job that runs locally and is used to map another job running 

on a remote engine. This relationship between the two jobs is called a cross dependency. You define a 

remote engine workstation if you want to federate your environment with another IBM®  Workload Scheduler 

environment, either distributed or z/OS, to add and monitor dependencies on jobs running in the other 

scheduling environment. This type of workstation uses a connection based on HTTP protocol to allow the two 

environments to communicate.

Dynamic agent

workstationdynamic agentdynamic agentdynamic schedulingdynamic workstationsA workstation that manages a wide variety of job types, for example, specific database or FTP jobs, in addition 

to existing job types. This workstation is automatically created and registered when you install the dynamic 

agent. Because the installation and registration processes are performed automatically, when you view the 

agent in the Dynamic Workload Console, it results as updated by the Resource Advisor Agent. You can group 

agents in pools and dynamic pools.

In a simple configuration, dynamic agents connect directly to a master domain manager  or to a dynamic 

domain manager. However, in more complex network topologies, if the network configuration prevents 

themaster domain manager  or the dynamic domain manager  from directly communicating with the dynamic 

agent, then you can configure your dynamic agents to use a local or remote gateway.

Pool

workstationpoolpooldynamic schedulingdynamic workstationsA workstation grouping a set of dynamic agents  with similar hardware or software characteristics to 

submit jobs to. IBM Workload Scheduler  balances the jobs among the dynamic agents  within the pool and 

automatically reassigns jobs to available dynamic agents  if an agent is no longer available. To create a pool of 

dynamic agents  in your IBM Workload Scheduler  environment, define a workstation of type pool  hosted by the 

workload broker workstation, then select the dynamic agents  you want to add to the pool. A computer system 

group is automatically defined in the workload broker database together with its associated dynamic agents.

Dynamic pool

workstationdynamic pooldynamic pooldynamic schedulingdynamic workstationsA workstation grouping a set of dynamic agents  that is dynamically defined based on the resource 

requirements you specify. For example, if you require a workstation with low CPU usage and the Windows 

operating system installed to run your job, you specify these requirements using the Dynamic Workload 

Console  or the composer  command. When you save the set of requirements, a new workstation is 

automatically created in the IBM Workload Scheduler  database. This workstation is hosted by the workload 

broker workstation. This workstation maps all the dynamic agents  in your environment that meet the 

requirements you specified. The resulting pool is dynamically updated whenever a new suitable agent 

47



Dynamic Workload Console User’s Guide

48

becomes available. Jobs scheduled on this workstation automatically inherit the requirements defined for the 

workstation.

Related information

Creating a task to Monitor Workstations  on page 195

Workstation types  on page 255

Creating Workload Broker objects  on page 137

Domain
The domain.

All the workstations in a distributed IBM Workload Scheduler  network are organized into one or more domains, each of which 

consists of one or more agents and a domain manager acting as the management hub. Most communication to and from 

the agents in the domain is routed through the domain manager. If the agent has the "behind firewall" designation, all of it is.

All the networks have a master domain where the domain manager is the master domain manager. It maintains the database 

of all the scheduling objects in the domain and the central configuration files. The master domain manager generates the 

plan and creates and distributes the Symphony file. In addition, logs and reports for the network are maintained on the 

master domain manager.

You can organize all the agents in your network into a single domain or into multiple domains.

Single-domain network

single-domain networknetworksingle-domainA single domain network consists of a master domain manager and any number of agents. Figure 1: Single-

domain network  on page 49 shows an example of a single-domain network. A single-domain network is well 

suited to companies that have few locations and business functions. All the communication in the network is 

routed through the master domain manager. With a single location, you are concerned only with the reliability of 

your local network and the amount of traffic it can handle.
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Figure  1. Single-domain network

Multiple-domain network

multiple-domain networknetworkmultiple-domainMultiple-domain networks are especially suited to companies that span multiple locations, departments, or 

business functions. A multiple-domain network consists of a master domain manager, any number of lower 

tier domain managers, and any number of agents in each domain. Agents communicate only with their domain 

managers, and domain managers communicate with their parent domain managers. The hierarchy of domains 

can have any number of levels.
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Figure  2. Multiple-domain network

In Figure 2: Multiple-domain network  on page 50, the master domain manager is located in Atlanta. The 

master domain manager contains the database files used to document the scheduling objects, and distributes 

the Symphony file to its agents and to the domain managers in Denver and Los Angeles. The Denver and Los 

Angeles domain managers then distribute the Symphony file to their agents and subordinate domain managers 

in New York, Aurora, and Burbank. The master domain manager in Atlanta is responsible for broadcasting inter-

domain information throughout the network.

All the communication to and from the New York domain manager is routed through its parent domain 

manager in Denver. If there are schedules or jobs in the New York domain that are dependent on schedules or 

jobs in the Aurora domain, those dependencies are resolved by the Denver domain manager. Most inter-agent 

dependencies are handled locally by the lower tier domain managers, greatly reducing traffic on the network.

You can change the domain infrastructure dynamically as you develop your network. You move a workstation to a different 

domain, by changing the domain name in its database definition. The change takes effect when the master generates/

extends the plan.
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Note:  You cannot schedule jobs or job streams to run on all workstations in a domain by identifying the domain in the 

job or job stream definition. To achieve this, you must create a workstation class  that contains all the workstations in 

the domain.

For more information about domain definitions, see "Defining objects in the database" in the User's Guide and Reference.

For more information about workstation classes, see Workstation class  on page 78

Related information

Creating job stream definitions  on page 106

Scheduling objects
Scheduling objects that you can view and manage using the Dynamic Workload Console.

The set of scheduling objects described in the current plan is a subset of all the scheduling objects stored in the database. 

The scheduling objects accessible from the Dynamic Workload Console  depend on your IBM Workload Scheduler 

environment.

For distributed environments, the scheduling objects reported in the production plan are:

• All the active workstations defined in the database. These are the workstations whose definition does 

not have the ignore  flag set to on.

• All the domains.

• All the job streams scheduled to start in the production period and all jobs belonging to these job 

streams.

• All the resources, files, parameters, variables, and prompts defined in the job streams.

For z/OS environments, the scheduling objects reported in the current plan are:

• All the active workstations defined in the database.

• All the job streams scheduled to start in the production period and all jobs belonging to these job 

streams.

• All the resources that these jobs and jobs streams depend on.

To differentiate between jobs and job streams defined in the database and jobs and job streams scheduled to run within the 

production period, according to the IBM Workload Scheduler  standard naming convention, each occurrence of a job or a job 

stream scheduled to run in the current plan is called an instance. A current plan can contain more than one instance of the 

same job or job stream.
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Related information

Creating and managing engine connections  on page 13

Designing your Workload  on page 101

Monitoring your Workload  on page 197

Job
Information about jobs, which are scheduling objects used to define and run activities in the scheduling environment.

A job  is a unit of work that specifies an action, such as a weekly data backup, to be performed on specific workstations in the 

IBM Workload Scheduler  network.

In a IBM Workload Scheduler  distributed environment, jobs can be defined either independently from job streams, within a job 

stream definition or in workflow folders.

In a IBM Workload Scheduler  for z/OS environment, jobs can be defined only within a job stream and are called operations. 

You can have started-task operations, which are operations run on a computer workstation that are used to start and stop 

started tasks.

shadow jobRegardless of whether the IBM Workload Scheduler  engine is distributed or z/OS based, you can define locally a shadow job 

to map a remote job instance running on a different IBM Workload Scheduler  engine.

For more information about the job definition, see "Defining scheduling objects" in User's Guide and Reference.

Once job definitions have been submitted into the production plan, you still have the opportunity to make one-off changes 

to the definitions before they run, or after they have run. You can update the definition of a job that has already run and then 

rerun it. The job definition in the database remains unchanged.

Related information

Creating job definitions  on page 107

Adding a job to a job stream  on page 121

Status description and mapping for distributed jobs  on page 246

Status description and mapping for z/OS jobs  on page 249

Limit the number of objects retrieved by queries  on page 34

Listing jobs and job streams  on page 142

Creating job stream definitions  on page 106

Prerequisite steps to create job types with advanced options  on page 118
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Job stream

A job stream  is a sequence of jobs to be run, together with times, priorities, and other dependencies that determine the 

order of processing. Each job stream is assigned a time to run, represented by run cycle with type calendar, set of dates, or 

repetition rates.

Job streams can be organized in workflow folders  and defined as part of the same line of business. Job streams can be 

easily monitored through the workflow folders  and every workflow folder  has its own security and notifications.

In an IBM®  Z Workload Scheduler  environment, job streams are called applications.

Related information

Creating job stream definitions  on page 106

Status description and mapping for distributed job streams  on page 251

Status description and mapping for z/OS job streams  on page 254

Limit the number of objects retrieved by queries  on page 34

Adding a job to a job stream  on page 121

Listing jobs and job streams  on page 142

Customizing your job stream  on page 234

Folder
A folder  is an object that can be used to organize job streams into lines of business  or other custom categories.

With the folder  you can organize jobs and job streams in folders  categorized by departments or adaptable tagging concepts.

You can also quickly move a set of jobs or job streams that use a specific naming convention into folders that are named 

after tokens contained in the object names. See the topic about organizing jobs and job streams into folders in the User's 

Guide and Reference.

Workload application
A workload application  is one or more job streams together with all the referenced jobs that can be shared with other IBM 

Workload Scheduler  environments through an easy deployment process.

A workload application  is an IBM Workload Scheduler  database object that acts as a container for one or more job streams. 

You can use workload applications  to standardize a workload automation solution so that the solution can be reused in one 

or more IBM Workload Scheduler  environments thereby automating business processes.

You can prepare a workload application  template in a source IBM Workload Scheduler  environment and then export it so 

that it can be deployed in a target environment. The export process extracts from the source environment all of the elements 

necessary to reproduce the solution in another environment. It produces a compressed file containing a number of files 

required to import the workload application  into the target environment. These files contain a definition of the objects in 

the source environment extracted from the IBM Workload Scheduler  database. For those elements that depend on the 
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topology of the target environment, some manual configuration is required. For example, the definitions extracted from the 

source environment contain references to workstations that do not exist in the target environment. For this reason, before 

proceeding with the import, a mapping of some of the elements must be made associating the name of the object in the 

target environment.

The exported workload application  template contains definitions or references for all of the following objects:

• Job streams

• Jobs

• Workstations, workstation classes

• Calendars

• Prompts

• Run cycles

• Run cycle groups

• Resources

• Internetwork dependencies

• External dependencies

• Event rules

For information about how to define workload application  templates, see "Defining workload application" in the User's Guide 

and Reference.

Period
perioddefinitionPeriods are either cyclic, such as a week or 28-day period, or noncyclic, such as an academic semester.

Cyclic periods

cyclic periodsdefinitionperiodcyclicDefined by their origin date and their length: a cyclic period starts on a specific date and has a specified number 

of days. There are two kinds of cyclic periods:

work-days-only cyclic periods

Only working days are considered.

all-days cyclic periods

All the days are considered.

Noncyclic periods

noncyclic periodsdefinitionperiodnoncyclicDefined by the origin date of each interval and can optionally have an end date for each interval.

Periods can be combined with offsets to create run cycles and define when a job stream runs. For example, an offset of 1 in 

a weekly period specifies Monday. An offset of 10 in a monthly period specifies the tenth day of each month.

The long-term planning process uses the calendar information, the period definitions, and the run cycle, to determine the 

days on which an application is scheduled to run.
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If you run workload on fixed days of the week, month, or year, and take one of the standard IBM®  Workload Scheduler  for 

z/OS actions when this day falls on a non-working day, you do not need to create your own periods. You can describe most 

cases with rules such as:

• First Sunday in June

• First working day in the week

• Last Friday in the year

• Last non-working day in the month

If you use rules with their built-in calendar cycles (days of the week, months of the year, and so on), you probably need 

to create only special noncyclic periods, such as university semesters and tax years. The following sections show some 

examples of types of periods.

Cyclic period examples

cyclic periodsexamplesExamples of cyclic periods are a day, a week, and a fortnight, with fixed intervals of 1 day, 7 days, and 14 days, respectively. 

An academic semester cannot be described as a cyclic period, because spring, summer, and fall semesters have different 

lengths. The following example shows a lunar calendar month, assumed to be 28 days:

Period name

Moon

Type

Cyclic based on all days

Interval

28 days

Interval origin

7 February 2009 (date of a new moon)

Non-cyclic period examples

non-cyclic periodsexamplesExamples of non-cyclic periods are a quarter and a payroll period. You specify the start of each interval of a non-cyclic period 

with an origin date. This example shows a period for university semesters, with the interval origin and end specified for each 

semester:

Period name

Semester

Type

Non-cyclic

Interval origin

26 August 2009, 13 January 2010, 9 June 2010.
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Interval end

13 December 2009, 16 May 2010, 28 June 2010

Non-cyclic periods have a once-a-year maintenance overhead when you must create the intervals for the coming months. For 

this reason, carefully consider how flexible your period definitions are, and remove potentially duplicated definitions.

Calendar

A calendar  is a list of dates that define when a job stream runs.

Calendar in a distributed environment

A calendar can also be designated as a non-working days  calendar in a job stream. A non-working days calendar is a 

calendar that is assigned to a job stream to represent the days when the job stream and its jobs do not run. It can also be 

used to designate Saturdays or Sundays, or both, as workdays. The default non-working days calendar for all job streams is 

called the holidays  calendar.

Calendar in a z/OS environment

The calendar specifies normal working days and public holidays. IBM®  Workload Scheduler  for z/OS uses the calendar to 

determine when job streams are scheduled and to calculate dates for JCL tailoring.

You can specify the calendar when you create a job stream. If no calendar is specified for the job stream, IBM®  Workload 

Scheduler  for z/OS uses the calendar in the CALENDAR keyword of the BATCHOPT initialization statement, for batch 

services such as extending the long-term plan, or the calendar specified under the IBM®  Workload Scheduler  for z/OS 

options, for online services such as testing a rule with GENDAYS.

If no calendar is specified, a calendar with the name DEFAULT is used. If the DEFAULT calendar does not exist, all days are 

considered as working days. You can have several calendars, but always name your default calendar DEFAULT, and specify 

the same calendar name on BATCHOPT or in the IBM®  Workload Scheduler  for z/OS options. A calendar must contain at 

least one working day.

Related information

Designing your Workload  on page 101

Listing workload objects  on page 141

Run cycle

A run cycle  specifies the days that a job stream is scheduled to run. Each run cycle is defined for a specific job stream and 

cannot be used by other job streams. You can specify the following types of run cycle:



Chapter 6. IBM Workload Scheduler Concepts

simple

A specific set of user-defined days when a job stream is run.

daily

A run cycle that specifies that the job stream runs according to a day frequency and type that you set. For 

example, it might run daily, every three days, or just on working days.

weekly

A run cycle that specifies the days of the week when a job stream is run. For example, a job stream can be run 

every Monday, Wednesday, and Friday using a weekly run cycle.

monthly

A run cycle that specifies that the job stream runs according to a monthly day or date that you set. For example, 

it might run every 1st and 2nd day of the month, or every 1st Monday and 2nd Tuesday of the month.

It can also run, for example, every 1st and 2nd day of the month every two months.

yearly

A run cycle that specifies that a job stream runs, for example, yearly.

It can also run, for example, every three years.

exclusive

A run cycle that specifies the days and times when a job stream cannot be run. Exclusive run cycles take 

precedence over inclusive run cycles.

inclusive

A run cycle that specifies the days and times when a job stream is scheduled to run. Exclusive run cycles take 

precedence over inclusive run cycles.

offset-based

A run cycle that uses a combination of user-defined periods and offsets. For example, an offset of 3 in a 

period of 15 days is the third day from the beginning of the period. It is more practical to use offset-based run 

cycles when the cycle is based on cyclic periods. This term is used only in IBM®  Z Workload Scheduler, but the 

concept applies also to the distributed product.

rule-based

A run cycle that uses rules based on lists of ordinal numbers, types of days, and common calendar intervals (or 

period names in IBM®  Z Workload Scheduler). For example, the last Thursday of every month. Rule-based run 

cycles are based on conventional periods, such as calendar months, weeks of the year, and days of the week. In 

IBM®  Z Workload Scheduler, run cycles can also be based on periods that you define, such as a semester. This 

term is used only in IBM®  Z Workload Scheduler, but the concept applies also to the distributed product. You 

can also specify a rule to establish when a job stream runs if it falls on a free day.
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Related information

Creating and managing run cycle groups and their run cycles  on page 128

Run Cycle Preview  on page 264

Run cycle group

You can optionally define a run cycle group for your job stream instead of, or in addition to, a number of single run cycles.

A run cycle group is a list of run cycles that are combined together to produce a set of run dates.

By using run cycle groups, you can benefit from the following advantages:

A run cycle group is a distinct database object

It is defined by itself and can be matched with one or more job streams. It is not defined as part of a specific 

job stream like single run cycles.

The same run cycle group can be used on different job streams

This improves the overall usability of the run cycles, because you can specify the same run cycle group in 

multiple job streams, avoiding the need to have multiple run cycle definitions for the same scheduling rules.

Run cycle groups enhance the use of exclusive run cycles

Exclusive (or negative) run cycles are used to generate negative occurrences, which identify the days when a 

job stream would normally be scheduled but is not required. The sum of the exclusive run cycles are subtracted 

from the inclusive ones. A negative occurrence always cancels any matching positive occurrences and you can 

specify a negative occurrence only if the positive equivalent already exists. An exact matching of the days, as 

well as any time restrictions, is required between the exclusive and inclusive run cycles for the cancellation to 

occur. Run cycle groups add much flexibility by allowing users to apply exclusive run cycles to a subset of the 

positive ones rather than to all of them. Group your run cycles into subsets  so that the exclusive run cycles can 

be applied only to the positive occurrences generated by the run cycles belonging to the same set.

Run cycles must be organized into subsets  within a run cycle group. The subsets are always in a logical OR 

relationship with each other. The result of the run cycle group is always a date or set of dates; it cannot be 

negative.

For example, you might want your job stream to run every day of the month except the last day of the month. 

But, you also want the it to be scheduled on the last day of the year (the last day of December). You can define 

a run cycle group using subsets, as follows:

Subset 1

• Run cycle 1  - Inclusive run cycle every day of the month

• Run cycle 2  - Exclusive run cycle on the last day of the month
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Subset 2

• Run cycle 3  - Inclusive run cycle on December 31st

where, run cycle 2 cancels the last day of each month in Subset 1, while run cycle 3 generates December 31st 

as a separate date and therefore you can schedule the job stream on Dec 31st.

Run cycle groups allow the use of a logical AND between individual run cycles in the subset

By default, the run cycles within a subset are in a logical OR  relationship but you can change this to a logical 

AND, if the run cycle group result is a positive date or set of dates (Inclusive). For each run cycle, you can 

specify either operator (AND ,OR), obtaining the following behavior:  

1. All the run cycles of the group that are in AND  relationship are calculated first. The result of this 

calculation is a date or a set of dates.

2. Then, all the run cycles in an OR  relationship are added to the result of the previous step.

A similar behavior is applied to inclusive and exclusive run cycles to determine the final date or set of dates of a 

group.

Inclusive (A)

Rule-based run cycle. Select days when the job stream is to be run if they belong to all A types of 

the set of run cycles.

Exclusive (D)

Exclusion rule-based run cycle. Select days when the job stream is NOT to be run if they belong to 

all D types of the set of run cycles.

For example, you can add two conditions together:

Run on Wednesday AND the 8th workday of the month. 

In this way, the only scheduled dates are any 8th work day of the month that falls on a Wednesday.

Full compatibility with traditional  run cycles

The traditional  run cycles specified in the job stream definition can reference run cycle groups, with the 

possibility to specify shift or offsets on them (as with periods for z/OS or calendars for distributed systems).

A set of dates (interval starts) is created automatically either at run cycle level directly (inclusively or 

exclusively with offsets, or in the rule. This is a two-step process with run cycles:

1. Define the key "business event", such as, Month End, using run cycles and free day rules

2. Define rules that use the dates of the "business event" as the intervals against which the other batch run 

can be scheduled relative to.

For example, you have a Month End process  that runs on the Last Friday of a month, but that moves forward to 

the next working day, except in December when it runs on the 3rd Friday of the month. This scheduling rule can 

be defined with a few rules, run cycles, and free day rules.
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Two working days before Month End you need to run a pre-validation process to allow problems to be 

addressed before the run. You cannot choose the last Wednesday of the month, because in some months this 

might occur after the last Friday. Similarly, if the last Friday was a free day, the last Wednesday will not be 2 

working days before it, because the Free Day rule applies ONLY to the day the rule falls on, it cannot look at 

anything else.

Many other batch runs might also need to be run on a certain number of days before or after the Month End, 

but the same restrictions apply.

You can now define work to run relative to something defined by a combination of run cycles and free day rules.

Use of calendars with run cycles within a run cycle group

Optionally, you can specify more than one calendar to calculate the working and non-working days definition for 

a run cycle. The primary calendar is used to calculate which working days are valid, and a secondary calendar 

is used to calculate specific non-working dates. If the dates calculated according to the secondary calendar 

match with the working days in the primary calendar, the job is scheduled; if they do not match, the job is not 

scheduled.

For example, a global company that runs workload in the United States for many other countries needs many 

calendar combinations to ensure that the batch jobs only run on a day that is a working day both in the United 

States and the other country. The calendar can be defined at job stream level and, if not specified, a default 

calendar is used. However, the calendar at run cycle level, whenever defined, can be used as secondary 

calendar and the job stream (or default) calendar can be used as the primary calendar.

For example, Primary calendar can be WORKDAYS, which is defined as MONDAY to FRIDAY excluding US 

holiday dates. You might also need to calculate the job runs based on calendar HKWORK, which is defined as 

Monday to Friday excluding Hong Kong holiday dates. The job might have several schedules:

• Run on working days, but not the last working day and not Mondays

• Run on Mondays, but not on the last working day

• Run on the last working day

Because each schedule is calculated against the WORKHK  calendar it is also checked against the 

WORKDAYS  calendar to ensure that it is scheduled on a US working day.

The use of time restrictions with run cycle groups

You can specify time constraints to define the time when processing must start or the time after which 

processing must no longer start. To do this, you can associate time restrictions  to job, job streams, run 

cycles, and run cycle groups. When you define a time restriction, you basically obtain a time. Because you can 

associate time restrictions to multiple objects, the following hierarchy shows the order by which the different 

time restrictions are taken into consideration to actually define when to start the processing:

1. Time restriction defined in the run cycle into the job stream

2. Time restriction defined in the job stream
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3. Time restriction defined in the run cycle contained in the run cycle group associated to the job stream.

4. Time restriction defined in the run cycle group associated to the job stream.

5. Start of Day

This means that:

Time restrictions in the job stream

Override and take precedence over any other time restrictions  defined in the run cycles or run 

cycle groups associated to the job stream.

No time restrictions in the job stream nor in the run cycle group

The group generates only a date that is the Start Of Day. If offsets and free day rules are to be 

calculated, the calculation always starts from the Start Of Day.

Time restrictions in the run cycle group (not in the job stream)

Time restrictions (and possible offset) are calculated starting from the Start Of Day  and the 

resulting date and time indicate the start of processing.

Examples

Table  5. Scenario 1. No time restriction in the run cycle group

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with offset (+ 3 days) 10/27 (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 0/29/ (Monday)

Run cycle in the job stream with time restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with free day rule 11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest start +1 

1pm

11/02 (Friday) 11/03 (Saturday) 1pm

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/02 (Friday) Start of Day

Run cycle in the job stream with free day rule 11/02 (Friday) 11/02 (Friday) Start of Day
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Table  6. Scenario 2. Time restriction in the run cycle group without offset

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with calendar offset (+ 3 days) 10/27/ (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 0/29/ (Monday)

Run cycle in the job stream with time restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with free day rule 11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest start +1 

1pm

11/02 (Friday) 11/03 (Saturday) 1pm

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/02 (Friday) Start of Day

Run cycle in the job stream with free day rule 11/02 (Friday) 11/02 (Friday) Start of Day

Table  7. Scenario 3. Time restriction in the run cycle group with offset (+1 12:00)

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with calendar offset (+ 3 days) 10/27/ (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 10/29/ (Monday)

Run cycle group with offset +1 12:00 10/29/ (Monday) 10/30 12:00 (Tuesday)

Run cycle in the job stream with time restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with free day rule 11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest start +1 

1pm

11/02 (Friday) 11/03 (Saturday) 1pm
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Table  7. Scenario 3. Time restriction in the run cycle group with offset (+1 12:00)

(continued)

Run cycle group Scheduled date Earliest Start

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working days 

shift

11/02 (Friday) 11/03 12:00 (Saturday)

Run cycle in the job stream with free day rule 11/02 (Friday) 11/03 12:00 (Saturday)

Availability of the GENDAYS command at run cycle group level

Using GENDAYS, you can check the result of the combination of all the run cycles in the group.

Related information

Creating and managing run cycle groups and their run cycles  on page 128

Run Cycle Preview  on page 264

Operator instructions

In a IBM Workload Scheduler  for z/OS environment, some jobs might require specific instructions about how they are to be 

handled. These instructions are called operator instructions.

An operator instruction  can be permanent or temporary. A temporary instruction has a validity period associated with it, 

which specifies when the instruction is valid.

Parameter

A parameter  is an object to which you assign different values to be substituted in jobs and job streams, either from values 

in the database or at run time. Parameters are useful when you have values that change depending on your job or job 

stream. Job and job stream definitions that use parameters are updated automatically with the value at the start of the 

production cycle. Use parameters as substitutes for repetitive values when defining jobs and job streams. For example, using 

parameters for user logon and script file names in job definitions and for file and prompt dependencies allows the use of 

values that can be maintained centrally in the database on the master.

For more information about how to define parameters, see Variable and parameter definition.

Dependencies
Controlling processing using dependencies

When defining job streams and managing the workload in the plan, you can control process flow using dependencies.
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You can specify the following types of dependencies:

Dependencies in a distributed environment:

You can have dependencies between jobs, between job streams, or between jobs and job streams. They can be:

Internal dependencies

dependenciesinternalinternal dependenciesThese are dependencies established between jobs belonging to the same job stream.

External dependencies

dependenciesexternalexternal dependenciesThese are dependencies between job streams, between job streams and jobs belonging to other 

job streams, or between jobs belonging to different job streams. The following resolution criteria 

are used to satisfy these dependencies:

Closest preceding

The closest preceding in time before the instance that includes the dependency.

Same scheduled date

The instance planned to run on the same day.

Within a relative interval

The closest preceding instance within the relative time interval you chose, or, if none 

is found, the closest following instance within the relative time interval you chose.

Within an absolute interval

The closest preceding instance within an absolute time interval you chose, or, if 

none is found, the closest following instance within the absolute time interval you 

chose.

Regardless of the used matching criteria, if multiple instances of potential predecessor job 

streams exist in the specified time interval, the rule used by the product to identify the correct 

predecessor instance is the following:

1. IBM Workload Scheduler  searches for the closest instance that precedes the depending 

job or job stream start time. If such an instance exists, this is the predecessor instance.

2. If there is no preceding instance, IBM Workload Scheduler  considers the correct 

predecessor instance as the closest instance that starts after the depending job or job 

stream start time.

Internetwork dependencies

dependenciesinternetworkinternetwork dependenciesThese are dependencies on jobs or job streams running in another IBM Workload Scheduler 

network. Internetwork dependencies require a network agent workstation to communicate with 

the external IBM Workload Scheduler  network.
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Conditional dependencies (distributed)  on page 68

A relationship between one job, named the successor, and one or more jobs or job streams, 

named predecessors, stating that the successor can run only when a specific combination of 

conditions occur or are satisfied by the predecessor job. Job output conditions are set on the 

job definition and when a conditional dependency is added to a job in a job stream, the output 

conditions that must be satisfied by the predecessor job are specified. Conditions can include 

if the job has started, the state of the job, and any number of custom defined conditions, often 

expressed as job return or exit codes. You can specify that only a single condition must be 

satisfied, all conditions must be satisfied, or specify a subset of conditions that must be satisfied.

When the conditions are not met by the predecessor, then any successor jobs with a conditional 

dependency associated to them are put in suppress  state. Successor jobs with a standard 

dependency or no dependency at all defined run normally.

Dependencies in a z/OS environment:

You can have different kind of dependencies between jobs and job streams. They can be:

Internal dependencies

dependenciesinternalinternal dependenciesThese are dependencies established between jobs belonging to the same job stream.

External dependencies

dependenciesexternalexternal dependenciesThese are dependencies between job streams, between job streams and jobs belonging to other 

job streams, or between jobs belonging to different job streams. The following resolution criteria 

are used to satisfy these dependencies:

Closest preceding

The closest preceding in time before the instance that includes the dependency.

Same scheduled date

The instance planned to run on the same day.

Within a relative interval

The closest preceding instance within the relative time interval you chose, or, if none 

is found, the closest following instance within the relative time interval you chose.

Within an absolute interval

The closest preceding instance within an absolute time interval you chose, or, if 

none is found, the closest following instance within the absolute time interval you 

chose.

Regardless of the used matching criteria, if multiple instances of potential predecessor job 

streams exist in the specified time interval, the rule used by the product to identify the correct 

predecessor instance is the following:
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1. IBM Workload Scheduler  searches for the closest instance that precedes the depending 

job or job stream start time. If such an instance exists, this is the predecessor instance.

2. If there is no preceding instance, IBM Workload Scheduler  considers the correct 

predecessor instance as the closest instance that starts after the depending job or job 

stream start time.

Condition dependencies (z/OS)  on page 71

condition dependenciesdefinitiondependenciesconditionIt is a relationship between one job, named a conditional successor, and one or more jobs, named 

conditional predecessors, stating that the conditional successor can run only when a specific 

combination of conditional predecessor status and return code values occurs. You can define a 

conditional dependency where the conditional successor starts if its conditional predecessors 

are in ended-in-error or started status.

Note:  Condition dependencies are always managed as external dependencies, even if 

they link jobs belonging to the same job stream occurrence in the plan.

Job streams in a z/OS environment do not support dependencies on files or prompts.

Cross dependencies  on page 76

cross dependenciesdependenciescrossshadow jobremote engine workstationIn multiple heterogeneous scheduling environments you can define dependencies on batch activities managed 

by other IBM Workload Scheduler  environments. To define a cross dependency on a job running on a different 

IBM Workload Scheduler  engine, you must define a dependency on a locally-defined shadow job  pointing to the 

remote job instance and running on a remote engine workstation. The remote engine workstation manages the 

communication with the remote engine using an HTTP or HTTPS connection.

Dependencies on resources are supported by IBM Workload Scheduler  in both the distributed and z/OS environments.

Related information

Adding a dependency  on page 126

Removing a dependency  on page 127

Prompt
Information about prompts, which are textual messages presented to the operator to pause the job or job stream processing.

A prompt  identifies a text message that is displayed to the operator and halts processing of the job or job stream until 

an affirmative answer is received (either manually from the operator or automatically by an event rule action). After the 

prompt is replied to, processing continues. You can use prompts as dependencies in jobs and job streams. You can also use 

prompts to alert an operator that a specific task was performed. In this case, an operator response is not required.

There are the following types of prompt:
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global or named

A prompt that is defined in the database as a scheduling object. It is identified by a unique name and can be 

used by any job or job stream.

local or ad-hoc

A prompt that is defined within a job or job stream definition. It does not have a name, and it is not defined as a 

scheduling object in the database, therefore it cannot be used by other jobs or job streams.

recovery or abend

A special type of prompt that you define to be used when a job ends abnormally. The response to this prompt 

determines the outcome of the job or job stream to which the job belongs. A recovery prompt can also be 

associated to an action and to a special type of job called a recovery job.

For information about how to define prompts, see "Defining scheduling objects" in the User's Guide and Reference.

Related information

Adding a dependency  on page 126

Removing a dependency  on page 127

Designing your Workload  on page 101

Listing workload objects  on page 141

Resource

A resource  is either a physical or logical system resource that you use as a dependency for jobs and job streams. A job or job 

stream with a resource dependency cannot start to run until the required quantity of the defined resource is available.

For information about how to define resources, see Resource definition.

Related information

Adding a dependency  on page 126

Removing a dependency  on page 127

Designing your Workload  on page 101

Listing workload objects  on page 141

File

A file  is used as a dependency for jobs and job streams. A job or job stream with a file dependency cannot start to run until 

the file exists with the characteristics defined in the dependency.
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Related information

Adding a dependency  on page 126

Removing a dependency  on page 127

Designing your Workload  on page 101

Listing workload objects  on page 141

Applying conditional branching logic
With IBM®  Workload Scheduler  you can define jobs to run when and as often as necessary. Sometimes some jobs might 

have to wait for other jobs to finish successfully before they start. Add even more flexibility to your job flows by choosing 

which job to run depending on the result of the job status or output of a previous job. Whenever you have conditions that 

specify whether or not a segment of your job flow should run, then that is a conditional dependency.

When specifying dependencies, you can define job flows with alternative branches based on conditions, specifically to 

achieve the same results as using IF/THEN/ELSE statements. You can use return codes, job status, output variables, and 

job log content as conditional logic  elements to determine the start of a successor job. In addition to providing flexibility to 

your job flows, the Graphical View provides a graphical representation of the relationships between the jobs and job streams, 

including the dependencies and conditions. This at-a-glance view of your job flow is easy to read and you can also edit your 

job flow from this view.

The following example shows the PAYROLL job stream that starts with the ABSENCES job, which is a predecessor job and is 

then followed by two possible branches of jobs that can run. The branch that runs depends on the outcome of the initial job, 

the predecessor ABSENCES job. Possible outcomes of the ABSENCES job are defined in output conditions. Any jobs in the 

flow that do not run, because the output conditions were not satisfied, are put in SUPPRESSED state, which is different from 

regular dependencies where jobs are put in Hold until the predecessor is in successful (SUCC) state. Predecessors can be 

either jobs or job streams.
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Conditions can be status conditions, based on job status, or other output conditions, based on a mapping expression such 

as a return code, output variables, or output in a job log. When the predecessor is a job stream, the conditional dependency 

can only be a status condition.

Status conditions

These are conditions based on job status, such as if the job started, or if the job completes in FAIL, ABEND, 

SUCC, or SUPPR state. For job streams, the valid statuses are SUCC, SUPPR, and ABEND.

Other output conditions

Other types of conditions, including successful output conditions, can be specified using a mapping 

expression, which can be:

• A return code (fault-tolerant and dynamic agents)

• Output variables (dynamic agents)

• Job log content (dynamic agents)

A condition dependency relationship is set up by using a condition. You specify the output conditions in the job definition. 

You can define an unlimited number of conditional dependencies. When you choose to add a conditional dependency on 

this job, you select the status and output conditions that you want to be considered during the job processing. The following 

example shows other output conditions defined in the job definition.
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You can define both successful output conditions, conditions that when satisfied signify that the job completed successfully, 

and other output conditions, which when satisfied determine which successor job to run. The output conditions are 

evaluated in "OR".

When this job is added to a job stream as a successor job, and a conditional dependency is added to the job preceding 

this job (predecessor job), then a selection of the conditions is made. The properties panel for the internal or external 

dependency is dynamically updated to include the conditions originally specified in the job definition. In addition to the 

conditions originating from the job definition, you can select conditions based on job status. If the selected conditions are 

satisfied during job processing, then the corresponding successor job runs.
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You can also join or aggregate conditional dependencies related to different predecessors. A join contains multiple 

dependencies, but you decide how many of those dependencies must be satisfied for the join to be considered satisfied. You 

can define an unlimited number of conditional dependencies, standard dependencies, or both in a join.

Conditional dependencies are supported only for dependencies where the predecessor is a job or a job stream in the 

same network and where all the components are at least at the Version 9.3 Fix Pack 2 level. They are not supported on 

internetwork dependencies, nor on Limited Fault-Tolerant Agents for IBM i.

Condition dependencies (z/OS)
Conditional logic  feature in IBM®  Workload Scheduler  for z/OS.

In IBM®  Workload Scheduler  for z/OS, you can specify that jobs are dependent on other jobs. For example, if job A1 must 

complete before job A2 can start, then A1 is a predecessor  of A2, and A2 is a successor  of A1. These relationships between 

jobs are called dependencies.
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When specifying dependencies, you can also define work flows with alternative branches based on conditions, specifically to 

achieve the same results as using IF/THEN/ELSE statements in the job JCL. You can use both job return code and job status 

as conditional logic  elements to determine the start of a successor job. The following example shows how this works.

A condition dependency relationship is set up by using a condition.

You can define condition dependencies at the following levels:

Job level

By conditioning the start of the successor to the check on job return code or status of the predecessor.

Step level

By conditioning the start of the successor to a specific step return code of the predecessor.

How condition dependencies work

A condition dependency  is a specific check of the status or return code of a predecessor job or of the return code of a job 

step.

The job processing flow is affected by the conditions set and their final status.

The status of a condition is set based on the rule defined and on the statuses of its condition dependencies.

The condition dependency is evaluated only when a path in the plan exists, otherwise the condition dependency remains 

Undefined until a manual intervention or a rerun is done.

A possible path for the conditional predecessor exists when at least one of the following conditions occurs:

• The job has status Completed  and a normal successor exists.

• There is at least one conditional successor that has all  the subsets of conditions, referencing that conditional 

predecessor, set to true, according to the condition rules.

For example:

• A conditional predecessor (Job A) has several conditional successors (Jobs B, C, D)

• Each conditional successor has a set of condition dependencies, relating to job A, that must be satisfied to make it 

possible for the successor to start.

• Job A runs and changes its status.

• If at least one subset of conditions between job A and one of its successors is true, the path in plan exists and all 

the successors' condition dependencies related to job A are evaluated. Otherwise all condition dependencies are left 

undefined.

When specifying predecessors in the database, you can define a list of conditions  by combining single condition 

dependencies  on predecessor job status or return code. You cannot define a job both as a conditional and as a normal 

predecessor of another job. For each condition you can specify one of the following rules:
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• At least n  number of conditions out of all the condition dependencies must be satisfied. This rule corresponds to the 

OR operator in Boolean logic.

• All the condition dependencies in the list must be satisfied. This rule corresponds to the AND operator in Boolean 

logic.

At run time, the scheduler evaluates the condition status resulting from the condition dependencies statuses, based on the 

selected rule. The condition status can be:

True

When ALL condition dependencies are true.

If the rule is set to AND

When ALL condition dependencies are true.

If the rule is set to OR (at least n  condition dependencies must be true)

When at least n  condition dependencies are true.

False

The condition was not satisfied.

If the rule is set to AND

When at least one condition dependency is false.

If the rule is set to OR (at least n  condition dependencies must be true)

When at least n  condition dependencies cannot be true.

Undefined

When the rule cannot be evaluated yet.

A set of conditions results as satisfied if all the conditions are satisfied, according to the logic of the AND operator.

When a predecessor ends, the successor job status changes to one of the following statuses:

Waiting

Undefined, until the scheduler evaluates all the defined conditions. At least one normal predecessor is not 

in Completed  or Suppressed by Condition  status or at least one condition is U (Undefined). The scheduler 

processes all subsequent statuses as usual, up to a final status.

Ready

Ready, when all the defined conditions are satisfied. Job normal predecessors are in Completed  or Suppressed 

by Condition  status and all its conditions are True. The scheduler processes all subsequent statuses as usual, 

up to a final status.

Suppressed by Condition

Suppressed by condition, when the defined condition dependency is not satisfied. At least one condition is 

False.
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Note:  When evaluating conditional successors status, predecessor jobs in status Suppressed by 

Condition  are considered equal to predecessor operations in status Completed.

Examples of condition dependencies

condition dependenciesexamplesUse a job-level condition dependency when you want a successor job to start depending on a combination of one or more 

return codes or statuses of predecessor jobs.

#unique_95_Connect_42_exconddepdef  on page 74 shows the two different types of job level conditions, one based 

on the predecessor return code and the other based on the predecessor job status. For example, using the return code as 

condition type, you can define that job OP2 is dependent on job OP1, specifying that OP2 must run when OP1 ends with a 

return code in the range from 1 to 3. Similarly, using job status as condition, you can define job OP4 as dependent on job 

OP3, specifying that OP4 must run if OP3 ends with status Error.

Figure  3. Example of a condition dependency definition

In this example, OP1 is a conditional predecessor  of OP2 and OP3 is a conditional predecessor  of OP4.

In the previous example, if OP1 ends with return code of 8, the scheduler sets OP2 to status Suppressed by Condition, 

because the condition is not satisfied.

Figure  4. Example of a condition dependency at run time

For further information about conditional logic, see IBM Workload Scheduler for z/OS Managing the Workload

http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/zos/src_man/eqqr1mst_welcome.html
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Step level dependency

condition dependenciesstep levelIf you configured IBM®  Workload Scheduler  for z/OS to track step-end events, then the step dependencies are checked at 

step-end time when the return code value is available.

This section contains an example showing how job processing flow is affected when using step-level conditions.

If the predecessor job is associated to a job comprising several steps, you can specify a dependency on step return codes. 

#unique_95_Connect_42_autorecjssld  on page 75 shows an example of conditional dependency logic at job step level, 

to obtain auto-recovery applications with recovery jobs that can start without waiting for the end of predecessor jobs, 

depending on the result of specific steps.

Figure  5. Auto-recovery job stream with step level dependency

In this example:

• JOBB can start if STEP100, belonging to JOBA, ends with RC=4.

• JOBC is a normal successor of JOBA and therefore starts if JOBA status is Completed.

condition dependencieshandling recoveryrecovered by condition optionoptionrecovered by conditionconditional recovery jobconditional recovery job optionHandling recovery using condition dependencies

Using condition dependencies, the error status of a job can be used as a criteria for starting a successor, when this 

successor is used as a recovery job.

By specifying the conditional recovery job option, you can define that the job is used as the recovery job for a conditional 

predecessor.

Any conditional predecessor that Ended-in-Error, with a status or error code matching a condition dependency defined for the 

job, does not prevent the daily plan process from removing the occurrence to which the predecessor belongs. To check if the 

status Ended-in-error  can be ignored at occurrence removal phase, the daily plan process uses a field automatically set by 

the scheduler, corresponding to Recovered by condition.

Note:  As soon as a recovery job becomes ready, the scheduler checks the predecessors in error status at that time. 

Any predecessor that ends in error after the recovery job runs cannot be flagged as Recovered by condition. The 

daily plan process removes the occurrence in the following cases:
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• The occurrence status is Completed.

• The occurrence status is Ended-in-error , and includes only jobs in one of the following statuses:

◦ Completed

◦ Suppressed by condition

◦ Ended-in-error  with the Recovered by condition  option specified.

For example, suppose that either JOBR1 or JOBR2 must run when JOBB ends with an error. You can specify JOBB as their 

conditional predecessor, as shown in #unique_95_Connect_42_examprecjobconddep  on page 76.

Figure  6. Example of recovery job with condition dependencies

When defining JOBR1 and JOBR2 and specifying JOBB as conditional predecessor, you can also set the Conditional recovery 

job  option to have the daily plan process remove the occurrence containing JOBB, because it ended with an error code 

matching one of the defined condition dependencies.

Cross dependencies
Using cross dependencies and shadow jobs.

A cross dependency is a dependency of a local job  on a remote job  running in a different scheduling environment. It is 

achieved by using a shadow job, which runs in the same environment as the local job and maps the remote job processing.

Cross dependencies help you integrate workload running on more than one engine. They can be both IBM®  Workload 

Scheduler  for z/OS engines (controller) and IBM®  Workload Scheduler  engines (master domain manager).

The following objects allow you to define and manage cross dependencies:

Remote engine

workstationremote engineremote engine workstationA workstation that represents locally a remote IBM®  Workload Scheduler  engine. It is a workstation used 

to run only shadow jobs. A shadow job is a job that runs locally and is used to map another job running 

on a remote engine. This relationship between the two jobs is called a cross dependency. You define a 

remote engine workstation if you want to federate your environment with another IBM®  Workload Scheduler 

environment, either distributed or z/OS, to add and monitor dependencies on jobs running in the other 

scheduling environment. This type of workstation uses a connection based on HTTP protocol to allow the two 

environments to communicate.

Shadow job

A job running locally that is used to map a job running on the remote engine. This job is called a remote 

job. Shadow jobs can run only on remote engine workstations. The shadow job definition contains all the 
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information needed to correctly match the remote job in the plan of the remote engine. The status transition of 

the shadow job reflects the status transition of the remote job.

Remote job

A job that runs on a remote scheduling environment and is mapped by a shadow job to become a dependency 

for a job that runs in a local environment.

To add a cross dependency to a local job on a job that is defined on a remote engine, you must define a normal dependency 

for your local job on a shadow job that:

• Points to the remote job on which you want to create the cross dependency

• Is defined on a local workstation of remote engine type, that points to the engine where the remote job is defined.

To do this, you must

1. Create a remote engine workstation where the shadow job runs.

2. Create a shadow job pointing to a specific job instance defined on a remote engine.

Shadow jobs can be added to the plan by the plan creation process or dynamically at run time. The shadow job 

scheduled time identifies the remote job instance in the remote engine plan.

The bind  process is the process to associate a shadow job with a job instance in the remote engine plan.

As soon as the bind is established, the remote engine sends back an HTTP notification containing the status of the 

bind and, if the bind was successful, the information to identify the remote job instance bound. This information is 

saved in the shadow job instance details.

3. Add the shadow job as a dependency of the local job.

The resolution of the cross dependency depends on the status of the shadow job, which reflects at any time the status of the 

remote job. Because the remote job status transition is mapped into the shadow job status transition, the status of the cross 

dependency is represented by the status of the normal dependency.

The key attributes to identify the remote job instance and the matching criteria depend on the type of remote engine where 

the remote job instance is defined. z/OS engines support only closest preceding  matching criteria. Distributed shadow jobs, 

instead, support the four matching criteria available for external dependencies. See Dependencies  on page 63 for more 

details.

The scheduled time of the job stream containing the shadow job is used to find the match.

To avoid incongruence, at plan creation or extension time, consistency checks are performed to ensure that no mismatch 

has occurred in between the definition of jobs and workstations in the database and their inclusion in the current plan.

Figure 7: Cross dependencies  on page 78 summarizes how cross dependencies work.
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Figure  7. Cross dependencies

For more information about cross dependencies, see the sections about defining and managing cross dependencies in 

User's Guide and Reference  and in Managing the Workload.

Related information

Creating cross dependencies  on page 127

User

A User  is the user name used as the login value for several operating system job definition. Users must be defined in the 

database.

If you schedule a job on an agent, on a pool, or on a dynamic pool, the job runs with the user defined on the pool or dynamic 

pool. However, the User must exist on all workstations in the pool or dynamic pool where you plan to run the job.

Users can be defined in a specific folder  if you want to organize them by line of business or some other custom category.

Related information

Designing your Workload  on page 101

Listing workload objects  on page 141

Workstation class

A workstation class  is a group of workstations with similar job scheduling characteristics. Any number of workstations can 

be grouped in a class, and a workstation can be included in many classes. Jobs and job streams can be assigned to run on a 

specific workstation class and this makes the running of jobs and job streams across multiple workstations easier.

For example, you can set up the following types of workstation classes:
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• Workstation classes that group workstations according to your internal departmental structure, so that you can 

define a job to run on all the workstations in a department

• Workstation classes that group workstations according to the software installed on them, so that you can define a 

job to run on all the workstations that have a particular application installed

• Workstation classes that group workstations according to the role of the user, so that you can define a job to run on 

all the workstations belonging to, for example, managers

In the previous example, an individual workstation can be in one workstation class for its department, another for its user, 

and several for the software installed on it.

Workstations can also be grouped into domains when your network is set up. Because the domain name is not one of the 

selection criteria used when choosing where to run a job, you might need to mirror your domain structure with workstation 

classes if you want to schedule a job to run on all workstations in a domain.

For more information about how to define workstation classes, see the section about workstation class definition in IBM 

Workload Scheduler: User's Guide and Reference.

Related information

Designing your Workload  on page 101

Listing workload objects  on page 141

Variable table

A variable table  is a table containing multiple variables and their values. All global parameters, now called variables, are 

contained in at least one variable table.

You are not required to create variable tables to be able to use variables, because the scheduler provides a default variable 

table.

However, you might want to define a variable with the same name, but different values, depending on when and where it is 

used. You do this by assigning different values to the same variable in different variable tables. You can then use the same 

variable name in different job definitions and when defining prompts and file dependencies. Variable tables can be assigned 

at run cycle, job stream, and workstation level.

Variable tables can be particularly useful in job definitions when a job definition is used as a template for a job that belongs 

to more than one job stream. For example, you can assign different values to the same variable and reuse the same job 

definition in different job streams.

For information about how to define variable tables, see Variable table definition.

Related information

Designing your Workload  on page 101

Listing workload objects  on page 141
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Workload Broker job definition

A Workload Broker job definition  is a text file in Job Submission Description Language (JSDL) schema file format, which 

contains all the parameters necessary to run a job.

The Job Brokering Definition Console provides an easy-to-use graphical interface that you can install locally to create and 

edit job definitions. Job definitions, saved in the JSDL schema, are created by your input into the Job Brokering Definition 

Console.

The JSDL schema offers great flexibility and supports a wide variety of criteria to determine job requirements, scheduling 

and load-balancing.

For more information about  Workload Broker, see the documentation in the previous release at IBM Workload Automation 

9.4.0  and browse to the Scheduling Workload Dynamically  manual.

From the Dynamic Workload Console, you can create Workload Broker  job definitions that map  Workload Broker  jobs. You 

can also monitor  Workload Broker  jobs and browse the corresponding job logs.

Related information

Creating Workload Broker objects  on page 137

Production process
Generating the IBM Workload Scheduler  production plan.

IBM Workload Scheduler  production is based on a plan that runs in a production period.

You can define the production period when creating or extending the production plan  and it can span from a few hours to 

multiple days (by default it lasts 24 hours).

The production plan contains information about the jobs to run, on which fault-tolerant agent, and what dependencies must 

be satisfied before each job can start.

JnextPlanYou use the JnextPlan  script to generate the production plan and distribute it across the IBM Workload Scheduler  network. 

Then, if you want to extend your production plan at a fixed time interval, for example every day, you have the option to 

automate the extension by using the final  job stream at the end of each production period. A sample job stream helps you 

to automate plan management and runs the sequence of script files included in JnextPlan  to generate the new production 

plan.

When the production plan is generated, all of the required information about that production period is taken from the 

scheduling environment and object definitions and is included in the plan.

During the production period, the production plan is regularly updated to show what work is completed, in progress, and left 

to process.

https://www.ibm.com/docs/en/workload-automation/9.4.0
https://www.ibm.com/docs/en/workload-automation/9.4.0
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Symphony fileIn IBM Workload Scheduler  for distributed environments or in a z/OS end-to-end network, a file called Symphony  contains all 

the information about the production plan. This file is sent to all the subordinate domain managers and fault-tolerant agents 

in the scheduling environment. This allows the fault-tolerant agents throughout the network to continue their processing 

even if the network connection to their domain manager is down.

IBM Workload Scheduler  processes monitor the production plan and make calls to the operating system to launch jobs as 

required. The operating system runs the jobs, and informs IBM Workload Scheduler  if the job completed successfully. This 

information is used to update the production plan to indicate the status of the job.

From the Dynamic Workload Console  or the command line interface, you can view and make changes in the current 

production plan.

Even once job definitions have been submitted into the production plan, you still have the opportunity to make one-off 

changes to the definitions before they run, or after they have run. You can update the definition of a job that has already run 

and then rerun it. You can update a job definition from either the Job Stream Graphical view, the job monitoring view, or from 

the conman  command line. The job definition in the database remains unchanged.

Database
The IBM®  Workload Scheduler  database.

The IBM®  Workload Scheduler  database, hereafter referred to as the database, is a relational database that is accessible by 

the master domain manager and contains all the definitions for scheduling objects, such as jobs, job streams, resources, and 

workstations. It also holds statistics of job and job stream execution, as well as information about the user ID that created an 

object and when an object was last modified.

For more information about the types and versions of the supported relational database, see the IBM®  Workload Scheduler 

documentation.

Related information

Designing your Workload  on page 101

Plans
Different types of plans you can access to manage the objects and the activities they contain.

A plan contains all jobs and job-related scheduling objects that are scheduled for a selected time interval. There are different 

types of plans based on the type of IBM®  Workload Scheduler  environment you are connected to.

Note:  The only type of plan that you can access through the Dynamic Workload Console  is the current plan.

The following plans are available:
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Production plan (current plan)

productionplancurrent planplancurrentproductionA production plan (in distributed environment) or current plan (in z/OS environment) is the master control for 

all job scheduling activity planned for a user-defined time interval, named the production period. Scheduling 

object definitions stored in the database, such as jobs and job streams, become instances in the production 

plan, where they can be monitored and modified.

The production plan is created on the master domain manager and contains all the jobs and job streams that 

are scheduled to run within the production period together with their depending objects and all workstation 

definitions. You do have the opportunity to make additional changes to job definitions even once they are in 

the plan as long as the job has not yet started running. If the job has already run, you can update the definition 

and rerun the job. Only the job instance is modified. The job definition in the database remains the same. 

The production plan can be extended to cover future time intervals. Any job streams that did not complete 

successfully within the production period or that are either running or still waiting to be run, can be carried 

forward into the plan extension.

The production plan data is stored in the Symphony file and replicated in the database. With IBM®  Workload 

Scheduler  version 9.1, accessing this information from the Dynamic Workload Console  directly queries the 

database thereby improving response times.

Preproduction plan

preproduction planplanpreproductionA preproduction plan is used to identify in advance the job stream instances and the job stream dependencies 

involved in a specified time period.

This improves performance when generating the production plan by preparing in advance a high-level schedule 

of the anticipated production workload.

The preproduction plan contains:

• The job stream instances to be run during the covered time period.

• The external dependencies that exist between the job streams and jobs included in different job 

streams.

Symnew plan

Symnew planplanSymnewA Symnew plan is a temporary plan. It is an intermediate production plan that covers the whole time the new 

production plan that is being generated will cover. It is replaced by the production plan as soon as it starts.

Archived Plan

archived planplanarchivedAn archived plan is a copy of an old production plan that ran in the IBM®  Workload Scheduler  environment and 

that is now stored in the IBM®  Workload Scheduler  database.

Using this type of plan you can, for example, see the result of running a past production plan. The difference 

between using an archived plan and a forecast plan covering the same time interval is that an archived plan 

shows how the real production was based on the job and job stream processing results, while a forecast plan 

shows how the production was planned to be.
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Trial plan

trial planplantrialA trial plan is a projection of what a production plan would be if it covered a longer period of time. For example, 

if you generate a production plan that covers two days, but you want to know what the plan would be if it 

covered three days, you can generate a trial plan.

A trial plan is typically created to extend a production plan and to have an idea of future impacts on the 

scheduling environment. Therefore, if there is a valid production plan, the start time option is greyed out. By 

default, the trial plan start date is the same as the production plan end date.

Using this type of plan you can, for example, see how the current production evolves based on the job and job 

stream dependencies defined in the production plan, if available, or in the preproduction plan. Trial plans are 

based on the information contained either in the production or in the preproduction plan. If neither is available, 

a trial plan cannot be created.

Forecast plan

forecast planplanforecastA forecast plan is a projection of what the production plan would be in a chosen time interval. For example, if 

you generate a production plan that covers two days and you want to know what the plan would be for the next 

week you can generate a forecast plan.

A forecast plan is typically created to anticipate and solve any kind of scheduling problems, therefore the start 

time is always enabled and it is a mandatory field.

Using this type of plan you can, for example, see how the production will be in a future time interval based 

on the job and job stream dependencies defined in the IBM®  Workload Scheduler  database. Based on this 

information, you can modify some information in the database, if needed, before extending the production plan.

When workload service assurance is enabled, it can calculate the predicted start time of each job in the job 

stream. You can enable and disable this feature using the enForecastStartTime  global option. IBM®  Workload 

Scheduler  calculates the average run for each job based on all previous runs. For complex plans, enabling this 

feature could negatively impact the time taken to generate the forecast plan.

Note:  Neither the trial nor the forecast plan takes into account any dynamic updates made to the Symphony file while 

the production plan is being processed. Therefore, all the job streams it contains are in one of the following states:

HOLD

If they are dependent on other job streams or if their start time is later than the plan start time.

READY

If they are free from dependencies and their start time has elapsed.

Related information

Display a graphical plan view  on page 173

Graphical views in the plan  on page 176
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Selecting the working plan  on page 211

Generating Trial and Forecast Plans  on page 212

Workload Dashboard  on page 188

Preproduction plan

The preproduction plan is used to identify in advance the job stream instances and the job stream dependencies involved in 

a specified time period.

This improves performance when generating the production plan by preparing in advance a high-level schedule of the 

predicted production workload.

The preproduction plan contains:

• The job stream instances to be run during the time interval of the plan.

• The external follows dependencies that exist between the job streams and jobs included in different job streams.

predecessorsuccessorsuccessorpredecessorA job or job stream that cannot start before another specific external job or job stream is successfully completed is named 

successor. An external job or job stream that must complete successfully before the successor job or job stream can start is 

named predecessor.

IBM Workload Scheduler  automatically generates, expands, and updates, if necessary, the preproduction plan by completing 

the following steps:

• Removes any job stream instances that are in COMPLETE or CANCEL state.

• Selects all the job streams that are scheduled to run after the end of the current production plan and generates their 

instances.

• Resolves all job and job stream dependencies, including external follows dependencies, according to the defined 

matching criteria.

To avoid any conflicts, the database is locked during the generation of the preproduction plan and unlocked when the 

generation completes or if an error condition occurs.

At this stage only the job streams with the time they are scheduled to start and their dependencies are highlighted. All the 

remaining information about the job streams and the other scheduling objects (calendars, prompts, domains, workstations, 

resources, files, and users) that will be involved in the production plan for that time period are not included, but are retrieved 

from the database as soon as the production plan is generated.

preproduction planFNCJSIFNCJSIpreproduction planWhen the production plan is extended, old job stream instances are automatically removed. The criteria used to remove 

these instances is based on the following conditions:
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• The first job stream instance that is not in COMPLETE state when the new plan is generated (FNCJSI). This job 

stream instance can be both a planned instance, that is an instance added to the plan when the production plan is 

generated, and a job stream instance submitted from the command line during production using the conman sbs 

command.

• The time period (T) between the time FNCJSI is planned to start and the end time of the old production plan.

Assuming T  is this time period, the algorithm used to calculate which job stream instances are removed from the 

preproduction plan is the following:

if T < 7

All job stream instances older than 7 days from the start time of the new production plan are removed from the 

preproduction plan; all job stream instances closer than 7 days to the start time of the new production plan are 

kept regardless of their states.

if T > 7

All job stream instances older than FNCJSI are removed from the preproduction plan; all job stream instances 

younger than FNCJSI are kept.

This algorithm is used to ensure that the preproduction plan size does not increase continuously and, at the same time, to 

ensure that no job stream instance that is a potential predecessor of a job stream newly added to the new preproduction 

plan is deleted.

For more information about how you can open the preproduction plan in view mode from the Dynamic Workload Console, 

see the section about how to view preproduction plan in the Dynamic Workload Console User's Guide.

Note:  In the IBM Workload Scheduler for z/OS  terminology the concept that corresponds to the preproduction plan is 

long term plan  (LTP).

Related information

Display a graphical preproduction plan  on page 213

Engine connections
You must define an engine connection to manage and monitor objects that run on a specific workstation in the IBM® 

Workload Scheduler  environment in the network.

To manage and monitor objects you must connect the Dynamic Workload Console  to IBM®  Workload Scheduler  distributed 

environments, z/OS environments, or both. You connect them by defining engine connections, and you can create as many 

engine connections as you need.

When you create a new connection, you must provide an engine name, the host name, and port number of the engine you 

want to connect to.
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If you connect to a IBM®  Workload Scheduler  for z/OS environment, the plan that you access is the current plan and the 

engine that you connect to is the controller workstation, which is the management hub of the IBM®  Workload Scheduler  for 

z/OS environment.

If you connect to a IBM®  Workload Scheduler  distributed environment, you can connect to:

The master domain manager workstation

A workstation acting as the management hub for the network. It manages all your scheduling objects. You can 

define and use different engine connections to the master domain manager, each accessing a different plan.

Backup master domain manager

A workstation that can act as a backup for the master domain manager when problems occur. It is a master 

domain manager, waiting to be activated. Its use is optional. This workstation must be installed as a master 

domain manager workstation.

Related information

Creating and managing engine connections  on page 13

Event management
What the event management feature is and how to use it.

You can use the event management  feature to launch a predefined set of actions in response to events that occur on the 

nodes where IBM®  Workload Scheduler  runs.

The main elements of event management are:

• Events  on page 86

• Actions  on page 87

• Event rules  on page 88

You can use event management capabilities to:

• Create Event Rules

• Create and run Workload Events  tasks

eventobjects relateddefinitionapplication monitoringgenericfilemonitoring eventobjectrelated eventapplication monitoring eventgenericevent Events 

An event represents a set of circumstances that match selected criteria. Events are divided into the following major 

categories:
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Note:  The topics listed below are .html files referenced by the PDF. Ensure you are connected to the Internet before 

clicking on the links.

IBM®  Workload Scheduler  object related events

All the events relating to scheduling objects such as jobs, job streams, workstations, and prompts.

This type of event is described in more detail in Workload Automation plan events.

Note:  Any change performed on a workstation referenced in a rule is not reported in the rule. For 

example if you modify, update, or delete a workstation that is referenced in a rule, the rule ignores the 

change and continues to consider the workstation as it was when it was included in the rule.

File monitoring events

Events relating to changes to files and logs. File monitoring events are not supported on IBM i systems.

This type of event is described in more detail in File monitor.

Application monitoring events

Events relating to IBM®  Workload Scheduler  processes, file system, and message box. Application monitoring 

events are not supported on IBM i  systems.

This type of event is described in more detail in Application Monitor.

SAP related events

These events are available only if you have installed IBM®  Workload Scheduler  for Applications and they are 

generated by external SAP systems.

This type of event is described in more detail in SAP Monitor.

Data set monitoring

These events are available only if you are using the agent for z/OS on IBM®  Workload Scheduler.

This type of event is described in more detail in Data Set Monitoring.

Generic events

Events used to manage custom events sent by external applications. You can write an XML file to define a 

custom event. A schema is provided to validate your XML, as well as a basic event template that you can use 

as a starting point. For more information, see the schemas for generic events. Events of this category are:

• Changes in a resource of the operating system, such as processes and memory

• Email received

actionnotificationoperationalgenericoperational actionnotification actiongenericactionActions
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When one or more of the above events occurs, you can specify which actions to perform. Actions are divided into the 

following main categories:

Operational actions

Actions that cause a change in the status of one or more IBM®  Workload Scheduler  objects. Actions in this 

category include:

• Submitting jobs or job streams

• Submitting ad hoc jobs

• Replying to a prompt

This type of action is described in more detail in .

• Adding an application occurrence (job stream) to the current plan on IBM Workload Scheduler 

for z/OS® in HCL Workload Automation-IBM Workload Scheduler for z/OS end-to-end scheduling 

configurations.

This type of action is described in more detail in IBM Workload Scheduler for z/OS.

Notification actions

Actions such as:

• Sending email's or SMS. For details, see .

• Actions performed by running a command. This type of action is described in more detail in .

• Forwarding messages. For details, see .

• Opening an incident in ServiceNow incident management. For details see .

eventrulesEvent rules

Use event rules  to associate one or more events to the response actions that you want to perform. When you create an event 

rule, you are actually creating an event rule definition  in the database. While the event rule is in Draft  status, it is not deployed 

to the IBM®  Workload Scheduler. All new and modified non-draft rules saved in the database are periodically (by default 

every five minutes) found, built, and deployed by an internal process named rule builder. At this time they become active. 

Meanwhile, an event processing server, which is normally located in the master domain manager, receives all events from 

the agents and processes them. The updated monitoring configurations are downloaded to the agent  and activated. The 

occurrence of an event rule that has performed the corresponding actions is called the event rule instance.

Related information

Event management configuration  on page 13

Reports
How to customize and generate IBM®  Workload Scheduler  reports.

../../../TWSForZosAction.html
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Create a report  task to customize and generate IBM®  Workload Scheduler  reports, which you can then view, print, and save, 

in different kinds of output. Reports help you in many business-related activities, such as:

Tuning the workload on the workstations

• Workstation Workload Summary

• Workstation Workload Runtimes

Extract detailed information about the plan

• Planned Production Details

• Actual Production Details

Detect jobs with exceptions

• Job Run History

• Job Run Statistics

To generate your reports, you can use either the predefined reports or create your personalized reports created using 

Business Intelligent Report Tool (BIRT). For more information, see Reporting  on page 227.

The following table shows the available reports within the Dynamic Workload Console  and their details.

Table  8. Report types

Report Name Description Supported environment

Job Run History Collects the historical job run data during a 

specified time interval. Use it to detect which jobs 

ended in error or were late. It also shows which 

jobs missed their deadline, long duration jobs, and 

rerun indicators for reruns.

Distributed and z/OS

Job Run Statistics 

Chart

Collects the job run statistics. Use it to detect 

success, error rates; minimum, maximum, and 

average duration; late and long duration statistics.

Distributed

Job Run Statistics 

Table

A report collecting the job run statistics, which 

returns output in table format. It is useful to detect 

success, error rates; minimum, maximum, and 

average duration; late and long duration statistics.

Distributed

Job Run Statistics A report collecting the job run statistics, which 

returns output in table format. It is useful to detect 

success, error rates; minimum, maximum, and 

average duration; late and long duration statistics.

z/OS
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Table  8. Report types  (continued)

Report Name Description Supported environment

Workstation 

Workload 

Summary

Shows the workload on the specified 

workstations. The workload is expressed in terms 

of number of jobs that ran on them. It helps 

for capacity planning adjustments (workload 

modelling and workstation tuning).

Distributed and z/OS

Workstation 

Workload 

Runtimes

Shows job run times and duration on the specified 

workstations. It helps for capacity planning 

adjustments (workload modelling and workstation 

tuning).

Distributed and z/OS

Custom SQL Allows you to create reports that best fit your 

business needs. You can specify an SQL query or 

import SQL scripts.

Distributed

Planned 

Production Details

Extracts information about planned production 

plans into either an XML or a CSV format, to be 

used respectively, with Microsoft Project and 

Microsoft Excel. This also allows users who do 

not know IBM®  Workload Scheduler  to access 

plan information in a familiar format.

Distributed

Actual Production 

Details

Extracts current plan information into either an 

XML or a CSV format, to be used, respectively, 

with Microsoft Project and Microsoft Excel. 

This also allows users who do not know IBM® 

Workload Scheduler  to access plan information in 

a familiar format.

Distributed

Analysis Job 

Duration 

Estimation Error

A report that shows the average estimation 

error. It is useful to detect whether a job ends 

in frequent errors, ends in error, or if the jobs 

have unsatisfactory accuracy rates. You can then 

drill down to display all the jobs that are in that 

threshold and finally you can visualize charts that 

will help you to identify the jobs that have a high 

estimated error rate allowing you to intervene 

beforehand on those jobs.

Distributed and z/OS

Analysis Job 

Duration Standard 

Deviation

A report showing variances in job duration. 

The variance is calculated as a percentage and 

according to which variance level the jobs are 

they will be presented as follows: High variability, 

Distributed and z/OS
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Table  8. Report types  (continued)

Report Name Description Supported environment

Medium variability  or a Low variability. You can 

drill down to display all the jobs that are in that 

threshold which then returns output in a chart 

format. This report is useful to identify the run that 

had a greater duration.

The output of historical reports, which is extracted from the database, consists of the following main sections. The output of 

a Planned and Actual report is not structured because it is a file that must be opened with an external program.

Report header

reportheaderContains the report title, description, engine name, engine type, creation time, type, and the total number of the 

result set extracted.

Report of content

Contains a set of hyper-links to each section and subsection.

Report format

reportformatDepending on the kind of information you are processing, you can choose to view it in the most appropriate 

format. The report output can be in:

Table format

It shows information organized in rows and columns, in a CSV or HTML file.

Graphical format (HTML)

If you choose the graphical formats, depending on the report type, and on the information you 

choose to include, you can have data displayed in pie charts, bar charts, line charts, or tables.

Note:  To see report output correctly, make sure that you configure your browser as follows:

• Allow pop-up windows.

• Remove any optional browser toolbar that you installed, if its settings prevent new windows from opening.

• To see CSV reports, configure the browser security settings to automatically prompt for file downloads.

Related information

Reporting  on page 227

Regular expressions and SQL reports  on page 269
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Workload service assurance
Basic concepts about critical jobs and the critical path, which are fundamental to take advantage of this feature.

Workload service assurance is an optional feature that allows you to identify critical jobs and to ensure that they are 

processed in a timely manner.

When the workload service assurance feature is enabled, you can indicate that a job is critical and define a deadline by which 

it must be completed when you add the job to a job stream. Defining a critical job and deadline triggers the calculation of 

timings for all jobs that make up the critical network. The critical network includes the critical job itself and any predecessors 

that are defined for the critical job. When changes that have an impact on timings are made to the critical network, for 

example addition or removal of jobs or follows dependencies, the critical start times are automatically recalculated.

The critical network is constantly monitored to ensure that the critical job deadline can be met. When a critical network job 

completes, timings of jobs that follow it are recalculated to take account of the actual duration of the job. The system also 

acts automatically to remedy delays by prioritizing jobs that are actually or potentially putting the target deadline at risk. 

Some conditions that cause delays might require your intervention. A series of specialized critical job views, available on the 

Dynamic Workload Console, allow you to monitor critical jobs, display their predecessors and the critical paths associated 

with them, identify jobs that are causing problems, and drill down to identify and remedy problems.

Dynamic critical path
dynamic critical path

If a job is critical and must complete by the deadline set on the database you can mark it as a critical job  thus specifying 

that it must be considered as the target of a critical path. The critical path consists of the critical job predecessors with the 

least slack time. In a critical job predecessor path, the slack time is the amount of time the predecessor processing can be 

delayed without exceeding the critical job deadline. It is the spare time calculated using the deadline, scheduled start, and 

duration settings of predecessors jobs. The calculation of critical path is performed dynamically. In this way, during daily 

planning processing, a critical path including the internal and external predecessors of the critical job is calculated, and a 

table of predecessors is cached (in the local memory for z/OS and on the master domain manager for distributed systems). 

Every time a predecessor of the critical job starts delaying, the scheduler dynamically  recalculates the critical path, to check 

whether a new path, involving different jobs, became more critical than the path calculated at daily planning phase.

You can launch a query for all the jobs included in a critical path by clicking Critical Path  in the panels that show the results 

of monitor jobs tasks.

As well as jobs included in the critical path job list, there are other lists of jobs that might be important to manage to ensure 

that your critical job does not fail.

Hot list
hot list

The hot list  contains a subset of critical predecessors that can cause a delay to the critical job because they are states such 

as error, late, fence (for distributed systems only), suppressed (for distributed systems only), or long duration. If these jobs 

do not complete successfully on time, they prevent the critical job from completing on time. Using the hot list view, you can 
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quickly see which jobs need you to take appropriate recovery actions. Jobs included in the hot list are not necessarily also 

included in the critical path.

You can launch a query for all the jobs in the hot list by clicking Hot List  in the panels that show the results of monitor critical 

jobs tasks.

Related information

Limit the number of objects retrieved by queries  on page 34

Using workload service assurance to monitor z/OS critical jobs  on page 236

Processing and monitoring critical jobs
Automatic tracking and prioritizing of critical network jobs.

Workload service assurance provides automatic tracking and prioritizing of critical network jobs and online functions that 

allow you to monitor and intervene in the processing of critical network jobs.

Automatic tracking and prioritizing

To ensure that critical deadlines can be met, workload service assurance provides the following automated services for 

critical jobs and for predecessor jobs that form their critical networks:

Promotion

promotionWhen the critical start time of a job is approaching and the job has not started, the promotion mechanism is 

used. A promoted job is assigned additional operating system resources and its submission is prioritized.

The timing of promotions is controlled by the global option promotionoffset. Promoted jobs are selected for 

submission after jobs that have priorities of "high" and "go", but before all other jobs. Prioritizing of operating 

system resources is controlled by the local options jm promoted nice  (UNIX™  and Linux™) and jm promoted 

priority  (Windows™).

Calculation of the critical path

critical pathcalculation ofpathcriticalcalculation ofThe critical path is the chain of dependencies, leading to the critical job, that is most at risk of causing the 

deadline to be missed at any given time. The critical path is calculated using the estimated end times of 

the critical job predecessors. Working back from the critical job, the path is constructed by selecting the 

predecessor with the latest estimated end time. If the actual end time differs substantially from the estimated 

end time, the critical path is automatically recalculated.

Figure 8: Critical path  on page 94 shows the critical path through a critical network at a specific time during 

the processing of the plan.
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Figure  8. Critical path

At this specific time, the critical path includes Job3a, Job2a, and Job1a. Job3a and Job3b are the immediate 

predecessors of the critical job, job4, and Job3a has the later estimated end date. Job3a has two immediate 

predecessors, Job2a and Job_y. Job2a has the later estimated end time, and so on.

Addition of jobs to the hot list

hot listaddition of jobsjobaddition to the hot listJobs that are part of the critical network are added to a hot list that is associated to the critical job itself. The 

hot list includes any critical network jobs that have a real or potential impact on the timely completion of the 

critical job. Jobs are added to the hot list for the one or more of the following reasons. Note that only the jobs 

that begin the current critical network, for which there is no predecessor, can be included in the hot list.

• The job has stopped with an error. The length of time before the critical start time is determined by the 

approachingLateOffset  global option.

• The job has been running longer than estimated by a factor defined in the longDurationThreshold  global 

option.

• The job has still not started, although all its follows dependencies have either been resolved or released, 

and at least one of the following conditions is true:
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◦ The critical start time has nearly been reached.

◦ The job is scheduled to run on a workstation where the limit is set to zero.

◦ The job belongs to a job stream for which the limit is set to zero.

◦ The job or its job stream has been suppressed.

◦ The job or its job stream currently has a priority that is lower than the fence or is set to zero.

Setting a high or potential risk status for the critical job

A critical job can be set to the following risk statuses:

High risk

high risk statuscritical jobhigh risk statusCalculated timings show that the critical job will finish after its deadline.

Initially, estimated start and end times are used. As jobs are completed, timings are recalculated 

to take account of the actual start and end times of jobs.

Potential risk

potential risk statuscritical jobpotential risk statusCritical predecessor jobs have been added to the hot list.

Online tracking of critical jobs
critical jobtrackingtrackingcritical job

The Dynamic Workload Console provides specialized views for tracking the progress of critical jobs and their predecessors. 

You can access the views from the following sources:

• Workload Dashboard: dedicated widgets to monitor the critical status: high risk, no risk, potential risk

• Monitor Critical Jobs  tasks: lists all critical jobs for a selected engine with the possibility to run actions against the 

results. View jobs with a high risk level along a horizontal time axis.

• What-if analysis view: from a Gantt view, highlight the critical path and show the impact on critical jobs.

The list of results produced by the Monitor Critical Jobs query displays all critical jobs for the engine, showing their status: 

normal, potential risk, or high risk. From this view, you can navigate to see:

• The hot list of jobs that put the critical deadline at risk.

• The critical path.

• Details of all critical predecessors.

• Details of completed critical predecessors.

• Job logs of jobs that have already run.

Using the views, you can monitor the progress of the critical network, find out about current and potential problems, release 

dependencies, and rerun jobs.

The Monitor Critical jobs view provides a timeline, Expand Timeline, which displays the placement along a horizontal time 

axis of the jobs in the list and highlights jobs with high risk level. Only critical jobs that have not completed are displayed in 

the timeline. It also allows you to modify the plan deadline and quickly see how it would affect jobs. If you see a job that is 
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late or in high risk state, right-click the job in the list of results and select What-if  from the table toolbar to open the What-if 

Analysis  and view them in a Gantt chart for further investigation.

Planning critical jobs
Planning critical jobs.

Workload service assurance provides the means to identify critical jobs, define deadlines, and calculate timings for all jobs 

that must precede the critical job.

If it is critical that a job must be completed before a specific time, you can flag it as critical when you add it to a job stream 

using the Workload Designer functions on the Dynamic Workload Console. You can define the deadline either at job or job 

stream level.

Jobs can also be flagged as critical by including the critical  key word on the job statement when you create or modify a job 

stream using the composer  command line.

When you run the command to include the new job in the production plan, all jobs that are direct or indirect predecessors of 

the critical job are identified. These jobs, together with the critical job itself, form a critical network.

Because timing of jobs in the critical network must be tightly controlled, Time Planner calculates the following timing 

benchmarks for each critical network job:

Critical start

Applies to distributed systems only and represents the latest time at which the job can start without causing 

the critical job to miss its deadline.

Critical start times are calculated starting with the deadline set for the critical job and working backwards using 

the estimated duration of each job to determine its critical start time. For example, if the critical job deadline is 

19:00 and the estimated duration of the critical job is 30 minutes, the critical job will not finish by the deadline 

unless it starts by 18:30. If the immediate predecessor of the critical job has an estimated duration of 20 

minutes, it must start at latest by 18.10.

Note:  Only the deadline of the critical job is considered when calculating critical start times for jobs in 

the critical network. If other jobs have deadlines defined, their critical start times might be later than 

their deadlines.

Earliest start

Represents the earliest time at which a job in the critical network can start, taking into consideration all 

dependencies and resource requirements.

Estimated start times are calculated starting with the earliest time at which the first job or jobs in the critical 

network can start and working forward using the estimated duration of each job to estimate the start time of 

the job that follows it.
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Estimated start and end time

For the initial calculations, these values are set to the planned start and end time. They are subsequently 

recalculated to take into consideration any changes or delays in the plan.

Estimated duration

The estimated duration of a job is based on statistics collected from previous runs of the job. If the job has 

never run before, a default value of one minute is used. Take this into account when considering the accuracy 

of calculated timings for critical job networks that include jobs running for the first time.

Symphony fileThe timings for each job in the critical network are added to the Symphony  file, which includes all the plan information and is 

distributed to all workstations on which jobs are to be run.

As the plan is run, Plan Monitor monitors all critical networks: subsequent changes to the critical network that affect the 

timing of jobs trigger the recalculation of the critical and estimated start times. Changes might include manual changes, 

for example, releasing dependencies or rerunning jobs, and changes made automatically by the system in response to a 

potential or actual risk to the timely completion of the critical job.

Specific views for critical jobs and their predecessors, available from the Dynamic Workload Console, allow you to keep track 

of the processing of the critical network. The views can immediately identify problems in your planning of the critical job. 

For example, if the estimated start time of a job in the critical network is later than the critical start time, this is immediately 

signaled as a potential risk to the critical job.

IBM Workload Scheduler  for SAP
With SAP support, you can use IBM Workload Scheduler  to do the following tasks:

• Use IBM Workload Scheduler  standard job dependencies and controls on SAP jobs.

• Create SAP jobs using the IBM Workload Scheduler  interface.

• Schedule SAP jobs to run on specified days and times, and in a defined order.

• Define inter-dependencies between SAP jobs and jobs that run on different platforms.

• Define the national language support options.

• Use the SAP Business Warehouse Support function.

• Customize job execution return codes.

• Use SAP logon groups for load balancing and fault-tolerance.

• Work with SAP variants and placeholders.

• Use Business Component-eXternal Interface Background Processing (BC-XBP 2.0) interface support to:

◦ Intercept jobs

◦ Track child jobs

◦ Keep all job attributes when you rerun a job

◦ Raise events
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Note:  For more information about SAP, see the topic about the intergation with SAP in IBM Workload Automation: 

Scheduling Applications with IBM Workload Automation.

extended agent workstationworkstationextended agentSAPextended agentdynamic agent workstationworkstationdynamic agentSAPdynamic agentz-centric agent workstationworkstationz-centric agentSAPz-centric agentdynamic poolSAPdynamic poolScheduling process for the SAP extended agent

IBM Workload Scheduler  launches jobs in SAP by using jobs defined on the following workstations that support the r3batch 

access method:

• A IBM Workload Scheduler  extended agent workstation. A workstation that is hosted by a fault-tolerant agent or 

master workstation.

• A dynamic agent workstation.

• A dynamic pool.

• A z-centric workstation.

These supported workstations use the r3batch access method to communicate with the SAP system. The access method is 

used to pass SAP job-specific information to predefined SAP instances. The access method uses information provided in an 

options file to connect and launch jobs on an SAP instance.

Note:  For more information about this, see the section about the integration with SAP in IBM Workload Automation: 

Scheduling Applications with IBM Workload Automation.

You can define multiple agent workstations to use the same host, by using multiple options entries or multiple options files. 

Using the SAP agent name as a key, r3batch uses the corresponding options file to determine which instance of SAP will 

run the job. It makes a copy of a template job in SAP and marks it as able to run with a start time of start immediate. It then 

monitors the job through to completion, writing job progress and status information to a job standard list found on the host 

workstation.
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creatingobjects in the database editingobjects in the database This section describes creating and editing objects in the database.

Designing your scheduling environment
To begin working with IBM Workload Scheduler  you must design your scheduling environment.

About this task

The scheduling environment is composed of the following objects:

• Workstations

• Domains

Depending on whether your engine is distributed or z/OS, the steps to follow are different:

• You create workstations and domains. Depending on the business needs of your organization and the complexity of 

your network, you can decide to have a hierarchical domain structure.

• You define workstations.

To create a scheduling environment perform the following steps:

Creating a workstation

About this task

You can create multiple workstation definitions.

For more information about the main workstation types and their attributes, see the section about workstation definition in 

the User's Guide and Reference.

To add a workstation definition to the database and to assign it to a domain, perform the following procedure.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. From the navigation toolbar, click Design  > Workload Definitions  > Create Workstations.

2. Select a engine from the list and click Create Workstations.

3. In the Workstations properties panel, specify the attributes for the workstation you are creating.

a. In a distributed environment, depending on the type of workstation you select, some attributes are mandatory.

b. In a z/OS environment, specify the workstation attributes using the General, Resources, and Open Time 

Intervals tabs as appropriate. Depending on the type of workstation you select, some attributes are 

mandatory.

4.  To assign the workstation to an existing domain
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a. Click Assign to Domain.

b. Select the domain and click Save.

5.  To assign the workstation to a new domain:

a. On the Select Domain  panel, click New.

b. Click Save  to add the domain to the database and return to the Select Domain  panel.

c. In the Select Domain  panel click OK  to assign the new domain to the workstation you are creating.

Results

The workstation is now added to the database. Alternatively, click Administration  > Workload Environment Design  > List 

Workstations, select a distributed engine, and click Display. From the workstation table, click New.

Note:  You can add workstation definitions to the database at any time, but you must run JnextPlan -for 0000  to add 

the workstation definition to the plan, so that you can run jobs on this-workstation. For dynamic agent workstation 

definitions, if you have the enAddWorkstation  global option set to "yes", the workstation definitions are automatically 

added to the plan after they are defined in the database.

What to do next

You can also edit and manage workstation and domain definitions.

To edit a workstation definition in the database and to assign it to a domain, perform the following steps.

1. Select the engine from Design  > Workload Definitions  > List Workstations.

2. Optionally, specify some filtering criteria that help you find the workstation you want to modify. You can also 

customize the workstation attribute that you want to display in the columns.

3. Click Display. From the workstation table, select a workstation click Edit  to modify its properties or choose another 

action form the buttons and menu available.

4. In the Workstations properties panel, specify the attributes for the workstation you are modifying. Depending on the 

type of workstation you select, some attributes are mandatory.

5. To assign the workstation to an existing domain or to create a new domain, click Assign to Domain.

6. Click Save.

To add a new domain definition from the list of distributed workstations, perform the following steps:

1. Click Administration  > Workload Environment Design  >  List Workstations.

2. Optionally, enter filtering criteria and click Display.

3. From the list of workstations, click Domains View.

4. Click New  and, on the Domain properties panel, specify the properties for the domain.

5. Click Save  to add the domain to the database or Cancel  to exit without saving.

Creating a pool of agents
Creating distributed workstation definitions in the IBM®  Workload Scheduler  database.

About this task
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You can define and schedule dynamic jobs to perform application specific operations, such as database, file transfer, Java, 

and Web Services operations. You can customize the sample files provided with the product to match the requirements of 

your environment.

To run these job types, you can use dynamic agents, a workstation type that you create by running the related installation 

process. The dynamic agents  are automatically created and registered at installation time. You can also organize the 

dynamic agents  into groups, called pools or dynamic pools.

To add this kind of workstation definition to the database and to assign it to a domain, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. From the navigation toolbar, click Design  > Workload Definitions  > Create Workstations.

2. Select an engine from the list and click Create Workstations.

3. In the Workstations properties panel, specify the attributes for the pool of dynamic agents  you are creating. In the 

Workstation Type  menu, select Pool  or Dynamic Pool, depending on the set of dynamic agents  you are defining.

Choose from:

◦ Select Pool  to define a cluster of dynamic agents  with similar hardware or software characteristics to submit 

jobs to. Then, in the Member  table that displays the dynamic agents  that belong to the Pool, click Add  to add 

new dynamic agents  and Remove  to remove unwanted dynamic agents.

When dynamic agents  are added to a pool, the agent is registered with the pool and this registration is written 

to the pools.properties  file located in TWS_home/ITA/cpa/config. As an alternative method, you can 

add dynamic agents  to a pool by directly editing this file.

◦ Select Dynamic Pool  to define a set of dynamic agents  that is dynamically defined based on the resource 

requirements you specify. Then click Edit Requirements  to display a panel where you can specify the 

requirements necessary for running your jobs. All your selections produce an XML file, which is used to 

select a workstation with the characteristics you require, to run  Workload Broker  jobs. When you provide the 

requirements, you specify a list of workstation candidates to be included in the Dynamic Pool  of dynamic 

agents  and the preferred order in which they must be considered. You also specify the best criteria, which is 

used to change the workstation (workload balance, CPU utilization, or its use of logical resources).

4. Optionally, you can associate the new pool to a variable table.

5. Specify the Workload Broker  hosting the workstation.

Designing your Workload
Create and editing workload definitions in the database.

Before you begin

To create and edit scheduling objects, open the Workload Designer, by performing the following steps:
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1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the displayed panel, specify the engine connection you want to use. Only the categories of objects supported by 

the engine that you selected are available.

You can open multiple occurrences of the Workload Designer. The following scenarios are supported:

• Same user connected to multiple engines

• Multiple users connected to the same engine.

When you open the Workload Designer, the window displays a list of new objects you can create, and a list of the most recent 

objects that were edited, and a Search tab for searching on object names. An Explore tab gives you access to folders in 

which job streams can be organized according to your internal business processes, geographies, or other categorizations.

Select an object in the Create New  list to create a new object definition or search for an object in the Search  field. Click on 

Advanced  to open the advanced search panel. Select one or more objects to open them in edit mode by clicking the Edit 

button. The open objects are locked in the database until you finish editing and save them.

To work with job streams assigned to folders representing meaningful custom categories, click Explore  and navigate to the 

folder containing the job stream you want to work with. Each folder contains up to 250 jobs, job streams and folders.

When an object is open in edit mode, its properties are displayed in the right pane, where you can view and edit them either in 

the Details view or the Graphical View.

You can add additional objects to the object in edit mode by either right-clicking the object or searching for an object in the 

Search  field. Select an object from the list of results, and click add (+) to add the object to the view of the existing object. 

For example, you can search for jobs and automatically add them to the job stream you are editing, or add other objects as 

dependencies, such as resources or prompts.

When you select the objects you want to work on, the following window is displayed, showing several working areas that you 

can use, depending on the task you want to perform.



Chapter 7. Creating and Editing Objects in the Database

Related information

Scheduling objects  on page 51

 Editing objects from the Working List View

About this task

To modify objects from the  Working List  view, perform the following steps:

1. Type an object name in the Search  text field.

2. In the displayed lookup panel, select the required filtering criteria and click the search icon.

3. From the displayed list, select one or multiple objects and click one of the following action buttons:

Edit

To modify the properties of the selected objects. When an object is open in edit mode the edit icon 

is displayed on the right of the object.

View

To open the selected objects in read-only mode.
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Add

To add the selected objects to existing objects in the Details  view.

 Create like

To create a new object with the same properties of the selected object.

 Edit

To modify the properties of the selected objects. When an object is open in edit mode the edit icon 

is displayed on the right of the object.

 Unlock

To unlock the selected objects for further actions. When an object is unlocked, it is displayed in read-

only mode.

 Delete

To delete the selected objects from the database.

What to do next

All the selected objects are listed in the Working List view. When you select an object from this list, its properties are 

displayed in the right pane, where you can view or edit them, if you have the required authorization defined in the IBM 

Workload Scheduler  security file.

By hovering with the cursor over the icons located on the toolbar, you can see all the actions you can perform on the selected 

objects.

Related information

Working List  on page 261

 Editing objects from the Details View

About this task

To modify object from the Details  view, perform the following steps:

1. Choose the object you want to modify and either:

Choose from:
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◦ Select it and click the  button.

◦ Right-click it and choose an action from the context menu.

2. Choose one of the displayed actions to act on the selected item. Only actions available for the selected item are 

displayed in the menus.

What to do next

When an object is open in edit mode, its properties are displayed in the bottom pane, where you can view and edit them.

Related information

Details view  on page 262

 Editing objects from the Graphical View

About this task

The Graphical View  shows the job stream with the jobs it contains and related dependencies.

From the  Graphical View  you can edit an object in any of the following ways:

• Select it and click the  button.

• Right-click it and choose an action from the context menu. Only actions available for the selected item are displayed 

in the menus.

• Select an object or an arrow and use the buttons on the graphical view toolbar to create or remove dependencies.

Related information

Graphical View - modelling  on page 183

Editing object properties

About this task

Use the Properties pane, to modify the properties of the selected object.
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The properties pane is divided into tabs, which contain options and properties relating to the object currently open.

If you have more than one object open in the Working List, the properties displayed in this pane are relating to the object 

currently selected in the Details  or Graphical  view above.

Enter the required information in the mandatory fields. An automatic check ensures you enter only supported characters.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

Creating job stream definitions
How to define a new job stream definitions using the Dynamic Workload Console.

About this task

From the Workload Designer  panel of the Dynamic Workload Console, you can define job streams, running on both 

distributed and z/OS environments. Most of them can also be created using composer  (on distributed systems) and ISPF  (on 

z/OS systems) interfaces.

Optionally, you can quickly submit the job stream into the current plan to be run immediately. You might want to do this for 

testing purposes before implementing the job stream in large-scale production. See Quick submit of jobs and job streams  on 

page 124.

To create a new job stream definition from the Dynamic Workload Console, perform the following procedure:

1. From the navigation toolbar, click  Administration  > Workload Definitions  > Manage Workload Definitions

2. Specify an engine name, either distributed or z/OS.

Result

The Workload Designer opens. Job types and characteristics vary depending on whether you select a distributed or a 

z/OS engine.

3. In the Create New pane, select Job Stream.

4. In the properties panel, specify the attributes for the job stream definition you are creating. For all the details about 

available fields and options, see the online help by clicking the "?" on the top-right corner.

5. Click Save  to save the job definition in the database.

Related information

Domain  on page 48

Job stream  on page 53

Status description and mapping for distributed job streams  on page 251

Status description and mapping for z/OS job streams  on page 254
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Limit the number of objects retrieved by queries  on page 34

Job  on page 52

Creating job definitions
How to define a new job definition using the Dynamic Workload Console.

About this task

From the Workload Designer  panel of the Dynamic Workload Console, you can define multiple types of jobs, running on both 

distributed and z/OS®  environments. Most of them can also be created using composer  (on distributed systems) and ISPF 

(on z/OS®  systems) interfaces. Some predefined job types are organized into categories including native jobs, and job types 

with advanced options, which are specific job types that you use to perform operations on external applications. In addition 

to the existing ones, you can define your own job types and add them to this list or organize them in workflow folders. To 

create a new job definition from the Dynamic Workload Console, perform the following procedure:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions

2. Specify an engine name, either distributed or z/OS®.

Result

The Workload Designer opens. Job types and characteristics vary depending on whether you select a distributed or a 

z/OS®  engine.

3. In the Create New pane, select Job Definition.

4. Select the category and type of job you want to create.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details about available 

fields and options, see the online help by clicking the "?" on the top-right corner.

6. Click Save  to save the job definition in the database.

Results

When you define a job, IBM Workload Scheduler  records the job type in the database without performing further checks. 

However, when the job is submitted, IBM Workload Scheduler  checks the operating system on the target workstation and 

defines the job type accordingly.

Optionally, if you are connected to a distributed engine, you can quickly submit the job definition into the current plan to be 

run. You might want to do this for testing purposes before implementing the job in large-scale production. See Quick submit 

of jobs and job streams  on page 124.

Once job definitions have been submitted into the production plan, you still have the opportunity to make one-off changes 

to the definitions before they run, or after they have run. You can update the definition of a job that has already run and then 

rerun it. The job definition in the database remains unchanged.

For more information about creating the plug-ins to support the definition and running of dynamic job types, see Developer's 

Guide: Extending IBM Workload Automation.
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Related information

Job  on page 52

Status description and mapping for distributed jobs  on page 246

Status description and mapping for z/OS jobs  on page 249

Limit the number of objects retrieved by queries  on page 34

Workstation  on page 44

Variable table  on page 79

Run cycle  on page 56

Dependencies  on page 63

Customizing your job stream  on page 234

Defining jobs based on the agent type

About this task

How to create a job definition for supported agents  using the Dynamic Workload Console.

supported agents  job defining withDynamic Workload ConsoleDynamic Workload Consoledefining supported agents  job Steps for defining a job for supported agents.

Fault-tolerant agents

To define jobs, follow these steps:

1. From the navigation toolbar, click Administration>Workload Definitions>Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select

◦ New  >  Job Definition

◦ New

4. Select the category and type of job you want to create.

◦ For IBM®  Workload Scheduler  native jobs, click

▪ Native  >  Windows, UNIX or Other.

▪  z/OS job. See Scheduling with the Agent for z/OS.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.

Limited fault-tolerant agent

To define jobs, follow these steps:
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1. From the navigation toolbar, click Administration>Workload Definitions>Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select

◦ New  >  Job Definition

◦ New

4. Select the category and type of job you want to create.

◦ For IBM®  Workload Scheduler  native jobs, click

▪ Native  > Other. See Limited Fault-tolerant Agent for IBMi.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.

Agent for z/OS

To define jobs, follow these steps:

1. From the navigation toolbar, click Administration>Workload Definitions>Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select

◦ New  >  Job Definition

◦ New

4. Select the category and type of job you want to create.

◦ For IBM®  Workload Scheduler  native jobs, click

▪ Native  > z/OS. See Scheduling with the Agent for z/OS.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.

Remote engines

To define shadow jobs, follow these steps:

1. From the navigation toolbar, click Administration>Workload Definitions>Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select

◦ For IBM®  Workload Scheduler  native jobs,

▪ New  >  Job Definition.

▪ New.

4. Select the category and type of job you want to create.
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◦ ForIBM®  Workload Scheduler  jobs,

▪ For IBM®  Workload Scheduler  native jobs,

▪ File Transfer and Coordination  > Shadow Distributed or Shadow z/OS. See IBM 

Workload Scheduler User's Guide and Reference, section about Job definition - 

Shadow jobs.

▪ Shadow Distributed or Shadow z/OS. See IBM Workload Scheduler for z/OS 

Managing the Workload, section about Specifying cross dependencies and 

shadow jobs.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.

Extended agents

To define jobs, follow these steps:

1. From the navigation toolbar, click Administration>Workload Definitions>Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select New  > Job Definition.

4. Select the category and type of job you want to create.

◦ For SAP jobs, ERP  > SAP Job on XA Workstations. See Scheduling Applications with IBM 

Workload Automation, section about Creating SAP Standard R/3 jobs from the Dynamic 

Workload Console.

◦ For MVS, ERP  > Access method

◦ For PeopleSoft, ERP  > Access method.

◦ For z/OS, Native  > z/OS.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.

Dynamic agent  and IBM®  Z®  Workload Scheduler  agents

supported agents  job defining withDynamic Workload ConsoleDynamic Workload Consoledefining supported agents  jobThe steps described here for defining a job are common to all access methods.

Follow these steps:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. Specify an engine name, either distributed or z/OS. The Workload Designer  opens. Job types and 

characteristics vary depending on whether you select a distributed or a z/OS engine.

3. In the Working List pane, select

◦ New  >  Job Definition

◦ New

4. Select the category and type of job you want to create.

http://www.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/distr/src_ref/awsrgmst_welcome.html
http://www.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/distr/src_ref/awsrgmst_welcome.html
http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/zos/src_man/eqqr1mst_welcome.html
http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/zos/src_man/eqqr1mst_welcome.html
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◦ For SAP R/3  jobs, ERP,

▪  SAP Job on Dynamic Workstations. See Scheduling Applications with IBM Workload 

Automation, section about Creating SAP Standard R/3 jobs from the Dynamic Workload 

Console.

▪  SAP. See Scheduling Applications with IBM Workload Automation, section about 

Creating SAP Standard R/3 jobs from the Dynamic Workload Console..

▪ SAP PI Channel, see Scheduling Applications with IBM Workload Automation, section 

about Defining a IBM®  Workload Scheduler  job that runs an SAP PI Channel job.

◦ For IBM®  Workload Scheduler  native job types, Native

▪ Executable, see IBM Workload Scheduler User's Guide and Reference, section about Job 

definition - Executable  jobs

▪ IBM®  i, see "Scheduling jobs on IBM i" in Limited Fault-Tolerant Agent IBM i.

▪ z/OS, see IBM Workload Scheduler for z/OS Scheduling End-to-end with z-centric 

Capabilities.

▪ Remote command, see IBM Workload Scheduler User's Guide and Reference, section 

about Job definition -remote command  jobs.

◦ For Database and Integrations  job types with advanced options, Database and Integrations,

▪ Database, see IBM Workload Scheduler User's Guide and Reference, section about Job 

definition - Database jobs.

▪ J2EE, see IBM Workload Scheduler User's Guide and Reference, section about Job 

definition - J2EE jobs.

▪ Java, see IBM Workload Scheduler User's Guide and Reference, section about Job 

definition - Java jobs.

▪ MS SQL, see IBM Workload Scheduler User's Guide and Reference, section about 

Creating job types with advanced options.

▪ Web Services, see IBM Workload Scheduler User's Guide and Reference, section about 

Job definition - Web services jobs.

◦ For Business Analytics  job types with advanced options, Business Analytics,

▪ InfoSphere®  DataStage®, see Scheduling Applications with IBM Workload Automation, 

section about Defining a IBM Workload Scheduler  job to run an InfoSphere DataStage 

job.

▪ Cognos®, see Scheduling Applications with IBM Workload Automation, section about 

Defining jobs by using composer.

◦ For Cloud  environments, Cloud  > IBM SmartCloud®  Provisioning, see IBM Workload Scheduler 

User's Guide and Reference, section about Job definition - IBM SmartCloud®  Provisioning  jobs

◦ For Access Method  job types, PeopleSoft, SAP r3batch and MVS, ERP  >  Access Method.

◦ For File Transfer and Coordination  > File Transfer, see IBM Workload Scheduler User's Guide 

and Reference, section about Job definition - File transfer jobs.

5. In the properties panel, specify the attributes for the job definition you are creating. For all the details 

about available fields and options, see the online help by clicking the "?" in the top-right corner.

6. Click Save  to save the job definition in the database.
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Note:  The access method for SAP R/3  provides supplementary features if you use the alternative steps described in 

Creating SAP Standard R/3 jobs from the Dynamic Workload Console  and associate it to an IBM Workload Scheduler 

job. You can create native SAP R/3  Standard jobs on a remote SAP  system directly from the Dynamic Workload 

Console.

Prerequisite steps to create Provisioning  jobs
How to define a new Provisioning  job definition using the Dynamic Workload Console.

About this task

To create a Provisioning  job definition, you must first complete the prerequisite steps listed below.

1. Install IBM SmartCloud®  Provisioning. To find out the version supported by the product, generate the Data Integration 

report from the IBM®  Software Product Compatibility Reports web site, and select the Supported Software  tab.

2. Obtain the SmartCloud HTTP server certificate and save it in a directory for later use. 

The Provisioning  administrator can provide the certificate, or you can retrieve the certificate performing the following 

steps in your browser. The following example is based on Mozilla Firefox:

a. Log in to Provisioning  server providing Provisioning  credentials.

b. To download the certificate, click: Tools>Options>Advanced>Encryption>View Certificates

c. Select IBM®>  IBM®  WebSphere®  Cloudburst Appliance  and click Export. 

A file, named IBMWebSphereCloudBurstAppliance.crt (X509 Certificate - PEM)  is created.

3. Browse to the directory where a JRE is installed, for example: C:\Program Files\IBM\TWS\javaExt\JRE\JRE

4. Create a new truststore by launching the following command: keytool -genkeypair -alias certificatekey -keyalg 

RSA -validity 7 -keystore keystore.jks,

where, keystore.jks  is the file path to the keystore.

5. Add IBM SmartCloud®  certificate to the truststore by launching the following command: keytool 

-import -file certificate_directory\IBMWebSphereCloudBurstAppliance.crt -alias scp -keystore 

trustore_directory\keystore.jks,

6. Open the TWA_HOME\TWS\ITA\cpa\config\JobManager.ini  file, and locate JavaJobLauncher  section, JVMOptions  row.

7. Add the following instructions to the row: "-Djavax.net.ssl.trustStore= DIRECTORY_TRUSTSTORE/keystore.jks 

-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASSWORD"

For example:

JVMOptions = -Djavax.net.ssl.trustStore=C:/myUtils/keystore.jks
-Djavax.net.ssl.trustStorePassword=passw0rd

8. To complete the procedure, stop and restart the agent.

Prerequisite steps to create OSLC  Automation and OSLC  Provisioning jobs
How to define a new OSLC  Automation and OSLC  Provisioning job definition by using the Dynamic Workload Console.

https://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/softwareReqsForProduct?deliverableId=E9230C00CE1611E78F8FA93481EF6122&osPlatforms=AIX%7CHP%7CIBM%20i%7CLinux%7CSolaris%7CWindows%7Cz/OS&duComponentIds=S004%7CS005%7CA001%7CA003%7CA002&mandatoryCapIds=30%7C9%7C13%7C121%7C25%7C26&optionalCapIds=130%7C132#prereqs-1
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About this task

To create an OSLC  Automation or OSLC  Provisioning job definition, you must first complete the prerequisite steps listed 

hereafter.

For more information about creating OSLC  Automation and OSLC  Provisioning job definitions, see the sections about Job 

definition - OSLC  Provisioning and OSLC  Automation jobs, in User's Guide and Reference.

Note:  Before performing the following procedure, ensure that you installed the Jazz for Service Management 

Registry Services  from the Installation Manager.

1. Obtain the Registry Services  server certificate and save it in a directory that you will later use. 

Registry Services  administrator can provide the certificate, or, with Firefox browser, for example, you can retrieve the 

certificate performing the following steps:

a. Log in to a Registry Services  (for example, https://hostname:16311/oslc/pr)

b. Download the certificate by clicking in the browser toolbar: Tools>Options>Advanced>Encryption>View 

Certificates

c. Select IBM>Registry_Services_hostname:port  and click Export.

A file is created with the name that you specify, for example myserver:16311.

2. Browse to the directory where a JRE is installed, for example: C:\Program Files\IBM\TWA_˂TWS_user>\TWS
\JavaExt\jre\jre\bin

3. Create a new truststore by launching the following command: keytool -genkeypair -alias certificatekey -keyalg 

RSA -validity 7 -keystore trustore_directory\keystore.jks

Note:  Ensure that the trustore_directory  is not created in the javaExt\JRE  path.

4. Add the IBM  Registry Services  certificate to the truststore by launching the following command: keytool -import 

-file certificate_directory\certificate_name  -alias oslc -keystore trustore_directory\keystore.jks

5. Open the TWA_HOME\TWS\ITA\cpa\config\JobManager.ini  file, and locate JavaJobLauncher  section, JVMOptions  row.

6. Add the following instructions to the row: "-Djavax.net.ssl.trustStore=DIRECTORY_TRUSTSTORE/keystore.jks 

-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASSWORD".

For example:

JVMOptions = -Djavax.net.ssl.trustStore=C:/myUtils/keystore.jks
-Djavax.net.ssl.trustStorePassword=passw0rd

7. Stop and restart the agent.

8. Create the OSLCAutomation.properties  and OSLCProvisioning.properties  files, respectively for the OSLC  Automation 

and OSLC  Provisioning jobs, and locate them in <TWA_Home>/TWS/JavaExt/cfg/.

Specify the service provider catalogs (or Registry Services) that you will later use to create the job in the following 

format:

113



Dynamic Workload Console User’s Guide

114

ServiceProviderCatalogName=RegistryServicesURI

9. Close and restart the WebSphere®  Application Server  on the master domain manager and on Jazz for Service 

Management.

Prerequisite steps to create IBM WebSphere®  MQ  jobs
How to define a new IBM WebSphere®  MQ  job definition using the Dynamic Workload Console.

About this task

To create a IBM WebSphere®  MQ  job definition, you must first complete the prerequisite steps that are listed in the following 

procedure.

For more information about creating IBM WebSphere®  MQ  job definitions, see the relevant chapter about Job definition - IBM 

WebSphere®  MQ  jobs in the IBM Workload Scheduler User's Guide and Reference.

1. Install IBM WebSphere®  MQ, version 7.5.

2. On the IBM WebSphere®  MQ  server workstation, create a user to use in the IBM Workload Scheduler  jobs definition 

that is not a privileged user. On UNIX operating systems, the user must not belong to the mqm  group created at 

installation time. On Windows operating systems, the user cannot be a member of the Administrators group.

3. Allow the user that is defined in step 2  on page 114 to connect to its queue manager, queues, and channels. For 

the queue manager associated to the user, set the Display  for the Administration authority, and the Connect  and the 

Inquire  for MQI authority. For more information about IBM WebSphere®  MQ  users, see http://pic.dhe.ibm.com/

infocenter/wmqv7/v7r5/topic/com.ibm.mq.sec.doc/q013290_.htm

Prerequisite steps to create Salesforce  jobs
Prerequisite steps to create a Salesforce  job definition.

About this task

Before you start to create Salesforce  job definition with IBM Workload Scheduler, consider the following limitations:

• The batch Apex classes (and related methods) that you want to run with the Salesforce  plug-in, must be defined with 

global  access level, in order to make them accessible by all Apex everywhere (the public  access level is not enough).

• At job definition time, only Salesforce  batch Apex classes can be run. If you select a non-batch Apex class, the job 

fails.

To create a Salesforce  job definition, you must complete the prerequisite steps that are listed in the following procedure.

1. Register on Salesforce  Server and ask for user ID and password.

2. Log in to Salesforce  Server.

3. Create the following Apex classes that are needed for the communication between IBM Workload Scheduler  and 

Salesforce  Server. The IBM Workload Scheduler  Apex classes must be defined outside any package.

http://www.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/distr/src_ref/awsrgmst_welcome.html
http://pic.dhe.ibm.com/infocenter/wmqv7/v7r5/topic/com.ibm.mq.sec.doc/q013290_.htm
http://pic.dhe.ibm.com/infocenter/wmqv7/v7r5/topic/com.ibm.mq.sec.doc/q013290_.htm
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Class TWSListApexClass

@RestResource(urlMapping='/TWSListApexClass/*')
global with sharing class TWSListApexClass{
//This Apex class exposes the TWSListApexClass REST service
//which returns a list of all known Batchable Apex classes.
    @HttpGet
    global static List˂ApexClass>  doGet() {
      RestRequest req = RestContext.request;
      RestResponse res = RestContext.response;
      String fullName='';
      List˂ApexClass>  tempList =
      [SELECT NamespacePrefix,Name FROM ApexClass ORDER BY Name];
      List˂ApexClass>  result = new List˂ApexClass>();
      for (ApexClass a: tempList){
       if (a.NamespacePrefix==null || a.NamespacePrefix.equals('')){
            fullName=a.Name;
           } else {
             fullName=a.NamespacePrefix+'.'+a.Name;
           }
           System.debug(LoggingLevel.Info, 'ApexClass: '+fullName);
           result.add(a);
        }
        return result;
    }
}

Class TWSSubmitApexJob

@RestResource(urlMapping='/TWSSubmitApexJob/*')
global with sharing class TWSSubmitApexJob{
//This Apex class exposes the TWSSubmitApexJob REST service
//which submits an Apex class to the Salesforce server.
    @HttpGet
    global static ID doGet() {
        RestRequest req = RestContext.request;
        RestResponse res = RestContext.response;
        String apexClass = req.params.get('className');
        System.debug(LoggingLevel.Info, 'Execute Batch:'+apexClass);
        Type t = Type.forName(apexClass);
        if (t == null){
           throw new TWSException (apexClass + ' not found');
        }
        Object s = t.newInstance();
        ID batchprocessid =
        Database.executeBatch((Database.Batchable˂sObject>)s);
        System.debug(LoggingLevel.Info, 'Job ID: '+batchprocessid);
        return batchprocessid;
    }
global class TWSException extends Exception{}
} 

Class TWSMonitorApexJob

@RestResource(urlMapping='/TWSMonitorApexJob/*')
global with sharing class TWSMonitorApexJob{
//This Apex class exposes the TWSMonitorApexJob REST service
//which will monitor the progress of the backend Apex job.
  @HttpGet
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  global static AsyncApexJob doGet() {
    RestRequest req = RestContext.request;
    RestResponse res = RestContext.response;
    ID i = (ID) req.params.get('jobID');
    AsyncApexJob a = [SELECT Id, Status, ExtendedStatus, NumberOfErrors,
    JobItemsProcessed, TotalJobItems FROM AsyncApexJob WHERE Id = :i];
    return a;
    }
}

Class TWSAbortApexJob

@RestResource(urlMapping='/TWSAbortApexJob/*')
global with sharing class TWSAbortApexJob{
//This Apex class exposes the TWSAbortApexJob REST service
//which will abort the Apex job on the Salesforce server.
    @HttpGet
    global static void doGet() {
        RestRequest req = RestContext.request;
        RestResponse res = RestContext.response;
        String jobID = req.params.get('jobID');
        System.abortJob(jobID);
    }
}

4. Verify the content of the Salesforce  plug-in properties file:

˂TWA_HOME>\TWS\javaExt\cfg\˂plug-in_name>.properties

This file contains the plug-in properties that were set at installation time and that you can choose to override later. 

The plug-in properties are the following:

ProxyServer
ProxyServerPort
pollingPeriod
pollingTimeout

where

ProxyServer

The IP address or the server name for the proxy server. Specify this property if you connect to the 

Salesforce  server through a proxy server.

ProxyServerPort

The listening port of the proxy server.

pollingPeriod

The monitoring frequency. It determines how often the job is monitored during its execution. It is 

expressed in seconds.

pollingTimeout

The monitoring time. It determines for how long the job is monitored during its execution. At the end of 

the timeout interval, the job fails. It is expressed in seconds.

The values that you specify in the properties file are the values that are used at job definition time.
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Prerequisite steps to create SAP BusinessObjects BI  jobs
How to define a new SAP BusinessObjects BI  job definition using the Dynamic Workload Console.

About this task

To create a SAP BusinessObjects Business Intelligence (BI)  job definition, you must first complete the prerequisite steps that 

are listed in the following procedure:

1. Open the SAP BusinessObjects BI  Central Management Console and find the access URL defined in the RESTful 

Web Service application (for example, https://hostname:6405/biprws), to be referenced as server  in the SAP 

BusinessObjects BI  job definition.

Note:  Only reports scheduled for the single user specified in the SAP BusinessObjects BI  server login are 

supported. The default setting for  Schedule for  field must be set to Schedule only for myself. Reports with 

default setting for  Schedule for  set to Schedule for specified users and user groups  are not supported.

2. Verify the content of the file

˂TWA_HOME>\TWS\javaExt\cfg\˂plug-in_name>.properties

This file contains the plug-in properties that were set at installation time. The default content of the properties file for 

SAP BusinessObjects BI  plug-in is the following:

server=
username=
password=
authType=
pollingPeriod=10
pollingTimeout=7200

where

server

The SAP BusinessObjects BI  access URL defined in the SAP BusinessObjects BI  RESTful Web Service 

application.

username

The name of the user authorized to access the SAP BusinessObjects BI  server.

password

The password that is associated with the user authorized to access the SAP BusinessObjects BI  server.

authType

The type of authentication supported by SAP BusinessObjects BI.

Can be:

◦ secEnterprise

◦ secLDAP

117



Dynamic Workload Console User’s Guide

118

◦ secWinAD

◦ secSAPR3

pollingPeriod

The monitoring frequency. It determines how often the job is monitored. It is expressed in seconds.

pollingTimeout

The monitoring time. It determines for how long the job is monitored. At the end of the timeout interval 

the job fails. It is expressed in seconds.

You can choose to override any of the default values set at installation time. The values that you specify in the 

properties file are the values that are used at job definition time.

Prerequisite steps to create job types with advanced options
How to define a new job definitions using the Dynamic Workload Console.

About this task

Perform the following steps before you define and schedule job types with advanced options.

1. Install a number of dynamic agents  and add the Java run time

To install dynamic agents, run the installation program. You can install the dynamic agent  during the full installation 

of IBM Workload Scheduler  or in a stand-alone installation of just the agent. During the installation, you have the 

option of adding the Java run time to run job types with advanced options, both those types supplied with the product 

and the additional types implemented through the custom plug-ins.

Follow the installation wizard to complete the installation.

For a description of the installation parameters and options, see the section about installation options in IBM 

Workload Scheduler: Planning and Installation.

2. Organize the dynamic agents  in pools and dynamic pools.

Pools and dynamic pools help you organize the environment based on the availability of your workstations and the 

requirements of the jobs you plan to run.

a. From the navigation toolbar, click  Administration  > Workload Environment Design  > Create 

Workstations.

b. Select a distributed or z/OS engine.

The workstations you can create vary depending on the engine type you select.

c. Select the workstation type you want to create.
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▪ To create a pool, define the dynamic agents  you want to add to the pool and the workload broker 

workstation where the pool is hosted.

▪ To create a dynamic pool, specify the requirements that each dynamic agent  must meet to be added 

to the dynamic pool.

3. Grant the required authorization for defining job types with advanced options.

The IBM Workload Scheduler  administrator has to grant specific authorizations in the security file to allow the 

operators to create job types with advanced options.

Choose from:

◦ In the distributed environment, perform the following steps:

a. Navigate to the TWA_home/TWSdirectory from where the dumpsec  and makesec  commands must be 

run.

b. Run the dumpsec  command to decrypt the current security file into an editable configuration file.

For more information, see the section about dumpsec  in IBM Workload Scheduler Administration.

c. Add display and run access to the workstation, as follows:

▪ If the operation is performed on the IBM Workload Scheduler  Connector, display and run 

access is required on the CPU corresponding to the workstation where the job is created.

▪ If the operation is performed on the workstation where the job runs, display access is required 

on the workload broker workstation.

For more information, see the section about configuring the security file in IBM Workload Scheduler 

Administration.

d. Close any open conman  user interfaces by using the exit  command.

e. Stop any connectors on systems running Windows operating systems.

f. Run the makesec  command to encrypt the security file and apply the modifications.

For more information, see the section about makesec  in IBM Workload Scheduler Administration.

g. If you are using local security, the file is immediately available on the workstation where it has been 

updated.

i. If you are using a backup master domain manager, copy the file to it.

ii. Distribute the centralized file manually to all fault-tolerant agents  in the network (not standard, 

extended, or broker agents), and store it in the TWA_home/TWS  directory.

iii. Run JnextPlan  to distribute the Symphony file that corresponds to the new security file.

◦ In the z/OS environment, perform the following steps:

a. Define the fixed resource that owns the subresource and give universal read access to it:

RDEFINE (CLASS_NAME) FIXED_RESOURCE  UACC(READ)

b. Give user USER_ID  update access to the FIXED_RESOURCE  fixed resource:

PERMIT FIXED_RESOURCE  ID(USER_ID) ACCESS(UPDATE) CLASS(CLASS_NAME)

c. Define a RACF resource, JSORACF_RESOURCE, to RACF and give universal read access to it:
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RDEFINE (OPCCLASS) JSORACF_RESOURCE  UACC(READ)

JSO is the 3-character code that RACF uses for JS.OWNER.

d. Give user USER_ID  update access to JSORACF_RESOURCE:

PERMIT JSORACF_RESOURCE  ID(USER_ID) ACCESS(UPDATE) CLASS(CLASS_NAME)

4. Define the job types with advanced options  as described in Creating job definitions  on page 107.

You can define job types with advanced options  also using the composer  command.

For more information, see the section about job definition in the IBM Workload Scheduler User's Guide and Reference

You can define job types with advanced options  also using the JOBREC  statement. For details, see the topic about 

JOBREC in IBM Z Workload Scheduler: Scheduling End-to-end with z-centric Capabilities.

Related information

Job  on page 52

Variable table  on page 79

Run cycle  on page 56

Dependencies  on page 63

Customizing your job stream  on page 234

Designing Folders
Create your folders  to organize your jobs and job streams through lines of business  or other custom categories.

About this task

The folders  help you to create different categories in which you can associate jobs and job streams. You can now define 

jobs and job streams that are part of the same line of business  in the same folder. You can manage user access to folders 

by setting user or group permissions according to the company policy. Jobs or job streams that are associated to the same 

folder  can be monitored more easily without relying on complicated object naming conventions.

You can also quickly move a set of jobs or job streams that use a specific naming convention into folders that are named 

after tokens contained in the object names. See the topic about organizing jobs and job streams into folders in the User's 

Guide and Reference.

To create a folder, complete the following steps:

1. Open the Dynamic Workload Console  and from the navigation toolbar, click Design  > Workload Definitions  > Manage 

Workload Definitions.

2. In the displayed panel, specify the engine connection that you want to use and click GO.

3. To create a new folder, from the Explore tab click Create new folder.

http://www.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/distr/src_ref/awsrgmst_welcome.html
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4. You can create your folder  in either the home folder  or as a subfolder in an existing folder. Enter the name of the 

folder  and press Enter.

Result

Your folder  has now been created in the selected location.

What to do next

You can now proceed to create a new job stream that is associated to the folder  by clicking Add new Job Stream, or modify 

and delete a selected folder  by clicking Edit folder  or Delete Folder.

Specifying the parameter format for date, time, and time stamp
When defining reports either using the Dynamic Workload Console, or composer, specify parameters of type date, time, and 

time stamp, using a specific syntax.

The following table shows the syntax you must use when defining reports containing date, time, and time stamp formats as 

parameters.

Table  9. Examples to use for parameters of date, time, and time stamp formats

Table with examples to use for parameters of date, time, and time stamp formats

Cognos®  parameter format examplesPro

mpt 

type

Cognos® 

parameter format
Single value List of values Interval values

Date CCYY-MM-DD 2012-02-03 2012-02-03-Value:2012-03-14 Between 2012-02-03 and 

2012-04-15

Time hh:mm:ss 01:00:00 01:00:00-Value:01:01:01 Between 01:00:00 and 23:59:30

Time 

Stamp
CCYY-MM-DDThh:mm:ss
or
CCYY-MM-DD hh:mm:ss

2012-02
-03
 15:05:00

2012-02-03 

15:05:00-Value:2012-02-03T16:01:00-Val

ue:2012-02-03T16:00:00

Between 2012-02-03 15:05:00
 and
 2012-04-15T16:00:00

Note:  You must specify the parameter format exactly as they are shown in the table respecting lower case and upper 

case formats.

Adding a job to a job stream
How to add an existing job to a job stream using the Dynamic Workload Console.

Before you begin

To perform this task, ensure the IBM Workload Scheduler  engine connection is up and running.

About this task
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Open an existing job stream and add an existing job definition to the job stream. To edit an existing object in the database 

you can use the different views available in the Workload Designer  window.

1. From the navigation toolbar, click Design  >Workload Definitions>Manage Workload Definitions.

2. Specify the engine connection and the Workload Designer  panel opens in a new window.

3. Open the job stream to which you want to add a job. To find the job stream you need, use the search field.

4. You can now work with the job stream by using either the Graphical View  or the Details  view. Select the tab for the 

view you want in the right pane.

Related information

Job  on page 52

Status description and mapping for distributed jobs  on page 246

Status description and mapping for z/OS jobs  on page 249

Limit the number of objects retrieved by queries  on page 34

Job stream  on page 53

Adding a job from the Graphical View

About this task

You can add a job to the job stream using the Graphical View.

From the  Graphical View  you can add a job to a job stream in either of the following ways:
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• Perform the following steps:

1. Right-click inside the graphical view and select Add Jobs  from the menu.

2. Search for the required job by using the displayed Search field and add it to the job stream.

• Search for the job and click Add.

• You can then edit the properties of the newly added job, optionally specifying its scheduling options and time 

restrictions. For example, here you can set a job as Critical  if the job is mission critical and must be processed 

accordingly.

Adding a job from the Details View

About this task

If you use the Details  view, you see a tree-table view of the job stream with all its jobs, dependencies, and run cycles.

From the Details  view you can add a job to a job stream in either of the following ways:

• Perform the following steps:

1. Right-click the job stream row and select Add Jobs  from the menu.

2. Search for the required job by using the Search field, and add it to the job stream.
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• Search for the job and click Add .

• You can then edit the properties of the newly added job, optionally specifying its scheduling options and time 

restrictions. For example, here you can set a job as Critical  if the job is mission critical and must be processed 

accordingly.

What to do next

If you want to remove the job click the remove icon  at the end of the job row.

Quick submit of jobs and job streams
Quickly submit a job or job stream from the Workload Designer. Supported on distributed engines only.

Before you begin

To perform this task, ensure the IBM Workload Scheduler  engine connection is up and running.

About this task

You can quickly submit a job or job stream defined in the database into the current plan and run it immediately from the 

Workload Designer. This operation is supported only on distributed engines. You might want to do this for testing purposes 

before implementing the job or job stream in large-scale production to verify, for example, if the job or job stream completes 

successfully or how long the job takes to complete.

To manage objects in the database, open the Workload Designer  window from the portfolio by clicking Design  > Workload 

Definitions  > Manage Workload Definitions.

Submitting a job stream

About this task

To submit a job stream from the Workload Designer:

1. Open the job stream that you want to submit to be run. To find the job stream, do either of the following actions:

Choose from:

◦ Search for it using the Search  menu in the Working List.

◦ Select the job stream icon  and launch a search (optionally filtered).

2. From the Details  view, click Select an Action  > Submit Job Stream into Current Plan.

Results

The job stream is submitted to the current plan to be run. You can now monitor the status of the job stream by clicking 

Monitoring & Reporting  > Workload Monitoring   > Monitor Workload  from the navigation bar of the Dynamic Workload 

Console. Then, select Job Stream in Object Type.

Submitting a job

About this task
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To submit a job from the Workload Designer:

1. Create a new job definition or open the job definition that you want to submit to be run. To find the job definition, do 

either of the following actions:

Choose from:

◦ Search for it using the Search  menu in the Working List.

◦ Select the job icon  and launch a search (optionally filtered).

2. From the Details  view, click Select an Action  > Submit Job into Current Plan.

3. You are prompted to enter the following optional information:

Job stream name

Type the name of the job stream into which you want to submit the job to run, or browse and select 

from a list of available job streams defined in the database. If you do not specify a job stream, the job is 

automatically submitted into the default JOBS  job stream.

Job stream workstation name

The name of the workstation where the job stream is defined. If you do not specify a (job stream) 

workstation name, then the name used is that of the workstation where the JOBS  job stream is defined.

Job alias

A name assigned to the job so that it can be easily recognized when monitoring the job run. If you do 

not specify an alias, it is automatically generated using the first six characters of the job Name  followed 

by 10 numerical characters.

Results

The job is submitted to the current plan to be run. You can now monitor the status of the job by clicking Monitoring & 

Reporting  > Workload Monitoring  >Workload Monitor  from the navigation bar of the Dynamic Workload Console. 

Then, select Job in Object Type.

What to do next

You still have an opportunity to modify the job definition, if necessary, in the plan. The job instance can be updated before the 

job runs, or after it has run and then the job with the updated definition can be rerun.

Adding and removing dependencies
How to add or remove dependencies using the Dynamic Workload Console.

Before you begin

To perform this task, ensure the IBM Workload Scheduler  engine connection is up and running.

About this task

To manage objects in the database, open the Workload Definitions section from the navigation bar by clicking 

Design>Manage Workload Definitions.
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Adding a dependency

About this task

To add a dependency, from the Workload Designer, perform the following steps:

1. Open the job stream to which you want to add a dependency or the job stream containing the job to which you want 

to add a dependency. To find the job stream, do either of the following actions:

Choose from:

◦ Search for it using the Search  menu in the Working List

◦ Select the job stream icon  and launch a search.

2. You can now work on the job stream by using either the Details  or the Graphical  view. Select the tab for the view you 

want.

Choose from:

◦ From the Details  view, by using the menus, do the following steps:

a. Right-click the job or job stream and select Add Dependencies  from the context menu or select the 

object and choose an option from the Select an Action  menu.

b. From the context menu, select the type of dependency you want to add.

c. From the Search  panel, search for the required object and add it to the job or job stream.

◦ From the Graphical  view, do either of the following actions:

▪ by using the menus, do the following steps:

a. Right-click the job or job stream and select Add Dependencies  from the context menu or 

select the object and choose an option from the Select an Action  menu.

b. From the context menu, select the type of dependency you want to add.

c. From the Search  panel, search for the required object and add it to the job or job stream.

▪ by using the toolbar, do the following steps:

a. Select the create dependency icon  .

b. Draw a line from the dependency to the job or job stream that must depend on it. You can use 

this tool to create dependencies only between objects displayed in the view.

What to do next

Note:  If you add a dependency to a job or job stream after it has completed, it is not evaluated. However, any 

subsequent reruns of the job or job stream will process the dependency correctly.

Related information

Dependencies  on page 63
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Removing a dependency

About this task

From the Workload Designer, you can remove a dependency in either of the following ways:

• From the Details  view, click the remove icon  at the end of the dependency row.

• From the Graphical View, select the dependency by clicking the node (if it is an external dependency) or by right-

clicking the arrow. When the arrow you want to remove is highlighted, click the remove icon  on the toolbar or 

from the context menu. If an object has multiple dependencies, click it again until the arrow you want to remove is 

highlighted.

Related information

Dependencies  on page 63

Creating cross dependencies
Creating a cross dependency using the Dynamic Workload Console.

About this task

To add a cross dependency to a local job on a job that is defined on a remote engine, you must define a normal dependency 

for your local job on a shadow job that:

• Points to the remote job on which you want to create the cross dependency

• Is defined on a local workstation of remote engine type, that points to the engine where the remote job is defined.

To define the cross dependency, perform the following steps:

1. Define a remote engine workstation

On a remote engine workstation you can run only shadow jobs. As a prerequisite for creating a remote engine 

workstation, you must ensure that an HTTP or HTTPS destination to communicate with the remote engine exists. The 

name of this destination must be specified in the remote engine workstation definition.

a. From the navigation toolbar, click Design > Workload Definitions > Create Workstations.

b. Select an engine from the list and click Create Workstations.

c. Specify the workstation properties, selecting Remote engine  as Workstation Type. For more details about the 

options to select, see the online help by clicking the question mark located at the top right corner of the panel.

2. Define a shadow job

It runs on the remote engine workstation and must contain the key values to identify the remote job.
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a. Click  Design  >Workload Definitions>Manage Workload Definitions  to define a job of type Shadow Job.

b. Select an engine from the list and click Go. You can select either a distributed engine (to create a shadow job 

as an independent object) or on a z/OS engine (to create a shadow job within an existing job stream.)

c. The Workload Designer  opens. In the Working List panel, create the new job.

New  > File Transfer and Coordination

New  > Job Definition  > File Transfer and Coordination

d. Select either Shadow Distributed  or Shadow z/OS, depending on the type of remote engine on which the 

remote job is scheduled to run. For more details about the attributes to select, see the online help by clicking 

the question mark located at the top right corner of the panel.

Shadow jobs can be added to the plan by the plan creation process or dynamically at run time. The shadow job 

scheduled time is used to identify the job instance in the remote engine plan.

3. Add the shadow job as a dependency of the local job

The dependency can be internal (distributed only) or external. In the Details  view, right-click the local job and use the 

pop-up menu to add the shadow job as a dependency.

Results

As soon as the shadow job status satisfies the dependency rule, the dependency of the local job on the shadow job is 

resolved, and the cross dependency for the local job on the remote job is also resolved.

For more information about cross dependencies, see the sections about defining and managing cross dependencies in IBM 

Workload Scheduler: User's Guide and Reference  and in IBM Z Workload Scheduler: Managing the Workload.

Related information

Cross dependencies  on page 76

Creating and managing run cycle groups and their run cycles
Why using run cycle groups

By using run cycle groups, you can benefit from the following advantages:

A run cycle group is a distinct database object

It is defined by itself and can be matched with one or more job streams. It is not defined as part of 

a specific job stream like single run cycles.
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The same run cycle group can be used on different job streams

This improves the overall usability of the run cycles, because you can specify the same run cycle 

group in multiple job streams, avoiding the need to have multiple run cycle definitions for the 

same scheduling rules.

Run cycle groups enhance the use of exclusive run cycles

Exclusive (or negative) run cycles are used to generate negative occurrences, which identify 

the days when a job stream would normally be scheduled but is not required. The sum of the 

exclusive run cycles are subtracted from the inclusive ones. A negative occurrence always 

cancels any matching positive occurrences and you can specify a negative occurrence only if the 

positive equivalent already exists. An exact matching of the days, as well as any time restrictions, 

is required between the exclusive and inclusive run cycles for the cancellation to occur. Run cycle 

groups add much flexibility by allowing users to apply exclusive run cycles to a subset of the 

positive ones rather than to all of them. Group your run cycles into subsets  so that the exclusive 

run cycles can be applied only to the positive occurrences generated by the run cycles belonging 

to the same set.

Run cycles must be organized into subsets  within a run cycle group. The subsets are always in a 

logical OR  relationship with each other. The result of the run cycle group is always a date or set of 

dates; it cannot be negative.

For example, you might want your job stream to run every day of the month except the last day 

of the month. But, you also want the it to be scheduled on the last day of the year (the last day of 

December). You can define a run cycle group using subsets, as follows:

Subset 1

• Run cycle 1  - Inclusive run cycle every day of the month

• Run cycle 2  - Exclusive run cycle on the last day of the month

Subset 2

• Run cycle 3  - Inclusive run cycle on December 31st

where, run cycle 2 cancels the last day of each month in Subset 1, while run cycle 3 generates 

December 31st as a separate date and therefore you can schedule the job stream on Dec 31st.

Run cycle groups allow the use of a logical AND between individual run cycles in the subset

By default, the run cycles within a subset are in a logical OR  relationship but you can change this 

to a logical AND, if the run cycle group result is a positive date or set of dates (Inclusive). For each 

run cycle, you can specify either operator (AND ,OR), obtaining the following behavior:  

1. All the run cycles of the group that are in AND  relationship are calculated first. The result 

of this calculation is a date or a set of dates.

2. Then, all the run cycles in an OR  relationship are added to the result of the previous step.
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A similar behavior is applied to inclusive and exclusive run cycles to determine the final date or 

set of dates of a group.

Inclusive (A)

Rule-based run cycle. Select days when the job stream is to be run if they belong to 

all A types of the set of run cycles.

Exclusive (D)

Exclusion rule-based run cycle. Select days when the job stream is NOT to be run if 

they belong to all D types of the set of run cycles.

For example, you can add two conditions together:

Run on Wednesday AND the 8th workday of the month. 

In this way, the only scheduled dates are any 8th work day of the month that falls on a 

Wednesday.

Full compatibility with traditional  run cycles

The traditional  run cycles specified in the job stream definition can reference run cycle groups, 

with the possibility to specify shift or offsets on them (as with periods for z/OS or calendars for 

distributed systems).

A set of dates (interval starts) is created automatically either at run cycle level directly (inclusively 

or exclusively with offsets, or in the rule. This is a two-step process with run cycles:

1. Define the key "business event", such as, Month End, using run cycles and free day rules

2. Define rules that use the dates of the "business event" as the intervals against which the 

other batch run can be scheduled relative to.

For example, you have a Month End process  that runs on the Last Friday of a month, but that 

moves forward to the next working day, except in December when it runs on the 3rd Friday of the 

month. This scheduling rule can be defined with a few rules, run cycles, and free day rules.

Two working days before Month End you need to run a pre-validation process to allow problems 

to be addressed before the run. You cannot choose the last Wednesday of the month, because in 

some months this might occur after the last Friday. Similarly, if the last Friday was a free day, the 

last Wednesday will not be 2 working days before it, because the Free Day rule applies ONLY to 

the day the rule falls on, it cannot look at anything else.

Many other batch runs might also need to be run on a certain number of days before or after the 

Month End, but the same restrictions apply.

You can now define work to run relative to something defined by a combination of run cycles and 

free day rules.
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Use of calendars with run cycles within a run cycle group

Optionally, you can specify more than one calendar to calculate the working and non-working 

days definition for a run cycle. The primary calendar is used to calculate which working days 

are valid, and a secondary calendar is used to calculate specific non-working dates. If the dates 

calculated according to the secondary calendar match with the working days in the primary 

calendar, the job is scheduled; if they do not match, the job is not scheduled.

For example, a global company that runs workload in the United States for many other countries 

needs many calendar combinations to ensure that the batch jobs only run on a day that is a 

working day both in the United States and the other country. The calendar can be defined at 

job stream level and, if not specified, a default calendar is used. However, the calendar at run 

cycle level, whenever defined, can be used as secondary calendar and the job stream (or default) 

calendar can be used as the primary calendar.

For example, Primary calendar can be WORKDAYS, which is defined as MONDAY to FRIDAY 

excluding US holiday dates. You might also need to calculate the job runs based on calendar 

HKWORK, which is defined as Monday to Friday excluding Hong Kong holiday dates. The job 

might have several schedules:

• Run on working days, but not the last working day and not Mondays

• Run on Mondays, but not on the last working day

• Run on the last working day

Because each schedule is calculated against the WORKHK  calendar it is also checked against 

the WORKDAYS  calendar to ensure that it is scheduled on a US working day.

The use of time restrictions with run cycle groups

You can specify time constraints to define the time when processing must start or the time after 

which processing must no longer start. To do this, you can associate time restrictions  to job, job 

streams, run cycles, and run cycle groups. When you define a time restriction, you basically obtain 

a time. Because you can associate time restrictions to multiple objects, the following hierarchy 

shows the order by which the different time restrictions are taken into consideration to actually 

define when to start the processing:

1. Time restriction defined in the run cycle into the job stream

2. Time restriction defined in the job stream

3. Time restriction defined in the run cycle contained in the run cycle group associated to the 

job stream.

4. Time restriction defined in the run cycle group associated to the job stream.

5. Start of Day

This means that:
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Time restrictions in the job stream

Override and take precedence over any other time restrictions  defined in the run 

cycles or run cycle groups associated to the job stream.

No time restrictions in the job stream nor in the run cycle group

The group generates only a date that is the Start Of Day. If offsets and free day 

rules are to be calculated, the calculation always starts from the Start Of Day.

Time restrictions in the run cycle group (not in the job stream)

Time restrictions (and possible offset) are calculated starting from the Start Of Day 

and the resulting date and time indicate the start of processing.

Examples

Table  10. Scenario 1. No time restriction in the run cycle group

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with offset (+ 3 days) 10/27 (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 0/29/ (Monday)

Run cycle in the job stream with time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest 

start +1 1pm

11/02 (Friday) 11/03 (Saturday) 1pm

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/02 (Friday) Start of 

Day

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/02 (Friday) Start of 

Day
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Table  11. Scenario 2. Time restriction in the run cycle group without offset

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with calendar offset (+ 3 

days)

10/27/ (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 0/29/ (Monday)

Run cycle in the job stream with time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest 

start +1 1pm

11/02 (Friday) 11/03 (Saturday) 1pm

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/02 (Friday) Start of 

Day

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/02 (Friday) Start of 

Day

Table  12. Scenario 3. Time restriction in the run cycle group with offset (+1 12:00)

Run cycle group Scheduled date Earliest Start

Run cycle group 10/24 10/24

Run cycle group with calendar offset (+ 3 

days)

10/27/ (Saturday) 10/27/ (Saturday)

Run cycle group with free day rule 10/29/ (Monday) 10/29/ (Monday)

Run cycle group with offset +1 12:00 10/29/ (Monday) 10/30 12:00 (Tuesday)

Run cycle in the job stream with time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/02 (Friday)

133



Dynamic Workload Console User’s Guide

134

Table  12. Scenario 3. Time restriction in the run cycle group with offset (+1 12:00)

(continued)

Run cycle group Scheduled date Earliest Start

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/02 (Friday)

Run cycle in the job stream with earliest 

start +1 1pm

11/02 (Friday) 11/03 (Saturday) 1pm

Run cycle in the job stream without time 

restrictions

Run cycle in the job stream with + 4 working 

days shift

11/02 (Friday) 11/03 12:00 (Saturday)

Run cycle in the job stream with free day 

rule

11/02 (Friday) 11/03 12:00 (Saturday)

Availability of the GENDAYS command at run cycle group level

Using GENDAYS, you can check the result of the combination of all the run cycles in the group.

When you create a run cycle within a run cycle group, you must include it in a subset, identified by a subset ID.

Managing subsets of run cycles provides a lot of flexibility in job stream scheduling.

For example, you create run cycle group that contains three run cycles, two inclusive and one exclusive, in OR 

relationship:

RC1

Inclusive: run every Thursday of the month.

RC2

Inclusive: run every Friday of the month.

RC3

Exclusive: do not run the first week of each month.

In this case the result would be: the job stream runs every Thursday and Friday of the month except for those 

occurring in the first week of the month.

But if you want that the job stream also runs the first Thursday of the month, you could accomplish your goal by 

organizing your run cycles in subsets:

RC1

Inclusive: run every Thursday of the month.
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RCSubset

RC2

Inclusive: run every Friday of the month.

RC3

Exclusive: do not run the first week of each month.

In this way the result would be: the job stream runs every Thursday of the month and every Friday of the month, 

except for the first Friday.

From the Workload Designer, you can run the following actions on run cycle groups:

• Create

• Create like

• Delete

• Edit

• View

To open the Workload Designer, do the following:

1. Log in to the Dashboard Application Services Hub.

2. From the navigation toolbar, click  Administration  >Workload Definitions>Manage Workload Definitions

In the displayed window, you are required to select an engine to connect with.

3. Enter the name of an engine and click Go.

The Workload Designer  opens.

To create a run cycle group:

1. Click New  in the Working List pane of the Workload designer window.

2. Select Run Cycle group  in the resulting list of objects.

A Properties - Run Cycle group pane is opened on the bottom-right section of the window.

3. Enter the properties of the new run cycle group as requested. You can proceed to define the run cycles that are part 

of the group or leave this task for later.

4. To save your data, click the box next to the run cycle group name listed in the Working list pane and select the Save 

selected  icon in the menu bar.

To exit the Properties - Run Cycle group pane without saving your data, click the box next to the run cycle group name 

listed in the Working list pane and select the Delete selected  icon in the menu bar.

You can also create a run cycle group starting from an existing one. To do so, list the existing run cycle group and click the 

Create Like  icon.

135



Dynamic Workload Console User’s Guide

136

To run any of the other actions on already defined run cycle groups, you must first list the run cycle groups upon which you 

want to act. You can do this in one of the following ways:

• Click Search  in the Working List pane:

1. Select Run Cycle group  in the resulting list of objects.

The Search - Run Cycle group window is displayed.

2. Click Search  to display a list of all the run cycle groups defined on the engine. Before doing so, you can 

narrow your search by entering names or partial names in the text box.

The found run cycle group definitions are listed.

3. Select the run cycle groups you want to act upon and click Edit, View, or Delete.

If you clicked Edit  or View, the selected groups, inclusive of their run cycles, are listed in the Working List 

pane, with the properties of the top one displayed on the right pane.

If you clicked Delete, you are asked to confirm the deletion from a pop-up window.

• Click the Run Cycle group  icon in the Quick Open pane:

1. Click Search  to display a list of all the run cycle groups defined on the engine. Before doing so, you can 

narrow your search by entering names or partial names in the text box.

The found run cycle group definitions are listed in the Quick Open pane.

2. Select the run cycle groups you want to act upon and click Edit  or View. You cannot delete from this pane.

The selected groups, inclusive of their run cycles, are listed in the Working List pane, with the properties of the 

top one displayed on the right pane.

To add run cycles to the group you are creating you must first include them in a subset, to do it perform the following steps:

1. From the Details view, right-click the run cycle group in the Details view and select Add Subset.

2. Right-click the subset and select Add Run Cycle .

3. Specify the run cycle attributes in the Run Cycle properties pane displayed at the bottom.

You can toggle between the panels displaying the properties of the run cycle group and of the included run cycles by 

selecting the entries listed in the Type  column

To view, edit, or create another run cycle of a run cycle group, just click the corresponding icon in the Working List pane or in 

the Details pane.

When you create a group of run cycles, you can choose whether the run cycles must be in AND  or in OR  relationship. 

However, the result of the run cycles combined within the group must be a set of dates; the group cannot produce an 

exclusive result.
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Related information

Run cycle  on page 56

Run cycle group  on page 58

Run Cycle Preview  on page 264

Creating  Workload Broker  objects
Creating  Workload Broker  workstations and jobs.

About this task

You can manage  Workload Broker  jobs in a IBM®  Workload Scheduler  environment by creating special workstations and job 

definitions.

Using the Dynamic Workload Console  you can:

• Create the  Workload Broker  workstation in the IBM®  Workload Scheduler  database.

• Create  Workload Broker  job definitions that map  Workload Broker  jobs.

• Monitor  Workload Broker  workstations in the plan.

• Submit jobs to the  Workload Broker  workstation.

• Monitor  Workload Broker  jobs and browse the corresponding job logs.

For more information about  Workload Broker, see the documentation in the previous release at IBM Workload Automation 

9.4.0  and browse to the Scheduling Workload Dynamically  manual.

To create a  Workload Broker  workstation, perform the following steps:

a. Click Design > Workload Definitions > Create Workstations.

b. Select a distributed engine from the list and click Create Workstations.

c. In the Workstations Properties panel, specify the following fields. The values you specify here must match the 

values specified during the installation of the  Workload Broker  component. You can retrieve them from the 

BrokerWorkstation.properties  configuration file.

Name

It is the value specified in the TWS Agent name field.

Workstation type

Select Workload Broker  from the available workstation types.

Node Name

The host name of the computer where the IBM®  Workload Scheduler  master is installed.

TCP/IP port

The port number you specified when installing the IBM®  Workload Scheduler  master. It is the value 

specified in the TWS Agent Port  field.
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Leave all other fields with their default values.

d. Click Save  to add the workstation to the database.

You can create IBM®  Workload Scheduler  job definitions that map to  Workload Broker  jobs, and submit and monitor the job 

status. To create a new  Workload Broker  job definition, perform the following steps:

1. From the navigation toolbar, click Design  >Workload Definitions>Manage Workload Definitions

2. In the Workload Designer, from the Working List pane click Job Definition > Cloud >  Workload Broker  .

3. In the Workspace pane, specify the properties for the job using the General, Task, Affinity, and Recovery Options tabs.

4. Click Save  to add the  Workload Broker  job definition.

Related information

Workstation  on page 44

Workload Broker job definition  on page 80

Creating an event rule
How you can create an event rule.

About this task

The purpose of the following scenario is to show how to create a new event rule in the context of an example.

The scope of the following draft event rule is to monitor log files named "messages.log*" for error messages written to the 

log containing the text "ERROR: Authentication did not succeed for user ID dwcadmin. An invalid user ID or password was 

specified", every 60 seconds on a workstation named "MDM_production". When an event that corresponds to this rule occurs, 

a new incident is automatically opened in Service Now  containing a description of the error.

1. Create a new event rule and define general information about it:

a. Go to Create Event Rules  section and choose an engine.

b. In the Explore area, select Create new +.

c. In General Info, in Name  type: SERVICENOW

d. In General Info, set Save as draft:  on

2. Define the event to be triggered:

a. Select Add events

b. Select the Log message written  event from the File Monitor  category

c. In Event name  type: logMessWritEvt1

d. In File name  type: matches C:\Users\DWC\stdlist\appserver\dwcServer\logs\messages.log*

e. In Match expression  type: matches ERROR: Authentication did not succeed for user ID dwcadmin. An invalid 

user ID or password was specified

f. In Sample interval: equal to 60

g. In Workstation:  matches MDM_production

https://www.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/ServiceNow.html
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3. Define the action to be performed when the defined event occurs:

a. Select Add actions

b. Select the Open Incident  action from the ServiceNow  category

c. In Short Description  type: In the %{logMessWritEvt1.FileName} file, the following error has been found: 

%{logMessWritEvt1.MatchExpression}

d. Set Priority:  3

e. In Description  type: At %{logMessWritEvt1.TimeStamp} on the %{logMessWritEvt1.Hostname} 

workstation, the following error %{logMessWritEvt1.MatchExpression} has been found in the 

%{logMessWritEvt1.FileName} file

f. Type the ServiceNow URL:  https://mycompanySupport.mycompany.com

g. Enter the ServiceNow User:  TWS_user

h. In Assignment Group:  L3_Busines_Unit_Team

4. Select the event rule and click Save.

Results

You have now created a draft event rule that monitors the log file, and when a new error string is added, an event is triggered 

and an action automatically opens an incident in Service Now. The ticket contains the error message, the name of the log 

file in which the error is written, and the name of the workstation on which the log file is located. Furthermore, the ticket is 

assigned to the specified user of the specified group.

What to do next

To activate the rule, you need to deploy it in the scheduling environment by switching the draft toggle off, and save again.

Go to Manage Event Rule  to verify that the event rule is active.

Related information

Event management  on page 86

Event management configuration  on page 13

Event rule  on page 277

Editing event rules
Editing event rules in the IBM®  Workload Scheduler  database.

About this task

The purpose of the following scenario is to show how to edit an existing event rule in the context of an example.

To avoid the SAP system overload when operators work, you want to set a low SAP job limit during the day, and instead 

increase the SAP job limit during the night. Thus, you created an event rule named SAP_OPERATOR_MODE that increases the 

number of running SAP jobs.
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The number of SAP jobs increases when an SAP event, which ID is SAP_OPMODE_SWITCH and the parameter is equal to 

NIGHT, is raised. In the following scenario, the NIGHT parameter corresponds to 8pm.

After few months, the number of SAP jobs is increased, so you need to edit the event rule to make all jobs run. To achieve 

that, you need to anticipate the running time from NIGHT to AFTERNOON. In the following scenario, the AFTERNOON 

parameter corresponds to 6pm.

1. Select the engine where the event rule has been created.

2. Select the event rule named SAP_OPERATOR_MODE and select Edit.

3. The SAP_OPERATOR_MODE event rule with the following parameters opens:

Choose from:

◦ Selecting SAP_OPERATOR_MODE, you can see the following parameters in the General Info  panel:

Name:  SAP_OPERATOR_MODE

Save as draft:  off

Description:  Increase workstation limit

◦ Selecting the SAP Event Raised on XA Workstations event, you can see the following parameters in the 

Properties  panel:

Event name:  R3EventRaised1

Workstation matches:  S4HANA

SAP Event ID equal to:  SAP_OPMODE_SWITCH

SAP Event parameter equal to:  NIGHT

◦ Selecting the Submit job action, you can see the following parameters in the Properties  panel:

Job name:  Increase_limit_on_S4HANA_wks

Job workstation name:  fta_production

Description:  definition to increase the SAP job limit

4. Select the SAP Event Raised on XA Workstations event and change the SAP Event parameter from NIGHT to 

AFTERNOON.

5. Select the event rule checkbox and then select Save.

Results

You have correctly edited the event rule that increases the SAP job limit at 6pm instead of 8pm.

What to do next

Monitor your event rule definition. Go to Monitor Event Rules  to verify that the event rule runs correctly.
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Listing object definitions in the database

About this task

The following sections describe how you list the object definitions available in the database.

Listing workload objects

About this task

To list all the workload definitions except for event rules, open the Workload Designer  as follows:

1. From the navigation toolbar, click >Workload Definitions>Manage Workload Definitions.

2. In the displayed panel, specify the engine connection you want to use. Only the categories of objects supported by 

the engine you selected are available.

You can open multiple occurrences of the Workload Designer, but only the following scenarios are supported:

• Same user connected to multiple engines

• Multiple users connected to the same engine.

From the Workload Designer  you can use the Working List view to list objects:

Perform the following steps:

1. Specify the object name in Search  field and select the object you want to view or modify. A toolbar is displayed with 

the icons of the objects you can search for. You can also click on Advanced to specify advanced search criteria.

2. From the displayed list, select one or multiple objects and click one of the following action buttons:

 Create like

To create a new object with the same properties of the selected object.

 Edit

To modify the properties of the selected objects. When an object is open in edit mode the edit icon 

is displayed on the right of the object.

 Unlock

To unlock the selected objects for further actions. When an object is unlocked, it is displayed in read-

only mode.

 Delete

To delete the selected objects from the database.
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 Create New menu

To create a new object.

 Close selected

To close the currently open object.

All the selected objects are listed in the Working List view. When you select an object from this list, its properties are 

displayed in the right pane, where you can view or edit them, if you have the required authorization defined in the IBM® 

Workload Scheduler  security file.

By hovering with the cursor over the icons located on the toolbar, you can see all the actions you can perform on the selected 

objects.

Related information

Prompt  on page 66

File  on page 67

Resource  on page 67

Calendar  on page 56

User  on page 78

Workstation class  on page 78

Variable table  on page 79

Listing jobs and job streams

About this task

To view a list of jobs and job streams available in the database, perform the following steps:

1. In the navigation bar at the top of the page, click Administration  > Workload Design  > Manage Workload Definitions

2. In the displayed panel, specify your engine connection and the filtering criteria for your query. With distributed engine 

connections, from the Object type  drop-down menu, select the object you want to list.

3. In the Columns  section, select the column you want to display in the list of results.

4. Click Display  to launch the query.
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Related information

Job  on page 52

Job stream  on page 53

Listing event rules

About this task

To view a list of event rules available in the database, perform the following steps:

1. From the navigation toolbar, click Administration  > Workload Definitions  > Manage Event Rules. Or In the navigation 

bar, click Monitoring & Reporting  > Monitor Event Rules  > New.

2. In the Select Task Type section, select Event Monitoring Task  > List Event Rule Definitions  and click Next.

3. In the Enter Task Information panel, specify the task name and select the engine connection where you want to run 

the task. You can run this type of query only for IBM Workload Scheduler  and IBM®  Z®  Workload Scheduler  Actions. 

You can click Lookup  to select jobs, job streams, and workstations defined in the database on either the master 

domain manager or on a node installed as a backup master domain manager, but not necessarily belonging to the 

master domain.  You can also specify whether to share the task with others, to allow them to see and run the task, but 

not to modify it.

4. Click Next  to proceed with task creation or click Finish  to complete the creation using the default values and exit 

without proceeding to the following steps. If you are editing an existing task, properties are organized in tabs.

5. In the Filter Criteria panel, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. You can 

search for event rule definitions based on their status, validity intervals, or types of events and associated actions.

6. In the Columns Definition panel, select the information you want to display in the table containing the query results. 

According to the columns you choose here, the corresponding information is displayed in the task results table. For 

example, for each of the event rule definitions resulting from your query, you might want to see the status, type, or 

timeframe during which it is valid. You can then drill down into this information displayed in the table and navigate it. 

In the Columns Definition panel, not only can you select the columns for this task results, but you can also specify the 

columns for secondary  queries on event rule instances. The information to be retrieved with these secondary queries 

is specified in this panel.

7. In the All Configured Tasks panel, you can see the main details about the task that you have just created. You can 

also choose to run the task immediately. The task is now in the list of your tasks where you can open and modify it. 

You can find it in the task lists displayed by clicking the following options:  All Configured Tasks  or Administration  > 

Workload Definitions  > Manage Event Rules.

8. After running the task, a table is displayed showing a list of event rule definitions, on which you can take several 

actions, such as setting them as complete or as draft depending whether you want to make them available for 

deployment.
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Listing workstations

About this task

To view a list of workstations available in the database, perform the following steps:

1. From the portfolio, click Administration  > Workload Environment Design  > List Workstations.

2. In the displayed panel, specify your engine connection and the filtering criteria for your query.

3. In the Columns  section, select the column you want to display in the list of results.

4. Click Display  to launch the query.

Reusing a workload in another environment
During the design of your workload it is possible to utilize workloads that have been used in other environments. For 

example, when necessary it is possible to import a workload application  template in a different environment. Here you can 

find the instructions to create, export and import a workload application  template.

Creating a workload application  template
How to define a workload application  template using the Dynamic Workload Console.

Before you begin

To ensure the workload automation solution can be easily reproduced in another environment, there are some best practices 

to consider when creating the workload application  template:

Job definitions

Jobs that refer to elements that are dependent on the environment or topology in which they reside, such 

as web service jobs, file transfer jobs, and database jobs to name a few, should make use of variables when 

specifying these elements such as credentials, paths, and port numbers. Variables can be managed in the 

mapping file so that the correct values can be assigned to the variable.

Workstation names

When jobs and job streams are extracted from the workload application  during the export process, the 

names of the workstations are extracted as they are found in the source environment. Meaningful names or a 

standardized naming convention can simplify the mapping process.

Users

Users are also extracted as they are found in the source environment. If the same user is not present in both 

source and target environment, then variables should be used to specify the user.

Mapping file

The mapping file should be maintained after performing the import process. It can be useful in the case where 

you want to replace a workload application  or update it making the necessary changes to the mapping file.
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Job stream variable table

All of the variables used to generically represent objects in the workload application  should be added to a 

specific variable table related to the job stream in the workload application. This enables the customization of 

the job stream to reflect the target environment through the mapping file. Avoid associating the default variable 

table to a job stream. The default variable table is extracted like any other table and will need to be renamed, 

otherwise, the import process fails because a table with the same name already exists. The target environment 

already has a default variable table, MAIN_TABLE, defined.

Run cycle variable table

All of the variables used to generically represent objects in the workload application  should be added to a 

specific variable table related to the run cycle in the workload application. This enables the customization of 

the run cycle to reflect the target environment through the mapping file. Avoid associating the default variable 

table to a run cycle. The default variable table is extracted like any other table and will need to be renamed, 

otherwise, the import process fails because a table with the same name already exists. The target environment 

already has a default variable table, MAIN_TABLE, defined.

Folders

The folders imported from a workload application  template must be already mapped in the existing 

environment. Therefore before importing a workload application  template from another environment, the 

folders contained in the template must be created before the process of import.

Storing scheduling objects in folders is supported starting from version 9.5 and later. When importing a 

workload application  from a product version earlier than 9.5, all imported objects are stored in the root folder. 

Ensure you have write access to the root folder before starting the import.

About this task

From the Workload Designer, you can create the template of a workload that can then be imported and run in another 

environment. You can create a workload application  template containing one or more job streams with all the related jobs 

and internal or external dependencies (such as files, resources, prompts) so as to have a self-contained workflow. You can 

then export the workload application  template to deploy and run it in another environment. Select the objects you do not 

want to import. If you choose to skip an object, an object with the same name must be present in the target environment, 

otherwise an error message is returned.To create a workload application  template, perform the following procedure:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions

2. Specify the name of a distributed engine.

Result

The Workload Designer  opens.

3. From the Create New  pane, select  Workload Application Template.

The workload application  template is created in the Details view and its properties page is displayed.

4. In the properties pane, specify the attributes for the workload application  template that you are creating:

Name

Mandatory field that contains the name of the workload application  template. The maximum length is 

80 characters.
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Description

Optional descriptive text to help workload application  users understand the purpose and characteristics 

of the workload application. The maximum length is 120 characters.

Provider

Optional field that specifies the creator of the workload application  template. It can be useful to let 

workload application  users know who created and provided it. The maximum length is 120 characters.

5. From the Details view, right-click the workload application  template and click Add Job Stream  to add job streams to 

it.

6. From the lookup dialog, search for and select the job streams that you want to add.

Together with the job streams, the corresponding dependencies are automatically also added to the workload 

application  template.

7. Click Save  to save the workload application  template in the database.

8. Right-click the workload application  template and click Export  to produce a compressed file, named workload 

application  template name.zip, containing all the files and information required to allow the workload to run also in 

another environment.

Results

The compressed file contains:

workload application  template name_Definitions.UTF8.xml

XML file that contains the definitions of all the exported objects. These definitions will be deployed in the target 

environment to populate the target database with the same objects existing in the source environment. The 

objects in the definition file can remain as they are or you can choose to rename them. If an object does not 

have a definition in the definition file, for example, a workstation, then at import time, a corresponding object 

will not be created in the target environment. The expectation is that such object is already present in the target 

environment, therefore, for these types of objects, you must map them in the mapping file.

workload application  template name_Mapping.UTF8.properties

Mapping file that is used to replace the names of the objects in the source environment with the names that 

these objects have in the target environment. The objects that will be created in the target environment can be 

created with the same names as those in the source environment or you can specify a different name in this 

file.

When the import process is performed from the wappman  command line, you can optionally request that the 

mapping file is automatically modified according to rules defined using regular expressions and specified in 

one of the following ad-hoc files:

• workload application  template name_BasicRegExpMapping.UTF8.rules

• workload application  template name_AdvancedRegExpMapping.UTF8.rules

These files are produced by the export process and, if used, must be properly customized.
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workload application  template name_SourceEnv_reference.txt

Reference information containing the definitions of the workstations used in the workload application  template 

and other information that can be useful to correctly map the source environment into the target environment 

so as to allow the workload application  to run.

workload application  template name_BasicRegExpMapping.UTF8.rules

A file containing rules, defined using basic regular expressions, to modify the mapping file. Optionally 

customize the file according to the names that the objects will have in the target environment. The import 

process performed from the wappman  command line then applies the defined rules to modify the mapping file.

workload application  template name_AdvancedRegExpMapping.UTF8.rules

A file containing rules, defined using advanced regular expressions, to modify the mapping file. Optionally 

customize the file according to the names that the objects will have in the target environment. The import 

process performed from the wappman  command line then applies the defined rules to modify the mapping file.

You can import the compressed package from the Dynamic Workload Console  with an intuitive guided procedure, as 

described in the section about importing a workload application  template in the Dynamic Workload Console User's Guide.

You can also use the wappman  command line to manually import the compressed package into the target environment 

where the workload application  will be deployed, thus creating all the required objects in the target environment. In the target 

environment, the workload application  name_Mapping.UTF8.properties  file must be modified, manually or using regular 

expression mapping files, by specifying the names of the objects as they are defined in the target environment (for example, 

the names of the workstations on which the job streams run). For more details, see User's Guide and Referencesections 

about workload applications  and the wappman  command.

Exporting a job stream definition as a workload application template

Before you begin

To perform this task, ensure the IBM Workload Scheduler  engine connection is up and running.

About this task

To export a job stream definition as a workload application template, run the following procedure from the Workload 

Designer :

1. Open the job stream whose definition that you want to export. To find the job stream, do either of the following 

actions:

Choose from:

◦ Search for it using the Search  menu in the Working List

◦ Select the job stream icon  and launch a search.

2. You can now export the job stream by using either the Details  or the Graphical  view. Select the tab for the view you 

want.

Choose from:
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◦ From the Details  view or the Graphical  view, by using the menus, do the following:

a. Right-click the job stream and select the Download Job Stream Definition  option from the context 

menu or select the job stream and choose the same option from the Select an Action  menu.

b. A system panel is displayed for you to specify the download location.

Results

The job stream definition is exported as a workload application template, in a compressed file. The compressed file is 

named, by default, job_stream_name.zip. You can now import the job stream definition in a different environment.

Importing a workload application  template
How to import a workload application  template using the Dynamic Workload Console.

Before you begin

Ensure you have created a workload application  template as described in Creating a workload application template  on 

page 144.

About this task

You can import a workload application  template that represents an efficient workload process or a standardized solution into 

a target environment to replicate all of the required objects to run the workload in the new environment.

You can also decide whether or not to maintain a tie to the workload application  which binds the objects to the workload 

application, or to import the objects eliminating any ties to the workload application. Eliminating ties to the workload 

application  allows you to manage objects with more flexibility.

Note:  Before you import a workload application  containing folders into an environment with a product version earlier 

than 9.5, ensure you remove every occurrence of the  FOLDER_/=/  string from the xml file.

To import a workload application  template, perform the following procedure:

1. From the navigation toolbar, click  Administration  > Workload Definitions  > Import Workload Application

2. Specify the name of a distributed engine

3. Browse to the workload application  template.

4. Click Upload.

If the administrator has enabled the justification option in the Auditing Preferences  page to maintain an audit trail, a 

panel is displayed requesting information about the changes you are about to perform.

5. In the section Import Options, select Import only the contents of the workload application template, if you want to 

import only the objects contained in the template, without any ties to the workload application. This allows you to 

work freely with the objects contained in the template. (This import is supported only when connected to an engine 

with version 9.4.0.4 or later)

6. You now need to edit the names of the objects as they are defined in the target environment (for example, the names 

of the workstations on which the job streams run). In the left column, under the Original Workload  heading, you can 
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find the original objects, such as workstations, jobs, and job streams. In the fields in the right column, you can enter 

the names to be assigned to the objects in the target environment.

7. Click Import.

Results

The workload application  template is now imported and ready for use in your target environment.

Import Cron and Windows™  Task Scheduler
How to import a Cron or Windows™  Task Scheduler job by using the Dynamic Workload Console.

Before you begin

You can use this procedure to import Cron or Windows™  Task Scheduler jobs into an IBM Workload Scheduler  distributed 

environment that has a dynamic agent, by using the Dynamic Workload Console. Before starting to import, ensure that 

you have generated your Cron or Windows™  Task Scheduler files. Run the command crontab -l, on the machine where you 

created your Cron definitions, to display and save them in a file. Export your Windows™  Task Scheduler definitions from 

the Windows™  Task Scheduler panel and save it as an xml file. Use a zip file to import more than one xml file. You can now 

import your Cron or Windows Task Scheduler files into IBM Workload Scheduler.

About this task

Import a Cron or Windows™  Task Scheduler job to take advantage of the powerful scheduling capabilities of IBM Workload 

Scheduler. You can use the Dynamic Workload Console  to read crontab files or Windows™  Task Scheduler jobs and convert 

them into IBM Workload Scheduler  objects. The jobs are added to your workload with the same specifications as the original 

jobs. The job streams reflect the time definition of the cron or Windows™  Task Scheduler commands. You can then modify, 

schedule, and monitor them together with all your other objects.

To manage your Cron or Windows™  Task Scheduler jobs in your IBM Workload Scheduler  environment, complete the 

following steps:

1. From the navigation toolbar, click  Design  >Import Definitions

2. Select the engine on which you want the job to run.

3. Browse for and select your Cron or Windows™  Task Scheduler file and click Upload.

4. IBM Workload Scheduler  identifies the file type and the wizard changes accordingly:

Cron files

Select the user to run the command specified in the cron file. You can choose between:

Defined in the file

The user that runs the command is defined in the cron file, before the command definition 

in the rule. This is the default value.

User name

Select to specify the user that runs the command.
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One job is created for each command in the file. Each job is scheduled to run independently of the other 

jobs, as defined in the cron file. A default editable name is given to the job stream and job that will be 

created.

Windows™  Task Scheduler files

Specify the agent where you want the process to run. A single job stream is created for all commands in 

the xml file, which are inserted in the job stream as jobs. To import multiple Windows™  Task Scheduler 

files, compress them in a zip file and import it.

Previously exported IBM Workload Scheduler  job stream

Specify the agent where you want the process to run.

5. Optionally, specify the prefix to apply to the imported object.

6. Optionally, check the box to not import a specific definition.

7. Click Import. Your scheduler files are now imported and available for use in the Dynamic Workload Console.

Results

Click Open job streams  to open the job stream in the Workload Designer. You can now manage, schedule, and monitor your 

Cron or Windows™  Task Scheduler job like any other job in the Dynamic Workload Console.

The following example shows a  Windows™  Task Scheduler input definition file:

˂?xml version="1.0" encoding="UTF-16"?>
˂Task  version="1.2" xmlns="http://schemas.microsoft.com/windows/2004/02/mit/task">
  ˂RegistrationInfo>
    ˂Date>2016-12-27T16:09:03.2293491˂/Date>
    ˂Author>NX051050\Administrator˂/Author>
  ˂/RegistrationInfo>
  ˂Triggers>
    ˂TimeTrigger>
      ˂StartBoundary>2016-12-27T16:08:33.47795˂/StartBoundary>
      ˂Enabled>true˂/Enabled>
    ˂/TimeTrigger>
  ˂/Triggers>
  ˂Principals>
    ˂Principal  id="Author">
      ˂UserId>NC051050\Administrator˂/UserId>
      ˂LogonType>InteractiveToken˂/LogonType>
      ˂RunLevel>LeastPrivilege˂/RunLevel>
    ˂/Principal>
  ˂/Principals>
  ˂Settings>
    ˂MultipleInstancesPolicy>IgnoreNew˂/MultipleInstancesPolicy>
    ˂DisallowStartIfOnBatteries>true˂/DisallowStartIfOnBatteries>
    ˂StopIfGoingOnBatteries>true˂/StopIfGoingOnBatteries>
    ˂AllowHardTerminate>true˂/AllowHardTerminate>
    ˂StartWhenAvailable>false˂/StartWhenAvailable>
    ˂RunOnlyIfNetworkAvailable>false˂/RunOnlyIfNetworkAvailable>
    ˂IdleSettings>
      ˂StopOnIdleEnd>true˂/StopOnIdleEnd>
      ˂RestartOnIdle>false˂/RestartOnIdle>
    ˂/IdleSettings>
    ˂AllowStartOnDemand>true˂/AllowStartOnDemand>
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    ˂Enabled>true˂/Enabled>
    ˂Hidden>false˂/Hidden>
    ˂RunOnlyIfIdle>false˂/RunOnlyIfIdle>
    ˂WakeToRun>false˂/WakeToRun>
    ˂ExecutionTimeLimit>P3D˂/ExecutionTimeLimit>
    ˂Priority>7˂/Priority>
  ˂/Settings>
  ˂Actions  Context="Author">
    ˂Exec>
      ˂Command>C:\Users\Administrator\Desktop\wts.bat˂/Command>
    ˂/Exec>
  ˂/Actions>
˂/Task>

The following example shows a Cron input definition file:

*/10 13 26 10 * echo hello world

Limitations

About this task

There are some limitations that do not permit the import of a Cron or Windows™  Task Scheduler job:

Cron

• You can use commas only for the second, third, and fifth fields, indicating the hour and the day of the 

month, respectively. In all other fields, you must use the dash (-) to indicate a range. For example, a 

range from one to five must be specified as follows: 1-5. Consider the following example, in which you 

specify that the job must run on the 30th day of each month once a minute, from 12;30 AM to 12;35 AM 

and from 12;30 PM to 12;35 PM:

30-35 0,12 30 * *

• The range-type syntax is not supported in the month field (penultimate) of the rule.

• In the last field of the rule, you can use a value between zero  or seven  and six  only if in both the third and 

fourth field the value provided is *. In all other cases, the value of the last field must be *. The zero  and 

seven  values both indicate Sunday  and can be used interchangeably.

Windows™  Task Scheduler

• Operating-system dependent options are not supported.

• Triggers are supported only if based on a schedule. The related advanced settings are not supported.

• Only the Start a program  action is supported.

• Conditions are not supported.

• Hidden rules are not supported.

• Rules configured for specific operating systems are not supported.

• Choosing the user account with which you run the task is supported.
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• Specifying how often the task should run is not supported.

• Settings are supported only for the rule applied if the task already running. The option "Stop the existing 

instance" is not supported.



Chapter 8. Managing Workload Security
Managing security settings in your environment by using Dynamic Workload Console.

creatingobjects in the database editingobjects in the database If you work with the role-based security model, you can manage security settings in your environment by using Dynamic 

Workload Console.

From the navigation toolbar click Administration  > Security  > Manage Workload Security. Here you can create and manage 

security objects in the database, according to a role-based security model.

You can work with the following security objects:

Security roles

Each role represents a certain level of authorization that defines the set of actions that users or groups can 

perform on a set of object types.

Security domains

Each domain represents the set of scheduling objects that users or groups can manage.

Access control lists

Each access control list assigns security roles to users or groups, in a certain security domainor folder.

Folders

Each folder  has its own level of authorisation that defines the set of actions that users or groups can perform 

on each folder.

If you want to specify different security attributes for some or all of your users, you can create additional security domains 

based on specific matching criteria. For example, you can define a domain that contains all objects named with a prefix 'AA' 

and specify the actions that each role can do on that domain. You can then associate the roles to users or group by defining 

an access control list.

To create or modify security objects with Dynamic Workload Console, you must have permission for the modify  action on the 

object type file  with attribute name=security.

When working with the role-based security from Dynamic Workload Console, be aware that access to security objects is 

controlled by an "optimistic locking" policy. When a security object is accessed by user "A", it is not actually locked. The 

security object is locked only when the object update is saved by user "A", and then it is unlocked immediately afterwards. If 

in the meantime, the object is accessed also by user "B", he receives a warning message saying that the object has just been 

updated by user "A", and asking him if he wants to override the changes made by user "A", or refresh the object and make his 

changes to the updated object.

For more information about enabling a role-based security model for your installation, see the section about getting started 

with security in Administration Guide.

Managing access control list
About this task
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Create an access control list by assigning security roles to users or groups, in a certain security domain or in one or more 

folders.

You can:

• Give access to user or group.

• View access for user or group.

• View access for Security Domain or folders.

• Manage accesses.

Give access to user or group

About this task

To give access to users or groups complete the following procedure:

1. From the navigation toolbar, click  Administration.

2. In the Workload Environment Design, select Manage Workload Security.

Result

The Manage Workload Security panel opens.

3. From the drop-down list, select the IBM Workload Scheduler  engine on which you want to manage security settings.

4. In the Access Control List section, click Give access to user or group.

Result

The Create Access Control List panel opens.

5. Enter the user name or the group name, the assigned roles, and the security domain  or enter the folders  assigned. For 

each Access Control List you can associate one or more folders.

6. Click Save  to save the access definition in the database.

7. Click Save and Create New  to save the access definition in the database and proceed to create a new access 

definition.

8. Click Save and Exit  to save the access definition in the database and return to the Manage Workload Security panel.

Results

The access definition has now been added to the database. If the optman enRoleBasedSecurityFileCreation  global option is 

set to yes, the access definition is activated in your security file.

View access for user or group

About this task

From Manage Workload Security, you can also view the access for users or groups.

1. In the Access Control List section of the Manage Workload Security panel, click View access for user or group.

Result

The input field for the user or group name is displayed.
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2. Enter the user or group name and click View.

Result

The user or group access, with the assigned roles, to the related security domains is displayed.

View access for Security Domain

About this task

From Manage Workload Security, you can also view the access to a certain security domain.

1. In the Access Control section of the Manage Workload Security panel, click View access for Security Domain.

Result

The input field for the security domain name is displayed.

2. Enter the security domain name and click View.

Result

The list of users or groups, with the assigned roles, that have access to the specified security domain is displayed.

Manage accesses

About this task

From Manage Workload Security, you can also remove  and edit  existing access control lists.

1. In the Access Control List section of the Manage Workload Security panel, click Manage Accesses.

Result

The list of users or groups, with the assigned roles, that have access to the different security domains is displayed.

2. Select the access control list that you want to manage.

3. Select the action that you want to run on the selected access control list.

If you select the edit  action, you can change only the roles associated with the access control list. You cannot change 

the associated domain. If you want to change the domain, you must remove  the access control list and redefine the 

access control list with a new domain.

Managing security domains
About this task

A security domain represents the set of objects that users or groups can manage. For example, you can define a domain that 

contains all objects named with a prefix 'AA'. If you want to specify different security attributes for some or all of your users, 

you can create additional security domains based on specific matching criteria.

You can filter objects by specifying one or more attributes for each security object type. You can include or exclude each 

attribute from the selection. For example, you can restrict access to a set of objects having the same name or being defined 

on the same workstation, or both.

For the attributes that you can specify for each security object type, see Attributes for object types  on page  .
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For the values that you can specify for each object attribute, see Specifying object attribute values  on page  .

You can create new security domains or manage existing security domains.

Create new security domain

About this task

To create a new security domain from the Dynamic Workload Console, complete the following procedure:

1. From the navigation toolbar, click  Administration.

2. In the Security, select Manage Workload Security .

Result

The Manage Workload Security panel opens.

3. From the drop-down list, select the IBM Workload Scheduler  engine on which you want to manage security settings.

4. In the Security Domains section, click Create new Security Domain.

Result

The security domain creation panel opens.

5. Enter the name of the security domain that you are creating and, optionally, the domain description.

6. Select the type of security domain that you want to define:

Simple

To define a filtering rule that applies to all object types. Events and actions are excluded from this 

filtering rule.

Complex

To define different filtering rules for different object types.

7. Use object filtering to select the set of security objects that users or groups can manage in the security domains that 

you are defining. You can use the wildcard character (*) when defining object attributes.

8. Click View  to see the mapping between the set of security objects that you are assigning to the domain and the 

corresponding set of security objects in the classic security model.

9. Click Save  to save the security domain definition in the database.

10. Click Save and Exit  to save the security domain definition in the database and then exit.

Results

The security domain has now been added to the database. If the optmanenRoleBasedSecurityFileCreation  global option is 

set to yes, the security domain is activated in your security file.

Manage security domain

About this task

From Manage Workload Security, you can also remove, edit, and duplicate  existing security domains.
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1. In the Security Domains section of the Manage Workload Security panel, click Manage Security Domain.

Result

The list of the available security domains is displayed.

2. Select the security domains that you want to manage.

3. Select the action that you want to run on the selected security domains.

Managing security roles
About this task

A security role represents a certain level of authorization and includes the set of actions that users or groups can perform on 

a set of object types.

For the list of actions that users or groups can perform on the different objects, for each IBM Workload Scheduler  task, see 

Actions on security objects  on page 160.

A set of predefined security roles is available in the master domain manager  database after the product has been installed:

• A full access definition for the user who installed the product, TWS_user with the default security role assigned 

named FULLCONTROL.

• An access definition for the system administrator, root on UNIX or Administrator on Windows.

You can create new security roles or manage existing security roles.

Create new role

About this task

To create a new security role from the Dynamic Workload Console, complete the following procedure:

1. From the navigation toolbar, click  Administration.

2. In the Security  select Manage Workload Security.

Result

The Manage Workload Security panel opens.

3. From the drop-down list, select the IBM Workload Scheduler  engine on which you want to manage security settings.

4. In the Roles section, click Create new role.

Result

The Create Role panel opens.

5. Enter the name of the security role that you are creating and, optionally, the role description.

6. For each of the IBM Workload Scheduler  tasks, assign the level of access for performing certain actions on specific 

object types to the security role. You can assign a predefined or a custom level of access.

7. Click Show Details  to see the permissions associated to a predefined level of access, or to define your custom level 

of access. Tooltips are available to explain what a certain permission means for a particular object type.
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8. Click View  to see the mapping between the set of permissions that you are assigning and the corresponding set of 

permissions in the classic security model.

9. Click Save  to save the security role definition in the database.

10. Click Save and Exit  to save the security role definition in the database and return to the Manage Workload Security 

panel.

Results

The security role has now been added to the database. If the optman enRoleBasedSecurityFileCreation  global option is set to 

yes, the security role is activated in your security file.

Manage roles

About this task

From Manage Workload Security, you can also remove, edit, and duplicate  existing roles.

1. In the Roles section of the Manage Workload Security panel, click Manage roles.

Result

The list of the available security roles is displayed.

2. Select the security roles that you want to manage.

3. Select the action that you want to run on the selected roles.

Managing folders

About this task

Folders  help you to organize jobs and job streams into different categories. You can create folders  with different levels of 

authorization that define the set of actions that users or groups can perform on each folder. More than one folder  can be 

associated to the same Access Control List, and the level of security is also applied to the sub-folders.

You can also grant a user administrator privileges on a folder  and its sub-folders so that this user can then create access 

control lists, with a dedicated role to manage the objects contained in the folder. See Granting administrator permissions to a 

user on a folder  on page 159.

Creating, renaming, or deleting a folder

About this task

To create, rename, or delete a folder:

1. From the navigation toolbar, click  Administration.

2. In the Security, select Manage Workload Security.

3. From the drop-down list, select the IBM Workload Scheduler  engine on which you want to manage security settings.

Result

The Manage Workload Security panel opens.
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4. In the folders  section, click Manage Folder.

Result

The Manage Folders  panel opens. From this panel you can:

◦ Use the search box to search folders and job streams in the current view.

◦ Create a folder  or subfolder, rename or delete a folder.

Granting administrator permissions to a user on a folder

About this task

The IBM Workload Scheduler  administrator can grant administrator permissions to a user on a folder  so that the user can 

freely define access control lists for other users on the same folder  or any sub-folders. Users can then access the objects in 

the folder  or sub-folders in accordance with the access permissions they have on the objects.

Tip:  Users with the FULLCONTROL security role assigned automatically have administrator rights on folders.

The following scenario demonstrates how Tim, the IBM Workload Scheduler  administrator, grants Linda, the application 

administrator (app1_admin  user), permissions on the folder  named /PRD/APP1/, and how Linda grants access to Alex, the 

application user, to work with the objects defined in /PRD/APP1/FINANCE:

1. Tim, the IBM Workload Scheduler  administrator, grants Linda, the app1_admin  user, administrator permissions on the 

folder, /PRD/APP1/, through the definition of an access control list and by modifying her currently assigned role, 

APPADMIN. Optionally, Tim can create a new role with the appropriate permissions to achieve the same result.

a. From the Manage Workload Security  page, Tim selects Manage roles.

b. He then selects her current role from the list, APPADMIN  and clicks Edit.

c. He gives this role administrator permissions on folders  by selecting Delegate folder permission (folder - acl) 

in the Administrative Tasks  section and clicks Save and Exit.

d. Tim then creates an access control list for Linda, the app1_admin  user. From the Manage Workload Security 

page, Tim selects Give access to users or groups.

e. From the Create Access Control  List page, Tim selects User name  from the drop-down and enters Linda's 

user name, app1_admin  in the text box.

f. In the Role  text box, Tim enters the APPADMIN  role he modified earlier.

g. In the text box next to the Folder  selection, Tim enters the folder path of the folders on which he wants to 

grant Linda permissions, /PRD/APP1/.

Result

Linda, the app1_admin  user, with the APPADMIN  role assigned, can now access the entire /PRD/APP1/  hierarchy, can create 

new folders  in this path, and can assign access to these folders  to other users.

2. Linda needs to give application users such as Alex, access to the objects in the /PRD/APP1/FINANCE  folder. She creates 

a new access control list on the folder  for the application user and assigns a role to this user.

a. From the Manage Workload Security  page, Linda selects Give access to users or groups  from the Access 

Control List  section.

b. On the Create Access Control List  page, Linda selects User name  from the drop-down and enters the user 

name for Alex, the application user, app1_user.
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c. Since Linda cannot create new roles, she specifies an existing role in the Role text box. Only Tim, the IBM 

Workload Scheduler  administrator, can create new roles.

d. In the text box next to the Folder  selection, Linda enters the folder  path to the new sub-folder she created and 

to which Alex requires access: /PRD/APP1/FINANCE.

Result

Alex now can access the /PRD/APP1/FINANCE  folder. He does not have access permissions on the /PRD/APP1  folder.

Actions on security objects
The following tables show the actions that users or groups can perform on the different object types, for each IBM Workload 

Scheduler  task. See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based 

security with composer  command line interface.

Table  13. Actions that users or groups can perform when designing and monitoring the workload

Design and Monitor Workload

Actions that users or groups can perform Security object types

List (list)

Display (display)

Create (add)

Delete (delete)

Modify (modify)

Use (use)

Unlock (unlock)

Actions on remote workstations while modeling jobs (cpu-run)

Note:  See in parenthesis the corresponding actions  and objects 

values that you must use when defining role-based security with 

the composer  command-line interface.

Jobs (job)

Job Streams (schedule)

User Objects (userobj)

Prompts (prompt)

Resources (resource)

Calendars (calendar)

Run Cycle Groups (runcygrp)

Variable Tables (vartable)

Workload Application (wkldappl)

Workflow Folders (folder)

Parameters (parameter)

Table  14. Actions that users or groups can perform when modifying current plan

Modify current plan

Actions that users or groups can perform on the current plan

Add job stream dependency (schedule - adddep)
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Table  14. Actions that users or groups can perform when modifying current plan

(continued)

Modify current plan

Actions that users or groups can perform on the current plan

Add job dependency (job - adddep)

Remove job dependency (job - deldep)

Remove job stream dependency (schedule - deldep)

Change job priority (job - altpri)

Change job stream priority (schedule - altpri)

Cancel job (job - cancel)

Cancel job stream (schedule - cancel)

Rerun job (job - rerun)

Confirm job (job - confirm)

Release job (job - release)

Release job stream (schedule - release)

Kill jobs (job - kill)

Reply to prompts (prompt - reply)

Reply to job prompts (job - reply)

Reply to job stream prompts (schedule - reply)

Alter user password (userobj - altpass)

Change jobs limit (schedule - limit)

Actions on job remote system (job - run)

Change resource quantity (resource - resource)
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Table  14. Actions that users or groups can perform when modifying current plan

(continued)

Modify current plan

Actions that users or groups can perform on the current plan

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Table  15. Actions that users or groups can perform when submitting workload

Submit Workload

Workload definitions that can be added to the current plan

Only existing job definitions (job - submitdb)

Existing jobs definitions and ad hoc jobs (job - submit)

Existing job stream definitions (schedule - submit)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Table  16. Actions that users or groups can perform when managing the workload environment

Manage Workload Environment

Actions that users or groups can perform on workstations, domains, and workstation classes

List workstations (cpu - list)

Display workstation details (cpu - display)

Create workstations (cpu - add)

Delete workstations (cpu - delete)

Modify workstations (cpu - modify)

Use workstations (cpu - use)

Unlock workstations (cpu - unlock)

Start a workstation (cpu - start)

Stop a workstation (cpu - stop)

Change limit (cpu - limit)
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Table  16. Actions that users or groups can perform when managing the workload environment

(continued)

Manage Workload Environment

Actions that users or groups can perform on workstations, domains, and workstation classes

Change fence (cpu - fence)

Shutdown (cpu - shutdown)

Reset FTA (cpu - resetfta)

Link (cpu - link)

Unlink (cpu - unlink)

Use 'console' command from conman (cpu - console)

Upgrade workstation (cpu - manage)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Table  17. Actions that users or groups can perform when managing event rules

Manage Event Rules

Actions that users or groups can perform on event rules

List event rules (eventrule - list)

Display event rules details (eventrule - display)

Create event rules (eventrule - add)

Delete event rules (eventrule - delete)

Modify event rules (eventrule - modify)

Use event rules (eventrule - use)

Unlock event rules (eventrule - unlock)

Display actions in the event rules (action - display)

Monitor triggered actions (action - list)

Use action types in the event rules (action - use)

Submit action (action - submit)

Use events in the event rules (event - use)
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Table  17. Actions that users or groups can perform when managing event rules

(continued)

Manage Event Rules

Actions that users or groups can perform on event rules

Use a File Monitor event on the workstation where the file resides. (event - display)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Table  18. Administrative tasks that users or groups can perform

Administrative Tasks

Administrative tasks that users or groups can perform

View configuration ( dump security and global options) (file - display)

Change configuration (makesec, optman add) (file - modify)

Delete objects definitions (file - delete)

Unlock objects definitions (file - unlock)

Allow planman deploy, prodsked and stageman (file - build)

Delegate security on folders  (folder  - acl)

Note:  See in parenthesis the corresponding action  and object  values that you must use when defining role-based security with the composer 

command-line interface.

Table  19. Actions that users or groups can perform on workload reports

Workload Reports

Actions that users or groups can perform on workload reports

Generate workload reports 

(display report)

Reports in Dynamic Workload Console

RUNHIST

Job Run History

RUNSTATS

Job Run Statistics

WWS

Workstation Workload Summary
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Table  19. Actions that users or groups can perform on workload reports

(continued)

Workload Reports

Actions that users or groups can perform on workload reports

WWR

Workstation Workload Runtimes

SQL

Custom SQL

ACTPROD

Actual production details (for current and archived plans)

PLAPROD

Planned production details (for trial and forecast plans)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Table  20. Actions that users or groups can perform on Application Lab

Application Lab

Actions that users or groups can perform on Application Lab

Access Application Lab  (use lob)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with composer 

command line interface.

Table  21. Actions that users or groups can perform on folders.

Folders

Actions that users or groups can perform on folders

Access folders

chfolder (display)

listfolder (list or list and display)

mkfolder (modify)
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Table  21. Actions that users or groups can perform on folders.

(continued)

Folders

Actions that users or groups can perform on folders

rmfolder (delete)

renamefolder (add)

Note:  See in parenthesis the corresponding actions  and objects  values that you must use when defining role-based security with the composer 

command line interface.

Attributes for security object types
Table 22: Attributes for security object types  on page 166 shows the attributes that you can specify for each security 

object type (see in parenthesis the corresponding object type and object attribute that you must use when defining security 

objects with the composer  command line interface).

Table  22. Attributes for security object types

Attribute

Security object type

Name (name) Workstation 

(cpu)

Custom 

(custom)

JCL (jcl) JCLtype 

(jcltype)

Logon 

(logon)

Provider 

(provider)

Type 

(type)

Host 

(host)

Port 

(port)

Folder 

(folder)

CPU Fol

der (cpuf

older)

Actions (action) ✓ ✓ ✓ ✓

Calendars (calendar) ✓ ✓

Workstations (cpu) ✓ ✓ ✓

Events (event) ✓ ✓ ✓

Event rules (eventrule) ✓ ✓

Files (file) ✓

Jobs (job) ✓ ✓ ✓ ✓ ✓ ✓ ✓

Application Lab  (lob) ✓

Parameters 

(parameter)

✓ ✓ ✓ ✓

Prompts (prompt) ✓ ✓

Reports (report) ✓

Resource (resource) ✓ ✓ ✓

RunCycle groups 

(runcygrp)

✓ ✓
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Table  22. Attributes for security object types  (continued)

Attribute

Security object type

Name (name) Workstation 

(cpu)

Custom 

(custom)

JCL (jcl) JCLtype 

(jcltype)

Logon 

(logon)

Provider 

(provider)

Type 

(type)

Host 

(host)

Port 

(port)

Folder 

(folder)

CPU Fol

der (cpuf

older)

Job streams 

(schedule)

✓ ✓ ✓ ✓

User objects (userobj) ✓ ✓ ✓

Variable tables 

(vartable)

✓ ✓

Workload applications 

(wkldappl)

✓ ✓

Folders (folder) ✓

For the values that are allowed for each object attribute, see Specifying object attribute values  on page 167.

Specifying object attribute values
The following values are allowed for each object attribute (see in parenthesis the corresponding object type and object 

attribute for the composer  command line interface):

Name (name)

Specifies one or more names for the object type.

• For the Files (file)  object type, the following values apply:

globalopts

Allows the user to set global options with the optman  command. The following access 

types are allowed:

◦ Display access for optman ls  and optman show

◦ Modify access for optman chg

prodsked

Allows the user to create, extend, or reset the production plan.

security

Allows the user to manage the security file.

Symphony

Allows the user to run stageman  and JnextPlan.

trialsked

Allows the user to create trial and forecast plans or to extend trial plans.
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Note:  Users who have restricted access to files should be given at least the following privilege 

to be able to display other object types that is, Calendars (calendar) and Workstations (cpu):

file  name=globalopts  action=display

• For the Variable Tables (vartable)  object type, you can use the $DEFAULT value for the Name (name) 

attribute to indicate the default variable table. This selects the table that is defined with the isdefault 

attribute.

Workstation (cpu)

Specifies one or more workstation, domain, or workstation class name. Workstations and workstation classes 

can optionally be defined in a folder. If this attribute is not specified, all defined workstations and domains can 

be accessed. Workstation variables can be used:

$MASTER

The IBM Workload Scheduler  master domain manager.

$AGENTS

Any fault-tolerant agent.

$REMOTES

Any standard agent.

$THISCPU

The workstation on which the user is running the IBM Workload Scheduler  command or program.

If you use the composer  command line to define security domains, the following syntax applies:

 

cpu=[folder/]workstation[,[folder/]workstation]...

folder=foldername

Scheduling objects such as, jobs, job streams, and workstations, to name a few, can be defined in a folder. A 

folder  can contain one or more scheduling objects, while each object can be associated to only one folder. The 

default folder is the root folder (/).

cpufolder=foldername

The folder  within which the workstation or workstation class is defined.

Custom (custom)

Use this attribute to assign access rights to events defined in event plug-ins. The precise syntax of the value 

depends on the plug-in. For example:
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• Specify different rights for different users based on SAP R/3 event names when defining event rules for 

SAP R/3 events.

• Define your own security attribute for your custom-made event providers.

• Specify the type of event that is to be monitored. Every event can refer to an event provider.

If you use composer  command line to define security domains, the following syntax applies:

custom=value[,value]...

JCL (jcl)

Specifies the command or the path name of a job object's executable file. If omitted, all defined job files and 

commands qualify.

You can also specify a string that is contained in the task string of a JSDL definition to be used for pattern 

matching.

If you use composer  command line to define security domains, the following syntax applies:

jcl="path" | "command" | "jsdl"

JCL Type (jcltype)

Specifies that the user is allowed to act on the definitions of jobs that run only scripts (if set to scriptname) 

or commands (if set to docommand). Use this optional attribute to restrict user authorization to actions on 

the definitions of jobs of one type only. Actions are granted for both scripts and commands when JCL Type 

(jcltype)  is missing.

A user who is not granted authorization to work on job definitions that run either a command or a script is 

returned a security error message when attempting to run an action on them.

If you use composer  command line to define security domains, the following syntax applies:

jcltype=[scriptname | docommand]

Logon (logon)

Specifies the user IDs. If omitted, all user IDs qualify.

You can use the following values for the Logon (logon)  attribute to indicate default logon:

$USER

Streamlogon is the conman/composer user.

$OWNER

Streamlogon is the job creator.

$JCLOWNER

Streamlogon is the OS owner of the file.

$JCLGROUP

Streamlogon is the OS group of the file.
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If you use composer  command line to define security domains, the following syntax applies:

logon=username[,username]...

Provider (provider)

For Actions (action)  object types, specifies the name of the action provider.

For Events (event)  object types, specifies the name of the event provider.

If Provider (provider)  is not specified, no defined objects can be accessed.

If you use composer  command line to define security domains, the following syntax applies:

provider=provider_name[,provider_name]...

Type (type)

For Actions (action)  object types, is the actionType.

For Events (event)  object types, is the eventType.

For Workstations (cpu)  object types, the permitted values are those used in composer  or the Dynamic 

Workload Console  when defining workstations, such as manager, broker, fta, agent, s-agent, x-agent, rem-eng, 

pool, d-pool, cpuclass, and domain.

Note:  The value master, used in conman  is mapped against the manager  security attributes.

If Type (type)  is not specified, all defined objects are accessed for the specified providers (this is always the 

case after installation or upgrade, as the type attribute is not supplied by default).

If you use composer  command line to define security domains, the following syntax applies:

type=type[,type]...

Host (host)

For Actions (action)  object types, specifies the TEC or SNMP host name (used for some types of actions, such 

as sending TEC events, or sending SNMP). If it does not apply, this field must be empty.

If you use composer  command line to define security domains, the following syntax applies:

host=host_name

Port (port)

For Actions (action)  object types, specifies the TEC or SNMP port number (used for some types of actions, 

such as sending TEC events, or sending SNMP). If it does not apply, this field must be empty.

If you use composer  command line to define security domains, the following syntax applies:

port=port_number
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How you change the user password in the plan.

About this task

A User is the user name used as the login value for several operating system job definitions. Users are defined in the 

database and are associated to a password.

Users need to access the workstation where IBM Workload Scheduler  launches jobs. If you need to change the user 

password after having already generated the plan, you can change the password in the plan. However, the changed password 

is only relevant to the current plan; Jnextplan restores the user password the next time it is run.

To change a user password in the plan, perform the following steps:

1. From the navigation toolbar, click Administration  > Security  > Alter User Password in Plan.

2. Select the engine.

3. Enter the following information in the Alter User Password in Plan  panel:

Workstation

The name of the IBM®  Workload Scheduler  workstation where the user can launch jobs.

User name

The user name. A user needs access to the workstation where IBM®  Workload Scheduler  launches 

jobs, and have the right to Log on as batch.

The following formats are supported when specifying the value of the user name:

username

The Windows user. For example user1.

domain\username

The user belongs to a Windows domain. Specify the Windows domain name to which the 

user belongs. For example MYDOMAIN\user1.

username@internet_domain

The user belongs to an internet domain. The user name is in User Principal Name (UPN) 

format. UPN format is the name of a system user in an email address format. The user 

name is followed by the "at sign" followed by the name of the Internet domain with which 

the user is associated.

For example administrator@bvt.com.

When a name is not unique it is considered to be a local user, a domain user, or a trusted domain user, 

in that order. If you schedule a job on a pool or a dynamic pool, the job runs with the user defined on 

the pool or dynamic pool. However, the user must exist on all workstations in the pool or dynamic pool 

where you plan to run the job.
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Maximum length is 47 characters.

Password

The user password as defined on the computer. Maximum length is 31 characters.

Confirm password

The user password again for confirmation.

Versions

Use this section to view the history of object changes and work with the different versions.

You can run the following actions:

Compare

Select two different versions and compare them.

Restore...

Select a previous version and start the restore process.

4. Modify the values as required and click Save  to save the modified task.
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monitoringobjects in the plan planmonitoring objects

Through the Dynamic Workload Console, you can monitor your plans, objects in plans, scheduling activities, workstations 

and domains in your environment.

The IBM®  Workload Scheduler  enables you to monitor your environment in three ways:

Graphical View

Through the Graphical View, you can have an overall picture of the plan and how it’s structured. At a glance, you 

can analyze one or more job streams, jobs, dependencies and also analyze the impact a job stream and its jobs 

can have on the rest of the plan. This helps you to focus where necessary, detect and resolve issues quickly.

Monitoring the process and troubleshooting is simple and immediate thanks to the Graphical View. You can 

also export the displayed graphic to either a Scalable Vector Graphics (SVG) file or a Portable Network Graphics 

(PNG) file.

Furthermore, you can tailor the view as you prefer thanks to the flexible layout of the Graphical View that 

enables you to reposition objects in whichever way is most useful or meaningful for you.

For further information about the Graphical View, see Display a graphical plan view  on page 173.

Dashboard

From the Workload Dashboard you can view the whole status of your workload at a glance for one or more of 

the engines you have configured. You can check the status of workstations, jobs, critical jobs, prompts, and 

other relevant information.

You can also create your customized dashboard by following the instructions here: Creating a customized 

dashboard for monitoring  on page 191

Plan Query

To monitor your environment you can easily define a monitoring plan query by clicking Monitoring & Reporting 

> Workload Monitoring  > Monitor Workload. For details about the complete procedure, see Monitoring your 

objects in the plan  on page 198.

Display a graphical plan view
Specify filter criteria and display a graphical representation of the plan in the Plan View.

About this task

To display a graphical representation of the plan, you can specify multiple filter criteria to match objects in the plan and 

display them in the plan view.

The IBM Workload Scheduler  engine must be version 9.3 or later.
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An enhanced graphical view of the plan is also available in the Plan View and Job Stream View, see Graphical views in the 

plan  on page 176.

Tip:  You can also request a graphical view of jobs and workstations from a mobile device. Refer to the Mobile 

Applications Users Guide.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

To display a Show Plan View, perform the following steps:

1. In the navigation bar, click Monitoring & Reporting  > Workload Monitoring  > Show Plan View

2. Specify the engine on which you want to search for the scheduling objects to display in the view.

3. Use the fields in the Filter Criteria section to limit the number of job streams displayed in the result. You can filter 

based on the names of job streams and workstations (distributed systems only).

4. You can also filter on the starting times of the job streams and decide if you want to include predecessors and 

successors in the Plan View.

5. Select Auto refresh view on a timer  to refresh the Plan View at regular intervals. By default, the view is refreshed 

every 300 seconds (5 minutes). You can control the auto refresh through timer controls on the toolbar to pause, stop, 

and resume the auto refresh. You configure the default auto refresh interval by setting the DefaultTime  property in 

the PlanViewAutorefresh  section of the TdwcGlobalSettings.xml  configuration file. See Plan View auto refresh 

interval  on page 28.

6. Click Go  when you are ready to see the results displayed in the graphical plan view.

Results

The Plan View is a graphical representation of a filtered set of the job streams that make up the plan. Using the Plan View 

toolbar, you can perform several actions on the objects displayed. You can also modify the original filter criteria to update the 

display. For more information about the objects in the view, see Graphical views in the plan  on page 176.

What to do next

There are several actions you can perform on the objects displayed in the Plan View:

• Use the actions available from the toolbar that include modifying the original filter criteria that was set to change the 

objects displayed.

• Right-clicking a job stream reveals a number of actions that you can perform on the job stream:

◦ Perform an action such as Cancel, Hold, Release, and add or remove a dependency.

◦ Launch and display the job stream in the What-if analysis Gantt chart.

◦ View the jobs in the job stream by launching the in-context link to the Job Stream View.

◦ Open the job stream definition within the Workload Designer

http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/common/src_md/awsmdmst_welcome.html
http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/common/src_md/awsmdmst_welcome.html
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◦ Perform actions on the workstation such as Link, Unlink, Start, and Stop.

◦ View workstation properties.

• Single-click a job stream to reveal an info-rich tooltip. The tooltip also includes a color-coded status bar that indicates 

the status of jobs such as, the number of failed jobs, successful jobs, jobs in abend, or jobs in waiting.

Related information

Plans  on page 81

Graphical views in the plan  on page 176

Display a graphical plan view
Specify filter criteria and display a graphical representation of the plan in the Plan View.

About this task

To display a graphical representation of the plan, you can specify multiple filter criteria to match objects in the plan and 

display them in the plan view.

The IBM Workload Scheduler  engine must be version 9.3 or later.

An enhanced graphical view of the plan is also available in the Plan View and Job Stream View, see Graphical views in the 

plan  on page 176.

Tip:  You can also request a graphical view of jobs and workstations from a mobile device. Refer to the Mobile 

Applications Users Guide.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

To display a Show Plan View, perform the following steps:

1. In the navigation bar, click Monitoring & Reporting  > Workload Monitoring  > Show Plan View

2. Specify the engine on which you want to search for the scheduling objects to display in the view.

3. Use the fields in the Filter Criteria section to limit the number of job streams displayed in the result. You can filter 

based on the names of job streams and workstations (distributed systems only).

4. You can also filter on the starting times of the job streams and decide if you want to include predecessors and 

successors in the Plan View.

5. Select Auto refresh view on a timer  to refresh the Plan View at regular intervals. By default, the view is refreshed 

every 300 seconds (5 minutes). You can control the auto refresh through timer controls on the toolbar to pause, stop, 

and resume the auto refresh. You configure the default auto refresh interval by setting the DefaultTime  property in 
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the PlanViewAutorefresh  section of the TdwcGlobalSettings.xml  configuration file. See Plan View auto refresh 

interval  on page 28.

6. Click Go  when you are ready to see the results displayed in the graphical plan view.

Results

The Plan View is a graphical representation of a filtered set of the job streams that make up the plan. Using the Plan View 

toolbar, you can perform several actions on the objects displayed. You can also modify the original filter criteria to update the 

display. For more information about the objects in the view, see Graphical views in the plan  on page 176.

What to do next

There are several actions you can perform on the objects displayed in the Plan View:

• Use the actions available from the toolbar that include modifying the original filter criteria that was set to change the 

objects displayed.

• Right-clicking a job stream reveals a number of actions that you can perform on the job stream:

◦ Perform an action such as Cancel, Hold, Release, and add or remove a dependency.

◦ Launch and display the job stream in the What-if analysis Gantt chart.

◦ View the jobs in the job stream by launching the in-context link to the Job Stream View.

◦ Open the job stream definition within the Workload Designer

◦ Perform actions on the workstation such as Link, Unlink, Start, and Stop.

◦ View workstation properties.

• Single-click a job stream to reveal an info-rich tooltip. The tooltip also includes a color-coded status bar that indicates 

the status of jobs such as, the number of failed jobs, successful jobs, jobs in abend, or jobs in waiting.

Related information

Plans  on page 81

Graphical views in the plan  on page 176

Graphical views in the plan
Views to monitor the progress of your job streams in the plan in a graphical map.

You can use these views to monitor the progress of your job streams in the plan from a graphical map.

You can also take several actions on the objects displayed in the view. Almost all of the actions and information available in 

the traditional views resulting from Monitor queries are also graphically available from these views.

All of the views provide a toolbar that you can use to act upon the views and the objects displayed. For more information 

about the actions available from the toolbar, see the specific panel help.

You can also export the displayed graphic to either a Scalable Vector Graphics (SVG) file or a Portable Network Graphics 

(PNG) file . In these formats, vector-based images can be scaled indefinitely without degrading the quality of the image.
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The graphical views contain a combination of textual (tooltips, labels) and visual elements (icons, colors, shapes, progress 

bar). See the following representations of the graphical elements in the views and what each represents:

Table  23. Graphical representation of scheduling objects

Object Shape Icon

Job In the Workload Designer, the job is 

represented by this icon: . In the 

plan, this icon is replaced with the icon 

representing the status of the job, see 

Table 24: Graphical representation of 

statuses  on page 178. If the job has 

a deadline set, then the deadline is 

visible in the lower-left corner of the job 

shape. An icon in the lower-left corner 

indicates if a job is time-dependent.

Job stream Workload Designer Graphical View

Job Stream View

Plan View

In the Workload Designer, the 

job stream is represented by 

this icon: . In the plan, the job 

stream is represented as a 

container containing jobs.

Prompt

Resource
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Table  23. Graphical representation of scheduling objects  (continued)

Object Shape Icon

File

Internetwork dependency

Dependency -

Conditional dependency -

Join dependency

Table  24. Graphical representation of statuses

The status of a job stream is represented by colors and specific icons

Status Icon Color

Blocked

Error

Red

Running Blue

Successful Green

Canceled

Suppressed

Grey

Held Light grey
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Table  24. Graphical representation of statuses

The status of a job stream is represented by colors and specific icons

(continued)

Status Icon Color

Undecided

Waiting

Ready

Table  25. Quick actions on scheduling objects

Icon Description

Remove the selected object from the view. Use it, for 

example, to remove a job from a job stream or a dependency 

from a job. The removal becomes effective only when you 

save the object.

Duplicate object. Available in the Workload Designer 

graphical view only.

Create a dependency. Click the icon, click an object, 

and then draw a line to the job stream or to the job that 

represents the depending object. The lines are drawn from 

the dependency to the depending object.

Remove all the dependencies of the object. Available in the 

Workload Designer graphical view only.

View the job log. Not available in the Workload Designer 

graphical view.

Rerun job. Not available in the Workload Designer graphical 

view.

View the properties. Not available in the Workload Designer 

graphical view.

Load successors. Not available in the Workload Designer 

graphical view.

Release dependency. Not available in the Workload Designer 

graphical view.
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Table  25. Quick actions on scheduling objects  (continued)

Icon Description

Open the actions menu which can also be accessed by 

right-clicking an object. Not available in the Workload 

Designer graphical view.

The following graphical views are currently available in the plan:

• Plan View  on page 180

• Job Stream View  on page 181

plan viewviewplanPlan View

Use this view to get an overall picture of your plan.

This view shows a collapsed plan; it shows only the job streams, hiding any jobs and internal dependencies. External 

dependencies, both at job and job stream levels, are shown as arrows between job streams. If a job stream has multiple 

dependencies on another job stream, these are shown as one single arrow.

The following is an example of the view:

Because potentially a plan can contain a large number of job streams, by default the Plan View displays a limited number of 

objects. You can determine which job streams to display by specifying filtering criteria in the Show Plan View  page before 

launching the view or from the toolbar within the view itself.
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The maximum number of job streams displayed by the Plan View is 1000. You can modify the default maximum 

number of job streams to display in the Plan View by modifying the planViewMaxJobstreams  property in the 

TdwcGlobalSettings.xml  global settings file for the Dynamic Workload Console.

To launch the Plan View:

1. From the portfolio, click: Monitoring and Reporting  > Workload Monitoring  > Show Plan View.

2. Specify any filter criteria and then click Go.

You can take multiple actions on the job streams in the view by right-clicking them and choosing an option from the context 

menu such as the following:

• Perform an action such as Cancel, Hold, Release, and add or remove a dependency.

• Launch and display a job stream in the What-if analysis Gantt chart.

• View the jobs in the job stream by launching the in context link to the Job Stream View.

job stream viewviewjob streamJob Stream View

This view displays a picture of the job stream with all its jobs and related dependencies. You can navigate through the 

displayed jobs and job streams, choosing the level of predecessors and successors to display. By default, this view displays 

all the objects in the job stream and the first-level of external predecessors.

You can open this view in the following ways:

• From the table of results of a Monitor Jobs or Monitor Job Streams task, select an item and select Job Stream View 

from the toolbar.

• From the Plan View, right-click a job stream and select Open  > Job Stream View.

Use the Rename  icon to change the name of the view. The Rename  icon is displayed when you hover over the Job Stream 

View string.

The following is an example of a Job Stream View:
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The main elements in the Job Stream View are:

• Jobs

The status of the job is indicated by the color and the small icon in the header. See Table 24: Graphical representation 

of statuses  on page 178 for the various icons representing the status. Additional information available about the 

job include:

◦ The deadline written in the lower-left of the rectangle representing the job.

◦ An icon is displayed in the lower-left indicating if the job is time dependent.

◦ The tooltip for the job indicates if the job is a critical job or a shadow job. Shadow jobs are jobs running locally 

that are used to map jobs running on the remote engine.
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Further details are available in the tooltip displayed when you click on the job.

You can take multiple actions on the job by right-clicking it and choosing options from the context menu. The actions 

available depend on the selected engine and on the type of job. From this menu, you can view and print the job log 

and the job properties, or act on the job and its dependencies. You can also take actions on the job workstation or 

open the job and job stream definitions in the database to modify them.

• Dependencies

They are shown as boxes different from those used to represent jobs, connected to the depending objects by arrows 

that represent the dependency relationships. A joined conditional dependency instead is represented by the circle 

icon connected to the dependency arrows. To take actions on dependencies, you can right-click either the box or the 

arrow and choose an option from the context menu. Icons displayed in the box to the left describe the dependency 

type. Further details are available in the tooltip displayed when you click on the dependency. If dependencies within 

a job stream form a loop, this is highlighted in the view and a message appears, so that you can take the appropriate 

actions to resolve it.

Related information

Plans  on page 81

Display a graphical plan view  on page 173

Graphical View - modelling

Use this panel to graphically view the selected job or job stream with its dependencies in the Workload Designer.

This view shows the jobs contained in a job stream and their associated dependencies or the job stream dependencies. 

When you select an object in the graphical view, the object properties are displayed at the bottom of the properties pane. In 

distributed environments, the flexibility of the layout in this view enables you to reposition objects in whichever way is most 

useful or meaningful for you. If you save changes to the layout, the changes are maintained the next time you open the same 

job stream in the Graphical View, and also if you open the same job stream in the Job Stream View. In a z/OS environment, 

and in the case of a connection to a previous version of the engine, any changes made in the layout persist for the current 

browser session only. Changes to the layout cannot be saved to the database in a z/OS environment or when the engine 

connection is an engine of a release previous to 9.4.
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For a description of the shapes and icons available in this view, as well as in the Job Stream View and Plan View, see 

Graphical views in the plan  on page 176.

The same information and actions available from the Details  pane are also available from the Graphical View.

You can select or open objects in the Welcome page and work on them in these panes to edit your definitions as required.

In this view, you can use the following toolbar, icons, and buttons:

Use this button to perform multiple actions. Select the object in the graphic and open the menu, or use the pop-

up menu by right-clicking the object. This button is enabled only if this operation is available for the selected 

object.

Use this toolbar to rapidly manage the view.

Use these icons or the slider bar to zoom in or out from the view. The percentage of the view is displayed.

Use this icon to adjust the zoom level of the view so that all the objects are shown at the maximum resolution.

Use this icon to adjust the view to full screen size.

Use this icon to dynamically calculate the best size and position of all the objects in your view.

Click this icon to highlight all the dependencies of the selected object.

Click this icon to display or hide the job stream and job external dependencies in the graphical view. It can be 

useful to customize the picture granularity, especially in complex and large job streams.

Click this icon to show or hide the job stream dependencies.
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Click this icon to open the graphic in a Scalable Vector Graphics (SVG) file. With this type of file, vector-

based images can be scaled indefinitely without losing any quality. A vector graphic program uses these 

mathematical formulas to construct the screen image, building the best quality image possible, for the given 

screen resolution.

Click this icon to open the graphic in a Portable Network Graphics (PNG) file. A PNG file is compressed in 

lossless fashion, which means that all image information is restored when the file is decompressed during 

viewing.

Use this icon to print the view.

Click an object to display a tooltip containing more object information.

You can select an object with a single click to view a quick actions menu above the selected object from where you can 

perform further actions using the following icons:

185



Dynamic Workload Console User’s Guide

186

Click this icon to remove the selected object from the view. Use it, for example, to remove a job from a job 

stream or a dependency from a job. The removal becomes effective only when you save the object.

Use this icon to duplicate the selected object.

Use this icon to create dependencies. Click the icon, click an object, and then draw a line to the job stream or to 

the job that represents the depending object. You can use this icon only to create dependencies from objects 

displayed in the view and by drawing lines in the correct direction (from the dependency to the depending 

object).

Use this icon to also create a conditional dependency on jobs internal to the job stream. However, in this 

case, the job stream cannot be saved until you have manually updated the conditional dependency table, by 

specifying all the required information about the condition.

Use this icon to remove all the dependencies of the object.

The following graphic is an example of a graphical representation of a job stream.

Dependencies

When you click a job stream or job dependency, you select its dependency relationship and you can remove it. If this object 

is a dependency for multiple items, click it again to select the next dependency relationship. If dependencies within a job 

stream form a loop, this is highlighted in a light yellow color in the view so that you can take the appropriate actions to 

resolve it. If you delete the dependency causing the loop, the highlighting disappears.
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The arrows represent the dependency relationships; where the arrow goes from the dependency to the object that depends 

on it.

Dependencies can also be conditional. In the graphical view, this type of dependency is represented by a dash arrow.

Related information

Designing your Workload  on page 101

Editing objects from the Graphical View  on page 105

Object properties
You can use the Properties pane to modify the properties of the selected object.

The properties pane is divided into tabs, which contain options and properties relating to the object currently open.

If you have more than one object open in the Working List, the properties displayed in this pane are relating to the object 

currently selected in the Details  or Graphical  view above.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

Analyzing the impact of changes on your environment
How to apply changes to your plan and see the related impact displayed in a Gantt chart.

The What-if Analysis  visualizes the current plan in real time, displaying the current status of jobs and job streams, the 

planned start and end times, deadline, and the risk level associated to each job or job stream. The analysis is launched from 

any job or job stream in a distributed environment, or from any critical job or job that is part of a critical network in a z/OS 

environment. This feature is supported on version 9.3 engines or later. The current plan is visually represented in a Gantt 

chart. A Gantt chart is a time and activity bar chart that is used for planning and controlling projects or programs that have 

a distinct beginning or end. In a Gantt chart, each main activity that is involved in the completion of the overall project or 

program is represented by a horizontal bar. The ends of the bar represent the start and end of the activity. In IBM®  Workload 

Scheduler, each activity represents a job or job stream.

Use the What-if Analysis  to simulate and evaluate the impact of changes on the current plan. For example, if you know that 

a required file will be made available later than expected, you can evaluate the effects on the whole plan of the delay in the 

delivery of the file and see in detail which jobs and job streams risk missing their deadlines. For example, if you know that 

a specific workstation is scheduled to undergo a programmed maintenance operation, you can simulate the impact of the 

missing workstation on the overall plan.

Drag and drop each job or job stream along the horizontal time axis to see how this changes the job or job stream status 

with respect to its planned deadline. For example, if you move a job too close to its planned deadline, its status changes 

to indicate a potential problem. When you move a job or job stream, its dependencies are maintained and automatically 

recalculated. You can also add and remove successors and predecessors for each job or job stream.
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If you need to enlarge the scope of your analysis, you can add more job streams and jobs to the Gantt view using the Show 

Jobs  and Show Job Streams  (distributed only) buttons. This operation performs a search on the current plan and adds the 

selected jobs or job streams with the related predecessors and successors.

You can also highlight the critical path for a selected job or job stream along with its successors and predecessors. Modify 

the job duration, start time, and end time, add or delete successors and predecessors and see how this affects the whole 

critical path.

Under More Actions  tab of the context menu you can find the Workstation Unavailability Intervals  page where you can select 

intervals of time when the workstation will be unavailable. Use Simulate Job Stream Submit  (distributed only) to simulate the 

impact of submitting a job stream. The predecessors and successors will not be matched automatically.

If you want to view the current plan again, click More Actions  > Reset  to revert the What-if Analysis  to the current plan status.

Running the What-if Analysis  before carrying out the actual plan shows your predicted results at a glance, and, by seeing the 

results beforehand, you can plan for any potential problems before you start.

Any changes that you make in What-if Analysis  are applied for simulation purposes until you use the option Apply changes  to 

the actual plan with exception to a z/OS environment where changes are made for simulation purposes only.

You can disable the What-if Analysis  in your environment by setting the optman  enWhatIf | wi  global option to no  (default 

value is yes ). If you change this global option value, run "JnextPlan" to make the change effective. For additional information 

about optman  global options , see the section about setting global options in Administration Guide.

The enWhatIf | wi  global option interacts with the enWorkloadServiceAssurance | wa  global option, which enables or 

disables privileged processing of mission-critical jobs and their predecessors. For details about the interaction between the 

What-if Analysis  and the workload service assurance, see the section about disabling the What-if Analysis  in Administration 

Guide.

If you want to extend the What-if Analysis  to plans other than the current plan, consider that the maximum number of plans 

that you can analyze simultaneously is 5.

If you want to use the What-if Analysis  on the backup master domain manager, ensure that on the backup master you have 

the same user definition as on the master domain manager.

If the administrator has enforced the related policy, when you apply the changes to the actual plan, a panel is displayed, 

where you enter the reason why the change was implemented, the ticket number, if any, and the category of the change. For 

more information about the justification policy, see Keeping track of changes to scheduling objects  on page 221.

Workload Dashboard
monitor your environment using the Workload Dashboard

You can monitor the progress of your plan by using a dashboard.

To open the Workload Dashboard, in the navigation bar at the top, click Boards  > Workload Dashboard. The panel opens 

showing a number of predefined widgets which return the results for the most widely-used queries. The Workload Dashboard 
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provides a single, consolidated view for monitoring the workload status. By selecting the engine on the list, you can see the 

information related to the engine.

To customize the Workload Dashboard  duplicate it by clicking the hamburger menu at the top left of the panel.

To create you own dashboard, refer to Creating a customized dashboard for monitoring  on page 191.

Workload Dashboard

In the Workload Dashboard  you can view the whole status of your workload at a glance for one or more of the engines you 

have configured. You can check the status of workstations, jobs, critical jobs, prompts, and other relevant information.

By clicking on selected widgets, you open the table listing the information in the widget in tabular format. The following 

widgets support the link to the table of results:

Engines

This table lists the available engines. By selecting the engine you can see the details in each widget.

Available workstations

This widget shows the number of available workstations for the selected engine. By clicking on the widget the 

Monitor Workstations  view is displayed with detailed information about available workstations.

Unavailable workstations

This widget shows the number of unavailable workstations for the selected engine. By double clicking on the 

widget the Monitor Workstations  view is displayed with detailed information about unavailable workstations.
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Pending Prompts

This panel shows prompts for the selected engine. By clicking on the widget the Monitor Prompts  view is 

displayed.

Critical job status

This widget shows in a bar chart the number of jobs in high, potential, and no risk status for the selected 

engine. By clicking on the widget the Monitor Jobs  view is displayed with detailed information about jobs in 

critical status.

Job status

This pane shows the status of the jobs. By clicking on the widget the Monitor Jobs  view is displayed with 

detailed information

Jobs in late

This widget shows how many jobs have completed in late status for the selected engine. By clicking on the 

widget the Monitor Jobs  view is displayed with detailed information about jobs in late status.

Jobs in error

This widget shows how many jobs have completed in error status for the selected engine. By clicking on the 

widget the Monitor Jobs  view is displayed with detailed information about jobs in error status.

Min duration

This widget shows the number of jobs that have not reached the minimum duration for the selected engine. By 

clicking on the widget the Monitor Jobs  view is displayed with detailed information about jobs that have not 

reached the minimum duration.

Max duration

This widget shows the number of jobs that have exceeded the maximum duration for the selected engine. 

By clicking on the widget the Monitor Jobs  view is displayed with detailed information about jobs that have 

exceeded the maximum duration.

Resources

This widget shows the status of your resources. By clicking on the widget the Monitor Resources  view is 

displayed with detailed information about the resources.

Related information

Running IBM Workload Scheduler from a mobile device  on page 16

Plans  on page 81

Widgets and Datasources

A Widget  is an element of the custom boards, it can be static or associated to a datasource. the Datasource  is the source of 

information and can be created by retrieving data from a query in the plan or from Rest APIs.
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Widgets can be static, such as Web content, or associated to datasources. According to the datasource you create, a 

different widget can be associated.

Table widget has a limit of 1000 objects but the drill down is active, therefore by clicking on the widget it is possible to see 

more results in the monitoring panel.

The Bubble chart retrieves data from any associated data source showing a series of bubbles of different sizes placed in 

descending order. For example, when monitoring the critical jobs, data is gathered together according to the job status, and 

you can see three bubbles:

• The biggest red one represents data on critical jobs at high risk.

• The medium yellow one represents data on critical jobs at potential risk.

• The small green one represents data on critical jobs at potential risk.

Note:  The bubble dimension and position does not change according to the number of jobs. They are placed 

according to the importance of the critical job status.

Gauge Chart and KPI widgets have a simplified process of creation. You can just select the datasource and insert a name. 

In addition you can set notification both for thresholds and advanced properties. Notifications are also available as pop-

up notifications and they can be turned off by selecting Browser notification  in the drop-down list of at the top right of the 

navigation bar.

During the creation of a widget, at the selection of the datasource the system suggests you which datasource can be 

associated.

A set of default datasources are provided in the list. These datasources only retrieve data from the engine specified from 

the list in the dashboard. To create a datasource associated to multiple engine, you can duplicate and edit the existing 

datasources or create new datasources.

To customize the workstation of a Rest API datasources with a z/OS engine use the filter WORKSTATION_NAME.

For information about how to add widgets to the custom pages, see the section about Creating a custom page in the 

Dynamic Workload Console User's Guide.

Creating a customized dashboard for monitoring
Create a dashboard to monitor your scheduling environment.

About this task

For monitoring purposes, you can create a dashboard to monitor your environments. For instance, in the new dashboard, you 

can have at a glance information about:

• Critical jobs using a KPI widget  on page 192

• List of your engines in a table  on page 192
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• Monitor of jobs in waiting status  on page 193

• Company's website  on page 193

The dashboard is composed of widgets that can be customized to show the data that you need; the data are collected from 

datasources that must be previously created. To start with a customized dashboard, first create the datasource or use our 

default, then create a board where you add the widgets.

Widgets and Datasources  on page 190

At the top right of the Dynamic Workload Console  there is a icon with a drop-down list to have all of the notifications at a 

glance. You can set the notifications with a threshold for each widget during the creation of a custom board, or set different 

type of notifications for the Workload Dashboard. You can also manage the pop up notifications by selecting Browser 

notification  in the drop-down list.

Monitor critical jobs

1. From the navigation toolbar, click the icon  and select Manage Datasources.

Result

The Manage Datasource  panel opens.

2. Click Add new plan query.

3. Enter the Engine  from the list, the object type  and the Plan.

4. Enter the query in the related field or click Edit  to select the filter that needs to be added in the query. Ensure the query 

has a valid result otherwise the widget could not work.

5. Enter a name and click Save.

Result

You can find your new datasource in the list.

Create the board and add the KPI widget to monitor your critical jobs

6. From the navigation toolbar, click the icon Board and create board.

7. Insert a name and click Save.

Result

The new board has been created.

8. Click the icon , select datasource widget  and choose from the list the datasource that you have created and you 

want to associate.

9. Select KPI  from the list of widgets.

10. Insert widget name  and add a threshold.

11. click Save.

You can edit, duplicate and remove the widget from the hamburger menu. and save  the changes in the board.

List of your engines
Add the Table widget to the Board
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1. Open the Board  that you have created from the drop-down menu.

2. Click the icon  to enter edit mode in the board and then click the icon  and select Datasource widgets.

3. Select the Datasource widget  and choose Engine List  from the drop-down menu.

4. Select the widget Table  and insert a name.

5. select the field you want to add and insert a name for each field.

6. Click Save.

You can edit properties by clicking the hamburger menu.

Monitor of jobs in waiting status

1. From the navigation toolbar, click the icon  and select Manage Datasources.

Result

The Manage Datasources  panel opens.

2. Select the Jobs count by status  and click duplicate.

3. Enter a name for the Datasource and then edit.

4. Type engine name and engine owner in the URL where requested.

5. save.

Add the KPI widget to the Board to monitor your jobs in waiting

6. Open the Board  that you have created from the drop-down menu.

7. Click the icon  to enter edit mode in the board and then click the icon  and select Datasource widgets.

8. Select the datasource  previously edited.

9. Select KPI and insert a widget name.

10. In the Select tracked properties  section click add new field

11. Insert the name and select items[].waiting  from the drop-down menu.

12. Click Add  and then Save.

Add your company website to the dashboard

1. Open the Board  that you have created.

2. Click the icon  to enter edit mode in the board and then click the icon  and select Static widgets.

3. Select Web content

4. Insert a name, select the datasource and insert the link of your company's website.

5. Click Save.

Exporting and importing a dashboard
The purpose of this scenario is to show how to export and import a dashboard.

About this task
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You have just created a dashboard on the test environment that perfectly suits your needs; you can easily monitor your 

environment and quickly obtain the information you need.

Now, you want to reproduce it on the development and production environments, but creating a new dashboard on each 

environment with the same configuration, requires substantial effort.

With the import/export feature, you can quickly reproduce your dashboard anywhere in your environment.

Procedure

1. From the dashboard to be exported, click on the options menu next to the name of the dashboard and select Export. 

A JSON file is downloaded.

2. Log in to the Dynamic Workload Console  that runs on the development environment.

3. Select the Boards  menu and then click Import Boards.

4. Optionally, add a prefix to be added to the board name, for example, “Dev-“. Although it is not required, it helps you 

identify the dashboard on the development environment.

5. Select the JSON file of the board to be imported and Save.

6. Reopen the Boards  menu, and select the imported dashboard. The board automatically displays the retrieved data for 

monitoring purposes.

You then replicate the same steps on the production environment.

Results

With just a few clicks, you have successfully reproduced the dashboard on all your environments.

Monitoring your Scheduling Environment
Tasks to monitor the workstations and domains of your environment.

To monitor workstations and domains in your environment, you create and run monitor tasks.

Note:  You must create a connection to a remote IBM Workload Scheduler  engine, before you can run tasks on it to 

obtain data.

When you create a task, you are actually defining a query where you specify multiple criteria to search for items and to 

display the search results. You can then save, reuse, and share this task with other users, and modify it at any time. When 

you run the task, you are actually running the query on the plan to retrieve the information according to the filters and level of 

detail you specified when you created the task.
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Note:  To add a task to your favorite bookmarks, from the panel displaying your task results, click the user icon 

 and select Favorites.

To create a task, perform the following steps.

1. In the navigation bar, click Monitoring and Reporting  > Workload Monitoring  > All Configured Task  > New.

2. In the Select Task Type panel, select the task you want to create, and click Next. You must select a task type to make 

the corresponding list active.

3. Follow the procedure relating to the specific task you are creating.

Alternatively, you can also create and run your task by specifying a query, as described in Creating a monitoring task query  on 

page 198.

Each task you create and save is included under the All Configured Tasks  menu.

Related information

Monitoring your Workload  on page 197

Creating a task to Monitor Workstations
How you can create a Monitor Workstations  task.

About this task

To create a Monitor Workstations  task, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation bar, click Workload Monitoring  > Monitor Workload  and follow the steps described in Monitoring 

your objects in the plan  on page 198.

If you are familiar with conman, in the Query  text box specify a query based on the conman showcpus  syntax. 

Alternatively, click Edit  to select the filter criteria from the list of options that is displayed.

2. In the General Filter section, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. Optionally, 

in some of the results tables in the Periodic Refresh Options section, you can customize how often to refresh the 

information by specifying the refresh interval in seconds in hh:mm:ss format, with a minimum of 30 seconds and a 

maximum of 7200 seconds. For example, 00:01:10 means 70 seconds. If the value specified is not valid, the last valid 

value is automatically used. If the periodic refresh is enabled for a task, when the task runs, the refresh time control 

options are shown in the results table. You can also set or change the periodic refresh interval directly in the results 

table when the timer is in stop status. In this case, the value specified at task creation time is temporarily overwritten.
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You can filter the task results based on the workstation and domain names, or part of names (using wildcard 

characters).

You can filter the task results based on the workstation types and reporting attributes.

3. In the Columns Definition section, select the information you want to display in the table containing the query results. 

According to the columns you choose here, the corresponding information is displayed in the task results table. For 

example, for all the objects resulting from your query, you might want to see their link statuses, domains, and type, or 

you might want to see their statuses and the number of jobs successful or running on them. You can then drill down 

into this information displayed in the table and navigate it.

In the Columns Definition section, not only can you select the columns for this task results, but you can also specify 

the columns for secondary  queries on:

jobs, job streams domains, files, and resources. For example, you are creating a task to search for all the 

workstations of a domain. From the resulting list of workstations, you can navigate to see (secondary query) a 

list of all the jobs running on each of them.

jobs. For example, you are creating a task to search for all the virtual workstations that are also fault-tolerant. 

From the resulting list of workstations, you can navigate to see (secondary query) a list of all the jobs running 

on each of them.

Results

After specifying all the required criteria, you can save your task or immediately run it to create a list of workstations that 

satisfies your filtering settings. For details, see Monitoring your objects in the plan  on page 198.

Related information

Workstation  on page 44

Workstation types  on page 255

Creating a task to Monitor Domains
Why and how you can create a Monitor Domains  task.

About this task

To create a Monitor Domains  task, perform the following steps.
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Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation toolbar, click Monitoring & Reporting  > Workload Monitoring  > Monitor Workload  and follow the 

steps described in Monitoring your objects in the plan  on page 198.

If you are familiar with conman, in the Query  text box specify a query based on the conman showdomains  syntax. 

Alternatively, click Edit  to select the filter criteria from the list of options that is displayed.

2. In the General Filter section, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. Optionally, 

in some of the results tables in the Periodic Refresh Options section, you can customize how often to refresh the 

information by specifying the refresh interval in seconds in hh:mm:ss format, with a minimum of 30 seconds and a 

maximum of 7200 seconds. For example, 00:01:10 means 70 seconds. If the value specified is not valid, the last valid 

value is automatically used. If the periodic refresh is enabled for a task, when the task runs, the refresh time control 

options are shown in the results table. You can also set or change the periodic refresh interval directly in the results 

table when the timer is in stop status. In this case, the value specified at task creation time is temporarily overwritten. 

You can filter the task results based on the domain name, or part of name (using wildcard characters). You can also 

configure the automatic refresh of the task results in the table.

3. In the Columns Definition section, select the information you want to display in the table containing the query 

results. According to the columns you choose here, the corresponding information is displayed in the task results 

table. You can then drill down into this information displayed in the table and navigate it. In the Columns Definition 

panel, not only can you select the columns for this task results, but you can also specify the columns for secondary 

queries on workstations. Starting from the Monitor Domains  task table of result, you can start further queries on the 

workstations associated to one of the domains in the table; the information to be retrieved with these secondary 

queries is specified in this panel.

Results

After specifying all the required criteria, you can save your task or immediately run it to create a list of domains that satisfies 

your filtering settings. For details, see Monitoring your objects in the plan  on page 198.

Monitoring your Workload
Controlling and managing scheduling activities and objects on plans with tasks.

To control and manage scheduling activities and objects in plans, you create and run tasks.

Note:  You must create a connection to a remote IBM Workload Scheduler  engine, before you can run tasks on it to 

obtain data.

You can create the following types of task:

197



Dynamic Workload Console User’s Guide

198

Monitor Task

When you create a Monitor  task, you define a query where you specify multiple criteria to search for items and 

to display the search results. You can then save, reuse, and share this task with other users, and modify it at 

any time.

Task sharing is enabled only if your role is authorized to share tasks. If you are not, contact the administrator or 

see: Limit task and engine sharing  on page 36.

When you run the task, you launch the query, according to the filtering criteria, on all the objects associated to 

the IBM®  Workload Scheduler  connection you specified. A list of the objects that satisfy the search criteria is 

displayed when you run the task. You can view the objects resulting from your query, and their properties, and 

take actions on some of them.

Event Monitoring Task

When you create an Event Monitoring Task  you define a query where you specify multiple criteria to search 

for specific monitoring objects stored on the database and to display the search results. Available monitoring 

objects are event rules, triggered actions, and operator messages. You can then save, reuse, and share this task 

with other users, and modify it at any time.

When you run the task, you launch the query, according to the filtering criteria, on all the objects associated to 

the IBM®  Workload Scheduler  connection you specified. A list of the objects that satisfy the search criteria is 

displayed when you run the task. You can view the objects resulting from your query, and their properties, and 

take actions on some of them.

Report Task

For information about this type of task, see Reporting  on page 227.

Note:

To create a monitoring task, you can also define a monitoring task query by clicking Monitoring & Reporting  > 

Workload Monitoring  > Monitor Workload. For details about the complete procedure, see Monitoring your objects in 

the plan  on page 198.

Related information

Scheduling objects  on page 51

Monitoring your Scheduling Environment  on page 194

Monitoring your objects in the plan
Define a task to monitor objects in the plan by specifying a query in a query line. The objects for which you can create a 

monitoring task query are: jobs, critical jobs, job streams, workstations, files, resources, domains,  and prompts.

About this task
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To monitor objects in the plan, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation toolbar, click Monitoring & Reporting  > Workload Monitoring  > Monitor Workload.

2. From the Engine  drop-down list, select the check box related to the engine where the task must run.

You can specify more than one engine only if the type of object you want to monitor is job or job stream.

3. From the Object Type  drop-down list, select the type of object you want to monitor. The available object types 

correspond to the type of engine and number of engines you selected.

For a distributed engine, you can create a monitoring task query for: Job, Critical Job, Job Stream, Workstation, File, 

Resource,Domain,  and Prompt.

For a z/OS engine, you can create a monitoring task query only for: Job, Critical Job, Job Stream, Workstation, and 

Resource.

4. From the List Plans  drop-down list, you can select the current plan or an archived plan related to the selected engine. 

Plans are only stored for the distributed engines, you cannot select the field for critical jobs.

5. In the Query  text box, type the query that specifies the filter criteria to apply to the object type you selected. If you are 

familiar with the conman  syntax, the query syntax is quite similar; for example, the syntax for filtering jobs is similar 

to conman showjobs. If you are not familiar with conman, click Edit  to create your query by selecting the options 

from the filter criteria that are displayed (for details, see step 7  on page 200).

In general, the following rules apply to the query syntax:

◦ The plus symbol (+) is used to separate filter parameters.

◦ The hash key symbol (#) is used to separate the workstation name from the job stream name, for a 

distributed engine.

◦ The exclamation mark (!) is used to separate the workstation from the job stream name, for a z/OS engine.

◦ The ampersand symbol (@) replaces one or more alphanumeric characters (wild card).

◦ The period (.) separates the workstation name, job stream name from the job name.

◦ The slash (/) separates the folders.

Example

For example, to display the status of all jobs in the acctg  job stream on workstation site3  for a distributed engine, 

type the following string in the Query  text box:

site3#/foo/acctg.@

or:

site3#/foo/acctg

For more example about queries and syntax, see Example  on page 200.

6. Click Run  to run the task immediately.

Result
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The results are displayed in table format in a new page. From this page you can continue to edit the query in the 

query line or click Edit  to make changes to the user interface selections. The list of results are updated with the 

changes you make.

Note:  After running, the query is automatically saved in the Query  drop-down list, enabling you to reuse it for 

future monitoring. You can manage the list either by removing a single query by selecting the minus (-) next to 

the query to be removed, or clearing all saved queries by selecting Clear Query History.

7. Alternatively, click Edit  to select the filter criteria from a list of options rather than specifying them in the Query  text 

box. 

Result

The Query  text field is automatically populated with the appropriate syntax.

For details about the filter criteria that apply to the object type you selected, refer to the following sections:

◦ Creating a task to Monitor Workstations  on page 195

◦ Creating a task to Monitor Domains  on page 196

8. Type a name for the monitoring task in the Task Name  text box.

9. Click Save  to save the task.

Result

Each task you create and save is included in the Query  drop-down list. You can reuse or modify each saved task, as 

required.

10. Select a task from the Query  drop-down list and click Edit. Duplicate  to create a new task exactly like the one you 

selected. This is useful if you want to work with a task that is not your own, but is shared with you.

11. Select one or more tasks from the Query  drop-down list and click Edit. Click Delete  to delete them. You cannot delete 

tasks that are not your own.

12. Click Run  to run the task.

Result

A list of results is displayed in table format in a new page. Alternatively you can view the output of the selected task 

in a report format in a separate HTML file. Click View as Report  to view the output.

Results

You have created your task that, when run, creates a list of results satisfying your filtering criteria and showing, for each 

object in the list, the information contained in the columns you selected to view.

Example

The following examples show the syntax used to create some specific queries:

Job query in a distributed environment

To query for all jobs, in all job streams and on all workstations on a specific distributed engine, with the 

following characteristics:

• Having a dependency on a workstation with a name beginning with FTA_1

• Beginning with Job_A  in a job stream beginning with JS_A
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in FOLDERA folder

• Scheduled to run at 10 a.m. on October 31, 2015

• Currently in Waiting  state with a priority in the range of 1 - 50

specify the following query in the query line:

/@/@#/@/@.@+follows=/@/FTA_1#/FOLDERA/JS_A@(1000 
 10/31/2015).JOB_A@+state=#Waiting,#Ready+priority=1,50

Job query in a z/OS environment

To query for all jobs in a job stream ending in 001, on all workstations beginning with HR  in a z/OS environment, 

with the following characteristics:

• Having an internal status of Interrupted  and Error

• Having a priority of 1

specify the following query in the query line:

HR@!@001.@+jsfrom=1000 10/10/2015+state=E,I+priority=1

Monitoring event rules
Why and how you can create a monitor event rule instances task.

About this task

To create a Monitor Event Rules task, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation bar, click Monitoring & Reporting  > Monitor Event Rules  > New.

2. In the Create Task panel, under Event Monitoring Task, select Monitor Event Rules  and click Next.

3. In the Enter Task Information panel, specify the task name and select the engine connection where you want to 

run the task. You can run this type of query only in a IBM Workload Scheduler  distributed environment on either the 

master domain manager or on a node installed as a backup master domain manager, but not necessarily belonging 

to the master domain. Here you also specify whether to share the task with others, to allow them to see and run the 

task, but not to modify it.

4. Click Next  to proceed with task creation or click Finish  to complete the creation using the default values and exit 

without proceeding to the following steps. If you are editing an existing task, properties are organized in tabs.

5. In the General Filter section, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. Optionally, 

in some of the results tables in the Periodic Refresh Options section, you can customize how often to refresh the 

information by specifying the refresh interval in seconds in hh:mm:ss format, with a minimum of 30 seconds and a 

maximum of 7200 seconds. For example, 00:01:10 means 70 seconds. If the value specified is not valid, the last valid 

value is automatically used. If the periodic refresh is enabled for a task, when the task runs, the refresh time control 
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options are shown in the results table. You can also set or change the periodic refresh interval directly in the results 

table when the timer is in stop status. In this case, the value specified at task creation time is temporarily overwritten. 

You can search for rule instances based on their status, type, or trigger timestamps.

6. In the Columns Definition panel, select the information you want to display in the table containing the query results. 

According to the columns you choose here, the corresponding information is displayed in the task results table. For 

example, for all the objects resulting from your query, you might want to see their statuses, and the kind of rule that 

generated them. You can then drill down into this information displayed in the table and navigate it. In the Columns 

Definition panel, not only can you select the columns for this task results, but you can also specify the columns for 

secondary  queries on event rules (the event rule definition stored in the database). The information to be retrieved 

with these secondary queries is specified in this panel.

7. Click next  to finalize the task creation, you can choose either to run the task immediately or finish to save the task 

and exit the wizard.

Results

You have created your query that, when run, lists the event rule instances satisfying your filtering criteria and shows, for each 

event rule in the list, the information you selected to view.

Related information

Creating an event monitoring tasks  on page 202

Event management configuration  on page 13

Creating an event monitoring tasks
Information about event monitoring tasks and how to create them.

You create and run an event monitoring task by specifying a filter and running a search to get information about event 

monitoring related objects.

The information retrieved when running event tasks is stored in the IBM Workload Scheduler  databases, therefore, to run 

event tasks you must be connected to a IBM Workload Scheduler  engine and must be authorized in the IBM Workload 

Scheduler  security file to access those objects in the database.

You can create event monitoring tasks to query for:

Event rule definitions

The template that defines an event rule consists of:

• One or more events, defined with its properties.

• The relationship between the specified events (they can be randomly grouped or listed in chronological 

order).

• The actions that must be performed when all the event conditions are satisfied.
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Event rules

The instance of a rule definition in the plan.

Triggered action

The actual occurrence of an action defined in the event rule and triggered when the event conditions have been 

satisfied.

Operator messages

The instance of the MessageLogger  action specified in the event rule definition. It provides information about 

the result of an event rule instance on a repository stored in the IBM Workload Scheduler  relational database.

Related information

Monitoring event rules  on page 201

Monitor Triggered Actions  on page 203

Monitor Operator Messages  on page 204

Monitor Triggered Actions
Why and how you can create a Monitor Triggered Actions  task.

About this task

To create a Monitor Triggered Actions  task, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation bar, click Monitoring & Reporting  > Monitor Triggered Actions  > New

2. In the Create Task panel, select Event Monitoring Task  > Monitor Triggered Actions  and click Next.

3. In the Enter Task Information panel, specify the task name and select the engine connection where you want to 

run the task. You can run this type of query only in a IBM Workload Scheduler  distributed environment on either the 

master domain manager or on a node installed as a backup master domain manager, but not necessarily belonging 

to the master domain. You can also specify whether to share the task with others, to allow them to see and run the 

task, but not to modify it.

4. Click Next  to proceed with task creation.

5. In the General Filter section, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. Optionally, 

in some of the results tables in the Periodic Refresh Options section, you can customize how often to refresh the 

information by specifying the refresh interval in seconds in hh:mm:ss format, with a minimum of 30 seconds and a 

maximum of 7200 seconds. For example, 00:01:10 means 70 seconds. If the value specified is not valid, the last valid 

value is automatically used. If the periodic refresh is enabled for a task, when the task runs, the refresh time control 

options are shown in the results table. You can also set or change the periodic refresh interval directly in the results 

table when the timer is in stop status. In this case, the value specified at task creation time is temporarily overwritten. 
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You can search for triggered actions based on the type of rule instance that triggers them or on their scope. The 

scope of an action (or an event) is the set of properties that most characterize it.

6. In the Columns Definition panel, select the information you want to display in the table containing the query results. 

According to the columns you choose here, the corresponding information is displayed in the task results table. For 

example, for each of the actions resulting from your query, you might want to see the status, type, or associated 

message. You can then drill down into this information displayed in the table and navigate it. In the Columns 

Definition panel, not only can you select the columns for this task results, but you can also specify the columns for 

secondary  queries on event rule instances. The information to be retrieved with these secondary queries is specified 

in this panel.

7. Click Next  to finalize the task creation, you can choose either to run the task immediately or finish to save the task 

and exit the wizard.

Results

You have created your query that, when run, lists the event rule instances satisfying your filtering criteria and shows, for each 

event rule in the list, the information you selected to view.

Related information

Creating an event monitoring tasks  on page 202

Event management configuration  on page 13

Monitor Operator Messages
Why and how you can create a Monitor Operator Messages  task.

About this task

To create a Monitor Operator Messages  task, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. In the navigation bar, click Monitoring & Reporting  > Monitor Operator Messages  > New

2. In the Create Task panel, select Event Monitoring Task  > Monitor Operator Messages  and click Next.

3. In the Enter Task Information panel, specify the task name and select the engine connection where you want to 

run the task. You can run this type of query only in a IBM Workload Scheduler  distributed environment on either the 

master domain manager or on a node installed as a backup master domain manager, but not necessarily belonging 

to the master domain. You also specify whether to share the task with others, to allow them to see and run the task, 

but not to modify it.

4. In the General Filter section, specify some broad filtering criteria to limit the results retrieved by your query. Here you 

start refining the scope of your query by also considering the amount of information you want to retrieve. Optionally, 

in some of the results tables in the Periodic Refresh Options section, you can customize how often to refresh the 

information by specifying the refresh interval in seconds in hh:mm:ss format, with a minimum of 30 seconds and 



Chapter 10. Monitoring your environment

a maximum of 7200 seconds. For example, 00:01:10 means 70 seconds. If the value specified is not valid, the last 

valid value is automatically used. If the periodic refresh is enabled for a task, when the task runs, the refresh time 

control options are shown in the results table. You can also set or change the periodic refresh interval directly in the 

results table when the timer is in stop status. In this case, the value specified at task creation time is temporarily 

overwritten.  You can search for operator messages based on their severity, time stamp, or scope. The scope of an 

operator message is the set of properties that most characterize it.

5. In the Columns Definition panel, select the information you want to display in the table containing the query results. 

According to the columns you choose here, the corresponding information is displayed in the task results table. 

For example, for each of the operator messages resulting from your query, you might want to see the severity, the 

type of associated event, or the group in whose queue the message is. You can then drill down into this information 

displayed in the table and navigate it.

6. Click Next  to finalize the task creation, you can choose either to run the task immediately or finish to save the task 

and exit the wizard.

Results

You have created your query that, when run, lists the event rule instances satisfying your filtering criteria and shows, for each 

event rule in the list, the information you selected to view.

Related information

Creating an event monitoring tasks  on page 202

Event management configuration  on page 13

Controlling job and job stream processing
How you can control job and job stream processing.

In the Dynamic Workload Console, you can control job and job stream processing by specifying dependencies, setting 

properties, and running actions against the job or job stream.

Using dependencies to control job and job stream processing

A dependency  is a prerequisite that must be satisfied before processing can proceed. You can define dependencies for both 

jobs and job streams to ensure the correct order of processing. You can use these types of dependencies:

On completion of jobs and job streams

A job or a job stream must not begin processing until other jobs and job streams have completed. May be 

defined to require success or just completion.

On satisfaction of specific conditions by jobs and job streams

A job or a job stream, named successor, must not begin processing until other jobs and job streams, named 

predecessor, have met one, all, or a subset of specific conditions that can be related to the status of the job 

or job stream, the return code, output variables, or job log content. When the conditions are not met by the 
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predecessor, then any successor jobs with a conditional dependency associated to them are put in suppress 

state. Successor jobs with a standard dependency or no dependency at all defined run normally.

Resource

A job or a job stream needs one or more resources available before it can begin to run.

File

A job or a job stream needs to have one or more files meet the specified criteria before it can begin to run.

Prompt

A job or a job stream needs to wait for an affirmative response to a prompt before it can begin to run.

You can define up to 40 dependencies for a job or job stream.  If you need to define more than 40 dependencies, you 

can group them in a join dependency. In this case, the join is used simply as a container of standard dependencies and 

therefore any standard dependencies in it that are not met are processed as usual and do not cause the join dependency to 

be considered as suppressed. For more information about join dependencies, see the section about joining or combining 

conditional dependencies and the join  keyword in the User's Guide and Reference.  In a IBM Workload Scheduler  network, 

dependencies can cross workstation and network boundaries. 

On completion of jobs and job streams

A job or a job stream must not begin processing until other jobs and job streams have completed. May be 

defined to require success or just completion.

Resource

A job or a job stream needs one or more resources available before it can begin to run.

In addition to this, each job needs the workstation where it is scheduled to run to be available.

To add a dependency to a job or to a job stream from the Workload Designer, see Adding and removing dependencies  on 

page 125.

You can also add a dependency from the panel displayed as result of your monitor task related to jobs or job streams by 

performing the following steps:

1. In the query result panel select a job or a job stream and click Dependencies.

2. In the Dependencies panel expand the section related to the dependency type you want to add and click Add.

3. Enter the required information and click OK.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

Using time restrictions to control job and job stream processing

Time restrictions  can be specified for both jobs and job streams.
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For a specific job or job stream you can specify the time that processing begins, earliest start, or the time after which 

processing can no longer be started, latest start. By specifying both, you define a time interval within which a job or job 

stream runs. You can use them as time dependencies.

You can also specify a deadline  to specify the time within which a job or a job stream must complete. Jobs or job streams 

that have not yet started or that are still running when the deadline time is reached, are considered late in the plan. The 

deadline does not prevent jobs or job streams from starting.

You can also specify a maximum duration  or a minimum duration  for a job defined within a job stream. If a job is running and 

the maximum duration time has been exceeded, then the job can either be killed or can continue to run. If a job does not run 

long enough to reach the minimum duration time, then the job can be set to Abend status, to Confirm status awaiting user 

confirmation, or it can continue running.

For jobs you can also specify a repeat range; for example, you can have IBM®  Workload Scheduler  launch the same job 

every 30 minutes between 8:30 a.m. and 1:30 p.m.

To specify time restrictions for a job or a job stream, perform the following steps:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the Workload Designer, edit the job stream you want to modify. For information about editing an object, see Editing 

objects from the Working List View  on page 103.

3. Select the job or the job stream in the Details view and click the Time restrictions  tab in the Properties section.

4. Enter the time restriction properties and save the job stream.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

Using job priority and workstation fence to control distributed job processing

IBM®  Workload Scheduler  has its own queuing system, consisting of levels of priority. Assigning a priority to jobs gives you 

added control over their precedence and order of running.

The fence  provides another type of control over job processing on a workstation. When it is set to a priority level, it only 

allows jobs whose priority exceeds the fence value to run on that workstation. Setting the fence to 40, for example, prevents 

jobs with priorities of 40 or less from being launched.

To specify job priority for a job, perform the following steps:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the Workload Designer, edit the job stream you want to modify. For information about editing an object see Editing 

objects from the Working List View  on page 103.

3. Select the job in the Details view and click the Scheduling options  tab in the Properties section.
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4. Enter the job priority and save the job stream.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

You can also add a job priority from the panel displayed as result of your monitor task related to jobs by performing the 

following steps:

1. In the query result panel select a job and click More Actions  > Priority.

2. In the Set Priority panel specify a priority value and click OK.

To set a workstation fence perform the following steps:

1. In the panel displayed as results of your monitor workstation task, select the workstation and click More Actions  > 

Fence.

2. In the Set Fence panel specify a fence value and click OK.

Using limits to control job and job stream processing

The limit  provides a means of setting the highest number of jobs that IBM Workload Scheduler  is allowed to launch. You can 

set a limit:

• In the job stream definition

• In the workstation definition

Setting the limit on a workstation to 25, for example, allows IBM Workload Scheduler  to have no more than 25 jobs running 

concurrently on that workstation.

To specify a limit for a job stream, perform the following steps:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the Workload Designer, edit the job stream you want to modify. For information about editing an object see Editing 

objects from the Working List View  on page 103.

3. Select the job stream in the Details view and click the Scheduling options  tab in the Properties section.

4. Enter the limit value and save the job stream.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

You can also add a limit from the panel displayed as result of your monitor job stream task by performing the following 

steps:

1. In the query result panel select a job stream and click More Actions  > Limit.

2. In the Set Limit panel specify a new limit value and click OK.

To set a workstation limit perform the following steps:
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1. In the panel displayed as result of your monitor workstation task, select the workstation and click More Actions  > 

Limit.

2. In the Set Limit panel specify a new limit value and click OK.

Using job confirmation to control job processing

There might be scenarios where the completion status of a job cannot be determined until you have performed some tasks. 

You might want to check the results printed in a report, for example. In this case, you can set in the job definition that the job 

requires confirmation, and IBM Workload Scheduler  waits for your response before marking the job as successful or failed.

To specify that a job requires confirmation, perform the following steps:

1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the Workload Designer, edit the job stream you want to modify. For information about editing an object see Editing 

objects from the Working List View  on page 103.

3. Select the job in the Details view and click the Scheduling options  tab in the Properties section.

4. Check Requires confirmation  and save the job stream.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

Using job recovery actions to control job processing

When you create a job definition, you can specify the type of recovery you want performed by IBM Workload Scheduler  if the 

job fails. The predefined recovery options are:

• Continue with the next job. You can also continue with the next job after a prompt is issued which requires a 

response from the operator.

• Stop and do not start the next job. You can also continue with the next job after a prompt is issued which requires a 

response from the operator.

• Run the failed job again. You can specify also how often you want IBM Workload Scheduler  to rerun the failed job and 

the maximum number of rerun attempts to be performed. If any rerun in the sequence completes successfully, the 

remaining rerun sequence is ignored and any job dependencies are released. You can optionally decide to also rerun 

the successors of the parent job, either all successors in the same job stream, or all successors, both in the same 

job stream and in other job streams, if any. In the Dynamic Workload Console, you can easily view the list of all job 

successors before rerunning them from the Monitor Workload  view, by selecting the job and clicking More Actions> 

Rerun with successors.

In addition, you can specify other actions to be taken in terms of recovery jobs and recovery prompts. For example, if a 

job fails, you can have IBM Workload Scheduler  automatically run a recovery job, issue a recovery prompt that requires an 

affirmative response, and then run the failed job again. For more information about recovery actions, see the section about 

defining job rerun and recovery actions in User's Guide and Reference.

To specify the job recovery actions, perform the following steps:
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1. From the navigation toolbar, click Design  > Workload Definitions  > Manage Workload Definitions.

2. In the Workload Designer, edit the job you want to modify. For information about editing an object see Editing objects 

from the Working List View  on page 103.

3. Click the Recovery options  tab in the Properties section.

4. Enter the recovery Action  and the remaining information, as necessary. Then save the job.

For all the details about options and fields displayed in the panel, see the online help by clicking the question mark 

located at the top-right corner of the panel.

Modifying job instances in the plan to control job processing

Even after your jobs have been submitted into the current plan, you still have opportunities to modify them without having to 

go back to the original job definition in the database. When modifying a job instance, you can change the definition if the job 

has not yet started to run, or you can change the definition of a job that has already run and rerun it with the new definition. 

For example, you can update a command or script, rerun a job with a different logon name or priority, or edit connection 

server details. Whatever the change, this is a quick and easy way to react and recover.

To modify the job definition of a job instance that has not yet run, perform the following steps:

1. From Monitor Workload, run a query on your jobs.

2. From the resulting list of jobs, select a job that has not yet run and click More Actions  > Edit Job.

3. Modify the job definition then click OK  to save the changes. To restore original definition, click Reload.

To rerun a job with a different definition, perform the following steps:

1. From Monitor Workload, run a query on your jobs.

2. From the resulting list of jobs, select a job that has already run and then click Rerun.

3. From the Rerun Job dialog, select Edit Job  and then click Edit Job.

4. Modify the job definition then click OK  to save the changes. To restore original definition, click Reload.

5. Click Rerun  to rerun the job with the modified definition.
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The main tasks that involve plans.

This section contains the main tasks that involve plans. You can find information about selecting the working plan, creating 

trial and forecast plans, monitoring the progress of a plan, and generating a graphical plan view or a preproduction plan view.

Selecting the working plan
How to list all the plans that are available on a specific engine.

From the Manage Available Plans, you can specify some filtering criteria to retrieve a list of plans. You can also generate a 

trial plan or a forecast plan.

Follow these steps to define a filter and run a query to create a list of available plans:

1. From the navigation toolbar, click Planning  > Workload Forecast  > Manage Available Plans.

2. In the Manage Available Plans panel:

a. Under Select an Engine, select the engine from which you want retrieve the list of plans.

b. Under Select Plan Type, click the corresponding check box to select the type of plan you want to list. 

Selections are mutually exclusive. By default, all available plans are listed.

c. Under Select Plan Name, specify the name of the file containing the plan you want to search. You can use 

wildcard characters.

d. Click Display Plans List  to generate a list of plans.

Clicking on Display Plans List, you can see a table containing the list of plans you are searching for.

On top of the table that lists the available plans, you can see the engine connection you are using together with the default 

and active plan.

The list of available plans shows the following set of information for each plan:

Type

The type of the plan. Possible settings are:

Blank

Current plan that is in process in the IBM®  Workload Scheduler  environment.

Symnew

Temporary files containing the information about the next production period based on the job and 

job stream dependencies defined in the IBM®  Workload Scheduler  database.

Forecast

Forecast plan. It contains a projection over a selected time interval of the current production 

plan based on the job and job stream dependencies defined in the IBM®  Workload Scheduler 

database.
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Trial

Trial plans. It contains a projection of the current plan for a different period.

Archived

Archived plan. It is a copy of an old production plan that ran in the IBM®  Workload Scheduler 

environment and that is now stored in the database.

File Name

The name of the file containing the plan.

Plan Start

The date and time when the plan starts.

Plan End

The date and time when the plan ends.

Schedule Date

The date when the plan was created.

Earliest Start

The actual date and time the plan began running. This column is blank for trial and forecast plans.

Last Updated

The time that the plan file was last updated.

Run Number

The run number associated to the plan. The run number is the total number of times the plan was generated. 

This number is zero for trial and forecast plans.

Size

The size of the file that contains the plan, in records.

From the header of the table, you can also generate a trial plan or a forecast plan. For further information about the creation 

of these two plans, see Generating Trial and Forecast Plans  on page 212.

Related information

Plans  on page 81

Generating Trial and Forecast Plans
How you create either a new trial or forecast plan.

About this task

To create a new plan, perform the following steps:
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1. From the navigation toolbar, click Planning  > Workload Forecast

Create Trial Plan

To create a trial plan. The Create Trial Plan panel is displayed.

Create Forecast Plan

To create a new forecast plan. The Create Forecast Plan panel is displayed.

2. Under the Plan Information  section, enter the required information:

Engine Name

In the drop-down menu, select the engine where you want to create the plan. Only the engine 

connections that you created are available in the menu.

Plan Filename

Assign a name to the file that contains the plan. This is a mandatory field.

3. Under the Plan Start  section, assign the date and time when the plan starts. Because the trial plan is mainly an 

extension of an existing and processing current plan, if you selected to create a new trial plan and a current plan is 

available on the engine, these fields are grayed out and their values are the same as the current plan end date. If you 

selected to create a new trial plan and a current plan is not available on the engine, or if you selected to create a new 

forecast plan, you can enter a date and time for the plan to start.

4. Under the Plan End  section, assign one of the following values:

Choose from:

◦ A date and time when the plan ends.

◦ The number of days and hours the plan lasts.

By default the plan covers a one-day time interval.

5. Under the Plan Time Zone  section, choose the time zone used in the plan.

6. Click OK  to create the plan.

Related information

Plans  on page 81

Display a graphical preproduction plan
How to view a graphical representation of a preproduction plan from the Dynamic Workload Console.

About this task

The preproduction plan is used to identify in advance the job stream instances and the job stream dependencies involved in 

a specified time period.

This improves performance when generating the production plan by preparing in advance a high-level schedule of the 

predicted production workload.
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The preproduction plan contains:

• The job stream instances to be run during the time interval covered by the plan.

• The external dependencies that exist between the job streams and jobs included in different job streams.

From the Dynamic Workload Console  you can view the preproduction plan graphically. You can open the preproduction plan 

in view mode only; you cannot extend it from this panel.

All users are allowed to view the preproduction plan. However, the preproduction plan content depends on the permissions 

you have on job streams. You can see only the job streams that you are allowed to see.

To open the preproduction plan view, perform the following procedure:

1. From the navigation toolbar, click Planning  > View Preproduction Plan.

2. In the displayed panel, select the distributed engine whose preproduction plan you want to view.

3. Optionally, specify a filter to reduce the number of job streams shown in the view. Only the job streams matching the 

string you entered as a filter are displayed in the preproduction plan view. By default, all job streams are shown. You 

can change your filtering criteria directly from the preproduction plan graphical view panel.

4. Specify the start and end dates to view only a portion of your preproduction plan. If you do not specify any date, the 

whole plan is shown. Optionally, you can organize the view by grouping the job streams by scheduled date.

Results

The graphical view of the preproduction plan is displayed. In this view, you can view the job streams included in the plan 

together with their job stream dependencies. Each box represents a job stream, whose color indicates the status. By default, 

it shows a maximum number of 1,000 job streams.

If you want to change this setting, modify the property preProdPlanViewMaxJobstreams  in the Override graphical view limits 

on page 27 file.

There are several actions you can perform on the objects displayed in the Preproduction Plan View:

• Right-click a job stream, to open the job stream definition within Workload Designer. You can modify a job stream 

from the Workload Designer  and then reload the updated preproduction plan view.

• Use the actions available from the toolbar:

◦ Zoom in and zoom out to better view segments of the plan.

◦ Print the plan or export it to either .svg (Scalable Vector Graphics) or .png (Portable Network Graphics) 

format.

◦ Highlight the dependencies in the view.

◦ Modify the original filter criteria that was set to change the objects displayed.

Related information

Preproduction plan  on page 84
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Predicting job duration using AI-based algorithms
A powerful analytical tool for the prediction of estimated job durations - in addition to the one provided by the logman 

command - is available through the deployment of the agent docker container. In addition to using Artificial Intelligence 

(AI) algorithms to predict the job duration, it also uses machine learning to train the tool to adjust predictions comparing 

previously predicted durations with actual durations. This tool does not employ specific time series to calculate the 

estimated job durations, as logman  does. On the contrary, it uses a very sophisticated algorithm that considers the previous 

50 job runs of a job instance to forecast the estimated durations for the next 7 job runs. The forecasts are precise to the 

very second thanks to the job duration trainer that trains jobs and updates the job duration data enabling the job predictor to 

perfect its predictions.

Whereas logman  is tailored to provide accurate estimates when the workload is subject to periodical shifts, the job duration 

predictor system is ideal in case of more complex patterns. For example, the job can be particularly useful to see beyond the 

accepted impacts of already known cyclic events, and understand what apparently hidden conflicts can affect the duration of 

a job. It can be effective to measure and forecast the durations of jobs along a critical path that occasionally does not meet 

its deadline.

The logman  command logs job statistics from a production plan log file. By default, the statistics are logged automatically for 

all the jobs in the plan. On the contrary, the job duration predictor processes only the jobs that you previously flagged for this 

purpose.

Using the job duration predictor system

To use the job duration predictor system on selected jobs to have a 7-run forecast of their estimated duration, follow these 

steps:

1. Create an engine connection between server and dynamic agent; the latter must be a specific agent that contains the 

machine learning and runs on Docker. For more information, see the section about deploying with Docker compose in 

Administration Guide.

2. Once the agent is started, launch the following command:

docker exec wa-agent sed -i '/"outputWindow"/s/: .*/: 7/' /opt/JDP/config.json

3. Add the workstation on which the dynamic agent  runs.

4. Select  on page 215 the jobs that you want to be measured by the job predictor.

5. Import and configure  on page 216 the job stream, the job training instance and the job prediction instance.

6. Schedule the time when the job predictor and the job trainer must run.

Selecting the jobs to be measured by the job duration predictor system

To select the jobs for which the estimated duration is to be forecast by the job duration predictor, you can use either the 

composer command line or the Dynamic Workload Console. In either case you update the definition of the job within the job 

stream definition.
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In composer:

1. Open the job stream definition that includes the jobs that you want to flag.

2. Flag the jobs by adding the statisticstype custom  keyword in their definition. For more information, see 

the section about the statisticstype custom  keyword in User's Guide and Reference.

In the Dynamic Workload Console:

1. In Manage Workload Definitions, edit the job stream definition that includes the jobs that you want to 

flag.

2. In the job stream definition, select every job you want to flag to open its definition.

3. In the Properties panel of the job, select the Duration forecast  tab.

4. In Duration forecast, select the Use Advanced analytics  checkbox.

You can change your selection anytime around your workload. The jobs that are not flagged for advanced statistics have 

their estimated duration calculated by logman. For more information, see the section about logman  in User's Guide and 

Reference.

Importing and configuring the job stream

To start using the job duration predictor system, a job stream must be added: you can import it with the workload application 

template (WAT) or create it manually through the user interface.

• Workload Application Template (WAT)

The workload application template is provided as a zip file. You must unpack the workload application template from 

the zip file and import it to the master domain manager  of your network as a job stream. The job stream contains 

the job predictor and job trainer instances already configured. By importing the WAT you must configure the name of 

the job stream, the name of the job predictor and job trainer, and the workstation where the agent with the machine 

learning engine is running.

• Manually add a new job stream

Create a new job stream definition. For more information, see the section about creating job stream definitions in 

User's Guide and Reference.

Define the workstation where the agent with the machine learning engine is running.

Add the Job duration trainer instance and then add the Job duration predictor instance. For more information about 

adding a job, see the section about adding a job to a job stream in User's Guide and Reference.

Once the job stream definition has been created/imported and configured, define when scheduling the job duration predictor 

and the job duration trainer. It is suggested to schedule the job duration predictor accordingly to the runs of the job to be 

analyzed.
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How you can insert jobs or job streams into your workflow at any time.

About this task

In addition to the jobs and job streams that are scheduled to run in production, you can also submit at any time other jobs 

and job streams. However, these jobs and jobs streams are not considered when identifying predecessors for jobs and job 

stream dependencies.

In production you can:

Submit Ad Hoc Jobs

This is a job that is:

• Not defined in the database.

• Used to run a command or a script in production.

Submit Predefined Jobs

This is a job that is:

• Defined in the database.

Submit Predefined Job Streams

This is a job stream that is:

• Defined in the database.

See the following sections for instructions about inserting each of these types.

Submitting ad hoc jobs
How to add an ad hoc job to the current plan.

About this task

To add an ad hoc job to the current plan, perform the steps listed below. You cannot submit ad hoc jobs to the 

˂env_ID>_CLOUD  pool which is automatically created when you request your trial. To submit an ad hoc job, you need to 

install an agent.

1. From the navigation toolbar, click Planning  > Workload Submission  >  Submit Ad Hoc Jobs  .

2. In the displayed panel, select, from the drop-down list, the engine where you want to run the job, and click Go.
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3. Enter all the required information about the job that you want to add. For more details about the information to enter 

in this panel, see the screen help, which you can open by clicking the question mark located at the top-right corner of 

the panel.

4. Click OK  to save your changes, exit the panel and submit the job.

Submitting predefined jobs
How to insert a predefined job into the production plan.

About this task

To add a predefined job to the current plan, perform the steps listed below. You cannot submit predefined jobs to the 

˂env_ID>_CLOUD  pool which is automatically created when you request your trial. To submit predefined jobs, you need to 

install an agent.

1. From the navigation toolbar, click Planning  > Workload Submission  >  Submit Predefined Jobs  .

2. In the displayed panel, select, from the drop-down list, the engine where you want to run the job, and click Go.

3. Enter all the required information about the job that you want to add. For more details about the information to enter 

in this panel, see the screen help, which you can open by clicking the question mark located at the top-right corner of 

the panel.

4. Click OK  to save your changes, exit the panel and submit the job.

Submitting predefined job streams
How to insert a predefined job stream into the current plan.

About this task

To add a predefined job stream to the current plan, perform the following steps:

1. From the navigation toolbar, click Planning  > Workload Submission  > Submit Predefined Job Streams.

2. In the displayed panel, select, from the drop-down list, the engine where you want to run the job.

3. Enter all the required information about the job stream that you want to add. For more details about the information 

to enter in this panel, see the screen help, which you can open by clicking the question mark located at the top-right 

corner of the panel. To find the job stream that you want to submit, you can launch searches based on part of the job 

stream name, workstation name, alias or variable table associated to it.

4. Optionally, specify a scheduled time to submit the job stream. The scheduled time refers to the submission of the job 

stream in the current production plan to evaluate dependencies resolution.

5. Note:  if the job stream has no dependencies it will start immediately. If you want to have an earliest start time 

specify it in the properties panel.

After completing the panel, click Submit  to submit your job stream in the plan. Close the tab to exit discarding your 

changes.
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Setting properties for ad hoc jobs and predefined jobs and job streams
This topic describes how to specify all the settings and properties required to add jobs or job streams to the current plan.

About this task

To set the properties required to add jobs or job streams to the current plan, perform the following steps.

Note:  For all the details about options and fields displayed in the panels, see the online help by clicking the question 

mark located at the top-left corner of each panel.

1. Enter the required information in the General  section.

2. For predefined and ad hoc jobs only: under the Task  tab, enter the task properties for the job in the displayed panel.

3. Select the Time Restrictions  tab, and enter the required information in the displayed panel to set time restrictions for 

the job or job stream.

4. Select the Resources  tab to set resource dependencies.

Choose from:

◦ To create a new resource, click New  and enter the required information in the Info panel.

◦ To delete an existing resource, select it from the list and click Delete.

◦ To modify a resource listed in the table, double-click its name and edit its properties in the Info panel.

5. Select the Prompts  tab to set prompts as dependencies for the job or job stream.

Choose from:

◦ To create a new prompt, click New  and enter the required information in the Info panel.

◦ To delete an existing prompt, select it from the list and click Delete.

◦ To modify a prompt listed in the table, double-click its name and edit its properties in the Info panel.

◦ Note:  When submitting ad hoc prompt no name is associated, therefore it is not possible to search for 

the name in the monitoring panel.

6. Select the Files  tab to set file dependencies for the job or job stream.

Choose from:

◦ To create a new file, click New  and enter the required information in the Info panel.

◦ To delete an existing file, select it from the list and click Delete.

◦ To modify the file properties, double-click the file and edit the settings in the displayed table.

7. Select the Internetwork Predecessors  tab to add predecessor dependencies from a remote IBM Workload Scheduler 

network. The displayed panel shows existing internetwork predecessor properties.

Choose from:

◦ To create a new internetwork predecessor, click New  and enter the required information in the Info panel. 

Click the  ...  (Browse) button to search for and select the name of the network agent. Internetwork 

dependencies require that a network agent is configured to communicate with the external scheduler 

network.

◦ To delete an existing internetwork predecessor, select it from the list and click Delete.

◦ To modify an existing internetwork predecessor properties, double-click it, and edit its settings.
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8. Select the Predecessors  tab to set predecessor dependencies for the job or job stream. The displayed panel shows 

existing predecessor properties. Select Conditional Dependencies  option to specify the type of the conditional 

dependency.

Choose from:

◦ To create a new predecessor, click New  and enter the required information in the displayed panel.

◦ To delete an existing predecessor, select it from the list and click Delete.

◦ To modify an existing predecessor properties, double-click it, and edit its settings in the displayed table.
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How to keep track of changes in your environment

From the Dynamic Workload Console, IBM®  Workload Scheduler  administrators, operators, and schedulers can review all 

changes to scheduling objects, both in the database and in the plan, discover which user performed a specific change, and 

the time and date when the change was performed.

Schedulers can review the history of all changes made on a specific object at any time and check previous versions of the 

object in scheduling language.

Historical information is available for each scheduling object in the Workload Designer  in the Versions  tab and in the results 

of the Monitor Workload  query.

Auditing justification and reporting

Administrators can maintain an audit trail, consisting of detailed information about the user who performed the change, the 

time and date when the change was performed, the reason why the change was implemented, and the details of the change 

for every modified item.

Administrators can optionally enforce a policy by which each user making a change to an object must provide a justification 

for the change.

They can produce a report containing information on all changed objects or on a subset of such objects.

You can audit both information available in the plan and in the database. By default, auditing is enabled. To disable auditing, 

use the following global options:

enDbAudit

Enables auditing of the information available in the database.

enPlanAudit

Enables auditing of the information available in the plan.

You can store auditing information in a file, in the IBM®  Workload Scheduler  database, or in both. To define in which type of 

store to log the audit records, use the auditStore  global option. For more information about global options, see the related 

section in the Administration Guide.

To enforce a policy by which each user making a change to an object from the Dynamic Workload Console  must provide a 

justification for the change, see Auditing justification and reporting  on page 222.

To enforce the policy when making changes from the command-line programs see:

• The composer  command-line program in the User's Guide and Reference .

• The conman  command-line program in the User's Guide and Reference.

• The optman  command-line program in the Administration Guide.

• The wappman  command-line program in the User's Guide and Reference.
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Versioning

Application developers and schedulers can compare and restore previous versions of each changed object because IBM® 

Workload Scheduler  Workload Automation on Cloud  maintains all previous versions for the whole set of objects.

Schedulers can also view the differences between versions using a comparison viewer, compare the differences, and 

rollback to a previous version.

Previous versions of changed objects are available in scheduling language.

Release management

Application developers and schedulers can promote the job workflow from development to test or production environments. 

An enhanced versioning capability keeps track of differences between different versions in the test and production 

environments to avoid conflicts.

They can also promote changes from production to pre-production or development environments to apply in the 

preproduction environments last-minute changes implemented into the active plan.

To move their workflows they can create and export a workload application template, a compressed file containing one 

or more job streams with all the related jobs and internal or external dependencies (such as files, resources, prompts). A 

workload application template is a self-contained workflow that you can import into a target environment.

Any mismatches in the versions of objects between development and production environments are seamlessly managed 

and resolved. For more information about creating and importing workload application templates, see Reusing a workload in 

another environment  on page 144.

Auditing justification and reporting
Enforcing justification policies and maintaining auditing reports

About this task

From the Dynamic Workload Console, administrators can enforce a policy by which each user making a change to an object 

must provide a justification for the change. From the Dynamic Workload Console, administrators perform the following steps:

1. From the navigation toolbar, click Administration.

2. In the Security  section, select Auditing Preferences.

3. For each displayed engine, you can enable the justification policy. After enabling the justification policy, decide which 

fields (Category, Ticket, and Description) are required.

4. Optionally create a new category to be added to the default ones in the lower section of the panel.

5. Optionally click on Ticket required  to specify the address of the ticketing server and the specific syntax supported on 

the server, for example: https://ticket.server.com/tickets/{$ticketnumber}, where:
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https://ticket.server.com/tickets/

is the ticketing server sample address

{ticketnumber}

is the ticket number to be provided by the user

After the justification policy is enabled, the justification panel is displayed each time a user performs a change in the 

Workload Designer  however, the justification will not be documented in the file. Justification can be viewed in the database. 

All other related changes are stored for auditing purposes in the IBM®  Workload Scheduler  database, in a file or in both, 

depending on the value you set in the auditStore  global option.

For more information about global options, see the IBM Workload Scheduler: Administration Guide.

For more information about enabling the storage of auditing information from the command line, see the following 

commands:

• The composer  command-line program in the User's Guide and Reference.

• The conman  command-line program in the User's Guide and Reference.

• The optman  command-line program in the Administration Guide.

• The wappman  command-line program in the User's Guide and Reference.

Checking version information
Work with previous versions of your scheduling and security objects.

About this task

IBM Workload Scheduler  maintains all previous versions, both for scheduling and security objects. From the Dynamic 

Workload Console  you can view and edit object definitions and check the related version information.

Depending on your object type, select the Versions  tab or the Show versions  button. For each object, you can view the history 

of changes, discover which user performed a specific change, the time stamp, and the reason for the change. You can also 

display previous versions in scheduling language.

For the object in the database, you can compare different versions in a comparison viewer. Perform the following steps:

• Open the object in edit mode and, depending on your object type, select the Versions  tab or the Show versions 

button.

• Select the two versions that you want to compare.

• Click on Compare.

• A comparison viewer opens that highlights the differences between the two versions.

For the object in the Workload Designer, you can also restore a previous version. Perform the following steps:
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• From the Workload Designer, open the object in edit mode and select the Versions  tab.

• Select the version that you want to revert to.

• Click on Restore...  to start the restore process.

• The selected version is opened in edit mode. Review the object definition and save it.

Auditing justification and reporting- a business scenario
Keep your scheduling environment under control

Jason and Tim both work for S&L, a primary brokering company. Tim is a IBM®  Workload Scheduler  administrator and he 

must be in control of every aspect of the scheduling process. Just when he is getting ready to leave, his boss calls him with 

an urgent request: he needs a complete audit report of last year's activities for the Toronto branch. Tim is in a hurry and it is 

getting late.

However, with IBM®  Workload Scheduler , he can easily trace all changes and quickly find out who did what  and why.

In the Dynamic Workload Console, Tim requires that justification information be provided for each change to an object by 

setting the Auditing Preferences. The requirement applies to all objects on the specified engines. Each time a user performs 

a change on an object, they have to specify a reason for making the change. Based on this information, Tim can produce a 

report containing all information about who, when, why, and what has changed for each modification on each scheduling 

object.

Tim's colleague, Jason, is an IBM®  Workload Scheduler  operator and he needs to make sure that his workflows run 

smoothly. However, this is not always the case: an error has occurred and Jason must understand what happened. The 

PAYROLL job stream has failed unexpectedly. In the Workload Designer, Jason can see that some jobs were modified 

yesterday  and why. He then applies the same correction to the one remaining job and restarts the job stream. With the 

correction applied, the job stream now runs correctly.

You can find more information and the detailed business scenario in the Stay in control of your workload video.

Streamline release management - a business scenario
Deploy new products, features, and fixes faster.

If you can reduce the amount of time it takes to push a code change into production, then you also reduce costs and 

maximize productivity, efficiency, and reliability. Code changes are usually triggered by a new feature or release, a minor 

enhancement stemming from a change request, or an emergency situation where a hot fix needs to be implemented.

Code changes also need to be continuously tested, integrated and built, and they often need to undergo an approval process 

before they can be promoted. To deliver business value, your release management process cannot suffer lag time from 

manual, error-prone processes that would slow down the development team's productivity.

IBM Workload Scheduler  can automate and control the entire process from the introduction of the code change to the 

promotion into production. With IBM Workload Scheduler  workload application templates, you can easily replicate a job flow 

from one environment to another through a quick and easy import and export operation.

https://youtu.be/EUH8SXjevkQ
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Business scenario

Rob is an application developer for an insurance company. He writes code for new releases, new features and 

enhancements, and hot fixes. His company applies agile methodology to their business development model. Agile is 

both iterative and incremental, with continuous improvement, that means that at the end of each abbreviated, repetitive 

cycle, a shippable deliverable is produced and can be deployed. This also means that in a short, abbreviated time slot, the 

development team is developing and testing and then promoting into production. The teams need an up-to-date environment 

with the latest code changes running at all times. Running a process like this manually is time consuming and error prone. 

Here's where Rob's colleague Marnie can help. Marnie is a scheduler. She suggests that rather than implement and run the 

release management system manually, that they could automate and schedule the development, test, and promotion into 

production of the process.

Rob maps the process to jobs, job streams, dependencies, prompts and any other scheduling objects needed to replicate the 

process. Here's what his workload includes:

• A job stream, JS1, is created to run a job every hour that runs an automation test suite that tests the code change.

• A job stream, JS2, that runs every night that contains jobs that, through a script, export the environment to a workload 

application template and then imports the template to deploy the environment into the test environment. Approval is 

obtained through a prompt. Another job is triggered to run a new automation test suite in the test environment.

• A third job stream, JS3, that runs at the end of each iteration and automatically tests and promotes after approval 

into the test environment and then again in the production environment. Finally, a job that performs a rollback if the 

test job fails.

Standardizing and automating your business processes ensures your deliverable is consistent every time guarantees a high 

level of quality, frees up human resources, saves money, and guarantees faster time to market.

Version control - a business scenario
Gain full control of changes in your scheduling environment.

Version control is most often used to track and control changes to software source code. However, to meet change 

management and auditing requirements, version control must also be applied to the scheduling objects, like jobs and job 

streams, associated to a certain application.
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IBM Workload Scheduler  is a modern, advanced workload automation solution supporting Version Control. IBM Workload 

Scheduler  maintains all versions of your scheduling objects in the database, and you can easily access them from the 

Dynamic Workload Console. For each scheduling object, you can view the history of changes, discover which user made a 

specific change, the time stamp of the change, and the reason for the change. Then, you can compare two different versions 

in a comparison viewer and restore a previous version.

Business scenario

Rob works as an application developer in a large healthcare company. Marnie works as a scheduler in the same company. 

Rob is working on the new release of an application for smart diagnostics. He prepares the full set of scheduling objects, 

jobs and job streams, associated to the application, and validates them in the test environment. The deadline has arrived, 

Rob is confident that the new release can be deployed in the production environment. He just makes a last minute change to 

the input file path for a java class in the DefineDiagnostics job. Time is running out and Rob leaves the office without verifying 

his last change.

The day after, Marnie, the scheduler, opens the Monitor Workload view and checks the job results for the daily plan. She 

is surprised to find out that the healthcare application job stream is blocked. The DefineDiagnostics job that has always 

completed successfully, today has ended abnormally. From the Workload Designer user interface, Marnie opens the failing 

job definition in edit mode. On the Versions page, she looks at the history of changes and realizes that Rob made a last 

minute change the day before.

Marnie can compare the failing job definition with the previous one, with no manual effort. By opening the comparison viewer 

and by looking at the differences between the two versions, she can determine the error introduced by Rob: a wrong file path. 

Marnie decides to restore the previous version of the job definition. From the Monitor Workload page, she reruns the failing 

job. This time, the healthcare application job stream completes successfully.

By using the version control feature, Marnie can quickly and easily solve a problem that otherwise would have compromised 

the release of the application into production. Version control enables audit readiness, reporting, collaboration, and change 

management within your company: all challenges that you must overcome in today´s business world.
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You can use IBM Workload Scheduler  reports to retrieve data from the IBM Workload Scheduler  database. You can then view, 

print, and save the results in different kinds of output. You can also save, reuse, and share the reports with other users and 

modify them at any time.

You can choose to use predefined reports  or import your personalized reports  created using Business Intelligent Report 

Tool (BIRT). By using predefined reports  it is possible to generate historical reports in a panel completely integrated in the 

Dynamic Workload Console. The  personalized reports  allow the administrator to generate reports from other databases by 

importing BIRT templates in the Dynamic Workload Console.

After you analyze the results of the reports, you can plan and assess changes and adjustments to your workload with the 

What-if Analysis. The What-if Analysis  simulates and evaluates the impact of any changes to the current plan. For more 

information on What-if Analysis, see Analyzing the impact of changes on your environment  on page 187.

Related information

Reports  on page 88

Regular expressions and SQL reports  on page 269

Predefined Reports
This topic lists the reports you can generate using the predefined reports section.

Before you can run a report to retrieve data from an IBM Workload Scheduler  engine, you must complete the following steps:

1. Create a connection to an IBM Workload Scheduler  engine.

2. Configure the Dynamic Workload Console  to view reports, as described in the section about reports in the User's 

Guide and Reference.

You can generate the following reports from the Dynamic Workload Console  using the predefined reports in Monitoring and 

Reporting from the navigation toolbar in the Dynamic Workload Console.

Creating a task to generate a Job Run Statistics  report
How to generate and run a Job Run Statistics  report task.

About this task

To create a task to run a Job Run Statistics  Report, perform the following steps:

1. From the navigation toolbar, click Monitor & Reporting > Reporting > Manage Predefined Reports  and click Create.

2. In the Task Information tab, select the Report Type  > Job Run Statistics.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 
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whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header  Tab, choose the title and the description of the output of the report. Check the boxes Append 

report selection criteria to the report header  and Include table of contents, if needed.

5. In the Filter Criteria tab, define a filter to select the jobs you want to include in the report. All the information about 

fields and options is available in the panel help.

6. In the Report Output Content tab, select the layout of your report. You can view the information either as a chart or as 

a table. The chart view displays the statistics for each job run in pie charts. You can select the report format. If you 

select HTML format, you can also limit the size of the report. You can also select the job details and the statistics you 

want to include in your report. After you made your selection, click Save  to create the task.

What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.

Related information

Reports  on page 88

Samples of report output

Creating a task to generate a Job Run History  report
How to generate and run a Job Run History  report task.

About this task

To create a task to run a Job Run History  report, perform the following steps:

1. From the navigation toolbar, click Monitor & Reporting > Reporting > Manage Predefined Reports  and click Create.

2. In the Task Information tab, select Job Run History  as report Type.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 

whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header  Tab, choose the title and the description of the output of the report. Check the boxes Append 

report selection criteria to the report header  and Include table of contents, if needed.

5. In the Filter Criteria tab, define a filter to select the jobs you want to include in the report. All the information about 

fields and options is available in the panel help.

6. In the Report Output Content tab, select the view of your report. You can view the information only as a table, but you 

can format it as an HTML or CSV file. If you select HTML format, you can also limit the size of the report. You can 

also select the job details you want to include in your report. After you make your selection, click Save  to create the 

task.
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What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.

Related information

Reports  on page 88

Samples of report output

Creating a task to generate a Workstation Workload Summary  report
How to create and run a Workstation Workload Summary  report.

About this task

To create a task to run a Workstation Workload Summary  report, perform the following steps:

1. From the navigation toolbar, click Monitor & Reporting > Reporting > Manage Predefined Reports  and click Create.

2. In the Task information tab, select Workstation Workload Summary  Report  as Report Type.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 

whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header  Tab, choose the title and the description of the output of the report. Check the boxes Append 

report selection criteria to the report header  and Include table of contents, if needed.

5. In the Filter Criteria tab, define a filter to select the jobs you want to include in the report. All the information about 

fields and options is available in the panel help.

6. In the Report Output Content tab, select the layout of your report. You can view the information either as a chart or 

as a table. The chart view shows the workload of all the specified workstations, aggregated by time. You can also 

choose to view the workloads of all the specified workstations in a single line chart. Aggregating all the information, 

you have a comparative view of the workstation workloads. You can select the report format. If you select HTML 

format, you can also limit the size of the report. You can also select the granularity with which to extract the data (by 

day or hour) and to order the report. After you make your selection, click Save  to complete the task creation using all 

the default values.

What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.
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Related information

Reports  on page 88

Samples of report output

Creating a task to generate a Workstation Workload Runtimes  report
How to create and run a Workstation Workload Runtimes  report.

About this task

To create a task to run a Workstation Workload Runtimes  report, perform the following steps:

1. From the navigation toolbar, click Monitor & Reporting > Reporting > Manage Predefined Reports  and click Create.

2. In the Task information tab, select Workstation Workload Runtimes  Report  as Report Type.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 

whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header  Tab, choose the title and the description of the output of the report. Check the boxes Append 

report selection criteria to the report header  and Include table of contents, if needed.

5. In the Filter Criteria tab, define a filter to select the jobs you want to include in the report. All the information about 

fields and options is available in the panel help.

6. In the Report Output Content tab, select the layout of your report. You can view the information either as a chart or as 

a table. The chart view shows in a bar chart the number of jobs that are running on the workstations. Selecting the 

chart view, you can also specify how many jobs to display in each chart. You can specify the format of your report. 

If you select HTML format, you can also limit the size of the report. You can also select the information you want 

to include in the report and how you want it ordered. After you make your selection, click Save  to complete the task 

creation.

What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.

Related information

Reports  on page 88

Samples of report output

Creating a task to Create Plan Reports
How to generate a Plan Report  task.
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About this task

Perform the following steps to create one of the following reports:

Actual Production Details  Report

A report based on the information stored either in the current or in an archived plan. The information contained 

in these plans is retrieved from the Symphony files. Actual Production Details  Report can be run on distributed 

engines (master domain manager, backup domain manager, domain manager with connector, and fault-tolerant 

agent with connector).

Planned Production Details  Report

A report based on the information stored either in a trial or in a forecast plan. The information contained in 

these plans is retrieved from the IBM Workload SchedulerWorkload Automation on Cloud  database. A Planned 

Production Details  Report can be run on distributed engines (master domain manager and backup domain 

manager). A real production report extracted from a fault-tolerant agent might contain different information 

with respect to a plan extracted from a master domain manager. For example, the number of jobs and job 

streams is the same, but their status can change, because a job successful on the master can be in hold or 

ready on the agent. The update status rate is the same only on the full status agent that runs on the domain 

master.

1. From the navigation toolbar, click Monitor & Reporting > Reporting > Manage Predefined Reports  and click Create.

2. In the Task information tab, select Actual Production Details  or Planned Production Details  as Report Type.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 

whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header  tab, choose the title and the description of the output of the report. Check the boxes Append 

report selection criteria to the report header  and Include table of contents, if needed.

5. In the Filter Criteria tab, define a filter to select the jobs you want to include in the report. All the information about 

fields and options is available in the panel help.

Wild cards are not allowed for Actual Production Details Report  and Planned Production Details Report  report types.

6. In the Report Output Content panel, select the job information that you want to display in the report output. After you 

make your selection, click Save  to complete the task creation.

What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.

Related information

Reports  on page 88

Samples of report output
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Creating a task to Create Custom SQL Reports
How to create an SQL query report task to run on a distributed IBM®  Workload Scheduler  environment.

About this task

Use this task to define your own reports by writing or importing SQL queries for extracting data in HTML or CSV format. To 

create an SQL report task, perform the following steps:

1. From the navigation toolbar, click Reporting  > Create Custom SQL Reports, and click New.

2. In the Create Task panel, select Report Definition  > Custom SQL  Report Task  > Next.

3. In the Enter Task Information panel, define the type of scheduler engine here you want to run the task. You can select 

an engine at a later time. Remember that the engine name must be specified before running the task. Depending on 

the engine type you choose, the filtering criteria and the results you can display are different. You can also specify 

whether to share the task with others, to allow them to see and run the task, but not to modify it. Task and engine 

sharing can be disabled by the TWSWEBUIAdministrator in the global settings customizable file.

4. In the Report Header panel, choose the name and the format of the output of the report and click Next  to proceed or 

Finish  to complete the task creation using all the default values. The Custom SQL  Report  supports only the Tables 

View  in either HTML or CSV format.

5. In the Filter Criteria panel, enter the SQL statement on which you want to base your report. You can write the query 

in the text pane or load an existing query from a file by browsing to the required file and clicking Load. Click Next  to 

proceed or Finish  to complete the task creation using all the default values.

6. In the Report Output Content panel, select the job information that you want to display in the report output. After you 

make your selection click Next  to proceed or Finish  to complete the task creation using all the default values.

What to do next

Next, run the report. For further details, see the section about running reports and batch reports in User's Guide and 

Reference.

Related information

Reports  on page 88

Samples of report output

SQL report examples  on page 275

Personalized Reports
This topic lists the reports you can generate using the personalized reports created with Business Intelligent Report Tool 

(BIRT).

To create a personalized report, customized with Business Intelligent Report Tool (BIRT), the administrator must import and 

every user can run it.

Before you can run a report to retrieve data from an IBM Workload Scheduler  engine, complete the following steps:
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1. Create a report with Business Intelligent Report Tool (BIRT) and import it in the section Monitoring & Reporting > 

Manage Personalized Reports.

2. Run your personalized reports in the section Monitoring & Reporting > Personalized Reports.

Manage personalized reports with BIRT
Create and run your personalized report with Business Intelligent Report Tool (BIRT).

About this task

With this functionality the administrator can manage a report starting from a custom template that has been previously 

created with Business Intelligent Report Tool (BIRT). The administrator can either put the information in the datasource 

before importing it in the Dynamic Workload Console  or perform the steps below and add the information during the process 

of import or run using the engine connection data.

To create a Personalized Report perform the following steps:

1. From the Navigation toolbar click Monitoring & Reporting > Reporting > Manage Personalized Reports.

2. Click Import  and insert a name  and a description  for the report.

3. You can also specify whether to share the task with others or not.

4. Check the box Run on dynamic workload engine  to use the database connection data that are on the Dynamic 

Workload engine. Selecting it, you can choose between the following two options:

Run on engine

Select one or more engines to include in the report.

Let users choose the engine

Postpone the choice to a later time when the report runs.

5. Click Choose a .rtpdesign file  to import a template created with Business Intelligent Report Tool (BIRT).

6. If needed, click Add property.file  to assign a resource file to the report.

7. click Import  to upload the report.

Run your personalized reports created with BIRT

About this task

To run your personalized perform the following steps:

1. From the Navigation toolbar click Monitoring & Reporting > Reporting > Personalized Reports.

2. Click the specified icon to run the report as HTML, PDF, XSLX, DOC or PPTX format.
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Chapter 15. Scenarios
Scenarios demonstrating practical application of IBM Workload Scheduler  in a business environment.

View these scenarios to help you get familiar with IBM Workload Scheduler  and learn how to use the product to achieve your 

business goals.

You can find additional scenarios in the Workload Automation channel in YouTube.

Customizing your job stream
Using the Dynamic Workload Console  to create and customize a job stream.

This scenario describes how you can use the Dynamic Workload Console  to create a job stream, schedule it to run at 

specified times, and change its behavior based on the day when it is scheduled to run.

Overview

A sales department manager needs to collect data on sales reports both at business unit level and at corporation level. For 

this reason the department manager needs reports both on a weekly and on a monthly basis. Report data is stored in two 

different directories, as follows:

• Data for weekly reports is stored in a set of files located in the directory /reports/weekly.

• Data for monthly reports is stored in a set of files located in the directory /reports2/monthly.

The job stream used for generating the reports has a dependency on the presence of these files. To collect the required data, 

the IBM Workload Scheduler  administrator creates one job stream with two different run cycles, one scheduled to run on a 

weekly basis and one scheduled to run on a monthly basis.

Each run cycle references two different variable tables, which contain the variable and the related value used to define the 

path where the correct input files are located.

Creating the job stream and the related objects

To create all the database objects required to reach the business goal, the IBM®  Workload Scheduler  designer uses the 

Workload Designer  on the Dynamic Workload Console.

1. He logs in to the Dynamic Workload Console  and, from the navigation toolbar, he clicks  Design  > Workload 

Definitions  > Manage Workload Definitions. The Workload Designer  opens.

Using the New  menu in the Working List  section, the administrator can create all the necessary objects. He can also 

search for existing objects to edit and insert in the plan.

2. The administrator selects New > Variable Table  to create the two variable tables required to provide the two different 

values for the input file paths.
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a. He creates a variable table with name SC1_WEEKLY_DATA_TABLE. This table is the default table. The path to 

the files required to generate the weekly reports is indicated by the REP_PATH variable, to which he assigns 

the value "/reports/weekly".

b. He creates a variable table with name SC1_MONTHLY_DATA_TABLE. The path to the files required to generate 

the monthly reports is indicated by the REP_PATH variable, to which he assigns the value "/reports2/monthly".

3. The administrator selects New > Job Definition > Windows Job Definition  to create the job definitions which generate 

the reports. All job definitions run a script each, which receives the value of the REP_PATH variable as the input value. 

He creates the following job definitions:

a. The job definition named SC1_PARSE_DATA SCRIPTNAME runs on the relevant workstation logging in as root. 

It runs a script which contains the following statement: "/reportApp/parseData.sh ^REP_PATH^".

b. The job definition named SC1_PROCESS_DATA SCRIPTNAME runs on the relevant workstation logging in as 

root. It runs a script which contains the following statement: "/reportApp/processData.sh ^REP_PATH^".

c. The job definition named SC1_CREATE_REPORTS SCRIPTNAME runs on the relevant workstation logging in as 

root. It runs a script which contains the following statement: "/reportApp/createReports.sh ^REP_PATH^".

4. The administrator selects New > Job Stream  to create the job stream which contains the jobs. The job stream is 

named SC1_RUN_REPORTS and runs on the relevant workstation.

5. The administrator selects Add to Selected > Run Cycle > Inclusive  to define two run cycles for the job stream, as 

follows:

a. The run cycle named SC1_WEEKLY_RCY uses the variable table SC1_WEEKLY_DATA_TABLE, which contains 

the value for the file path to be used for generating the weekly report. The run cycle also specifies that the job 

stream is to run once per week on Friday.

b. The run cycle named SC1_MONTHLY_RCY uses the variable table SC1_MONTHLY_DATA_TABLE, which 

contains the value for the file path to be used for generating the monthly report. The run cycle also specifies 

that the job stream is to run once per month on the 27th day.

6. The administrator selects Add to Selected > Add Dependency > File  to specify a dependency from the files containing 

the data used for report generation. He uses the REP_PATH variable to define the path to the required files.

7. The administrator searches for the job definitions he previously created (SC1_PARSE_DATA SCRIPTNAME, 

SC1_PROCESS_DATA SCRIPTNAME, SC1_CREATE_REPORTS SCRIPTNAME) and adds them to the job stream.

8. The administrator creates a plan lasting 30 days to generate multiple instances of the job stream.

As a result, the variable REP_PATH is assigned different values depending on the run cycle that applies. The administrator 

defines two run cycles, each of which references a specific variable table.

In this way, the job stream instances have a dependency on a different set of files depending on the type of report they have 

to produce, either monthly or weekly, as follows:

• The job stream instances that generate the weekly report have a dependency on the files located in the /reports/

weekly directory.

• The job stream instances that generate the monthly report have a dependency on the files located in the /reports2/

monthly directory.

Furthermore, the name of the target directory is correctly replaced in the task string of the three jobs run by every job stream 

instance, as follows:
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• The jobs run by job stream instances that generate the weekly report run shell scripts with the directory /reports/

weekly as an input argument.

• The jobs run by job stream instances that generate the monthly report run shell scripts with the directory /reports2/

monthly as an input argument.

The administrator can therefore define a single job stream with two different run cycles and ensure that the appropriate 

reports are generated on the correct dates without further user intervention.

Related information

Job stream  on page 53

Job  on page 52

Variable table  on page 79

Run cycle  on page 56

Dependencies  on page 63

Designing your Workload  on page 101

Creating job definitions  on page 107

Prerequisite steps to create job types with advanced options  on page 118

Using workload service assurance to monitor z/OS critical jobs
How to monitor jobs that are critical for the customer business and that must complete by their deadline.

This scenario shows how an operator can monitor the jobs that are critical for the customer business and that must 

complete by their deadline.

Overview

The operator uses the Dynamic Workload Console  to meet a Service Level Agreement (SLA) that requires a DB2 database to 

be up and running each day by 3 p.m., after its backup.

The operator must be informed whether critical jobs risk missing their deadline, to take the appropriate actions if needed. 

While the plan is running, the operator expects that the scheduler dynamically controls the network of submitted jobs, 

detecting when a critical job predecessor is late, long running, or ended with an error.

Roles
The scheduling administrator and the operator are involved in this scenario:

IBM Workload Scheduler  for z/OS scheduling administrator

When planning the operations, the administrator defines:
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• Scheduled time, duration, and deadline times.

• Critical jobs.

IBM Workload Scheduler  operator

Controls the submitted workload by using Critical Jobs and Hot List views.

Setting up the environment

Complete the following tasks when planning your operations:

1. Mark your critical jobs in the z/OS database. Set DBSTART and DBPRINT as critical jobs, using a job network with the 

following structure:

2. Run a daily planning job. The daily planning process calculates the critical paths in your job network, using the 

deadline, scheduled time arrival, and duration settings.

Running the scenario
After you updated your current plan, you can monitor your critical workload by using Critical Path  and Hot List  views:

1. In the navigation bar, click Monitoring & Reporting  > Workload Monitoring  > Monitor Workload.

2. Under the Engine  drop-down list, select the check-box related to the engine or engines where the task must run.

3. Under the Object Type  drop-down list select Critical job.

4. Click Edit.
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5. In the General Filter panel, specify DB* as Job Name  and set a Risk Level  different from None as filter criteria, 

because you want to monitor the critical jobs that risk missing their deadlines.

6. Click Save  to complete the task, leaving the default values in the remaining panels.

7. Run  the task.

8. Select the DBSTART job and click Critical Path  to view the path of the DBSTART predecessors with the least slack 

time. The Critical Path  view does not show any cause for the delay, because no problems occurred for any of the 

DBSTART predecessors in the critical path. Return to the Monitor Workload task output.

9. Click Hot List  or the Potential Risk  hyperlink to get a list of any critical job predecessor that is late, has been running 

for too long, or has ended with an error. The returned Hot List  shows DBMAINT as a late job. It is scheduled to run on 

the CPU2 workstation.

a. Click the CPU2 hyperlink.

b. After verifying that CPU2 is offline, activate the workstation. The DBMAINT job starts to run.

10. Refresh the  Monitor Workload  task output. It shows that the Risk Level  for DBSTART job is now No Risk.

Related information

Workload service assurance  on page 92

Limit the number of objects retrieved by queries  on page 34

Monitoring jobs running on multiple engines
Using the Dynamic Workload Console  to create a task to simultaneously monitor jobs that run on multiple engines.

This scenario describes how you use the Dynamic Workload Console  to create a task to simultaneously monitor jobs that run 

on multiple engines, which can be in mixed distributed and z/OS environments.

Overview

High efficiency batch processing relies on powerful monitoring capabilities. The need for a single operator to monitor 

systems is continuously increasing. Up until about 10 years ago, only a limited amount of workload was monitored, but this 

is increasing to the monitoring of an entire division, and even to an entire company.

Today operators frequently have to monitor multiple large divisions or multiple companies for service providers. These 

operators work in shifts in multiple geographical locations according to a "follow-the-sun" approach, in some cases. They 

must try to balance what must be monitored with the size of the monitored environment.

Business scenario

In this scenario, an insurance company, named Starbank, consists of a headquarters where its central office accounting 

department is located, and multiple branch offices located all over the world, where several administrative departments 

perform accounting activities.
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The central office is in charge of the company's entire accounting workload. Therefore, the IBM Workload Scheduler  operator 

must verify that all the workload processing for the Starbank  company proceeds smoothly and without errors and needs a 

comprehensive workload management solution.

To achieve this goal, the operator needs to create a task that he can run every day to monitor all the administrative jobs, 

detecting in real time any possible failures.

However, although the sales department of the company runs its jobs in a z/OS environment, the single business units run 

their jobs in distributed environments. The operator needs a single console panel, from which he can control all the jobs, both 

z/OS and distributed, at the same time.

The operator creates a task to monitor jobs that run on multiple engines, including both the environments. He does this by 

creating and running a task to Monitor Jobs  on multiple engines.

Creating a Monitor Jobs  task for multiple engines

The operator logs in to the Dynamic Workload Console  and, from the navigation bar, he clicks Monitoring & Reporting  > 

Workload Monitoring  > Monitor Workload.

To create a task using Monitor Workload, see Monitoring your objects in the plan  on page 198.
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Selecting the engines
In the Enter Task Information panel, the operator specifies a name for the task, for example AccError, and defines the 

scheduler engines on which to run the task.

According to a company naming convention policy, all the engine names have a prefix specifying to which department 

they belong. Therefore, the operator includes in the Selected Engines  list all the engines named acc_*. The operator then 

organizes the list by importance, placing the engines belonging to the most critical company departments (like Finance  and 

Sales) at the beginning of the list, so as to have their results displayed as the first rows of the table. The task runs following 

the engine sequence, but the results are displayed altogether, only after the task has run on all the engines in the list.

Defining the filter
In the General Filter panel, the IBM Workload Scheduler  operator specifies some filtering criteria to limit the results retrieved 

by the query. Here he starts refining the scope of the query by also considering the amount of information to retrieve. 

Defining a meaningful filter is very important to avoid unnecessary overhead, considering that the task runs on multiple 

engines. First, the operator sets the automatic refresh time to 600  so as to receive the updated monitoring results every 600 

seconds (10 minutes). He then filters for jobs based on their job streams. According to a company policy, all administrative 

job streams begin with the company name followed by the department code. In our scenario, the operator looks for all the 

job streams whose identifier starts with Starb*  that did not complete successfully.

Selecting the columns
In the Columns Definition panel, the operator selects the information to display in the table containing the query results. 

According to the columns he chooses, the corresponding information is displayed in the task results table. In our scenario, 

for all the jobs resulting from the query, the operator wants to see their statuses, the job streams they belong to, when they 

were scheduled to run, and the engines on which they ran. Then, if more details are necessary, he can drill down into this 

information displayed in the table of results and navigate it.

Results

In the All Configured Tasks panel, the operator can see the main details about the task that he has just created and launch 

the task immediately. The task is now in the list of saved tasks from where the operator can open and modify it any time. To 

find the task from the displayed task lists, he clicks the following options: Monitoring and Reporting  > Workload Monitoring 

> Monitor Workload.

The operator has created a task that can be run every day to highlight possible critical failure in real time. If there is a failure 

in any of the administrative jobs run by the selected offices, the operator discovers it no later than 10 minutes after the error 

occurs.

Running the Monitor Jobs  task for multiple engines

To launch the task, the operator clicks Monitoring & Reporting  > Workload Monitoring  > Monitor Workload.

The operator clicks AccError  task to launch it. Because some engine connections do not work correctly, the Checking engine 

connections panel reports some errors on two of the eight engines defined. The failing connections are the Tokyo  and Paris 

offices. The operator could ignore the failed connections and proceed, running the task on the successful engines only. 

However, monitoring the entire workload running in all the branch offices is crucial to his activity, and he does not want to 
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skip any engine connection. Therefore, by clicking Fix it  next to each failing engine connection, the operator opens a dialog 

where he can enter the credentials required for that engine. After entering the correct credentials, also the remaining engine 

connections work successfully and the operator clicks Proceed  to run the task against all the engines.

Viewing results and taking corrective actions

Viewing the results of the AccError  task, the operator realizes that there is a job in error, named PayAcc1. He right-clicks the 

job to open its job log, to better determine the cause and effects of this error.

From the job log, he finds out that only the last step of the job failed, which was a data backup process. This step can be 

done manually at a later time. The most important part of the job, consisting of the accounting processes related to payrolls, 

completed successfully.

Now the operator needs to determine the impact that this job in error has on the overall plan. To do this, he selects the 

PayAcc1  job and clicks Job Stream View. From this view, he realizes that this job is a predecessor dependency of another 

job, named Balance1. The operator releases the failing job dependency so as to make it possible for the successor Balance1 

to start and the whole workload processing to complete.

A second job in error results from the AccError  task. It is a z/OS job, named Info. The operator selects this job from the list 

and right-clicks it to open the Operator Instructions  that give him important information about what to do. According to the 

instructions, this is an optional procedure, which can be skipped without consequence for the entire processing. Therefore, 

the operator right-clicks the job and cancels it.

The operator then refreshes the view to ensure that there are no other jobs in error.

To view connection status information and statistical information about the engines against which the task was run, the 

operator clicks the statistical icon  on the table toolbar.

A pie chart showing the number of query results and job status is displayed for each engine on which the task ran 

successfully. By clicking the pie sections, he can see further details. If the task did not run successfully run on one or more 

engines, he sees a message containing details about the errors.

Related information

Limit the number of objects retrieved by queries  on page 34
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Chapter 16. Troubleshooting the Dynamic Workload Console
Accessing troubleshooting information.

About this task

You can find information about how to troubleshoot problems with the Dynamic Workload Console, related to connections, 

performance, user access, reports, and others at the following link: IBM Workload Scheduler Troubleshooting, under the 

section about troubleshooting Dynamic Workload Console  problems.

Note:  If you print PDF publications on other than letter-sized paper, set the option in the File -> Print window that 

enables Adobe Reader to print letter-sized pages on your local paper.

http://www-01.ibm.com/support/knowledgecenter/SSGSPN_9.5.0/com.ibm.tivoli.itws.doc_9.5/distr/src_tr/awstrmst_welcome.html
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Reference information to perform the main tasks and activities from the Dynamic Workload Console.

This section provides some reference information that can be useful to perform the main tasks and activities from the 

Dynamic Workload Console.

Accessing online product documentation
Accessing the products online publications in IBM®  Knowledge Center.

About this task

IBM®  posts publications for this and all other products, as they become available and whenever they are updated, to IBM® 

Knowledge Center. You can access product documentation at the following links:

• IBM Workload Automation product information, to access all the online product documentation related to the IBM 

Workload Scheduler  product.

• IBM Workload Scheduler for z/OS Publications in PDF format, to access publications in Adobe™  PDF format.

• Workload Automation YouTube channel, to access scenario-based and how-to videos about product features.

• IBM Workload Scheduler Wiki Media Gallery, to access demos about how to use the IBM Workload Scheduler 

product.

• IBM Workload Automation wiki, to access information about IBM®  Workload Scheduler  such as best practices, 

product features, and new tools.

Note:  If you print PDF publications on other than letter-sized paper, set the option in the File -> Print window that 

enables Adobe™  Reader to print letter-sized pages on your local paper.

Users and groups
How a system of users and groups allows different types of access to the Dynamic Workload Console.

In the Dynamic Workload Console  you can manage the users to authorize them to the different views to which every role is 

associated. From the Manage Roles  panel you can also create customized roles and  share the boards. Users are granted 

access to resources based on the role to which they have been assigned. The roles in which users are defined or the role 

assigned to users determines the operations they can perform and which resources are visible to them. This means that 

depending on your user role designation, you might not see all of the items described in this help system. The groups or 

predefined roles available are:

API User

Users in this group can use only the Dynamic Workload Console  APIs to perform the available actions. Logging 

to the Dynamic Workload Console  through a Web browser would not give them access to any feature. For more 

details about the Dynamic Workload Console  APIs, see  https://<DWC_hostname>:<port>/dwc/api.
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Administrator

Users with this role can see the entire portfolio and use all features of the Dynamic Workload Console.

Users with this group can also access and use all features of the Self-Service Catalog  and theSelf-Service 

Dashboards  mobile applications. From the Self-Service Catalog  mobile application, these users can create and 

edit catalogs, create and edit services, add services to catalogs, submit services associated to job streams, 

and share catalogs and services with other users. From the Self-Service Dashboards  mobile application, 

these users can create and edit dashboards to filter for jobs and workstations, display a dashboard of results, 

perform recovery actions on a single result.

From the Manage Roles panel, the administrator can add entities, manage pinned pages and shared boards.

Analyst

Users in this group can manage Dynamic Workload Console  reports and user preferences.

Broker

Users in this group can define Broker settings, create and manage Broker jobs and resources, and monitor 

Broker computers and resources.

Developer

Users in this group can create, list, and edit workload definitions, workstations, and event rule definitions in the 

IBM Workload Scheduler  database.

Mobile User

Users in this group can manage the Self-Service Catalog  and theSelf-Service Dashboards  mobile applications 

but the actions they can perform are limited to submitting service requests (job streams) from the Self-Service 

Catalog  and , from the Self-Service Dashboards  mobile application, displaying a dashboard of results and 

performing recovery actions on them.

Operator

Users in this group can see Dynamic Workload Console:

• All Monitor  tasks.

• Jobs and job streams to be submitted on request

• Set User Preferences

Example

The following table lists some entries of the navigation toolbar, and some activities you can perform from the Dynamic 

Workload Console. Beside each item, the table shows the groups whose users are authorized to access them.
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Table  26. Menu and Group Permissions

Menu Item

Groups with 

Permission

Quick Start Administrator

All Configured Tasks Administrator, 

Operator

Manage Workload Reports Administrator, Analyst

Design -> Workload Definitions Administrator 

Developer

Planning & Submission -> Workload Forecast Administrator, 

Operator

Administration  -> Workload Submission Administrator 

Operator

Monitoring & Reporting Administrator, 

Operator

Design -> Workload Definitions Administrator

Reporting Administrator, 

Analyst

Security ->Manage Engines Administrator 

Security -> Manage Settings Administrator 

Administration  →  Broker Settings; Design →  Broker Design; Monitoring & Reporting →  Broker 

Monitoring
Administrator, Broker 

Type of communication based on SSL communication options
How the SSL communication options for distributed workstations affect communication between workstations.

Based on the authentication types that you defined for the workstations in your network, communication between 

workstations is different. The following table summarizes the types of connection for the different authentication type 

settings.
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Table  27. Type of communication based on workstation SSL communication options

Fault-tolerant Agent 

(Domain Manager)

Domain Manager (Parent 

Domain Manager) Connection Type

Disabled Disabled TCP/IP

Allow Incoming Disabled TCP/IP

Upward Forced Disabled No connection

All Forced Disabled No connection

Disabled Upward Forced TCP/IP

Allow Incoming Upward Forced TCP/IP

Upward Forced Upward Forced SSL

All Forced Upward Forced SSL

Disabled Allow Incoming TCP/IP

Allow Incoming Allow Incoming TCP/IP

Upward Forced Allow Incoming SSL

All Forced Allow Incoming SSL

Disabled All Forced No connection

Allow Incoming All Forced SSL

Upward Forced All Forced SSL

All Forced All Forced SSL

For details about how to create SSL certificates and how to set local options for SSL communication, see IBM Workload 

Scheduler: Administration Guide.

Status description and mapping for distributed jobs
The job status as described in Dynamic Workload Console  and how it is defined in IBM Workload Scheduler.

There are the following types of status for distributed jobs:

Job status  on page 247

A subset of internal status that is common for both IBM®  Workload Scheduler  for distributed and IBM®  Z 

Workload Scheduler  environments.

Job internal status  on page 247

The IBM Workload Scheduler  job status registered on the workstation where the job is running. The internal 

status uniquely identifies a job status in IBM Workload Scheduler.
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jobstatusdescriptionstatus descriptiondistributed jobsJob status

Table 28: Job status  on page 247 lists the job statuses.

Table  28. Job status

This job status ... Means that ...

Waiting The job is waiting for its dependencies to be resolved.

Ready The dependencies of the job have been resolved and the job is ready to run.

Running The job is running.

Successful The job completed successfully.

Error The job stopped running with an error.

Canceled The job was canceled.

Held The job was put on hold.

Undecided The job status is currently being checked.

Blocked The job was blocked because of unfulfilled dependencies.

Suppressed by condition The job is suppressed because the condition dependencies associated to its predecessors are 

not satisfied.

jobinternal statusinternal statusdistributed jobsJob internal status

Table 29: Job internal status  on page 247 lists the job internal statuses.

Note:  The + flag written beside the INTRO and EXEC statuses means that the job is managed by the local batchman 

process.

Table  29. Job internal status

This job status ... Means that ...

ABEND The job terminated with a nonzero exit code or with an exit code outside the defined RC 

mapping.

ABEND P An ABEND confirmation was received, but the job is not completed.

ADD The job is being submitted.

+AUTOGEN+ A monitoring job automatically created to monitor conditions in condition-based workload 

automation. For more information, see the section about condition-based workload 

automation in User's Guide and Reference.

BOUND For shadow jobs, it means that the shadow job matched a remote job instance in the remote 

plan. For IBM Z Workload Scheduler Agent, it means that the job is on the JES queue.
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Table  29. Job internal status  (continued)

This job status ... Means that ...

CANCEL The job was canceled.

CANCEL P The job is pending cancellation. Cancellation is deferred until all of the dependencies, 

including at  time dependencies, are resolved.

DONE The job completed in an unknown status.

ERROR For internetwork and cross dependencies only, an error occurred while checking for the 

remote status.

EXEC The job is running.

EXTRN For internetwork dependencies only, the status is unknown. An error occurred, a rerun action 

was just performed on the job in the external  job stream, or the remote job or job stream does 

not exist.

FAILED Unable to launch the job.

FENCE The job's priority is below the fence.

HOLD The job is awaiting dependency resolution.

INTRO The job is introduced for launching by the system.

PEND The job completed, and is awaiting confirmation.

READY The job is ready to launch, and all dependencies are resolved. If a job fails because the agent 

is not available, the job is automatically restarted and set to the READY status, waiting for the 

agent to connect again. As soon as the agent connects again, the job is submitted.

R JOB The job is running.

SCHED The job's at  time has not arrived.

SUCC The job completed with an exit code of zero.

SUCC P A SUCC  confirmation was received, but the job is not completed.

SUSP The job was blocked because of unfulfilled dependencies. For IBM i  jobs only, this status 

indicates that the IBM i  job is waiting for a reply to a message.

For more information, see the section about scheduling jobs on IBM i  systems in User's Guide 

and Reference.

USER STAT The job was put on hold by the user.

WAIT The job is waiting to fulfill its dependencies.

WAITD The job is waiting to fulfill its dependencies.

SUPPRESS The job is suppressed because the condition dependencies associated to its predecessors 

are not satisfied.
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jobstatusmappingstatus mappingdistributed jobsJob status mapping

Table 30: Job status mapping  on page 249 describes how a job status is mapped to the corresponding job internal status.

Table  30. Job status mapping

This job status ... Maps to this job internal status

Waiting ADD, PEND, WAIT, WAITD, INTRO, HOLD

Ready READY

Running EXEC, SUCC P, ABEND P, R JOB, BOUND

Successful SUCC

Error ABEND, FAILED

Canceled Status of the job when it was canceled. Canceled flag is 

set.

Held Priority = 0, WAIT, READY, USER STAT

Undecided ERROR, EXTRN

Blocked SUSP

Suppressed by 

condition

SUPPR

Related information

Job  on page 52

Creating job definitions  on page 107

Adding a job to a job stream  on page 121

Status description and mapping for z/OS jobs
z/OS job status displayed by Dynamic Workload Console  and how it is defined in IBM®  Workload Scheduler  for z/OS.

There are the following types of status for z/OS jobs:

z/OS job status  on page 249

A subset of internal statuses common for both IBM®  Workload Scheduler  distributed and z/OS environments.

z/OS job internal status  on page 250

The job status registered on the IBM®  Workload Scheduler  controller. The internal status uniquely identifies the 

status of a z/OS job.

jobstatusdescriptionstatus descriptionz/OS jobsz/OS job status
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Table 31: z/OS job status  on page 250 shows the z/OS job statuses that are displayed by the Dynamic Workload Console.

Table  31. z/OS job status

This job status ... Means that ...

Waiting The job is waiting for its dependencies to be resolved.

Ready The dependencies of the job have been resolved and the job is ready to run.

Running The job is running.

Successful The job completed successfully.

Error The job has stopped running with an error.

Canceled The job was canceled.

Held The job was put in hold.

Undefined The job status is currently being checked.

Suppressed by Condition The job is suppressed because the condition dependencies associated to its predecessors are 

false.

jobinternal statusinternal statusz/OS jobsz/OS job internal status

Table 32: z/OS job internal status  on page 250 shows the z/OS job internal statuses that are displayed by the Dynamic 

Workload Console  and how they map to the status displayed on the IBM®  Workload Scheduler  for z/OS controller.

Table  32. z/OS job internal status

This job internal status ... Means that ... Maps to ...

Arriving The job is ready for processing; no 

predecessors were defined.

A

Complete The job has completed C

Deleted The job has been deleted from the plan D

Error The job has ended-in-error. E

Interrupted The job is interrupted. I

Ready The job is ready for processing; all 

predecessors are complete.

R

Started The job has started S

Undefined The job status is being evaluated. U

Waiting The job is waiting for a predecessor to 

complete.

W
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Table  32. z/OS job internal status  (continued)

This job internal status ... Means that ... Maps to ...

Ready - non-reporting workstation Ready - At least one predecessor is 

defined on a nonreporting  workstation; all 

predecessors are complete.

*

Suppressed by Condition The condition dependencies associated to 

its predecessors are not satisfied.

X

jobstatusmappingstatus mappingz/OS jobsz/OS job status mapping

Table 33: z/OS job status mapping  on page 251 describes how a z/OS job status is mapped to the corresponding job 

internal status.

Table  33. z/OS job status mapping

This job status ... Maps to this job internal status

Waiting W

Ready A, R, *

Running S

Successful C

Error E

Canceled I, D

Held A,R,* manually held

Undefined U

Suppressed by 

Condition

X

Related information

Job  on page 52

Creating job definitions  on page 107

Adding a job to a job stream  on page 121

Status description and mapping for distributed job streams
The job stream status in Dynamic Workload Console  and how it is defined in IBM Workload Scheduler.

There are the following types of status for job streams:
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Job stream status  on page 252

A subset of internal statuses that is common for both IBM Workload Scheduler  for distributed and IBM®  Z 

Workload Scheduler  environments.

Job stream internal status  on page 252

The IBM Workload Scheduler  job stream status registered on the workstation where the job stream is running. 

The internal status uniquely identifies a job stream status in IBM Workload Scheduler.

job streamstatusdescriptionstatus descriptiondistributed job streamJob stream status

Table 34: Job stream status  on page 252 lists the job stream statuses.

Table  34. Job stream status

This job stream status ... Means that ...

Waiting The job stream is waiting for its dependencies to be resolved.

Ready The dependencies of the job stream have been resolved and the job stream is ready to run.

Running The job stream is running.

Successful The job stream completed successfully.

Error The job stream has stopped running with an error.

Canceled The job stream was canceled.

Held The job stream was interrupted.

Undefined The job stream status is currently being checked.

Blocked The job stream was blocked because of unfulfilled dependencies.

Suppressed by condition The job stream is suppressed because the condition dependencies associated to its 

predecessors are not satisfied.

job streaminternal statusinternal statusdistributed job streamJob stream internal status

Table 35: Job stream internal status  on page 252 lists the job stream internal statuses.

Table  35. Job stream internal status

This job stream status ... Means that ...

ABEND The job stream terminated with a nonzero exit code.

ADD The job stream was added with operator intervention.

CANCEL The job stream was canceled.

CANCEL P The job stream is pending cancellation. Cancellation is deferred until all of the dependencies, 

including an at time, are resolved.
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Table  35. Job stream internal status  (continued)

This job stream status ... Means that ...

EXEC The job stream is running.

EXTRN The job stream is in a remote IBM Workload Scheduler  network and its status is unknown. An 

error occurred, a Rerun action was performed on the EXTERNAL  job stream, or the INET  job or 

job stream does not exist.

HOLD The job stream is awaiting dependency resolution.

READY The dependencies for the job stream have been met but the time restrictions for the job 

stream have not.

STUCK The job stream was interrupted. No jobs are launched without operator intervention.

SUCC The job stream completed with an exit code of zero.

SUPPRESS The job stream is suppressed because the condition dependencies associated to its 

predecessors are not satisfied.

Get Job Status Error This is for internetwork job streams and specifies that an error occurred while checking for 

the remote status.

job streamstatusmappingstatus mappingdistributed job streamJob stream status mapping

Table 36: Job stream status mapping  on page 253 describes how a job stream status is mapped to the corresponding job 

stream internal status.

Table  36. Job stream status mapping

This job stream 

status ... Maps to this job stream internal status

Waiting ADD, PEND, WAIT, WAITD, INTRO, 

HOLD

Ready READY

Running EXEC

Successful SUCC

Error ABEND, FAILED

Canceled CANCEL, HOLD, CANCEL P

Held HOLD

Undefined ERROR, EXTRN

Blocked STUCK

Suppressed by condition SUPPR
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Related information

Job stream  on page 53

Creating job stream definitions  on page 106

Status description and mapping for z/OS job streams
The z/OS job stream status in Dynamic Workload Console  and how it is defined in IBM Z Workload Scheduler.

There are the following types of status for z/OS job streams:

z/OS job stream statuses  on page 254

A subset of internal statuses that is common for both IBM®  Workload Scheduler  for distributed and IBM Z 

Workload Scheduler  environments.

z/OS job stream internal statuses  on page 254

The IBM®  Workload Scheduler  job stream statuses registered on the controller. The internal status uniquely 

identifies the status of a z/OS job stream in IBM®  Workload Scheduler.

job streamstatusdescriptionstatus descriptionz/OS job streamz/OS job stream statuses

Table 37: z/OS job stream status  on page 254 shows the z/OS job stream statuses that are displayed by the Dynamic 

Workload Console.

Table  37. z/OS job stream status

This job stream status ... Means that ...

Waiting No job in the job stream has started.

Running The job stream is running.

Successful The job stream completed successfully.

Error The job stream has stopped running with an error.

Canceled The job stream was canceled.

job streaminternal statusinternal statusz/OS job streamz/OS job stream internal statuses

Table 38: z/OS job stream internal status  on page 254 shows the z/OS job stream internal statuses that are registered on 

the Dynamic Workload Console  controller.

Table  38. z/OS job stream internal status

This job stream status ... Means that ...

Waiting No job in the job stream has started.
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Table  38. z/OS job stream internal status  (continued)

This job stream status ... Means that ...

Started The job stream is running.

Completed The job stream completed successfully.

Error The job stream has stopped running with an error.

Deleted The job stream was deleted.

Undefined The job stream status is not known.

job streamstatusmappingstatus mappingz/OS job streamz/OS job stream status mapping

Table 39: z/OS job stream status mapping  on page 255 describes how a z/OS job stream status is mapped to the 

corresponding job stream internal status.

Table  39. z/OS job stream status mapping

This job stream 

status ...

Maps to this job stream 

internal status

Waiting Waiting

Running Started

Successful Completed

Error Error

Canceled Deleted

Related information

Job stream  on page 53

Creating job stream definitions  on page 106

Workstation types
The following are the main workstation types and their attributes.

Table  40. Attribute settings for management workstation types

this table shows the attribute settings for management workstation types

Attributes Master domain manager Domain manager Backup domain manager

cpuname The name of the workstation.
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Table  40. Attribute settings for management workstation types

this table shows the attribute settings for management workstation types

(continued)

Attributes Master domain manager Domain manager Backup domain manager

description A description for the workstation enclosed within double quotes. This attribute is 

optional.

vartable The name of a variable table associated with the workstation. Variables used with the 

workstation are defined in this table. This attribute is optional.

os The operating system installed on the system. Specify one of the following values:

UNIX

WNT

OTHER

IBM_i

node The system host name or IP address.

tcpaddr The value assigned to nm port  in the localopts  file. For multiple workstations on a 

system, enter an unused port number. The default value is 31111.

secureaddr The value assigned to nm ssl port  in the localopts  file. Specify it if securitylevel  is set to 

on, force  or enabled.

timezone | tz The time zone in which the system is located. It is recommended that the value matches 

the value set on the operating system.

domain MASTERDM The name of the managed domain.

host Not applicable

access Not applicable

type manager fta

ignore Use this attribute if you do not want this workstation to appear in the next production 

plan.

autolink It indicates if a link between workstations is automatically opened at startup. Specify one 

of the following values:

ON

OFF

This is an optional attribute. The default value is ON.

behindfirewall This setting is ignored. It indicates if there is a firewall between the workstation 

and the master domain manager. Specify one of the 

following values:
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Table  40. Attribute settings for management workstation types

this table shows the attribute settings for management workstation types

(continued)

Attributes Master domain manager Domain manager Backup domain manager

ON

OFF

The default value is OFF.

securitylevel The type of SSL authentication to use:

enabled

on

force

fullstatus ON

server Not applicable This setting is ignored.

protocol Not applicable

members Not applicable

requirements Not applicable

Table 41: Attribute settings for target workstation types  on page 257 describes the values you set for each attribute for 

target workstation types. Following the table you find additional details about each attribute.

Table  41. Attribute settings for target workstation types

this table shows the attribute settings for target workstation types

Attribute Fault-tolerant agent 

and standard agent

Workload broker 

workstation

Extended agent Agent Remote engine 

workstation

Pool Dynamic 

pool

cpuname The name of the workstation.

description A description for the workstation enclosed within double quotes. This attribute is optional.

vartable The name of a variable table associated with the workstation. Variables used with the workstation are defined in this table. This 

attribute is optional.

os The operating system 

installed on the system. 

Specify one of the 

following values:

UNIX

WNT

OTHER

IBM_i

OTHER The operating 

system installed 

on the machine. 

Specify one of the 

following values:

UNIX

WNT

This value setting 

is discovered on 

the system.

The operating 

system installed 

on the machine. 

Specify one of the 

following values:

The operating system 

installed on the machine. 

Specify one of the 

following values:

UNIX

WNT
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Table  41. Attribute settings for target workstation types

this table shows the attribute settings for target workstation types

(continued)

Attribute Fault-tolerant agent 

and standard agent

Workload broker 

workstation

Extended agent Agent Remote engine 

workstation

Pool Dynamic 

pool

Specify OTHER  for IBM® 

i  systems running as 

limited fault-tolerant 

agents.

OTHER

IBM_i

UNIX

WNT

ZOS

OTHER

IBM_i

node The system host name or IP address. The system 

host name or IP 

address. Specify 

NULL  when host  is 

set to $MASTER, or 

when defining an 

extended agent 

for PeopleSoft, 

MVS or Oracle.

Agent host name 

or IP address.

Remote engine 

host name or IP 

address.

Not applicable

tcpaddr The value assigned to 

nm port  in the localopts 

file. When defining 

multiple workstations 

on a system, enter an 

unused port number. The 

default value is 31111.

The value 

assigned to 

nm port  in 

the localopts 

file. When 

defining multiple 

workstations on 

a system, enter 

an unused port 

number. The 

default value is 

41114.

See the selected 

access method 

specifications.

The port number 

to communicate 

with the agent 

when the protocol 

is http.

The port number 

to communicate 

with the remote 

engine when the 

protocol is http.

Not applicable

secureaddr The value assigned 

to nm ssl port  in the 

localopts  file. Specify it if 

securitylevel  is set to on, 

force  or enabled.

Not Applicable Not Applicable The port number 

to communicate 

with the agent 

when the protocol 

is https.

The port number 

to communicate 

with the remote 

engine when the 

protocol is https.

Not applicable

timezone | tz The time zone in which the system is located. 

It is recommended that the value matches the 

value set on the operating system.

The time zone set 

on the workstation 

specified in the 

host  attribute.

The time zone set 

on the agent.

The time zone 

set on the remote 

engine.

The time 

zone 

set on 

The time 

zone set on 

the dynamic 

pool agents.
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Table  41. Attribute settings for target workstation types

this table shows the attribute settings for target workstation types

(continued)

Attribute Fault-tolerant agent 

and standard agent

Workload broker 

workstation

Extended agent Agent Remote engine 

workstation

Pool Dynamic 

pool

the pool 

agents.

domain Specify an existing 

domain. The default 

value for fault-tolerant 

agents is MASTERDM. This 

setting is mandatory for 

standard agents.

Specify an 

existing domain. 

This setting is 

mandatory.

This setting is 

needed only if the 

value assigned to 

host  is $MANAGER.

Not applicable

host Not Applicable The host 

workstation. It can 

be set to $MASTER 

or $MANAGER.

The broker workstation.

access Not Applicable Select the 

appropriate 

access method 

file name.

Not Applicable

agentID The unique 

identifier of the 

dynamic agent

type
fta

s-agent

The default value is fta.

Specify fta  for IBM® 

i  systems running as 

limited fault-tolerant 

agents.

broker x-agent agent rem-eng pool d-pool

ignore Use this attribute if you do not want this workstation to appear in the next production plan.

autolink It indicates if a link between workstations is 

automatically opened at startup. Specify one 

of the following values:

ON

OFF

OFF Not applicable
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Table  41. Attribute settings for target workstation types

this table shows the attribute settings for target workstation types

(continued)

Attribute Fault-tolerant agent 

and standard agent

Workload broker 

workstation

Extended agent Agent Remote engine 

workstation

Pool Dynamic 

pool

This is an optional attribute. The default value 

is ON.

behindfirewall It indicates if there is a firewall between the 

workstation and the master domain manager. 

Specify one of the following values:

ON

OFF

The default value is OFF.

OFF Not applicable

securitylevel The type of SSL 

authentication to use:

enabled

on

force

Not applicable for IBM® 

i  systems running as 

limited fault-tolerant 

agents.

Not Applicable

fullstatus It indicates if the 

workstation is updated 

about job processing 

status in its domain and 

subdomains. Specify one 

of the following values:

ON

OFF

Specify OFF  for standard 

agents.

OFF Not applicable

server 0-9, A-Z. When specified, it requires the 

creation of a dedicated mailman processes 

on the parent workstation.

Not Applicable

protocol Not applicable Specify one of the following values:

http

https

Not applicable
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Table  41. Attribute settings for target workstation types

this table shows the attribute settings for target workstation types

(continued)

Attribute Fault-tolerant agent 

and standard agent

Workload broker 

workstation

Extended agent Agent Remote engine 

workstation

Pool Dynamic 

pool

This attribute is optional. When 

not specified, it is automatically 

determined from the settings specified 

for tcpaddr  and secureaddr.

members Not applicable Required 

value

Not 

applicable

requirements Not applicable Required 

value

Related information

Workstation  on page 44

Creating a task to Monitor Workstations  on page 195

Workload Designer
Reference information about the Workload Designer.

This section provides some reference information about the Workload Designer.

Working List
Use this pane to view all the objects that you are working on, to create new objects and to search for existing ones.

Use this pane to view all the objects you are working on, to create new objects, and to search for existing ones in the 

database.

The objects you see in this list are those you have currently open and you can switch between them to act on them in the 

workspace on the right.

In this pane you can use the following toolbars:

Use the toolbar to work with the objects displayed in this pane.
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Use the toolbar to select or clear all the objects displayed in the list or to collapse and expand the list.

The object highlighted in the list is open in the workspace on the right, where you can edit it.

The object open in the workspace on the right is displayed in bold in this list.

The objects in the list can be marked by the following icons: The objects in the list can be marked by the following icons:

 The object is open in edit mode.

 The object has pending changes that must still be saved. Click the Save icon to commit the changes to the 

database.

 The object is incorrect or incomplete and cannot be saved until all errors are fixed.

 The object is currently being loaded. It cannot be edited until the loading completes.

If you close an object, it is removed from the working list. If it was locked, by closing it you also unlock it.

Related information

Designing your Workload  on page 101

Editing objects from the Working List View  on page 103

Details view
Details view displays the structure of the job streams, associated dependencies, and run cycles in a tree table.

Use this view to create, display, and modify job streams, and to add jobs, run cycles, and dependencies to them. It shows the 

job stream with all the jobs it contains, associated dependencies, and run cycles.

This view displays the structure of the objects in a tree table. It applies to

job streams

job streams and resources.

It also shows the resource availability intervals. Use the view also to create, display, and modify resources, and to add 

availability intervals to them.

In this view you can use the following toolbar, icons, and buttons:
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All the actions available using the icons of the toolbar act on the root object of the tree table.

Use this button to print the contents of the tree in text format for job streams. Click the button to open a new 

page containing the information in the tree table for the job stream you are viewing. The output is organized in 

columns. For all job streams, the object properties shown are Name, Type, and Workstation.

For z/OS job streams, also Task Type and Owner are shown.

This icon is located at the end of each row and in the objects pop-up menu. Click it to remove the 

corresponding object from the tree table. Use it, for example, to remove a job from a job stream or a 

dependency from a job. The removal becomes effective only when you save the object.

Use this button to act on objects located at inner levels. Select the object in the tree table and open the menu, 

or use the pop-up menu by right-clicking the object. This button is enabled only if the operation is available for 

the selected object.

Some of the actions available from the action menus are:

Add Objects Selected in Working List

Add all the objects currently selected in the Working List. The objects are added as part of the flow or as 

dependencies. For example, adding a job definition to a job stream adds it to the job stream flow, while adding 

a prompt adds it as a dependency.

Add object

Add any specific object listed in the option.

Open Job Definition

Open the definition of the job to display its properties as they are defined in the database.

Copy

Copy the object and keep it in memory until you either copy another object or close the Workload Designer 

window. You can only copy a job stream if it already exists in the database (that is, it must have been saved at 

least once). You can also copy dependencies, except for internal job dependencies.
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Paste as Dependency

Paste the object previously copied as a dependency of the selected one. The copied object can be a job, a job 

stream, or any kind of dependency. You can only paste source objects that already exist in the database.

You can paste a job stream as:

• External job stream dependency of the same or of another job stream

• External job stream dependency of a job in the same or in another job stream

You can paste a job as:

• External job dependency of itself or of the job stream it belongs to

• Internal job dependency of another job in the same job stream

• External job dependency of another job stream or job in another job stream

The object selected in the tree table is highlighted in light blue and is displayed in bold in the Working List. When you select 

an object in the tree table, its properties are displayed in the lower pane, where you can view and edit them, if you are 

authorized to do so.

Related information

Designing your Workload  on page 101

Editing objects from the Details View  on page 104

Run Cycle Preview
This view applies only to job streams and shows the run cycles defined for the selected job stream.

It shows the days on which the job stream runs and the days on which it is explicitly excluded from running. You can see this 

view as a Month or full Year view, and use the navigation toolbar to go to the next or previous Month or Year.

When you modify a run cycle, the view is automatically updated.

Color coding and symbols are used to indicate included and excluded days in the run cycle rule.

Selecting a run cycle, the colors have the following meanings:

 The run cycle includes that day.

 The run cycle excludes that day.

Selecting a job stream, the colors have the following meanings:

 The job stream runs only once on that day.

 The job stream runs more than once on that day.
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 The job stream runs, but some runs have been excluded.

 The job stream runs more than once, but some runs have been excluded.

 The job stream does not run, because it is excluded by a rule.

 Non-working day.

Click any highlighted day to view details about the run cycles occurring on the selected day.

Related information

Run cycle  on page 56

Run cycle group  on page 58

Creating and managing run cycle groups and their run cycles  on page 128

Designing your Workload  on page 101

Message History
Use this panel to view all the messages related to the active session.

When you open this section, by default all warning and error messages of the current session are displayed.

Click the error, warning or information icon to filter for the corresponding messages. No message is displayed until you click 

an icon.

Click this icon to view error messages.

Click this icon to view warning messages.

Click this icon to view informational messages.

Click this icon to clear only the messages currently displayed.

Find

Type the string you want to find in the messages. Typing in the text fields automatically triggers the search, you 

do not have to click any further button. To reset the search criteria, clear the Find  text field.
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Main view

Click this button to go back to the main view, hiding the Message History view.

Related information

Designing your Workload  on page 101

Using recovery options in job definitions
Possible combinations of recovery options and actions.

The recovery options indicate the actions to be taken if a job fails.

The following table summarizes possible combinations of recovery options and actions. The table is based on the following 

criteria from a job stream called sked1:

• Job stream sked1  has two jobs, job1  and job2.

• If selected for job1, the recovery job is jobr.

• Job2  is dependent on job1  and will not start until job1  is complete.

Table  42. Recovery option table

Prompt/Job Stop Continue Rerun

Recovery prompt: No

Recovery job:  No

Intervention is required. Run job2 regardless of 

job1 completion status. • Rerun job1.

◦ If job1 ends 

in error, issue 

scheduler 

prompt.

◦ If reply is yes, 

repeat the 

above steps.

• If job1 is successful, 

run job2.
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Table  42. Recovery option table  (continued)

Prompt/Job Stop Continue Rerun

Recovery prompt: Yes

Recovery job:  No

Issue recovery prompt. 

Intervention is required. • Issue recovery 

prompt.

• If reply is yes, run 

job2 regardless of 

job1 completion 

status.

• Issue recovery prompt.

◦ If reply is yes, 

rerun job1.

◦ If job1 ends in 

error, repeat 

the above 

steps.

• If job1 is successful, 

run job2.

Recovery prompt: No

Recovery job:  Yes

• Run jobr.

◦ If jobr ends 

in error, 

intervention is 

required.

◦ If jobr is 

successful, run 

job2.

• Run jobr.

• Run job2 

regardless of job1 

completion status.

• Run jobr.

◦ If jobr ends 

in error, 

intervention is 

required.

◦ If jobr is 

successful, 

rerun job1.

• If job1 ends in error, 

issue scheduler 

prompt.

◦ If reply is yes, 

repeat the 

above steps.

◦ If job1 is 

successful, run 

job2.

267



Dynamic Workload Console User’s Guide

268

Table  42. Recovery option table  (continued)

Prompt/Job Stop Continue Rerun

Recovery prompt: Yes

Recovery job:  Yes

• Issue recovery 

prompt.

◦ If reply is yes, 

run jobr.

▪ If jobr 

ends in 

error, 

interve

ntion is 

requir

ed.

▪ If jobr 

is 

succes

sful, 

run 

job2.

• Issue recovery 

prompt.

◦ If reply is 

yes, run 

jobr.

• Run job2 

regardless of job1 

completion status.

• Issue recovery prompt.

◦ If reply is yes, 

run jobr.

▪ If jobr 

ends in 

error, 

interven

tion is 

requir

ed.

▪ If jobr is 

succes

sful, 

rerun 

job1.

• If job1 ends in error, 

repeat the above 

steps.

• If job1 is successful, 

run job2.

Note:

• Intervention is required  means that job2 is not released from its dependency on job1, and therefore must be 

released by the operator. You can also manually rerun job1 or cancel it.

• The continue  recovery option overrides the abend state, which might cause the schedule containing the job 

ended in error to be marked as successful. This prevents the schedule from being carried forward to the next 

day.

• If you select the Rerun  option without supplying a recovery prompt, when the job is unsuccessful IBM 

Workload Scheduler  creates a prompt that asks if you want to proceed.

• To reference a recovery job in conman, you must use the name of the original job (job1 in the scenario above, 

not jobr). Recovery jobs are run only one per abend.

Not all jobs are eligible to have recovery jobs run on a different workstation. Follow these guidelines:



Chapter 17. Reference

• If either workstation is an extended agent, it must be hosted by a domain manager or a fault-tolerant agent that runs 

in Full Status  mode.

• The recovery job workstation must be in the same domain as the parent job workstation.

• If the recovery job workstation is a fault-tolerant agent, it must run in Full Status  mode.

Regular expressions and SQL reports

This section contains examples of regular expressions and SQL reports. Some samples of report output are also shown.

Related information

Reports  on page 88

Reporting  on page 227

Regular Expressions
Examples of useful regular expressions supported by IBM Workload Scheduler.

This section gives some examples of useful regular expressions, together with a table that defines the expressions 

supported by IBM Workload Scheduler. Further information about regular expressions is also widely available in the Internet.

regular expressionsexpressionregularUseful regular expressions

The following table shows some useful regular expressions for use with the plan extractor, both for filtering jobs and job 

streams, and for configuring business unit names.

Table  43.  Useful regular expressions

Requirement Regular expression Example

To obtain the same effect as using the 

"@"character in the Tivoli Workload Scheduler 

command line

.* -JScpu .*

Used as a parameter to the plan extractor, 

filters for all job stream workstations.

To join different criteria in an "OR" relationship | (XYZ.*)|(.*ABC.*)

Filters for all items that begin with the string 

"XYZ or that contain the string "ABC" (regular 

expressions are case-sensitive).

To select objects that begin with one of several 

characters

[˂the  characters to 

be included>]

[ABC].*

Filters for all items that begin with either "A", 

"B", or "C".
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Table  43.  Useful regular expressions  (continued)

Requirement Regular expression Example

To select objects that do not begin with one of 

several characters

[^˂the  characters to 

be excluded>]

[^ABC].*

Filters for all items that do not begin with 

either "A", "B", or "C".

To select objects in which certain characters 

appear a certain number of times

˂the  character to 

be counted>{˂the 

character count>}

A{3}.*

Filters for all items that begin with the string 

"AAA".

To select objects in which certain characters 

appear at least a certain number of times

˂the  character to 

be counted>{˂the 

character count>}

A{3,}.*

Filters for all items that begin with the string 

"AAA", "AAAA", "AAAAA", and so on.

To select objects in which certain characters 

appear at least a certain number of times, but not 

more than a certain number of times

˂the  character to be 

counted>{˂the  lower 

character count>,˂the 

upper character 

count>,}

A{3,4}.*

Filters for all items that begin with the string 

"AAA", or "AAAA"; a string that began with 

"AAAAA" would not be selected.

complex expressionsexpressioncomplexComplex expressions

These individual regular expressions can be combined to make a complex expression, as shown in the following table.

Table  44.  Complex expressions

Example requirement Regular expression

Select all strings that begin with "AA", "AB", "AC", "BA", "BB", "BC", "CA", "CB", or "CC", 

and also those that do not end in "X", "Y", or "Z".

([ABC]{2}.*)|(.*[^XYZ])

Select all strings that begin with "AA" followed by either one or more numbers or one 

or more letters, and then by the character "_". It can finish with any characters.

This would, for example, select the string AA11_XYZ76  and the string AAFGH_43KKK, 

but not the string AA8H_3232IHSDG, because this latter has both numbers and letters 

between the "AA" and the "_".

A{2}([0-9]+|[A-Z]+)_.*

regular expressionsexpressionregularplan extractorregular expressions supportedRegular expressions supported by the plan extractor

The following tables provide full details of the regular expressions supported by the plan extractor.
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Table  45.  Regular expressions supported by the plan extractor: character

Syntax Filters for?

x The character  x  (regular expressions are case-sensitive)

\\ The backslash character

\0n The character with octal value 0n  (0 ˂=  n <= 7)

\0nn The character with octal value \0nn  (0 ˂=  n <= 7)

\0mnn The character with octal value \0mnn(0 ˂=  m ˂=  3, 0 ˂=  n ˂=  7)

\0xhh The character with hexadecimal value 0xhh

\uhhhh The character with hexadecimal value 0xhhhh

\t The tab character ('\u0009')

\n The newline (line feed) character ('\u000A')

\r The carriage-return character ('\u000D')

\f The form-feed character ('\u000C')

\a The alert (bell) character ('\u0007')

\e The escape character ('\u001B')

\cx The control character corresponding to x

Table  46.  Regular expressions supported by the plan extractor: character classes

Syntax Filters for?

[abc] a, b, or c (simple class)

[^abc] Any character except a, b, or c  (negation)

[a-zA-Z] a  through z  or A  through Z, inclusive (range)

[a-d[m-p]] a  through d, or m  through  p: [a-dm-p]  (union)

[a-z&&[def]] d, e, or f  (intersection)

[a-z&&[^bc]] a  through z, except for b  and c: [ad-z] (subtraction)

[a-z&&[^m-p]] a  through z, and not m  through p: [a-lq-z]  (subtraction)

Table  47.  Regular expressions supported by the plan extractor: predefined character classes

Syntax Filters for?

. Any character (might or might not match line terminators)

\d A digit:  [0-9]

\D A non-digit: [^0-9]
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Table  47.  Regular expressions supported by the plan extractor: predefined character classes  (continued)

Syntax Filters for?

\s A whitespace character: [ \t\n\x0B\f\r]

\S A non-whitespace character: [^\s]

\w A word character: [a-zA-Z_0-9]

\W A non-word character:  [^\w]

Table  48.  Regular expressions supported by the plan extractor: POSIX character classes (US-ASCII only)

Syntax Filters for?

\p{Lower} A lowercase alphabetic character: [a-z]

\p{Upper} An uppercase alphabetic character:[A-Z]

\p{ASCII} All ASCII:[\x00-\x7F]

\p{Alpha} An alphabetic character: [\p{Lower}\p{Upper}]

\p{Digit} A decimal digit: [0-9]

\p{Alnum} An alphanumeric character: [\p{Alpha}\p{Digit}]

\p{Punct} Punctuation: One of !"#$%&'()*+,-./:;˂=>?@[\]^_`{|}~

\p{Graph} A visible character: [\p{Alnum}\p{Punct}]

\p{Print} A printable character:  [\p{Graph}]

\p{Blank} A space or a tab:  [ \t]

\p{Cntrl} A control character: [\x00-\x1F\x7F]

\p{XDigit} A hexadecimal digit:  [0-9a-fA-F]

\p{Space} A whitespace character:  [ \t\n\x0B\f\r]

Table  49. Regular expressions supported by the plan extractor: classes for Unicode blocks and categories

Syntax Filters for?

\p{InGreek} A character in the Greek block (simple block)

\p{Lu} An uppercase letter (simple category)

\\p{Sc} A currency symbol

\P{InGreek} Any character except one in the Greek block (negation)

[\p{L}&&[^\p{Lu}]] Any letter except an uppercase letter (subtraction)
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Table  50. Regular expressions supported by the plan extractor: boundary matchers

Syntax Filters for?

^ The beginning of a line

$ The end of a line

\b A word boundary

\B A non-word boundary

\A The beginning of the input

\G The end of the previous match

\Z The end of the input but for the final terminator, if any

\z The end of the input

Table  51. Regular expressions supported by the plan extractor: greedy quantifiers

Syntax Filters for?

X? X, once or not at all

X* X, zero or more times

X+ X, one or more times

X{n} X, exactly n  times

X{n,} X, at least n times

X{n,m} X, at least n  but not more than m  times

Table  52. Regular expressions supported by the plan extractor: reluctant quantifiers

Syntax Filters for?

X?? X, once or not at all

X*? X, zero or more times

X+? X, one or more times

X{n}? X, exactly n  times

X{n,}? X, at least n times

X{n,m}? X, at least n  but not more than m  times

Table  53. Regular expressions supported by the plan extractor: possessive quantifiers

Syntax Filters for?

X?+ X, once or not at all
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Table  53. Regular expressions supported by the plan extractor: possessive quantifiers  (continued)

Syntax Filters for?

X*+ X, zero or more times

X++ X, one or more times

X{n}+ X, exactly n  times

X{n,}+ X, at least n times

X{n,m}+ X, at least n  but not more than m  times

Table  54. Regular expressions supported by the plan extractor: logical operators

Syntax Filters for?

XY X  followed by Y

X|Y Either X  or Y

(X) X, as a capturing group

Table  55. Regular expressions supported by the plan extractor: back references

Syntax Filters for?

\n Whatever the nth capturing group matched

Table  56. Regular expressions supported by the plan extractor: quotation

Syntax Filters for?

\ Nothing, but quotes the following character

\Q Nothing, but quotes all characters until \E

\E Nothing, but quotes all characters until \Q

Table  57. Regular expressions supported by the plan extractor: special constructs (non-capturing)

Syntax Filters for?

(?:X) X, as a non-capturing group

(?idmsux-idmsux) Nothing, but turns match flags on - off

(?idmsux-idmsux:X) X, as a non-capturing group with the given flags on - off

(?=X) X, via zero-width positive lookahead

(?!X) X, via zero-width negative lookahead

(?˂=X) X, via zero-width positive lookbehind

(?˂!X) X, via zero-width positive lookbehind
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Table  57. Regular expressions supported by the plan extractor: special constructs (non-capturing)  (continued)

Syntax Filters for?

(?>X) X, as an independent, non-capturing group

SQL report examples
Examples of queries that can be run using the SQL custom reports.

This section provides some examples of queries that can be run using the SQL custom reports.

jobreturn codesreturn codesjobs grouped byJobs grouped by return codes

For each return code, this query returns the number of jobs that ended with the corresponding return code:

SELECT DISTINCT return_code AS RC  count(job_name) AS ,#JOB

FROM mdl.job_history_v

GROUP BY return_code

Table  58. 

Example 

of query 

outcome

RC #JOB

0 1670

5 11

6 1

50 2

127 352

jobstatisticsreturn codesreturn codesjob statistics grouped byJob statistics grouped on job status

For each job status, this query returns the number of jobs that ended with the corresponding job status and also the planned 

duration time, the total elapsed time, and total CPU time:

SELECT job_status, count(job_name) AS  job count, floor(sum(planned_duration/1000)) AS

planned duration,  floor(sum(total_elapsed_time/1000)) AS  total elapsed,

floor(sum(total_cpu_time/1000)) AS  total cpu

FROM mdl.job_history_v GROUP BY job_status
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FROM mdl.job_history_v

GROUP BY return_code

Table  59. Example of query outcome

JOB_S

TATUS JOB COUNT

PLANNED 

DURATION

TOTAL 

ELAPSED

TOTAL 

CPU

A 366 0 21960 0

S 1670 1413360 1423500 183

Jobs in a range of return code

This query returns the number of job in a range of return codes

SELECT *

FROM (select DISTINCT return_code, count(job_name) AS #JOB

FROM mdl.job_history_v

GROUP BY return_code) AS temp

WHERE return_code > 0 AND return_code ˂  6

Table  60. Example of 

query outcome

RETURN_CODE #JOB

5 11

jobtime rangetime rangeJobs that ran within a time range and finished with a specific job status

SELECT WORKSTATION_NAME, JOB_NAME, JOB_RUN_DATE_TIME

FROM MDL.JOB_HISTORY_V

WHERE JOB_RUN_DATE_TIME BETWEEN '2008-05-19 10:00:00.0' AND '2008-05-19

21:00:00.0' AND JOB_STATUS ˂>  'S'

ORDER BY JOB_RUN_DATE_TIME
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Table  61. Example of query outcome

WORKSTAT

ION_NAME JOB_NAME JOB_RUN_DATE_TIME

NC122072 PEAK_A_06 2008–08–03 23:23:00.0

NC122072 JOB_RER_A 2008–08–03 23:23:00.0

NC122072 PEAK_A_13 2008–08–03 23:23:00.0

NC122072 PEAK_A_20 2008–08–03 23:23:00.0

NC122072 PEAK_A_27 2008–08–03 23:23:00.0

NC122072 PEAK_A_43 2008–08–03 23:23:00.0

NC122072 PEAK_B_19 2008–08–03 23:24:00.0

Related information

Creating a task to Create Custom SQL Reports  on page 232

Event rule
An event rule  defines a set of actions that run when specific event conditions occur. An event rule definition correlates events 

and trigger actions.

For information about how to define event rules, see the topic about defining event rules in the User's Guide and Reference .

Related information

Event management  on page 86

Event management configuration  on page 13

Creating an event rule  on page 138

Action properties
How to specify and use action properties.

When you select an action, its properties are displayed on the right of the table, where you can edit them.

Mandatory property fields are marked by asterisks. If you try to save an action without specifying one or more mandatory 

values, the required fields turn red and the rule cannot be saved. If available, default values are automatically entered in the 

fields.

actionpropertiesusing variable informationvariable informationusing into action properties

Using variable information into action properties
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To better qualify your action, you can use some event properties as variable information that can be added to the action 

properties. To use variables, select the variable icon  above the field. If you select the machine-readable format  check 

box the variable is used as input to a command or a script; otherwise, if you don't select it, the variable is included in normal 

text information (e.g. in a message or an email).

For example, you can include the job name in the mail body, if you have mail notification as a response action to a job-related 

event. You can include this variable information together with normal text in action properties that require a string value. For 

those properties that require a numeric value, you can enter either the variable information or a number.

Otherwise, you can click the lookup icon , enter your filter criteria and click Search. All the model items that reflect the 

inserted criteria are shown. Selecting an item, the fields are automatically filled in with its values.

Event properties
How to use event properties.

When you select an event, its properties are displayed on the right of the table, where you can edit them.

When you choose the event properties, you define a filter  for all the events that you want to monitor and manage. The most 

meaningful properties you choose are logically correlated and represent the event scope, which is displayed in the related 

event row.

Mandatory property fields are marked by asterisks. If you try to save an event without specifying one or more mandatory 

values, the required fields turn red and the rule cannot be saved. If available, default values are automatically entered in the 

fields.

Some property fields support wildcard characters. If supported, the wildcard icon  appears above the field.

You can also specify multiple values in the same field, separating them by semicolon (;). In this case, the properties are 

logically correlated by the conjunction or. When available, you see the multiple filters icon  above the field.

For example, if you create a Job Status Changed  event specifying the Job name  property as "A;B;C", an action is triggered 

each time either of the specified jobs changes its status.

Furthermore, by clicking on Add Properties  at the end of the Properties  panel, you can add the same property field multiple 

times and assign different values to it. The properties are logically correlated by the conjunction and, creating a cumulative 

filter.

To remove an added properties, click on the close icon . You cannot remove mandatory properties.
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For example, when you define a Job Status Changed  event, if you want to exclude some jobs from it, you can define as event 

properties all the job names that match  production_*, and all the job names that do not match  production_*_1.
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A

access method

An executable file used by extended agents to connect to and control jobs on other operating systems (for 

example, z/OS) and applications (for example, Oracle Applications, PeopleSoft, and SAP R/3). The access 

method is specified in the workstation definition for the extended agent. This term applies only to IBM® 

Workload Scheduler  distributed environments. See also "extended agent  on page 284".

actual start

The time that a job or job stream, planned to run during current production, actually starts. See also:

• "earliest start  on page 283"

• "latest start  on page 286"

• "planned start  on page 288"

• "scheduled time  on page 290"

ad hoc job

A job used to run a command or a script file that is inserted into the current plan. These jobs are not saved in 

the IBM®  Workload Scheduler  database. See also:

• "database  on page 282"

• "plan  on page 288"

ad hoc prompt dependency

A prompt dependency that is defined within the properties of a job or job stream and is unique to that job or 

job stream. This term applies only to IBM®  Workload Scheduler  distributed environments. See also "prompt 

dependency  on page 289".

availability

The degree to which a system or resource is ready when needed to process data.

B

batchman

A process running on IBM®  Workload Scheduler  workstations. This process accesses the copy of the 

Symphony  file distributed to workstations at the beginning of the production period and updates it, resolving 

dependencies. It is the only process that can update the Symphony  file. This term applies only to IBM® 

Workload Scheduler  distributed environments. See also:

• "processes  on page 289"

• "production period  on page 289"

• "symphony file  on page 291"
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backup domain manager

A full status fault-tolerant agent in a distributed network that can assume the responsibilities of its domain 

manager. This term applies only to IBM®  Workload Scheduler  distributed environments. See also:

• "fault-tolerant agent  on page 284"

• "full status  on page 285"

• "domain manager  on page 283"

backup master domain manager

A full status fault-tolerant agent in a distributed network that can assume the responsibilities of the master 

domain manager. This term applies only to IBM®  Workload Scheduler  distributed environments. See also:

• "fault-tolerant agent  on page 284"

• "full status  on page 285"

• "master domain manager  on page 287"

C

calendar

A list of scheduling dates used either to identify the dates when job streams or jobs can be run (when used with 

inclusive run cycles), or when they cannot be run (when used with exclusive run cycles). See also:

carry forward

A property of a job stream that, if not completed before the end of the current production period, is carried 

forward to the next and then to subsequent periods, until the latest start time is reached or the job stream 

completes. See also "latest start  on page 286".

computer workstation

In the IBM®  Z Workload Scheduler, either:

• A workstation that performs z/OS processing of jobs and started-task jobs, and that usually reports 

status to Dynamic Workload Console  automatically.

or:

• A processor used as a workstation. It can refer to single processors or multiprocessor complexes 

serving a single job queue, for example JES2 or JES3 systems.

connector

An installed component that provides the interface between the Dynamic Workload Console  and the engine. 

This term applies only to IBM®  Workload Scheduler  distributed environments. See also:

• "engine  on page 283"
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controller

In the IBM®  Z Workload Scheduler, the component that runs on the management hub, and that contains the 

tasks that manage the plans and the database.

cpu time

The processor time used by a job when running. See also "duration  on page 283".

current plan

In the IBM®  Z Workload Scheduler  the detail plan of activity that covers a period of at least 1 minute, and not 

more than 21 days. A current plan typically covers 1 or 2 days.

D

database

In IBM®  Workload Scheduler  for distributed environments it consists of a set of tables defined in relational 

database, such as DB2 or Oracle, containing the definitions for all scheduling objects (jobs, job streams, 

resources, workstations, domains, parameters, prompts and files), job and job stream statistics, user data, and 

the last time an object was modified.

In the IBM®  Z Workload Scheduler  it consists of collection of the following data: calendar, period, workstation 

description, JCL variable table, application description, and operation instruction.

deadline

The time by which a job or job stream is set to complete. When a job or job stream passes the deadline, 

notifications are sent to users and integrated applications, but the job or job stream is not prevented from 

running if all time restrictions and dependencies are satisfied. Jobs or job streams that have not yet started 

or that are still running after the deadline time has expired are marked as "late" in the plan. See also "plan  on 

page 288".

dependency

A prerequisite condition that must be satisfied before a job or job stream can start or continue to run. See also:

• "external dependency  on page 284"

• "file dependency  on page 284"

• "follows dependency  on page 284"

• "prompt dependency  on page 289"

• "resource dependency  on page 289"

distributed network

A connected group of workstations defined using IBM®  Workload Scheduler  for distributed environments. See 

also:

• "engine  on page 283"

• "workstation  on page 292"
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distributed workstation

A workstation in the IBM®  Workload Scheduler  distributed environment on which jobs and job streams are run. 

See also:

• "engine  on page 283"

• "workstation  on page 292"

domain

A named group of workstations in a IBM®  Workload Scheduler  distributed network, consisting of one or more 

agents and a domain manager acting as the management hub. All domains have a parent domain except for 

the master domain. This term applies only to IBM®  Workload Scheduler  distributed environments. See also:

• "domain manager  on page 283"

• "master domain manager  on page 287"

domain manager

An installed component in a IBM®  Workload Scheduler  distributed network that is the management hub in a 

domain. All communication to and from the agents in the domain is routed through the domain manager. This 

term applies only to IBM®  Workload Scheduler  distributed environments. See also "workstation  on page 292"

duration

The elapsed time that a job is expected to take to complete (estimated duration) and actually takes (actual 

duration). See also:

• "cpu time  on page 282"

• "time restriction  on page 291"

E

earliest start

The time before which a job or job stream cannot start. The job or job stream can start after the earliest start 

time provided that all other time restrictions and dependencies are satisfied. See also:

• "actual start  on page 280"

• "latest start time  on page 286"

• "planned start  on page 288"

• "scheduled time  on page 290"

engine

The core software for the scheduling environment. The engine can be either a z/OS engine (installed as part of 

IBM Z Workload Scheduler), or a distributed engine (installed as part of IBM Workload Scheduler).
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extended agent

An agent used to integrate Tivoli®  Workload Scheduler job control features with other entities such as 

operating systems (for example, z/OS) and applications (for example, Oracle Applications, PeopleSoft, and 

SAP R/3). Extended agents must be hosted by a master domain manager, domain manager, or an agent (not 

another extended agent), and use access methods to communicate with the other entities. This term applies 

only to IBM®  Workload Scheduler  distributed environments. See also "access method  on page 280".

external dependency

A dependency defined in one job or job stream that refers to another job stream or to a job in another job 

stream.

external job

A job referred to in an external dependency. See also "external dependency  on page 284".

F

fault-tolerant agent

A installed agent component in a distributed network capable of resolving local dependencies and launching its 

jobs. This term applies only to IBM®  Workload Scheduler  distributed environments.

fence

An attribute on a workstation that regulates whether a job can be run on a workstation. The job fence is a 

priority level that the priority of a job must exceed before it can run. This term applies only to IBM®  Workload 

Scheduler  distributed environments.

file dependency

A dependency where a job or job stream cannot start until it finds a specific file is present in a specific path on 

a specific workstation. Sometimes called an opens file  dependency. This term applies only to IBM®  Workload 

Scheduler  distributed environments. See also "dependency  on page 282".

follows dependency

A dependency where a job or job stream cannot start until other jobs or job streams have completed 

successfully. See also "dependency  on page 282".

forecast plan

A projection over a selected time interval based on the job streams and dependencies defined in the database. 

This term applies only to IBM®  Workload Scheduler  distributed environments. See also

• "database  on page 282"

• "plan  on page 288"

FTA

See "fault-tolerant agent  on page 284"
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full status

An attribute of an agent that enables it to be updated with the status of jobs and job streams running on all 

other workstations in its domain and in subordinate domains, but not on peer or parent domains. A backup 

domain manager or master domain manager must be full status. See also:

• "backup domain manager  on page 281"

• "domain  on page 283"

• "master domain manager  on page 287"

G

general workstation

In the IBM®  Z Workload Scheduler  this is a workstation where activities other than printing, and processing are 

carried out. A general workstation is usually manual, but it can also be automatic. Manual activities can include 

data entry and job setup.

H

host

A workstation required by extended agents. It can be any IBM®  Workload Scheduler  workstation except 

another extended agent. This term applies only to IBM®  Workload Scheduler  distributed environments.

I

internal status

The current status of jobs and job streams in the IBM®  Workload Scheduler  engine. The internal status is 

unique to IBM®  Workload Scheduler. See also "status  on page 291".

internetwork dependencies

A dependency between jobs or job streams in separate IBM®  Workload Scheduler  networks. This term applies 

only to IBM®  Workload Scheduler  distributed environments. See also "network agent  on page 287".

internetwork job or job stream

A job or job stream in a remote IBM®  Workload Scheduler  network that is referenced by an internetwork 

dependency defined for a job or job stream in the local network. This term applies only to IBM®  Workload 

Scheduler  distributed environments. See also "network agent  on page 287".

J

job

A unit of work scheduled for a specific run date in the plan that is processed at a workstation. In IBM®  Z 

Workload Scheduler, a job is an operation performed at a computer workstation.

job limit

See "limit  on page 286"
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job status

See "status  on page 291".

job stream

A list of jobs that scheduled to run as a unit in the plan (such as a weekly backup application), along with run 

cycles, times, priorities, and other dependencies that determine the exact order in which the jobs run.

jobman

A process running on IBM®  Workload Scheduler  workstations. This process controls the launching of jobs 

under the direction of batchman  and reports job status back to mailman. This term applies only to IBM® 

Workload Scheduler  distributed environments. See also:

• "batchman  on page 280"

• "jobmon  on page 286"

• "mailman  on page 287"

jobmon

An additional process running on IBM®  Workload Scheduler  Windows workstations. It manages and monitors 

job processing. A separate jobmon  process is created to launch and monitor each job. This term applies only to 

IBM®  Workload Scheduler  distributed environments. It reports job status back to jobman. See also:

• "jobman  on page 286"

• "processes  on page 289"

L

latest start

The time before which the job or job stream must start. The job or job stream can start before the latest start 

time provided that all other dependencies are satisfied. See also:

• "actual start  on page 280"

• "earliest start time  on page 283"

• "planned start  on page 288"

• "scheduled time  on page 290"

limit

A means of allocating a specific number of job slots into which IBM®  Workload Scheduler  is allowed to launch 

jobs. A job limit can be set for each job stream, and for each workstation. For example, setting the workstation 

job limit to 25 permits IBM®  Workload Scheduler  to have no more than 25 jobs running concurrently on the 

workstation.

list

A means of filtering plan and objects and presenting them in a table. Lists on Dynamic Workload Console  are 

the result of running tasks.
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M

mailman

The mail management process running on IBM®  Workload Scheduler  workstations. It routes messages about 

jobs processing status to local and remote workstations. This term applies only to IBM®  Workload Scheduler 

distributed environments. See also "processes  on page 289".

master domain manager

The management hub of the top-level domain in the IBM®  Workload Scheduler  distributed network. It 

maintains the database of all scheduling objects in the domain and the central configuration files. The master 

domain manager generates and distributes the current plan through the network as a program control file 

named Symphony file. In addition, logs and reports for the network are maintained on the master domain 

manager. See also:

• "backup master domain manager  on page 281"

• "database  on page 282"

• "domain  on page 283"

• "plan  on page 288"

MDM

See "master domain manager  on page 287".

N

netman

The network management process that is started first when the IBM®  Workload Scheduler  workstations starts 

up. It processes start, stop, link  or unlink  commands or requests to run actions impacting the job processing 

on that workstation. The netman  process examines each request received and either implements the request 

itself or create a local IBM®  Workload Scheduler  process to do so. This term applies only to IBM®  Workload 

Scheduler  distributed environments. See also "processes  on page 289".

network agent

A logical extended agent used to create dependencies between jobs and job streams on separate IBM® 

Workload Scheduler  networks. This term applies only to IBM®  Workload Scheduler  distributed environments. 

See also "internetwork dependencies  on page 285".

O

opens file dependency

See "file dependency  on page 284".

open interval

The time interval during which a workstation is active and can process work.
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owner ID

In IBM®  Z Workload Scheduler, the identifier that represents the job stream owner.

P

parameter

An entity that enables job instance-specific values to be substituted in job and job stream scripts, either from 

values set in the database or at run time. Parameters cannot be used when scripting extended agent jobs. This 

term applies only to IBM®  Workload Scheduler  distributed environments.

plan

The means of scheduling jobs. See also:

• "database  on page 282"

• "current plan  on page 289"

• "trial plan  on page 291"

planned start

The time that IBM®  Workload Scheduler  estimates a job instance will start. This estimate is based on start 

times of previous instances of the job. See also:

• "actual start  on page 280"

• "earliest start  on page 283"

• "latest start  on page 286"

• "scheduled time  on page 290"

portlet

A pluggable user interface components that are managed and displayed in a web portal.

predecessor

A job or job stream that must complete successfully before successor jobs or job streams can be started. See 

also "successor  on page 291".

predefined prompt dependency

A prompt dependency that is defined in the database and can be associated to any job or job stream. This 

term applies only to IBM®  Workload Scheduler  distributed environments. See also "prompt dependency  on 

page 289".

printer workstation

In IBM®  Z Workload Scheduler, a workstation that prints output and usually reports status automatically.

priority

A way of determining the order in which jobs and job streams start. Priorities for each job and job stream range 

from 0  to 101. A job or job stream with a priority of 0  does not run.
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production period

The time interval covered by the current plan. See also "current plan  on page 289".

current plan

Contains all job scheduling activity planned for a production period. The plan is stored in the Symphony  file, and 

consists of all the jobs, job streams, and dependency objects that are scheduled to run for that period, including 

any jobs or job streams carried forward from the previous plan. See also:

• "carry forward  on page 281"

• "plan  on page 288"

processes

IBM®  Workload Scheduler  workstation processes that control the scheduling environment and network traffic. 

This term applies only to IBM®  Workload Scheduler  distributed environments. See also:

• "batchman  on page 280"

• "jobman  on page 286"

• "jobmon  on page 286"

• "mailman  on page 287"

• "netman  on page 287"

prompt dependency

A dependency where an operator must respond affirmatively to a prompt so that the dependent job or job 

stream can run. See also:

• "ad hoc prompt dependency  on page 280"

• "predefined prompt dependency  on page 288"

R

resource

Either physical or logical system resources. Resources are used as dependencies for jobs and job streams. See 

also "resource dependency  on page 289".

resource dependency

A dependency where a job or job stream cannot start until the required quantity of the defined resource is 

available. See also "resource  on page 289".

restart and cleanup

A recovery function that ensures the restart of a job and the related cleanup actions, for example, deleting 

temporary files or dataset created in a job run.
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rule-based run cycle

A run cycle that uses rules based on lists of ordinal numbers, types of days, and common calendar intervals (or 

period names in IBM®  Z Workload Scheduler). For example, the last Thursday of every month. Rule-based run 

cycles are based on conventional periods, such as calendar months, weeks of the year, and days of the week. 

In IBM®  Z Workload Scheduler, run cycles can also be based on periods that you define, such as a semester. 

This term is only used as such in IBM®  Z Workload Scheduler, but the concept applies also to the distributed 

product. See also:

• "run cycle  on page 290"

run cycle

Specifies the days that a job stream is scheduled to run. The specification can be in the form of a rule or as a 

combination of period and offset. See also:

• "calendar  on page 281"

S

schedule

See "job stream  on page 286".

scheduled time

The time when a job or job stream is scheduled to run. See also:

• "actual start  on page 280"

• "earliest start  on page 283"

• "latest start  on page 286"

• "planned start  on page 288"

slack time

In a critical job predecessor path, the slack time is the amount of time the predecessor processing can be 

delayed without exceeding the critical job deadline. It is the spare time calculated using the deadline, input 

arrival, and duration settings of predecessors jobs

special resource

In IBM®  Z Workload Scheduler, a resource that is not associated with a particular workstation, such as a data 

set.

standard agent

An installed agent component in a distributed network that runs jobs, but requires a domain manager to resolve 

local dependencies and launch the jobs.
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started-task operation

In IBM®  Z Workload Scheduler, an operation that starts or stops started tasks. This operations are run at a 

computer workstation with the STC option specified.

status

The current job or job stream status within the Dynamic Workload Console. The Dynamic Workload Console 

status is common to IBM®  Workload Scheduler  and IBM®  Z Workload Scheduler. See also "internal status  on 

page 285".

successor

A job that cannot start until all of the predecessor jobs or job streams on which it is dependent are completed 

successfully. See also: "predecessor  on page 288".

Symphony file

A file containing the scheduling information needed by the production control process (batchman) to run the 

plan. The file is built and loaded when the current plan is created or extended on the master domain manager. 

During the production phase, this file is continually updated to indicate the current status of production 

processing: work completed, work in progress, and work to be done. The tasks run from the Dynamic Workload 

Console  display the contents of the Symphony  file (plan) and are run against it. See also:

• "batchman  on page 280"

• "plan  on page 288"

T

task

A filter that returns, when run, a list of scheduling objects of the same type whose attributes satisfy the criteria 

set in the task definition.

time restriction

Determines the times before which, after which, or both, that a job or job stream cannot be run. Specifying both 

defines a time interval within which a job or job stream runs. Jobs can also have a repetition rate. For example, 

IBM®  Workload Scheduler  can launch the same job every 30 minutes between the hours of 8:30 a.m. and 1:30 

p.m.

tracker

In IBM®  Z Workload Scheduler, a component that runs on every system in your complex. It acts as the 

communication link between the z/OS system that it runs on and the controller.

trial plan

A projection of the current plan for a different period, using the same start date. It is used to determine 

the effect of different plan decisions. This term applies only to IBM®  Workload Scheduler  distributed 

environments. See also "plan  on page 288".

V
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virtual workstation

It is a computer workstation where you define a pool of destinations for the workload submission. When the 

scheduler processes the operations submitted to a virtual workstation, it distributes the workload according 

a balanced turn criteria. To obtain the job submission, at least one of the destinations in the pool must be 

available.

W

workstation

A definition of an individual computer or computer partition on which jobs and job streams are run. Types of 

workstation vary depending on the type of engine. See also:

• "distributed workstation  on page 283"

• "z/OS workstation  on page 292"

workstation resource

In IBM®  Z Workload Scheduler, a physical resource, such as a tape driver, that must be allocated among jobs. 

When you define a workstation, you can specify the quantity of each of the two resources (R1 and R2) that are 

available to jobs. When defining jobs to that workstation, you can specify the number of these resources that 

must be available for the operation to start on that workstation.

write-to-operator workstation

In IBM®  Z Workload Scheduler, a general workstation that lets you use scheduling facilities to issue a write-to-

operator (WTO) message at a specific operator console defined by the workstation destination.

WTO operation

In IBM®  Z Workload Scheduler, jobs that consists of and operator instruction that is passed to IBM Tivoli 

NetView. These operations are run at a general workstation with the WTO option specified.

X

x-agent

See "extended agent  on page 284".

Z

z/OS network

A connected group of workstations that use the z/OS engine to perform workload scheduling. See also:

• "engine  on page 283"

• "workstation  on page 292"

z/OS workstation

A representation of system configuration elements in the IBM®  Z Workload Scheduler  network. For the IBM®  Z 

Workload Scheduler  engine, workstations can be:
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• Computer

• General

• Printer

IBM®  Z Workload Scheduler  requires that you define for every workstation: the type of work it does, the 

quantity of work it can handle at any particular time, and the time it is active. See also "workstation  on 

page 292".
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